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1. Zehn Schritte im Schnelldurchlauf (Ten Easy Steps to Su ccessful Logging) 
 

(nein, ich war nicht im Stoff, als ich dieses Kapitel geschrieben habe…)  

1.1 Schritt 1 : Einrichten (Step 1. Setup) 

 

Stellen Sie Verbindungen zum Transceiver und zum Packet- oder Telnet-DXCluster her (Tools/Configure). Sie werden 
beeindruckt sein, was passiert, wenn ein Spot vom Cluster einläuft.   

    

1.2 Schritt 2 : Fenster anordnen (Step 2. Adjust Window Positions) 

Ziehen Sie die Fenster an die gewünschte Stelle und korrigieren Sie ihre Grösse. Öffnen Sie – falls nötig – die Fenster 
nacheinander über das 'Window' - Menü.  

    

1.3 Schritt 3 : Soundkarte und CW-Interface anschliesse n                                                                                   
(Step 3. Connect the Sound Card and the CW interface ) 

Verbinden Sie die Soundkarte mit Ihrem Transceiver, um Sprachdateien  (*.wav) abspielen oder Verbindungen 
aufzeichnen zu können. Stecken Sie die CW-Tastung an die serielle oder parallele Schnittstelle. Siehe Interface ( 
interface section ) für Möglichkeiten.  

    

1.4 Schritt 4 : Rufzeicheneingabe (Step 4. Entering a C all) 
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Jetzt kann’s mit dem Log losgehen. Voreingestellt ist das General log  (DX) wie im Bild gezeigt. Wollen Sie ein QSO 
loggen ? Geben Sie das Rufzeichen in das Eingabefenster (Entry Window) ein, z.B. N1MM. Beobachten Sie das Prüf-
Fenster (Check window ). Ab 2 Zeichen-hier N1- bekommen Sie eine Liste mit – aus Contesten - bekannten Rufzeichen. 
Sie können N1MM in dieser Liste anklicken und es wird in das Rufzeichenfeld übernommen. In die RS(T)-Felder wird 
eine Voreinstellung (59/599) eingetragen und der Cursor steht im Namensfeld. 

1.5 Schritt 5 : Weiterschalten mit Leertaste (Step 5. Us ing the Space Bar to Tab) 

Es geht auch anders. Klicken Sie auf die Löschtaste (Wipe) und löschen Sie den aktuellen Eintrag. Der Cursor steht 
wieder im Rufzeichenfeld. Geben Sie N1MM ein und drücken Sie auf die Leertaste. Die RST-Felder werden wieder 
automatisch gefüllt und der Cursor steht im Namensfeld. Geben Sie Tom  ein. Wenn Sie wieder die Leertaste drücken, 
bleiben Sie ausnahmsweise weiter im Namensfeld, denn ein Name kann auch Leerzeichen zur Trennung enthalten. Bei 
den anderen Feldern kommen Sie mit der Leertaste in das nächste Feld. Diese Funktion ist bei Contesten sehr nützlich. 

1.6 Schritt 6 : TAB-Taste verwenden (Step 6. Using the Tab Key) 

Mit der TAB-(Tabulator)-Taste kommen Sie ohne Einschränkung vorwärts und mit gedrückter Shift-Taste rückwärts von 
Feld zu Feld und erreichen auch die voreingestellten RST-Felder. 

1.7 Schritt 7 : Bandskalen, DX-Meldungen und sonstiges (Step 7. Bandmaps, Spots and Other Cool Stuff) 
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Wenn Sie die CAT-Steuerung Ihres Transceivers richtig angeschlossen haben, sehen Sie zwei Bandskalen (Bandmaps) 
mit den an den VFOs A und B eingestellten Frequenzen und Sendearten. In diese Skalen wollen wir jetzt DX-Meldungen 
holen und benötigen dazu eine Verbindung zu einem DX-Cluster über Packet oder das Internet. Klicken Sie im Menü 
Windows auf den Eintrag Packet. Das Packet-Fenster hat je eine Karteikarte für eine Packet- oder eine Telnet-
Verbindung. Ist Ihr TNC richtig angeschlossen und konfiguriert, klicken Sie auf die Packet-Karte und geben in das 
einzeilige Eingabefenster neben den Reiter ein ‚C DB0MDX’ (oder ‚c db0mdx db0dsd’). Im Fenster darunter können Sie 
die Verbindungsaufnahme verfolgen. Klicken Sie nach erfolgreichem Connect zum DX-Cluster auf die Taste SH/DX. 
Voreingestellt auf dieser Taste ist ‚sh/dx/30’, voreingestellt ist auch die Verfallszeit der Meldungen auf 60min. 
Für einen Telnet-Connect muss Ihr Rechner im Internet eingeloggt sein. Der gewünschte Server wird bei der 
Konfigurierung eingestellt, über das Menü rechts oben angewählt und mit einem Klick auf die Taste CONN gerufen. Sie 
können es auch mal mit sh/dx/100 probieren. Wenn Sie nicht alle 100 Spots sehen, liegt das daran, dass die Verfallszeit 
von 60 Minuten schon abgelaufen ist. 

1.8 Schritt 8  : DX-Meldungen auswerten (Step 8. Spots are Fun!) 

Bei den DX-Spots in den Bandskalen stehen Gradangaben. Sie geben die Antennenrichtung korrekt an,  wenn Sie unter 
Configure > Change Your Station Data die Koordinaten Ihres Standorts richtig eingetragen haben. Klicken Sie einmal auf 
eine DX-Clustermeldung in der Bandskala. Das Rufzeichen erscheint über dem Rufzeichenfeld im Eingabefenster und 
wird mit der Leertaste in dieses Feld übernommen. Leeren Sie das Rufzeichenfeld mit Wipe, drehen Sie die Abstimmung 
am Transceiver hin und her. Wenn Sie dem Spot auf 300 Hz nahekommen, wird das Rufzeichen wieder über das 
Rufzeichenfeld übernommen. Mit der Leetaste wird es wieder eingetragen. Löschen Sie es wieder und klicken Sie jetzt 
zweimal auf eine Clustermeldung, der Transceiver wird auf die gemeldete Frequenz gestellt und das Rufzeichen sofort 
ins Rufzeichenfeld eingetragen. Bestätigen Sie es mit der Leertaste, werden die voreingestellten Rapporte eingetragen 
und der Cursor steht im Namensfeld.  
Mit den Tasten CTRL-UP und CTRL-DOWN können Sie von Spot zu Spot schalten, und mit den AUF (UP)- und 
RUNTER (DOWN)- Tasten ohne CTRL (Strg) können Sie Frequenz am Transceiver um 100 Hz (in SSB) oder 20 Hz (in 
CW) ändern (einstellbar). Es gibt noch mehr Möglichkeiten, gehen Sie zu Tastenzuordnungen (Key Assignments ). 

   

1.9 Schritt 9 : QSO speichern (Step 9. Actually Logging  Contacts) 

Sie haben Rufzeichen und Name ins Logeingabefenster eingetragen. Drücken Sie jetzt auf ENTER , das QSO wird 
abgespeichert und erscheint zu Kontrolle im Logfenster. 
Wenn Sie jetzt das gleiche Rufzeichen erneut im Logeingabefenster eingeben, passiert etwas : Das QSO von zuvor 
erscheint im bisher leeren unteren Teil des Logfensters und ein dickes DUPE! ist im rechten Teil des Logeingabefensters 
zu sehen. DUPE heisst DOPPELT und ist wichtig für Conteste, bei denen Doppel-QSOs ein Fehler sind. Haben Sie das 
QSO trotzdem abgespeichert, können Sie mit einem Rechtsklick auf das QSO im Logfenster „Delete contact“ (QSO 
löschen) wählen. 

1.10 Schritt 10 : Finale (Step 10. The Exciting Finale) 

Hören wir lieber hier beim Schnelldurchgang auf. N1MMLogger ist ein umfangreiches Programm mit sehr vielen 
Möglichkeiten. Sie können eine Menge an Einstellungen, Anpassungen, Zuweisungen machen, Sendearten wählen, 
Conteste vorbereiten und Punktzahlen ausrechnen oder auch die neuesten Länder, Sektionen und Koordinaten 
eintragen. Lesen Sie dieses Handbuch in Ruhe und spielen Sie die Möglichkeiten durch. 
Halten Sie sich vor allem an die Werkzeuge, lernen Sie, wie Sie die Punktzahl neu berechnen (rescore), sich die neueste 
Länderliste CTY.DAT holen oder die benötigte Konfiguration einstellen. 

1.11 Schritt 1 : CW- und WAV- Aufzeichnungen (Step 11. CW and WAV Recordings) 

Hallo, ich habe noch etwas vergessen, deswegen dieser Schritt 11 : Mit einem CW-Interface können Sie die F-Tasten mit 
vorzüglichem CW nutzen, die auch dann laufen, wenn Sie inzwischen etwas anderes in einem anderen Fenster machen. 
Die gleichen Tasten können Sie in einem SSB-Contest dazu benutzen, getrennt vorbereitete WAV-Dateien z.B. zum CQ-
rufen zu starten. Hier gelten die gleichen technischen Regeln für das Interface zwischen Soundkarte und Transceiver wie 
für Sendearten wie PSK und RTTY.  Informieren Sie sich unter Interfacing, wie Transceiver und Computer aneinander 
angepasst werden müssen. 
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2. N1MM Ein freies Contestprogramm   
(N1MM Free Contest Logger) 

2.1 Überblick (General Overview) 

Das Programm N1MMLogger ist ein kostenloses Programm (Freeware)  und 
in erster Linie für das Loggen von Contesten und Dxpedtionen gedacht. Es ist 
kein generelles Logprogramm mit der Suche nach bestätigten QSOs für 
Diplome u.ä. Sehen Sie sich die Eigenschaften ( Features ) an. 

Wichtig  : Informieren Sie sich unbedingt über die Tastenzuordnungen (Key 
Assignments), wenn Sie das Programm effektiv nutzen wollen.  

Zur Einführung ist der Schnelldurchlauf mit den ersten 10 Schritten (Quick 
Tour) gedacht.  

Zahlreiche Conteste (Supported Contests) und Transceivertypen (Supported 
Radios) werden vom Programm unterstützt.  

Das Programm läuft unter Windows 95/98/ME /NT/2000 und XP. DOS wird 
nicht unterstützt. 

2.2 Die N1MMLogger-Diskussionsrunde  (N1MM logger discussion 
group)  

Diese Diskussionrunde finden Sie im Internet unter 
http://groups.yahoo.com/group/N1MMLogger. Die Runde diskutiert 
Programmeigenschaften, Programmfehler und Ideen für den N1MMLogger. 
Sie können hier auch Fragen stellen und Anmerkungen machen. 

2.3 Dokumentation (Documentation) 

Sie erhalten die Hilfe und Dokumentation zu N1MMLogger aus drei Quellen :   

• Auf der N1MMLogger-Homepage können Sie mit 'View Help files' die Hilfe direkt lesen 
• Vom Programm aus kann die Hilfedatei N1MMLoggerHelp.chm gerufen werden   
• Sie können sich die vorliegende Hilfe als PDF-Datei mit dem Namen N1MM Logger.pdf oder eine 

Übersetzung Ihrer Wahl von der N1MM-Homepage holen und mit dem Adobe Acrobat Reader 
(Version 3 oder höher) lesen 

 
Sowohl auf die Hilfedatei (CHM-Datei) als auch auf das Handbuch (PDF-Datei) kann während der Arbeit mit dem 
Programm N1MMLogger zugegriffen werden. Die Dateien müssen im Verzeichnis von N1MMLogger abgelegt sein. 

2.4 Diskussionsrunde bei YAHOO  (Group Email Addresses) 

Post message: N1MMLogger@yahoogroups.com 

Subscribe: N1MMLogger-subscribe@yahoogroups.com 

Unsubscribe: N1MMLogger-unsubscribe@yahoogroups.com 

List owner: N1MMLogger-owner@yahoogroups.com 

2.5 Programmspezifikationen (Programming specifics) 

• Geschrieben in Visual Basic 6.0 (ohne aftermarket controls)  
• Grösse des EXE-Teils (p-code) etwa 2500 kB 
• 38 Forms, 21 Modules, 115 Classes  
• 71718 Programmzeilen  (57156 Zeilen ohne die Fenstersteuerung)  
• Es wird ein freies Programm (dll) für die Steuerung der LPT-Schnittstelle verwendet  
• Datenbasis ist Access 2000  
• Verwendung von  Data-bound-Steuerungen für  Log- und Prüffunktionen  
• Verwendet  MMTTY für RTTY über die Soundkarte  
• Verwendet PSKCore für PSK31 und PSK63 über die Soundkarte 
• Projekt mit offener Quelle  
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Das Logprogramm wurde so entwickelt, dass es auf einem Pentium II 233 MHz als minimale Plattform läuft. Ob es auf 
langsameren Maschinen läuft, muss im Einzelfall getestet werden., allerdings ist es nicht für zu alte Rechner gedacht. 

2.6 Programmentwicklung ?  (Program development?) 

Im Moment arbeiten  N2AMG, PA1M und ich (N1MM) an der Programmentwicklung. Es ist ein kooperatives 
Unternehmen und wenn Sie wollen, können Sie mitmachen. Sie sollten aber Ihr eigenes Visual Basic 6.0 und Access 
2000 haben. Nehmen Sie mit mir (N1MM) Verbindung auf. Wir können dann über das Projekt diskutieren. 

3. Features 
• Es werden alle grossen HF-

Conteste 
unterstützt und zusätzlich eine 
Möglichkeit zum generellen 
Loggen (General DX logging 
und Dxpedition) bereitgestellt  

• Mit der Soundkarte können Sie 
WAV-Dateien einkoppeln  

• Sie können die Transceiver-NF 
in WAV-Dateien abspeichern. 
Klicken Sie rechts auf das 
Logeingabefenster zur 
Wiedergabe.  

• Automatische CW -Tastung  

• RTTY-Unterstützung für MMTTY, HAL 
DXP38 und andere externe TNCs wie 
PK-232  

• Unterstützung von PSK31 und PSK63 

• Das Programm speichert die Grösse und Position der Fenster - wie vom Nutzer vorgegeben – ab. In der 
Regel werden die Fenster als Kacheln angeordnet, sie können sich aber nach Wunsch auch überlappen. 

• Die Hauptfenster (Logeingabefenster, Log, Bandskalen, Packet, Prüfen( Check) und verfügbare Multis und 
QSOs (Available Mults and Q's) sind nicht-modal, d.h, sie können in diesen Fenstern arbeiten, ohne das 
Fenster, in dem sie vorher waren, schliessen zu müssen.  

• Im Fenster für die verfügbaren Multis (Available Window) werden die interessanten DXCluster-Meldungen 
für Stationen und Multis für die Bänder getrennt und farbig gekennzeichnet ausgegeben, um eine 
Entscheidung zu einem Bandwechsel treffen zu können. Farbig hinterlegte Tasten geben an, auf welchem 
Band die gemeldete Station noch benötigt wird.  

•  Über das CAT-Interface werden Transceiver von Kenwood, Yaesu (z.B.: FT-1000, FT-1000MP, FT-990, 
FT-920 und andere), Icom und Elecraft gesteuert. Siehe  unterstützte Transceiver (support radios) 

• Klicken Sie auf eine DXCluster-Meldung im Packetfenster (packet window) , um den Transceiver auf diese 
Station nach Frequenz und Sendeart zu setzen.  

• Gemeldete Stationen erscheinen im Logeingabefenster über dem Rufzeichenfenster, wenn Sie in die Nähe 
dieser Station abstimmen. Mit einem Klick auf die Leertaste wird das Rufzeichen in das Rufzeichenfeld 
übernommen.  

• Sendearten-abhängige Feinverstimmung über die Tastatur  

• Automatische Berechnung der Antennenrichtung und des Sonnenauf- und untergangs bei der Gegenstation 

• Packet & Telnet-Unterstützung – die Meldungen aus beiden Quellen erscheinen automatisch aufgefrischt in 
den Bandskalen  

• Die Packetmeldungen können gefiltert werden  

• CW-Tastung über die Tastatur  

• Rufzeichenprüfung (Check partial)  

• Zwei grafisch gestaltete Bandskalen (bandmaps)  zum Abstimmen auf die ausgewählte Clustermeldung. 
Die Bandskalen können je nach Bedarf gezoomt werden und der Zahl der Meldungen angepasst werden.  

• Unterstützung von zwei Transceivern oder von zwei VFOs eines Transceivers. Je VFO wird eine Bandskala 
angezeigt.  

• Multiplikator-Fenster 

• LPT-Port-Funktionen zur Steuerung von Antennenschaltern, Transceiverauswahl und PTT 
(WIN95/98/ME/NT/2000/XP)  

• Multi-User-Betrieb  

•  Logexport im Cabrillo-Format  

• Logexport/-import im ADIF-Format  

• Alle Daten werden in einer Access 2000 Datenbasis abgelegt und stehen für die weitere Verarbeitung und 
zur Integration mit anderen Programmen bereit  

• Arbeit mit zwei Monitoren (Two monitor support) (ab Win 98 aufwärts)  

• S&P-QSO-Stapelspeicher (S&P=Suchbetrieb) 

• Rufzeichen-Stapelspeicher  
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•  

• Alle S&P-Rufzeichen lokal melden  

• Transverterunterstützung (SHF bis 10, 24, 47, 76, 142 und 241 GHz)  

• Winkey-Unterstützung  (Serial CW – Geber von K1EL)  

• Antennenumschaltung  

• SO2R/SO2V -Unterstützung 

• Vom Nutzer editierbare Bandpläne für CW, SSB und Digimodes  

• Erzeugung von CW über einen USB>Serial-Konverter 

• und vieles andere..........  

  

Demnächst  

• Seriennummer-Server für Multi-User-Betrieb 

4. Anforderungen an den PC (Minimal PC Requirements) 
4.1 Mindestanforderungen (Minimum hardware requirements ) 

Das Logprogramm wurde so entwickelt, dass es auf einem Pentium II 233 MHz als minimale Plattform läuft. Ob es auf 
langsameren Maschinen läuft, muss im Einzelfall getestet werden., allerdings ist es nicht für zu alte Rechner gedacht, es 
dürfte aber noch auf einem Pentium 1 laufen. Die Grafikauflösung sollte mindestens 800 x 600, besser jedoch 1024 x 
768 Punkte betragen, um alle Fenster auf dem Schirm unterzubringen.  
Der PC sollte über zusätzliche serielle Schnittstellen verfügen, um alle Transceiver, die CW- und PTT-Tastung, auch für 
MMTTY anzuschliessen. Siehe  Radio Computer interfacing 

4.2 Unterstützte Betriebssysteme (Supported Operating s ystems)  

• Windows 95  

• Windows 98  

• Windows ME  

• Windows NT  

• Windows 2000  

• Windows XP  

• und zukünftige Windows-Versionen (hoffentlich)  

5. Installation und Aktualisieren (  Installation and Upgrading) 
5.1 Programm holen  (Downloading the software) 

• Sie können N1MMLogger von den Links in der Tabelle unten holen.  
• Holen Sie sich zuerst die Grundsoftware N1MM.zip und installieren Sie sie. Danach müssen 

Sie sich die aktuelle Version ‚NewexeV…’ holen und sie und über die Grundinstallation 
entpacken. Zur Zeit (1.8.04) ist die Version 4.0.93 aktuell. 

• Holen Sie sich die neueste Help-Datei als *.chm-Datei und wahlweise zusätzlich die neueste  
PDF-Version der Hilfedatei.  

• Für die Unterstützung der seriellen und parallelen Schnittstellen müssen die Nutzer von  
Windows NT, 2000 und XP das Programm DLPORTIO.ZIP holen und starten 

• Holen Sie sich MMTTY, wenn Sie mit N1MMLogger in RTTY funken wollen  

Netherlands  Italy  

1  Holen Sie sich die 7 MB lange 
Basisdatei N1MM.zip von 

  

 

Holen Sie sie von www.kms.nl/n1mm - 
Diese holländische Seite wird von PA8AD / 

 

Holen Sie sie von  
WWW.PAGUS.IT/~n1mm - 

Die italienische Seite wird von 
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  PI4DEC bereitgestellt 

Download N1MM.zip  

  

I8NHJ bereitgestellt 

Download N1MM.zip  

2  
Holen Sie sich die neueste 
NewexeVx.x.xxx-Datei (1 MB) von :: 

www.n1mm.com und wählen Sie: Download latest Update  

3  

Überprüfen Sie die Ausgabeversion 
der aktuellen Hilfe. Sie wird unten in 
der ersten Seite angezeigt : 

HtmlDocTitlepage.htm  

4  
Holen Sie sich die Windows-Hilfe 
(1,6 MB). 

N1MMLoggerHelp.chm  
(klickern Sie rechts darauf und wählen Sie Speichern unter  )  

5  

Windows NT, 2000 und XP – 
Nutzer holen sich  
DLPORTIO.ZIP (800 kB) oder  
PORT95NT.EXE (1,6 MB)  

dlportio.zip (hier müssen Sie einige Arbeit reinstecken) oder (besser!) starten Sie 
einfach port95nt.exe  

Für mehr Information sehen Sie nach unter 
Interfacing page (32 bit OS part) 

6  
Holen Sie sich die PDF-Version der 
Hilfe und drucken sie aus  (3 MB). 

N1MMLogger.pdf 
(klickern Sie rechts darauf und wählen Sie Speichern unter  ) 

7  

Frischen Sie die Länderdatei 
Country file (cty.dat oder wl_cty.dat) 
auf. Das Werkzeug dazu steht unter  
Tools! 

http://www.k1ea.com/cty/index.htm 
Sehen Sie nach unter: DXCC-Liste anpassen (Customizing the DXCC list)  

8 

Frischen Sie die Master Callsign 
database (master.dta) auf 
Sie steht im  'Program folder'. 
N1MMLogger unterstützt das CT-
Format master.dta file. 

http://www.datomonline.com/suppfiles.html 
or  

http://members.buckeye-express.com/k9tm 
Klicken Sie oben auf der Seite auf den Master Callsign Databases Link. 

9  
Holen Sie MMTTY von der  MMTTY 
- Homepage. 

http://www.qsl.net/mmhamsoft/  
Informieren Sie sich unter  RTTY-Unterstützung  

5.2 Erstinstallation (First-Time Install Instructions)  

1. Holen Sie sich das Basisprogramm N1MM.zip von www.n1mm.com oder einer der oben angeführten Links.  
2. Entpacken Sie N1MM.ZIP in ein Verzeichnis, z.B. C:\N1MMInstall. Verwenden Sie Winzip ab Version 7.0 

oder später.  
3. Starten Sie im Installationsverzeichnis das Programm Setup.exe und wählen Sie ein Verzeichnis Ihrer 

Wahl. Voreingestellt ist 'C:\Programme\N1MM Logger' . Sie werden von Ihrem Computer u.U. laufend 
darauf hingewiesen, dass N1MM eine ältere Datei installieren will, als die, die auf Ihrem PC schon 
vorhanden ist. Sie können die Frage zur  Installation jeweils mit Ja, Ja für alle  oder Nein  beantworten. 
Wenn Sie alle neuen Dateien behalten wollen, gibt es einen Trick : Drücken Sie auf die Taste Shift und 
klicken dabei auf Nein.  Damit weisen Sie ein im Menü nicht vorhandenes Nein für alle   an. Ab sofort wird 
das Verzeichnis, in das Sie N1MM installiert haben als „Programmverzeichnis“ bezeichnet, 

4. Holen Sie sich dann die aktuelle Version NewexeVx.x.xxx  von einer der oben angegebenen Seiten.  
o Die Aktualisierungsdatei heisst NewExe(Version).zip  (z.B. NewExeVx.x.xxx.zip)  
o Die Versionsnummer ist auch in der Dateibeschreibung enthalten   
o Die Datei enthält die neuesten EXE-Dateien und ergänzende Dateien.  
o Sie benötigen nur die neueste Version, um eine ältere Version zu aktualisieren...  

5. Entpacken Sie die aktuelle Version in das Programmverzeichnis von N1MMLogger und bestätigen Sie das 
Überschreiben aller alten Dateien.  

6. Holen Sie sich die aktuelle Hilfe(Help) N1MMLoggerHelp.chm und das aktuelle Handbuch (Manual) 
N1MMLogger.pdf . Beide Hilfen werden parallel möglichst nah zu den neuen Versionen gepflegt. Beachten 
Sie die Ausgabenummer jeweils auf der ersten Seite von Hilfe und Handbuch.  

7. Kopieren Sie beide Hilfen in das Programmverzeichnis von N1MMLogger. Für das PDF-Handbuch 
brauchen Sie den Adobe Acrobat Reader ab Version 3.0. Sie können zu der *.chm-Hilfe vom Programm 
aus oder getrennt davon zugreifen. 

8. Nutzer von Windows NT, 2000 und XP benötigen den Treiber DLPORTIO für die korrekte Funktion der 
seriellen und parallelen Schnittstellen, DLPORTIO ist ein komplexes Installationprogramm mit 800kB, das 
eine Datei von lediglich 11kB auf dem Rechner installiert.  Sie müssen dieses Programm mit 
Administratorrechten auf Ihrer Maschine installieren. In der Sektion 3.2. der mitgelieferten 
Installationsanweisungen wird das Verfahren erläutert.  

9. Frischen Sie die Länderliste durch Aufruf von Import country list from downloaded file'  unter Tools  auf. 
Sie müssen dabei mit dem Internet verbunden sein. 

10. Holen Sie sich die neueste Rufzeichenliste master.dta und kopieren Sie sie in das N1MMLogger-
Verzeichnis. N1MMLogger unterstützt das CT-Format von master.dta.  

11. Holen Sie sich das Programm MMTTY, um RTTY mit der Soundkarte machen zu können. Siehe auch : 
MMTTY holen, konfigurieren und testen  
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5.3 Aktualisieren von N1MMLogger  (Subsequent Install Instructions / Upgrading to a new program 
version)  

 
1. Holen Sie sich nur die neueste NewexeVx.x.xxx - Datei  
 

• Der Name ist NewExe(Version).zip (Beispiel: NewExeVx.x.xxx.zip)  
• Die Versionsnummer steht auch in der Dateibeschreibung  
• Die ZIP-Datei enthält die neueste Datei N1MM.exe und die zugehörigen Dateien  
• Sie benötigen nur die neueste Version, ignorieren Sie die Versionen davor  

 

2. Entpacken Sie die ZIP-Datei in das N1MMLogger-Verzeichnis und überschreiben Sie alle alten Dateien.  
Ist bei diesem Paket eine neue cty.dat-Datei dabei, importieren Sie diese mit Tools > Import country list from 
downloaded file nach N1MMLogger 

 
Sind Sie Mitglied in der YAHHO-Gruppe von N1MMLogger werden Sie über eine Email über die neue Version informiert. 
 

5.4 Aktualisieren der Hilfe und des Handbuchs (Upgradin g the Help file and Manual)  

Die Windows-Hilfe (*.chm) und das Handbuch (*.pdf) werden getrennt vom Programm gepflegt, folgen diesem aber so 
nah wie möglich. Überprüfen Sie beim Laden einer neuen Programmversion, ob nicht auch eine neue Hilfe vorliegt. Sie 
sehen die aktuelle Versions-Nummer und das zugehörige Datum jeweils auf der ersten Seite.  
 

• Die Windows Hilfe heisst N1MMLoggerHelp.chm   
• Das Handbuch heisst N1MMLogger.pdf  
• Holen Sie sich die neue Hilfe oder das neue Handbuch, wenn eine neue Version vorliegt  Sie 

erkennen die Version jeweils an der ersten Seite. 
• Kopieren Sie die neuen Versionen in das N1MMLogger-Verzeichnis und überschreiben Sie die 

alten Versionen  
• Die Hilfe kann aus dem Programm heraus mit ALT-H gerufen werden, ist aber auch mit Windows 

getrennt zugänglich  
• Das Handbuch ist vom Programm erreichbar, aber auch mit einem Acrobat Reader lesbar. Das 

Handbuch können Sie als Papierversion ausdrucken.  
• Auf Wunsch können Sie vom YAHOO-Reflektor eine Email bekommen, wenn eine neue 

N1MMLogger-Hilfe zum Abholen vorliegt.   

5.5 Programm-Erststart  (Using the Program the First Time)  

Wenn Sie das Programm zum ersten Mal starten, gehen Sie wie folgt vor :  
 

• Stellen Sie zuerst Ihre Stationsdaten ein : 
• Gehen Sie zu Config > Change Your Station data 
• Beim Erststart erscheint dieser Dialog automatisch  
• Tragen Sie Ihre Stationsdaten, vor allem die Koordinaten, korrekt ein (Antennenrichtung !) 
• Konfigurieren Sie die CAT-Steuerung, PTT-Leitungen, TNCs, CW-Tastung, Telnet-Anschluss etc.  
• Wählen Sie Config/Configure ports, Telnet Address, Other  
• Konfigurieren Sie die Funktionstasten im Logeingabefenster und im Packet-Fenster  
• Siehe Config menu.  
• Mit Alt-H rufen Sie die Hilfe  
• Schalten Sie mit der Leertaste anstelle von TAB im Logeingabefenster weiter  
• Lesen Sie in der Hilfe oder dem Handbuch mindestens:  

• Zehn Schritte im Schnelldurchlauf 
• Programm einstellen 
• Grundfunktionen 
• Logeingabefenster  
• Liste der Tastenzuordnungen  (drucken Sie sich dieses Kapitel aus und legen Sie es neben 

den Transceiver) 

.  

5.6 Werden Sie Tester und berichten Sie von Problemen  (Become a Tester and Report Problems)  

• Werden Sie Mitglied der YAHOO-Diskussionsrunde mit  
http://groups.yahoo.com/group/N1MMLogger/join. Dort erhalten Sie Informationen über die 
neueste Version und behobene Programmfehler. Meist werden schon während eines Contest 
erkannte Fehler beseitigt.  
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• Stellen Sie sicher, dass Sie nur die neueste Version von N1MMLogger verwenden. Sie können 
als Gruppenmitglied eine Email beziehen, wenn eine neue Version zur Verfügung steht.  

• Geben Sie die von Ihnen verwendete Versionsnummer an, wenn Sie einen Fehler melden. Sie 
sehen die aktuelle Version beim Programmstart auf dem Startbild mit dem Antennenmast oder 
unter Help > About  

• Bitte melden Sie Programmprobleme. Wenn ich (N1MM) sie nicht kenne, kann ich sie nicht 
beheben. N1MMLogger ist ein freies Programm und seine Qualität hängt direkt von Ihrer Mitarbeit 
und der von Helfern wie Ihnen ab ! Danke für Ihre Hilfe !   

• Wollen Sie als Tester mitmachen, sollten Sie einen Pentium II – Rechner, einen Packetcluster- 
und einen Transceiveranschluss haben.  

5.7 Programm entfernen  (Uninstalling the program)  

Wenn Sie N1MMLogger vom Rechner entfernen oder es von Grund auf neu installieren wollen, gehen Sie so vor :  

• Gehen Sie zur Windows-Systemsteuerung > Software und wählen Sie N1MMLogger entfernen  

• Entfernen Sie dann das Programmverzeichnis von N1MMLogger und die noch darin befindlichen Dateien. 

6. Programm einrichten (Setting up the Program) 
 
Wenn Sie das Programm nutzen wollen, sollten Sie sich über den Anschluss des/der Transceiver, des Packetclusters, 
der Telnetverbindung und auch der Konfigurierung des aktuellen Contest informieren. Die Links in der Tabelle führen Sie 
zu den wichtigsten Kapiteln. Lesen für einen schnellen Überblick die Kapitel Grundfunktionen , Tastenzuordnungen und 
10 Schritte im Schnelldurchlauf.  

• Stationsdaten einstellen (Setup station information ) 

• Transceiversteuerung einstellen (Setting up radio control) 

•  Packet/Telnet einstellen (Setup packet/telnet) 

• WAV-Dateien vorbereiten (Setup up wav files (SSB)) 

• CW mit dem PC senden (How to send messages in CW?) 

• Nummernaustausch vorbereiten (Setting up the exchanges) 

• ' Funkltionstasten für ENTER-Modus programmieren (How to set up function keys with 'Enter mode)' 

6.1 Stationsdaten einstellen (Setup station information ) 

Der Stationsdialog ist weitgehend selbsterklärend. Tragen Sie auf jeden Fall das Stationsrufzeichen ein. Füllen Sie auch 
die anderen Felder richtig aus, denn aus ihnen wird der Vorspann für die Contestlogs z.B. in Cabrillo gebildet. Für die 
Berechnung der Antennenrichtung und der Entfernung werden die richtige Koordinaten benötigt. Tragen Sie die östliche 
Länge mit einem Minuszeichen davor ein. Die Email-Adresse wird für die automatische Meldung von Programmfehlern 
benötigt. 

6.2 Transceiversteuerung einstellen (Setting up radio c ontrol)  

Das Programm läuft erst richtig mit einer funktionierenden Transceiversteuerung (CAT=Computer Aided Tuning). Richten 
Sie zuerst diese Steuerung ein : 

• Prüfen Sie, ob Ihr Transceiver in der Liste der unterstützten Transceiver enthalten ist. Auch wenn er nicht 
enthalten ist, gibt es bei modernen Geräten meist eine Lösung, z.B. über die Adresse und das Datenformat. 
Alte Geräte ohne einen CAT-Anschluss scheiden leider aus. 

• Falls er enthalten ist :   
o Schliessen Sie das richtige Interface an. Sehen Sie im Handbuch des Transceivers nach, ob Sie 

u.U. ein spezielles Kabel oder ein zusätzliches Interface benötigen 
o Gehen Sie im N1MM-Menü zu Config > Configure Ports.. > Configurer  (Karteikarte Hardware).  

� Wählen Sie die serielle Schnittstelle aus, an der der Transceiver angeschlossen ist und 
geben Sie den Transceivertyp an  

� Klicken Sie bei dieser Schnittstelle auf die Taste 'Set' und geben Sie Baudrate und 
Datenformat ein. Die Einstellungen von N1MMLogger und Transceiver müssen 
übereinstimmen   

� Sehen Sie im Handbuch zum Transceiver nach  
� Informieren Sie sich im Kapitel Unterstützte Transceiver. 

� Klicken Sie auf OK, wählen Sie VFO A und die am Transceiver eingestellte Frequenz 
des VFO A erscheint richtig in der Bandskala  

6.3 Packet/Telnet einstellen (Setup packet/telnet)  
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Wir brauchen DX-Spots um die Bandskalen zu füllen. Der nächste Schritt ist die Verbindung zu einem DXCluster. Haben 
Sie in Funkgerät und einen TNC, wählen Sie im Configurer die Schnittstelle, an die der TNC angeschlossen ist. Wollen 
Sie einen Telnet-Connect zu einem Internet-DXCluster einrichten, muss Ihr PC mit dem Internet verbunden sein. 

Verbindung über Telnet :  

• Gehen Sie im Konfigurationsmenü zur Karteikarte  Hardware 

• Wählen Sie in der Tabelle links unten einen Telnet-DXCluster. Voreingestellt ist AB5K, der gut funktioniert. 
(DM3ML: Für Europa ist dx.ea7urc.org:8000 zu empfehlen) 

• Öffnen Sie das Packet-Fenster und wählen Sie dort die Karteikarte Telnet   
o Cluster-Kommandos werden im einzeiligen Fenster eingegeben, die Ausgaben erfolgen im 

mehrzeiligen Fenster darunter 
o Lesen Sie unter Packet-Fenster zu Einzelheiten nach  
o Zur Verbindungsaufnahme mit einem Telnet-Cluster reicht es in der Regel, das eigene 

Rufzeichen zu senden 
o Funktioniert alles, erscheinen die Spots in den Bandskalen bei  der aktuellen Frequenz  

Verbindung über einenPacket-DXCluster mit einem TNC :   

• Schliessen Sie den TNC  an die gewünschte PC-Schnittstelle an. Prüfen Sie mit einem Terminalprogramm 
wie Hyperterminal, ob die Kommunikation zwischen PC und TNC und zwischen TNC und UKW-Gerät 
richtig funktioniert  

• Gehen Sie zum  Configurer  und hier zur Karteikarte Hardware 

• Wählen Sie die serielle Schnittstelle für den TNC und machen Sie dort einen Haken in das Feld Packet  

• Klicken Sie dann auf die zugehörige Taste 'Set' und stellen Sie Baudrate und Datenformat ein 

• Öffnen Sie das Packet-Fenster und klicken Sie dort auf die Karteikarte Packet 
o Kommandos und Eingaben erfolgen in dem einzeiligen Feld oben neben den Karteikartenreitern 
o Ausgaben des TNC erscheinen in dem mehrzeiligen Fenster darunter 
o Lesen Sie unter  Packet-Fenster  zu Einzelheiten nach 
o Funktioniert alles, erscheinen die Spots in den Bandskalen bei  der aktuellen Frequenz  

6.4 WAV-Dateien vorbereiten (Setup up wav files (SSB))  

Die Sprachdateien (WAV-Dateien) enthalten Standardtexte, die entweder allgemein verwendbar sind oder 
contestspezifische Texte enthalten. Es gibt auch Sprachfolgen, die aus einzelnen WAV-Dateien für Buchstabierworte und 
Ziffern zusammengesetzt werden, um z.B. Rufzeichen zusammenzubauen. 
In der Regel müssen die zu sendenden Texte mit geeigneten Werkzeugen selbst erzeugt werden. 

6.5 CW mit dem PC senden (How to send messages in CW?)  

Der N1MMLogger kann über eine parallele oder serielle Schnittstelle des PC den/die Transceiver tasten. Gehen Sie so 
vor :   

• Tragen Sie die zu sendenden Texte mit Config > Change Packet/CW/SSB/Digital Message 
Buttons > Change CW Buttons in die zu den F-Tasten gehörenden Tabellenfelder ein. Die 
ersten 8 Reihen gehören zum Run-Modus (eigener CQ-Ruf) und den Tasten F1-F8. Die 
zweiten acht Reihen gehören zum S&P-Modus (Suchen und Rufen) und gleichen Tasten F1-
F8. Enhalten die S&P-Felder keinen Eintrag, werden Sie mit den Texten des Run-Modus 
belegt. :  
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• Stellen Sie sicher, dass die F-Tasten in der Karteikarte Function keys  auch der richtigen 
Funktion zugeordnet sind, z.B. die F1-Taste dem CQ-Ruf. 

 

Wollen Sie die aktuelle Seriennummer senden, tragen Sie das Zeichen # in den Text ein. Es gibt weitere Platzhalter für 
die Textzeilen. Siehe Macros 

6.6 Nummernaustausch vorbereiten (Setting up the exchan ges)  

N1MMLogger hat verschiedene Möglichkeiten, die Texte zum Contestaustausch zu gestalten und optimal auszusenden. 
Sie können der Reihe nach die F-Tasten drücken oder anklicken, aber auch mit dem ENTER-Modus ESM (ENTER 
sends Messages) die Texte nacheinander in Abhängigkeit von der Vorgeschichte und von den gefüllten Feldern im 
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Logeingabefenster nur mit der ENTER-Taste auslösen. Informieren Sie sich genau und testen Sie die Texte vor dem 
Contest. Die nachstehenden Beispiele stehen für einen RTTY-Test mit dem Rufzeichen WW3S : 
 

• Gehen Sie zu Config > Config Ports, telnet > Function keys.  
o Wenn Sie den ESM-Modus verwenden wollen, vertauschen Sie F5 und F3 :  

� F5 : 'End of Qso Key'  
� F3 : 'His call'  

• Gehen Sie dann zu Change Packet/CW/SSB/Digital Message Buttons > , Change Digital 
Buttons.  

o Die Tabelle wird beginnend mit F1 angezeigt  
o Ändern Sie die Taste F4 in &WW3S in der ersten Reihe und in  WW3S in der 

zweiten Reihe für F4.  
� Das & erzeugt ein unterstrichenes W  im Tastenfeld  

o Tragen bei F2 den Contestaustausch 599-599 + US-Staat + CQ-Zone ein :   
� Bei mir steht 599-599 PA PA 05 05 BK.  
� Wollen Sie im ESM-Modus arbeiten, müssen die passenden Tasten 

unter Config, Ports >Telnet > Change function keys richtig 
zugewiesen sein 

� Prüfen Sie, ob die Folge CQ-Ruf (F1) > Rufzeichen der 
Gegenstation(F5) + Contestnummer(F2) > Bestätigung (F3) mit der 
ENTER-Taste in der richtigen Folge ausgelöst wird 

o Tragen  Sie bei F3 den Text  für das QSO-Ende ein : z.B. TU QRZ DE WW3S 
WW3S TEST.  

o Tragen Sie bei F1 den CQ-Text ein z.B. CQ CQWW TEST DE WW3S WW3S 
TEST.  

• Die Angaben gelten für einen RTTY-Contest und die digitalen F-Tasten, sie gelten aber 
sinngemäß auch für CW (Change CW Buttons). 

73 Jamie WW3S 

6.7 Funktionstasten für ENTER-Modus programmieren (How to set up function keys with 'Enter mode)'  

Hier sehen Sie ein Beispiel von Jose, CT1AOZ.  

Stellen Sie die Texte über Config > Configure Ports > Telnet Address, Other > Function Keys ein  :  

CQ Key F1 

Exchange Key F2 

End of QSO Key F3 

His Call Key F4 

My Call Key F5 

QSO B4 Key F6 

Again Key F8 

Machen Sie einen Haken in alle Felder der Karteikarte mit Ausnahme von Monitor via PC-speaker. Füllen Sie jetzt die 
MACROS ' in der Tabelle Config > Change CW buttons  aus. Die gleichen Einstellungen können Sie auch für SSB und 
RTTY verwenden :  

Button Caption  CW message / .WAV file /Text to Send  

F1 CQ CQ CQ ** 

F2 Exch <<< ENN >>># 

F3 TU TU * 

F4 My * 

F5 His ! 

F6 QSOB4 ! QSOB4 TU * QRZ 

F7 His/TU ! TU 

F8 Again ! AGN PSE * 
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Shift-F1 QSY PSE QSY QRL * 

Shift-F2 Exch <<< ENN >>># 

Shift-F3   

Shift-F4 My * 

Shift-F5 His ! 

Shift-F6 QSOB4 ! QSOB4 DE * 

Shift-F7 Corr   

Shift-F8 Again   

Jose schreibt : Probieren Sie es aus und Sie werden begeistert über das Programm in der ENTER KEY MODE sein. 

7. Grundfunktionen (Basic Functions) 
 
Sie werden bei der Nutzung des Programms Standardroutinen z.B. zum Ändern der Frequenz, des Bands und der 
Sendeart finden. Informieren Sie sich weiterhin über Tastenzuordnungen, Programm einrichten, das Logeingabefenster 
und die 10 Schritte im Schnelldurchlauf. Für den Contest selbst werden Begriffe wie CQ-Rufen (Running mode), Suchen 
und Anrufen (S&P) und die das Loggen nur mit ENTER ('Enter Sends message) beschrieben. Sehen Sie auch bei Tipps 
und Tricks zum Betriebsablauf nach.     
 

• Fenstergrösse anpassen (Resizing windows)  
• Hilfe (Help) 
• Frequenz ändern (Changing Frequency)  
• Band wechseln  (Changing Band)  
• Sendeart ändern (Changing Mode)  
• Operator wechseln (Changing Operator)  
• Splitbetrieb (Split Operation)  
• CQ rufen (Running Mode)  
• Suchen und Anrufen (Search and Pounce Mode (S&P mode))  
• Loggen mit ENTER (Enter Sends Messages Mode (ESM mode))  
• Rufzeichenstapel (Call Stacking)  
• Alle QSOs lokal melden (Spot all S&P qsos locally)  
• Verbindung zum Telnet-Cluster (Connecting a telnet cluster) 
• WAV-Dateien abrufen (Playing Wav files) 
• Lautstärke einstellen (Wav file control) 
• Log sichern (How to save the log) 
• Daten sichern und Restaurieren (Backup and Restore)  

7.1 Fenstergrösse anpassen  (Resizing Windows)  

Sie können die Fenster des Programms nach Ihren Wünschen auf dem Schirm anordnen und bis auf Ausnahmen auch in 
der Höhe und Breite verändern. Die einzige Ausnahme ist das Logeingabefenster, das in seiner Grösse nicht verändert 
werden kann. Die Bandskalen und das Prüffenster (Check window) können nur in der Höhe, aber nicht in der Breite 
verändert werden. Für das Packet-Fenster können Sie ein beliebige Grösse wählen. Lage und Abmessungen der Fenster 
werden zum Programmende abgespeichert. Wird das Logeingabefenster geschlossen, wird das Programm beendet. Alle 
QSOs werden sofort auf der Festplatte gespeichert werden, wenn der Auftrag zum Loggen erteilt wurde. 

7.2 Hilfe (Help)  

Für fast jedes Fenster gibt es eine Hilfe-Funktion. Klicken Sie rechts in das Fenster und wählen Sie im sich öffnenden 
Menü den Punkt Hilfe (Help). Die Hilfe zum Logeingabefenster erreichen Sie über die Hilfe im Hauptmenü oder mit der 
der Taste ALT-H . Die Hilfe für die Tastenzuordnung kann ebenfalls direkt über die Hilfe im Logeingabefenster gerufen 
werden. Sie können jedes Hilfe.Kapitel mit einem Klick auf die Drucktaste ausdrucken. Sie erreichen aus einem Fenster 
die zu dem Fenster gehörende Hilfe, so dass Sie nicht lange suchen müssen. 
  

7.3 Frequenz ändern  (Changing Frequency)  

• Für die Frequenzänderung mit N1MMLogger gibt es verschiedene Möglichkeiten. Voraussetzung 
für diesen und die folgenden Abschnitte ist eine funktionierende  CAT-Steuerung  :  

• Drehen Sie am Abstimmknopf Ihres Transceivers, der Zeiger auf der aktuellen Bandskala folgt 
der Transceiverskala  

• Klicken Sie auf eine Frequenz in der Bandskala, der Transceiver wird dorthin gestellt 
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• Geben Sie eine Frequenz in das Rufzeichenfeld des Logeingabefensters ein, z.B. 14200,5 und 
der Transceiver wird auf 14.200,5 MHz eingestellt. 

• Geben Sie einen Offset in das Rufzeichenfeld ein, z.B. +3 und der Transceiver wird 3 kHz höher, 
hier auf 14203,5 gesetzt  

• Geben Sie einen Offset ohne Vorzeichen ein, z.B. 123 , dann geht der Transceiver auf eine 
Frequenz von ‚Bandanfang + 123 kHz’,  

• Wenn Sie einen Schrägstrich  /  vor den jeweiligen Offset setzen, wird der zweite VFO B in der 
Frequenz gesetzt, z.B.: /14200,5    /+3    /123 und gleichzeitig aktiviert 

• Klicken Sie auf einen DX-Spot in einer Bandskala, der VFO wird dorthin geschaltet.  
• Klicken Sie auf einen DX-Spot im Packet/Telnet-Fenster 
• Verwenden Sie eine der Tasten in der Tabelle, um Frequenz, Band, VFO oder Transceiver zu 

verändern. Sehen Sie unter Tastenzuordnungen nach, welche Wirkung die Tasten haben  (Arrow 
= Pfeil, Up=Aufwärts, Down=Abwärts, Right=nach rechts, Left=nach links) 

Alt-Ctrl-Down Arrow Ctrl-Shift-Page Down Ctrl-Down Arrow Alt-Ctrl-Q Ctrl-Left F10 

Alt-Ctrl-Up Arrow Ctrl-Shift-Page Up Ctrl-Page Up Page Up Ctrl-Right F9 

Ctrl-Shift-Up Arrow Ctrl-Shift-Down Arrow Ctrl-Page Down Up Arrow Page Down Ctrl-F9 

Alt-Shift-Ctrl-Up Arrow Alt-Shift-Ctrl-Down Arrow Ctrl-Up Arrow Alt-Shift-Q Down Arrow Alt-Q 

 
• Klicken Sie im Logfenster erst links auf die gewünschte Station, dann rechts, wählen Sie im Menü 

Jump to this frequency und der VFO springt auf die zusammen mit der Station geloggte Frequenz 
• Klicken Sie auf einen Station im Fenster  Available Mult's and &' Qs   
• Klicken Sie auf eine der Bandtasten im Fenster Available Mult's and &' Qs  , um das Band zu 

wechseln  
• Tragen Sie eine Splitfrequenz in das Logeingabefenster ein. Siehe Splitbetrieb.  
• Usw...usf....  

Ist kein Transceiver angeschlossen, haben die Tasten PgUp/PgDn keinen Effekt. Sie werden bei Überschreitung der 
Bandgrenzen gewarnt :  

 

7.4 Bandwechsel  (Changing Band)  

Sie können das Band so wechseln :.  
 

• Umschalten am Transceiver   
• Ctrl-Page Up  – Gehe ein Band höher. WARC-Bänder werden bei Contesten übergangen.  
• Ctrl-Page Down  - Gehe ein Band tiefer. WARC-Bänder werden bei Contesten übergangen.  
• Geben Sie eine Frequenz ins Rufzeichenfeld des Logeingabefensters ein : 14200,5 schaltet auf 

14.200,5 MHz  
• Klicken Sie auf eine Bandtaste im Fenster Available Mult's and &' Qs   
• Klicken Sie auf einen DX-Spot im Fenster  Available Mult's and &' Qs   
• Klicken Sie auf einen DX-Spot im Packet/Telnet-Fenster  

7.5 Sendeart ändern  (Changing Mode)  

• Umschalten am Transceiver  
• Klicken Sie in der Bandskala auf das Sendeartenfeld oben rechts. Die Sendearten werden 

zyklisch durchgeschaltet (CW > SSB > RTTY)  
• Geben Sie in das Rufzeichenfeld die Sendeart mit CW, LSB, USB, RTTY, AM, FM, DIGI, PSK 

oder SSTV ein  

7.6 Operator wechseln  (Changing Operator)  

• Ctrl-O  – Öffnet den Dialog für den Eintrag des Operator-Rufzeichens. Voreingestellt ist das 
Rufzeichen aus dem Stationsdialog. Der Operator ist nur für die Klasse Multi-OP interessant.  
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• Geben Sie OPON in das Rufzeichenfeld ein, um den OP-Dialog zu öffnen .  

7.7 Splitbetrieb (Split Operation)  

Wenn Sie auf einer anderen Frequenz senden als Sie empfangen ist das Splitbetrieb. Split wird gearbeitet, wenn seltene 
Stationen ungestört auf ihrer Sendefrequenz gehört werden wollen oder wenn der Bandplan keinen Gleichwellenverkehr 
zulässt (z.B. im 40m-Band zwischen EU und USA) . Sie können den Splitverkehr auf der Bandskala sehen. Der dicke 
blaue Pfeil  steht auf Ihrer Empfangsfrequenz, die rote Marke  auf Ihrer Sendefrequenz. Bei Splitbetrieb werden beide 
Frequenzen auch am Kopf der Bandskala angezeigt, die Sendefrequenz steht unter der Empfangsfrequenz. 

 
Hinweis: Wenn Sie auf  'Running mode’ geschaltet ha ben, im Splitbetrieb arbeiten und die Empfangsfrequ enz 
wechseln, wird nicht automatisch auf S&P-Modus umge schaltet, wie beim Betrieb ohne Split . 

7.7.1 Splitfrequenz von Hand einstellen (Split frequencie s can be set manual)  

Der Splitdialog wird mit Alt-F7  gestartet oder durch die Eingabe von Frequenz oder Offset in das Rufzeichenfeld des 
Logeingabefenster und Abschluss mit Ctrl-Enter .  
In der Frequenzangabe können Kommas (bei Einstellung von Windows auf Deutsch) enthalten sein. Sie können folgende 
Eingaben machen : 

• Geben Sie die Splitfrequenz direkt ein oder  
• Geben Sie den Offset vom Bandanfang ein oder  
• Geben Sie den Offset von der aktuellen Frequenz als +5, +4, 3, 6, -2, -5 etc. ein 
• Beispiele :  

o 7050,3 Ctrl-Enter 
o 220,3 Ctrl-Enter 
o +5,3 Ctrl-Enter 

7.7.2 Splitfrequenz aus DXCluster-Spots  (Split frequencies can be set automatic by packet sp ots)  

Ist in der DXClustermeldung ein Offset angegeben, wird N1MMLogger automatisch auf Splitbetrieb geschaltet. 

     

7.7.3 Splitbetrieb abschalten  (Resetting to non-split mode)  

• Gehen Sie zu einer anderen Frequenz oder einem anderen Band  
• Klicken Sie auf die Sendefrequenz oben  in der Bandskala unter der Empfangsfrequenz  
• Klicken Sie auf einen Spot in der Bandskala oder im Packet/Telnet-Fenster  
• Klicken Sie auf eine Frequenz in der Bandskala  
• Klicken Sie auf eine Bandtaste im  Available Mult's & Q's-Fenster  
• Drücken Sie  PgUp oder PgDn   

 

7.7.4 Tastenzuordnung für Splitbetrieb (Split operation K ey Assignments)  

Alt-F7  – Setzt die Splitfrequenz durch Eingabe einer Frequenz oder des Offsets am aktiven VFO oder Transceiver 

Alt-S  – Mit dieser Eingabe wird die Empfangsfrequenz auf die Sendefrequenz gesetzt, aber der Transceiver bleibt auf 
Splitbetrieb geschaltet. Mit dieser Einstellung kann der OP anstelle des kleinen und schlecht einzustellenden RIT-Knopf 
die Hauptabstimmung zur Suche nach zu arbeitenden Stationen benutzen. Die Sendefrequenz bleibt auf der 
eingestellten Splitfrequenz stehen und mit ALT-S kann der OP Sendefrequenz und Empfangsfrequenz angleichen und 
dann von der Sendefrequenz nach oben (UP) oder unter (DWN) nach anrufenden Stationen suchen. Diese Funktion 
arbeitet nur mit der linken Bandskala  

Im CONFIG-Menü kann die Funktion Reset RX freq when running split  freigegeben werden, so dass die ALT-S-
Funktion (RIT clear) nach jedem geloggten QSO ausgelöst wird. Der RX steht danach wieder auf der Sendefrequenz. Die 
exakte Folge bei Betätigung der ENTER-Taste ist : Setze den RX auf die Sende-Frequenz > logge das QSO > sende TU. 

Ctrl-S  – Steht Ihr Transceiver auf Splitbetrieb, können Sie mit CTRL-S den Empfänger auf die Sendefrequenz und 
wieder zurück auf die Splitfrequenz stellen. Diese Funktion ist vor allem für SSB-Betrieb auf 80m und 40m interessant, 
wenn jemand z.B. ruft CQ CQ de N1MM listening on this  frequency (7183) and 7068 . Mit Ctrl-S  kann N1MM zwischen 
7183 und 7068 umschalten und nach  USA- oder DX-Anrufern suchen.  

7.8 CQ rufen  (Running Mode)  
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Im “Running mode” rufen Sie CQ und erwarten Anrufe anderer Stationen. Sie sitzen auf einer festen Frequenz und 
suchen nicht nach anderen Stationen. Das Programm markiert Ihre aktuelle Frequenz als CQ-frequency in der Bandskala 
und im Logeingabefenster ist ein Haken im kleinen Fenster Running . Der Running mode hat seinen eigenen Satz von 
Funktionstasten F1 bis F8. In den Funktionstasten ist der Text zu sehen, der ihnen in der F-Tastentabelle unter Button 
Caption  zugeordnet worden ist. Ein zweiter Satz der gleichen Funktionstasten ist für den Modus „Suchen und Rufen“ 
(S&P = Search and Pounce) – Modus vorgesehen. Sie können diesen Satz mit Shift-F1 bis Shift-F8 erreichen.   
Sie kommen in die Running mode  mit : 
 

• Einem Klick auf CQ-frequency in der Bandskala  
• Wenn Sie den Transceiver auf die CQ-frequency  im gleichen Band abstimmen  
• Mit einem Druck auf Shift-F1 (= CQ-Taste) im S&P-Modus. Diese Zuordnung kann mit Config > 

Karteikarte Function Keys geändert werden   
• Mit der Zeichenkette "CQ" in einer der Tastentexte oder Funktionstastentexte oder im Namen 

einer WAV-Datei in SSB  
• Einem Mausklick (Haken) in das Feld Running 

 
Wenn Sie die CQ-Frequenz verlassen, wird der Haken im Feld Running entfernt, das Programm schaltet auf S&P und 
die Funktionstasten F1-F8 bekommen die S&P-Belegung. Mit einem Klick auf die CQ-Frequenz in der Bandskala 
kommen Sie zurück zu Running .  
Eine Ausnahme bildet der Splitbetrieb, Hier bleibt der Sender auf der CQ-Frequenz und Sie können die 
Empfangsfrequenz verändern. 
Es gibt nur EINE CQ-Frequenz pro Band. Falls Sie die VFOs umschalten, kommen Sie u.U. von Running- in den S&P-
Modus. 
 

7.9 Suchen und Anrufen   (Search and Pounce mode (S&P mode))  

Im S&P-Modus suchen Sie andere Stationen und rufen sie an. Die Sendefrequenz ist nicht fest, sie rufen nicht CQ, 
sondern richten sich nach der Gegenstation. Die Running-Anzeige ist ohne Markierung, die F-Tasten sind mit den für 
S&P-Betrieb programmierten Texten belegt. Die Tasten des Running-Modus können mit Shift-F1 bis Shift-F8 erreicht 
werden. Schon wenn Sie die Shift-Taste drücken, werden die Texte in den F-Tasten umgeschaltet. 
Haben Sie im S&P-Modus Shift-F1 gedrückt, startet der CQ-Ruf, das Programm schaltet in den Running-Modus und 
bleibt dort. Jeder Druck auf F1 löst einen weiteren CQ-Ruf aus 
Sie können auch eine F-Taste im S&P-Modus mit CQ belegen und mit dieser die Umschaltung auslösen. 
Wenn Sie im S&P-Modus ein Rufzeichen in das Rufzeichenfeld eingegeben haben, das sich dann als DUPE erweist und 
sie verstimmen den VFO, wird das Eingabefenster gelöscht und das Rufzeichen in der Bandskala eingetragen. 

 
Haben Sie beim Suchen eine Station gefunden, die eine Frequenz belegt, aber nicht am Contest teilnimmt, können Sie 
diese Frequenz mit ALT-M  als “belegt (busy)“ markieren und brauchen beim Abstimmen nicht jedes Mal zuzuhören. 

7.10 Loggen mit ENTER  (Enter Sends Messages mode (ESM mode))  

Wenn Sie unter Config > Enter Sends Messages (ESM mode)  anhaken oder CTRL-M eingeben , können Sie QSOs im 
beschleunigten Eildurchlauf abarbeiten und brauchen nur noch die ENTER-Taste, aber nicht mehr die F-Tasten zu 
drücken.  
Die ESM-Mode funktioniert unter Running und S&P mit unterschiedlicher Tastenbelegung und –folge. Was aktuell 
gesendet wird, hängt vom Füllungsstand des Rufzeichenfelds und des Felds für die empfangene Kontroll-Nummer ab. 
Sind beide leer, ist die CQ-Taste F1 hellblau hinterlegt und wenn Sie ENTER drücken, wird ein CQ-Ruf gestartet. Wenn 
Sie das Rufzeichen einer Station eingegeben haben, wird mit dem nächsten ENTER das Rufzeichen der Gegenstation 
(F5) und der Rapport (F2) gesendet. Haben Sie die Kontrollnummer empfangen und eingetragen, wird TU+QRZ? (F3) 
gesendet, ist das Kontrollnummernfeld noch leer, wird mit ENTER die Nachfrage AGN (F8) ausgelöst. Siehe auch die 
Statustabelle weiter unten. 

Hier ist ein typisches Szenario für N1MM, der im CQ WW CW Contest: CQ ruft :  

ENTER 1 > sendet CQ-Ruf  
PA1M ruft an > PA1M ins Rufzeichenfeld 
ENTER 2 > N1MM sendet PA1M 5NN T5, das Programm setzt schon immer eine 14 ins Kontrollnummernfeld 
PA1M sendet 599 14 > die Zone stimmt also 
ENTER 3 > QSO wird ins Log übertragen und N1MM sendet TU de N1MM 

N1MM brauchte nur PA1M einzutragen und dreimal die ENTER-Taste drücken ! 

Sehen wir uns das gleiche für ein S&P-QSO mit ESM an : 

Sie (PA1M) hören N1MM mit einem CQ-Ruf und tragen N1MM ins Rufzeichenfeld ein 
ENTER 1 sendet PA1M (Taste F4), die Zone für N1MM wird schon mit 05 ausgefüllt 
N1MM sendet  PA1M 5NN T5 > aha, die Zone stimmt ! 
ENTER 2 sendet 599 14 (Taste F3) 
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N1MM sendet TU de N1MM > QSO komplett 
ENTER 3 speichert das QSO ab 

Wieder 3x ENTER und eine Eingabe. In anderen Contesten wie beim WPX müssen Sie noch die Kontrollnummer selbst 
hören und eintragen. Mit ESM kürzen Sie den Bedienungsaufwand in jedem Fall wesentlich ab.  
Sie können an den Farben der F-Tasten sehen, bei welche Phase des QSOs sie angelangt sind. Die mit dem nächsten 
ENTER ausgelösten Tasten sind hellblau (aqua blue) hinterlegt und zeigen Ihnen, was am nächsten dran kommt 
Sind Sie mal in der ENTER-Folge ausser Tritt geraten, brauchen Sie nicht in Panik zu geraten. Lösen Sie die passenden 
Texte selbst mit den F-Tasten aus und drücken zum Schluss Shift-ENTER. Das QSO wird gespeichert und ESM auf den 
Start des nächsten CQ-Rufs oder des nächsten QSOs gesetzt und der Ablauf wieder synchronisiert. 

Im ESM-Modus stoppt die Eingabe eines Zeichens in das Rufzeichenfeld den aktuellen CQ-Ruf, falls diese Modifikation 
unter Config > Configure Ports.. > Function Keys  mit Stop Sending CQ when Callsign changed  aktiviert worden ist. 

Wie oben schon erwähnt, durchläuft ESM eine Standard-Folge. Nur wenn Einträge im Rufzeichenfeld oder im 
Kontrollnummernfeld fehlen, werden abweichende Text gesendet. In der Statustabelle können Sie sehen, was wann 
gesendet wird : 

     Running-Modus    S&P-Modus  

Rufzeichenfeld  Kontrollnummernfeld  ENTER sendet:  ENTER  sendet:  

LEER LEER CQ (F1) Eigenes Call (F4) 

Neues Rufzeichen  LEER oder ungültig 
Call der Gegenstation 

+ Num 
(F5 + F2)  

Eigenes Call (F4) 

Neues Rufzeichen 
(wdh) LEER oder ungültig  Again? (F8) Eigenes Call (F4) 

Neues Rufzeichen  Gültig, vor gesendeter 
Nummer  

Call der Gegenstation 
+ Num 

(F5 + F2)  
Nummer (F2) 

Neues Rufzeichen  Gültig, nach gesendeter 
Nummer  

QSO-Ende + Log 
(F3 + Log It)  

Sendet nichts+ 
QSO abspeichern 

Doppeltes 
Rufzeichen LEER oder ungültig  QSO B4 (F6) - nichts - 

Doppeltes 
Rufzeichen  

Gültig, vor gesendeter 
Nummer  QSO B4 (F6) Nummer (F2) 

Doppeltes 
Rufzeichen 

Gültig, nach gesendeter 
Nummer  

QSO-Ende + Log 
(F3 + Log It)  

Sendet nichts+ 
QSO abspeichern  

Dupe (das 1.Mal) 
Work Dupes gesperrt  LEER oder ungültig  

Call der Gegenstation 
+ Num 

(F5 + F2)  
QSO B4 (F6) 

Dupe (wiederholt) 
Work Dupes gesperrt  

LEER oder ungültig  Again? (F8) QSO B4 (F6) 

Dupe, 
Work Dupes 
zugelassen  

Gültig, vor gesendeter 
Nummer  

Call der Gegenstation 
+ Num 

(F5 + F2)  
Nummer (F2) 

Dupe, 
Work Dupes 
zugelassen  

Gültig, nach gesendeter 
Nummer  

QSO-Ende + 
Abspeichern  

Nichts senden und 
abspeichern 

 
Hinweis: Wenn Sie im S&P-Modus sind und ESM eingeschaltet haben und der Cursor sich nicht im Rufzeichenfeld 
befindet und der Austausch noch nicht abggeschlossen ist wird der Text Again? (F8)  gesendet. 

N1MM ermöglicht es den Nutzern festzulegen, welche F-Taste welcher Funktion im Running- oder S&P-Modus 
zugeordnet werden soll. Die Funktion CQ kann z.B. jeder der Tasten F1 bis F8 zugeordnet werden. Voreingestellt ist 
dafür die Taste F1, auch den anderen Funktionen sind die in der Tabelle angegebenen F-Tasten als Voreinstellung 
zugewiesen. Die Zuordnung entspricht anderen Contestprogrammen wie CT, so dass Sie sich bei N1MM nicht 
umgewöhnen müssen. Gehen Sie zu Config > Configure Ports, Telnet Address, Other > F unction Keys tab , um 
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nach Ihren Wünschen den  sieben Funktionen u.U. eine andere F-Taste zuzuordnen, bzw. Einstellungen zu korrigieren, 
wenn der ESM-Ablauf nicht Ihren Wünschen entspricht. 

Welcher Text den Funktionen wie  CQ Key, Exchange Key, My Call Key, etc . über die F-Tasten zugewiesen ist, können 
Sie unter Config > Change Packet/CW/SSB Digital Message Butto ns  in die Tabelle eintragen. Die Tabelle hat Platz 
für 16 Texte, die ersten acht sind dem Running-Modus, die folgenden acht dem S&P-Modus zugeordnet. Jede Sendeart 
(CW, SSB, Digital) hat einen eigenen Satz an Texten in den F-Tasten. Sie können die Texte in den F-Tasten mit einem 
rechten Mausklick auf eine der Tasten editieren. In der Regel ist der 8er-Satz voll ausgefüllt, der zweite aber nur dort, 
wenn ein abweichender Text (z.B. für F1 und F2) benötigt wird. Bei nicht programmierten S&P-Tasten wird der Text aus 
dem Running-Satz genommen. Sendet das Programm einen falschen Text, sehen Sie zuerst hier nach. 

Wenn Sie im Running-Modus den ESM-Betrieb gewählt haben und ein ? in das Rufzeichenfeld eintragen, bleibt der 
Cursor im Rufzeichenfeld stehen und geht nicht in das Nummernfeld. 

Hinweis  : Sie können in CW die Antwort schon starten, bevor das komplette Rufzeichen in das Rufzeichenfeld 
eingetragen ist. Sie können solange eingeben, wie das Rufzeichen noch nicht vollständig gesendet wurde und der 
Cursor noch im Rufzeichenfeld steht. 

7.10.1 Ein bekanntes Problem  (A known 'problem' (it's actually a feature))  

Das Problem:  
Falls im ESM-Modus der Cursor schon in das Nummernfeld gesprungen ist, bevor sie die Rufzeicheneingabe beendet 
habe, können Sie in der Konfiguration der Funktionstasten mit Config > Configure Ports, Telnet Address, Other > 
Function Keys tab den Haken aus dem Feld Fill in his exchange when sending yours  nehmen. Dann bleiben Sie 
synchronisiert in der ESM-Schleife.  

 
Tipp:  Mit ESM können Sie die Antwort mit der Contestnummer schon nach der Eingabe weniger Zeichen in das 
Rufzeichenfeld mit ENTER starten und während der CW-Ausgabe das Rufzeichen voll eintragen. Der Cursor bleibt 
solange im Rufzeichenfeld bis der Inhalt gesendet wurde, dann erst springt er ins Nummernfeld. Sie können mit diesem 
Werkzeug noch schneller im Pileup arbeiten. 

7.11 Rufzeichenstapel  (Call Stacking)  

Mit diesem Werkzeug können Sie Rufzeichen samt der zugehörigen Frequenz in einen Stapelspeicher schieben und 
danach die Rufzeichen samt Frequenz wieder herausholen. Der Transceiver wird auf die jeweilige Frequenz abgestimmt. 

• Shift-Enter  überträgt das Rufzeichen aus dem Rufzeichenfeld in den Stapelspeicher (Stack).  
• Das aktuelle Rufzeichen im Stack steht über dem Rufzeichenfenster, wenn Shift-Enter 

eingegeben wird  
• Rufzeichen im Stack werden über dem Rufzeichenfeld mit nachgestellten drei Punkten angezeigt 

z.B: W1XXX...   
• Steht kein Rufzeichen im Rufzeichenfeld werden die im Stack stehenden Rufzeichen der Reihe 

nach mit Shift-Enter aus dem Stack geholt und können mit der Leertaste ins Rufzeichenfeld 
geholt werden.  

• Ist das Rufzeichenfeld nach dem Loggen oder einem ALT-W wieder leer, wird das Rufzeichen 
geholt und der Transceiver auf die Frequenz dieser Station gestellt.  

• Zum Löschen eines Rufzeichens aus dem Stack drücken Sie die Leertaste oder geben ALT-W 
(Wipe=Löschen) ein.  

• Das gleiche Rufzeichen kann pro Band nur einmal in den Stack übertragen werden.  
• Ein Rufzeichen kann bei einem Multi-User-Betrieb  vom PC2 in den Stack des PC1 geschickt und 

an dieser Station abgearbeitet werden. Informieren Sie sich im Kapitel  Multi-User  über diese 
Fernspeichern. 

7.12 Alle QSOs lokal melden  (Spot all QSOs locally ) 

Wenn Sie Config > Spot all S&P QSOs locally   freigeben, werden auch Stationen in der Bandskala gemeldet, die Sie 
selbst noch nicht gearbeitet haben oder nicht arbeiten wollen. Diese Stationen werden nicht über Packet- oder Telnet 
gemeldet, sondern nur auf Ihrer Bandskala oder im lokalen Multi-User-Netz eingetragen. Jedes Rufzeichen aus 3 
Buchstaben oder mehr, das Sie ins Rufzeichenfeld eingetragen haben, werden automatisch in die Bandskala 
eingetragen, wenn Sie den VFO-Knopf weiter drehen. Mit dieser Variante können Sie sich Stationen merken, die Sie im 
Moment nicht erreichen konnten (Pileup) oder wollten (z.B. falsche Antennenrichtung). Stimmen Sie den VFO wieder auf 
die Frequenz dieser Stationen, werden ihre Rufzeichen über dem Rufzeichenfeld bereitgestellt.. Sie erkennen diese 
„selbst gemeldeten“ Stationen an der fetten Schrift in der Bandskala. 
Die Variante ist vor allem in einer M/S- oder M/M-Umgebung interessant. Meist ist es die MULTI-Station, die die 
interessanten Stationen meldet, die dann von der meist stärkeren RUNNING-Station zwischendurch gearbeitet werden 
können. Die MULTI-Station kann so für die RUNNING-Station eine Bandskala voll interessanter Rufzeichen erzeugen. 
Ob diese Betriebstechnik in jedem Fall der Contestausschreibung entspricht, soll hier nicht diskutiert werden 

Sie können z.B. folgendes machen :  
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• Auf 21200 abstimmen 
• VU2PTT ins Rufzechenfeld eingeben 
• Weiter drehen 
• VU2PTT wird auf 21200 gemeldet 
• Auf  21208 abstimmen 
• G4UJS ins Rufzeichenfeld eingeben 
• Weiter drehen 
• G4UJS wird auf 21208 in der Bandskala eingetragen, das Rufzeichenfeld wird geleert  
• Prozedur so lange wie gewünscht wiederholen 

• Bandskala mit CTRL-UP und CTRL-DWN durchtasten und die Stationen abarbeiten 

 
Hinweis : Es gibt auch eine Option Config > Spot all S&P qsos  , mit der alle Stationen automatisch via Packet oder 
Telnet gemeldet werden, mit denen Sie ein QSO hatten und die noch nicht von einer anderen Stationen gemeldet 
wurden. (Anmerkung DM3ML : ..sollte man nicht verwenden ! ) 

7.13 Verbindung zum Telnet-Cluster (Connecting a telnet cluster)  

• Wählen Sie die Karteikarte Telnet im Packetfenster 

• Wählen Sie einnen Telnetcluster aus der Liste in der oberen rechten Ecke  
o Sie können diese Liste im Configurer (Config > Configure Ports, Telnet Address, Other 

>Karteikarte Hardware > Telnet Cluster > Taste Edit ).erweitern. Klicken Sie auf die Taste 
un tragen in die sich öffnende Liste z.B. den Cluster PI4CC mit der Adresse dxc.pi4cc.net:23 
nach 

• Klicken Sie auf die Taste mit ihrem Rufzeichen rechts unten in der Statusleiste. Die Verbindung zum 
Telnet-DXCluster wird hergestellt. Nehmen Sie nicht die Taste CONN, die ist für den Packetradio-
Connect reserviert. 

7.14 WAV-Dateien abrufen (Playing Wav files)  

Das Programm kann in SSB vorbereitete Dateien z.B. für den CQ-Ruf oder Standard-Rapport abspielen. Diese Dateien 
müssen Sie vor dem Contest erzeugt  bearbeitet und in dem Unterverzeichnis \wav  des N1MM-Verzeichnisses 
abgspeichert werden. Die Dateien können über die Funktionstasten in SSB aufgerufen werden. Sie können, wenn Sie die 
Teildateien zur Verfügung stellen, Rufzeichen aus Buchstaben und Ziffern zusammenbauen. 

• Programmieren Sie die F-Tasten in SSB z.B. so :  

• Beispiele:   
o CQ-Ruf : wav\cq.wav  
o Standardnummer : : wav\5905.wav  
o Rufzeichen der Gegenstation wie im Logeingabefenster eingetragen über die Soundkarte mit 

dem Macro ! (sent his call) senden. Sie müssen dazu ein Unterverzeichnis \letters  mit den 
Dateien a.wav bis z.wav und 0.wav bis 9.wav zuzüglich der Sonderzeichen eingerichtet und 
bestückt haben 

o Wollen Sie das Rufzeichen nicht über die Soundkarte senden, ersetzen Sie es im Macro durch 
ein einfaches Leerzeichen. Dadurch wird die Leerdatei empty.wav eingefügt.. 

• Wollen Sie die Stimmen einem bestimmten Operator zuordnen, speichern Sie die WAV-Dateien in 
Unterverzeichnissen mit dem Operatorrufzeichen ab, z.B.\wav\{OPERATOR} cq.wav . Ersetzen Sie 
{OPERATOR} durch das reale Rufzeichen des OPs und adressieren Sie diese Datei in der F-Taste mit : 
wav\{OPERATOR}\cq. Wenn der OP an der Multi-OP-Station wechselt, wird die zugehörige WAV-Datei 
mit seiner Stimme aus dem zugehörigen Verzeichnis genommen, z.B.  

o CQ mit der passenden Operatorstimme :: wav\{OPERATOR}\cq.wav  
o Rufzeichen der Gegenstation aus Teil-WAVs zusammengesetzt :  {OPERATOR}\letters\!  
o Standardnummer mit der Operatorstimme : : wav\{OPERATOR}\5905.wav  

Sie finden Einzelheiten im Kapitel SSB macro examples unter {OPERATOR} .  

7.15 Lautstärke einstellen (Wav file control)  

Wenn Sie in SSB WAV-Dateien rufen und abspielen, kann die Lautstärke über N1MMLogger oder die Schieberegler von 
Windows gesteuert werden : 

• Mit N1MMLogger : Sie können in der Konfiguration von N1MMLogger mit Config > Configure  
Ports… > Others  Vorgaben für die Lautstärke eintragen. Diese Werte werden beim Start von 
N1MMLogger in die Windowssteuerung übertragen und überschreiben dort stehende Werte. 

• Wollen Sie nicht, dass  N1MMLogger die Windowsregler verstellt, tragen Sie eine -1 unter Volume 
level  und Wav volume level ein. Die Windowsregler werden dann von N1MMLogger nicht 
verstellt.   
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7.16 Log sichern (How to save the log)  

Es gibt keine getrennte Sicherungstaste. Sie ist nicht notwendig. Alle Änderungen in der Datenbank werden „im Flug“ 
abgespeichert. Die Datei ham.mdb auf Ihrer Festplatte speichert alle Contest-QSOs zusammen mit der Information zu 
einem Contest. Sie brauchen nicht für jeden Contest eine Datenbank anlegen. Gehen Sie zu File > Chose contest > 
Start a new log for a contest  und wählen Sie aus der Liste der Conteste den gewünschten Contest aus. Nach einigen 
Jahren haben Sie in der Datenbank dutzende von Contesten mit tausenden von QSOs abgespeichert. Natürlich können 
Sie auch neue Datenbanken für unterschiedliche Rufzeichen und unterschiedliche Conteste anlegen, aber die meisten 
Nutzer kommen mit einer Datenbank aus. Sie können diese Datenbank sichern, aber stellen Sie sicher, dass sie gut 
behandelt wird. 

7.17 Daten sichern und wiederherstellen (Backup and Rest ore)  

Die vom Programm genutzten Daten werden in der MDB-Datenbank, in *.ini-Dateien und einigen Unterverzeichnissen 
abgespeichert. Beispiele für die Unterverzeichnisse sind die WAV-Dateien für die SSB-F-Tasten und die Dateien für die 
Buchstaben zur Kombination von Rufzeichen. Sichern Sie daher nicht nur die MDB-Dateien sondern auch die TXT-
Dateien und die Unterverzeichnisse. 
  

Vorschlag für eine Datensicherung : : 

• Alle Datenbanken *.mdb-Dateien  
o In den Datenbanken stehen alle Contestdaten, die Belegung der F-Tasten, die Stationsdaten 

u.a. Komprimieren Sie diese Datenbanken, um sie klein zu halten. 

• N1MM Logger.ini   
o Windowseinstellungen, Transceiverdaten, Einstellung der Schnittstellen, RTTY-Einstellungen 

und anderes aus dem Konfigurationsmenü. Auch der letzte verwendete Contest steht in der 
Datei  N1MM Logger.ini . 

• Wav-Dateien  
o \WAV-Dateien für die SSB-F-Tasten und \Letters für den Zusammenbau von Rufzeichen 

Sie sollten die Dateien regelmässig  sichern, um sie bei einem Rechnerzusammenbruch wieder herstellen zu können. 

Wiederherstellen auf dem gleichen Computer :  

• Wiederherstellen der Datenbanken aus den *.mdb-Date ien   
o Abspeichern im N1MM-Verzeichnis  

• N1MM Logger.ini   
o Abspeichern im N1MM-Verzeichnis. 

• Wav files  
o WAV-Dateien im Unterverzeichnis \wav abspeichern 
o WAV-Dateien zum Rufzeichenbau im Unterverzeichnis \letters abspeichern 

 
Hinweis : Diese Aufzählung funktioniert NICHT beim Kopieren auf einen Zweitcomputer ! Hier muss das 
Programm zuerst installiert werden.  

Installation auf einen anderen Computer  

Sie müssen zuerst  das komplette N1MM-Logger-Programm auf dem neuen Rechner installieren, um die ganzen *. dll , 
*.ocx files usw. kopiert und registriert zu bekommen. Danach  können die *.mdb-Dateien und die Einstellungen aus dem 
Erstrechner kopieren und auf dem Zweitrechner wie bei der vorstehend beschriebenen Restaurierung überschreiben.  

Achten Sie darauf, das die Einstellungen der Schnittstellen, die Verteichnisstruktur, die Bildschirmauflösung u.a. bei den 
Rechnern übereinstimmen bzw. auf dem Zweitrechner korrigiert werden. Sonst sind Probleme zu erwarten. 

Copy, zip, cd/rw etc.  

Sie können die Datenbankdateien mit WinZip auf etwa 10..25 Prozent ihrer Ursprungsgrösse komprimieren. Eine 4MB-
Datenbank passt dann auf eine Diskette. 
Ich mache öfter ein backup des gesamten N1MMLogger-Verzeichnisses mit allen Unterverzeichnissen auf einer CD-
R/W. Sind Sie in einem Netzwerk eingeloggt, können Sie die N1MMLogger-dateien auf einem anderen PC im Netz 
sichern. Sichern Sie mit dem N1MMLogger zusammen auch die Windows- und Programmeinstellungen. 
 

8. Zwei-Monitor-Betrieb (Two Monitor Support) 
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Original von Joe Natale, K1JN  

8.1 Anforderungen (Requirements)  

• Windows 98 oder höher 
• Zusätzliche Videokarte 
• Zusätzlicher Monitor  

8.2 Überblick (General)  

Die Nutzung von zwei Monitoren ist einfach und wenn Sie es einmal eingerichtet haben, werden Sie kaum zur früheren 
Lösung zurückkehren. Stellen Sie sich die beiden nebeneinander stehenden Monitore als einen Monitor vor. Sie können 
Fenster von der einen Seite auf die andere Seite ziehen und sich von der linken Seite des einen Monitors auf die rechte 
Seite des anderen Monitors bewegen. Öffnen Sie ein Programm auf dem einen Monitor und ziehen Sie es auf den 
anderen Monitor. Sie brauchen nur eine Maus und eine Tastatur und können mit der Maus über beide Monitore fahren 
und Daten anklicken. Die Befehle und Einstellungen stehen für beide Monitore und können auf beiden unterschiedlich 
sein. 
Stecken sie eine billige PCI- oder AGP-Karte in Ihren PC und schliessen Sie den zweiten Monitor an. Überprüfen Sie die 
Monitoreinstellung und passen Sie Ihren Wünschen an. Starten Sie mit zwei Monitoren und haben Sie Spass damit. 
Mitunter unterstützt auch Ihr Laptop einen Doppelmonitor, d.h. den Laptopschirm und einen zusätzlichen Monitor. 
Der jeweils erste Monitor sollte sich links von Ihnen befinden, denn die meisten Programme verarbeiten keine negativen 
Positionsangaben. Sie sollten es, machen es aber nicht. Wenn Sie den primären Monitor links aufstellen und den zweiten 
rechts funktioniert es aber. 

8.3 Einstellungen für zwei Monitore (Two Monitor Setup)  
8.3.1 Hardware installieren (Install hardware) 

• Windows beenden 
• Rechner ausschalten, Netzstecker ziehen 
• Gehäuse öffnen 
• zweite Videokarte installieren 
• Monitor anschliessen  
• Sie können beliebige Videokarten und Monitore verwenden, es müssen nicht die gleichen sein 

wie die bereits installierten. Ich verwende eine ATI Rage Videokarte aus der Win’95-Ära und 
einen alten  Gateway 2000 CrystalScan Monitor.  

• Gehäuse schliessen  
• Software  
• Netzstecker anschliessen, Rechner anschalten, Windows starten 
• Windows findet die neue Karte  und den Monitor und Sie können die zugehörige Software 

installieren  
o Sie erhalten eine Ausschrift auf dem zweiten Monitor, dass Sie  – wenn Sie die 

Ausschrift lesen können - ihren Desktop auf diesen Monitor erweitern können   
• Klicken Sie rechts auf Ihren Monitor,  wählen Sie Eigenschaften und dann die Karteikarte 

Einstellungen . Dort finden Sie Icons für zwei Monitore, klicken Sie auf den Icon mit der Nummer 
2 und machen sie einen Haken in das Feld, mit dem Sie den Desktop auf diesen Monitor 
erweitern können..  

• Ziehen Sie die Icons und legen Sie damit fest, welcher Monitor rechts oder links steht.  
o Der zweite Monitor ist eine Erweiterung Ihres ersten Monitors. Er hat das gleiche 

Hintergrundbild und Farbmuster. Wenn Sie die Maus über den rechten Rand des 
linken Monitors ziehen, erscheint der Mauscursor auf der linken Seite des rechten 
Monitors. Der Bildschirmschoner läuft aber nur auf dem Hauptschirm, nicht auf dem 
zweiten Schirm. .  

8.3.2 Beispiel für einen Aufbau (Example Setup)  

Das untenstehende Bild stammt von K1JN aus einem  CQ WPX CW  Contest.  
Der linke Monitor ist ein 17-Zoller mit 1024 x 768 Punkten, der rechte ein 15-Zoller mit  800 x 600 Punkten..  

   Linker Schirm     Rechter Schirm   

  Beide Bandskalen   Packet/Telnet-Fenster  

  Logfenster   Info-Fenster  

  Logeingabefenster   Multis im Angebot  

  Check-Fenster   Stationen im Angebot  

    Aktueller Punktestand   

 
9. Logeingabefenster (Entry Window) 
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Sie sehen dieses oder ein ähnliches Fenster :   

 

Sie haben zwei Möglichkeiten um von Feld zu Feld zu kommen :  

• Mit Tab oder Shift+Tab   kommen Sie vorwärts oder rückwärts normal von Feld zu Feld  

• Wenn Sie auf die Leertaste  drücken werden die voreingestellten Daten in die Felder eingetragen und 
nur die zu füllenden Felder angesteuert, Das über dem Rufzeichenfeld stehende Rufzeichen wird 
übernommen, als Rapport 59/9 eingetragen und auf die Eingabe des Rapports gewartet. Daten aus 
früheren QSOs wie die Zonennummer oder ein DOK werden bereitgestellt. 
Die Leertaste sollte die bevorzugte Taste sein !   

 

Statusbalken-Information (Status Bar Information) 

 

• Tastenzuordnung (Button Assignments) 

• Weitere Informationen (Other Info) 

• Statusbalken-Information (Status Bar Information) 

• Rufzeichenfarben (Callsign Colors) 

• Die roten und grünen LEDs (The red and green dots (LEDs)) 

• Das Logeingabefenster (The Entry Windows) 

• Weitere Möglichkeiten (Other Features) 

• Funktionstasten (Function Keys) 

• Andere Tasten (Other Keys) 

• Datei-Menü (File Menu Selections) 

• Editier-Menü (Edit Menu Selections) 

• Ansichten-Menü (View Menu Selections) 

• Werkzeug-Menü (Tools Menu Selections) 

• Konfigurations-Menü (Config Menu Selections) 

• Fenster-Menü (Window Menu Selections) 

• Hilfen (Help Selections) 

9.1 Tastenzuordnung (Button Assignments)  

• Wipe/Alt-W  : Löscht alle Felder des Logeingabefensters und die Information dazu  
• Log It / ENTER  : QSO abspeichern  
• Edit  : Öffnet Edit-Fenster für zusätzliche Informationen zum aktuellen Call  
• Mark /Alt-M  : Markiert aktuelle Frequenz als belegt (Busy) durch ein nicht zu arbeitendes Call 

(Station nicht im Contest o.ä.)  
• Store / Alt-O  : Speichert aktuelles Rufzeichen in der Bandskala, fett, weil selbst eingetragen  
• Spot it / Alt-P   : Melder aktuelles QSO im Packet und/oder Telnet-Link.  
• Buck  : Zeigt Information zum Rufzeichen aus der Buckmaster-Callbook-CD an, falls hamcal32.dll 

im N1MMLogger-Verzeichnis abgelegt ist und die CD erreichbar ist. Muss in der Konfiguration 
eingetragen sein, sonst wird die Taste nicht angezeigt.  
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• F1 bis F8   : Sendet den für die Taste eingetragen CW-Text oder die zugewiesene WAV-Datei für 
den aktuellen Running- oder S&P-Modus. Mit einem rechten Mausklick können Sie den Inhalt der 
Tasten editieren.  

• Shift-F1 bis Shift- F8  : Sendet den zum jeweils anderen Modus gehörenden CW-Text bzw. die 
WAV-Datei.  

• Esc   : Bricht jede laufende Sendung  (CW oder WAV) unmittelbar ab. Stoppt auch die 
Aufzeichnung (Record)  

• ALT-U  : Schaltet zwischen Running- und S&P-Modus hin und her 
• CW speed   : CW-Geschwindigkeit in Worten pro Minute wpm. Kann durch die Pfeile erhöht oder 

erniedrig werden. Wird nur in CW angezeigt.  

 

9.2 Weitere Informationen (Other Info)  

Ein Haken in das Feld Running   schaltet den PC in den CQ-Ruf-Modus (Running).  

Running  wird automatisch eingeschaltet,   

• Wenn Sie auf die Marke CQ-frequency in der Bandskala klicken  
• Wenn Sie den VFO auf die Marke CQ-frequency  abstimmen  
• Wenn Sie im S&P-Modus die Taste Sift-F1(= CQ-Taste) drücken  
• Wenn Sie auf den grünen Punkt neben dem Rufzeichenfeld klicken und der Punkt die Schrift SP 

(Search & Pounce) anzeigt. 

9.3 Statusbalken-Information (Status Bar Information)  

Unten im Logeingabefenster sehen Sie die Statuszeile. Sie enthält folgende Informationen : 

• Links :  
o Nach Eingabe des Rufzeichens : DXCC-Land, Zone, Kontinent  
o Sonst : Fehlermeldungen, Ergebnisse von Kommandos usw. 

• Mitte :  Zahl der QSOs/Multiplikatoren/Zonen abhängig vom Contest  

• Rechts :  Aktuelle Gesamtpunktzahl  

9.4 Rufzeichenfarben (Callsign Colors)  

Rufzeichenfarbe nach der Eingabe ins Rufzeichenfeld  

Rot  Neuer Multi  

Blau  Neuer Kontakt  

Grau  Dupe  oder Station, die keine Punkte bringt oder die im Contest nicht gearbeitet werden darf 
 

Rufzeichenfarbe eines Rufzeichens über dem Rufzeich enfeld  

Rot  Neuer Multi  

Grau Dupe  oder Station, die keine Punkte bringt oder die im Contest nicht gearbeitet werden darf 

9.5 Die roten und grünen LEDs (The red and green dots ( LEDs))  

Links neben dem Rufzeichenfeld sehen Sie zwei stilisierte LEDs in grün und rot. Sie zeigen an, was in den beiden 
VFOs/Transceivern passiert und welcher VFO/Transceiver welchem Eingabefeld zugeordnet und aktiv ist. Diese Anzeige 
gehört zur Philosophie von N1MMLogger, auch optisch den aktuellen Stand anzuzeigen. 

Die grüne LED zeigt an, dass der VFO/TCVR auf Empfang steht und der Tastatur zugeordnet ist. Die rote LED ist blass, 
wenn der VFO/TCVR senden kann und leuchtet hell, wenn der VFO/TCVR auf Senden geschaltet wird. In den LEDs 
steht SP (S&P) oder Ru (Running). 

9.5.1 Farben der LEDs  

Grüne LED  – Der VFO/TCVR steht auf Empfang und ist der Tastatur zugeordnet. RX und Tastatur gehören zusammen. 
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• Innen in der LED steht Ru oder SP. Bei Ru befindet sich die Station im Running-Modus und bei SP 
im S&P-Modus  

• Mit einem Klick auf die grüne LED können Sie zwischen beiden Modi hin und her schalten  
• Die RX/Tastaturzuordnung kann zwischen zwei VFOs/TCVR durch einen Klick in einen leeren 

Bereich des jeweils zugehörigen Logeingabefensters (bei Betrieb mit zwei Eingabefenstern im 
SO2V/SO2R-Modus) hin und her geschaltet werden oder durch Eingabe eines \ (Backslash)  
gewechselt werden  

• Um sowohl TX- als auch RX-Zuordnung zwischen den Fenstern und dem linken oder rechten 
Transceiver umzuschalten, drücken Sie CTRL-Linkspfeil  oder CTRL-Rechtspfeil   

 
Rote LED   - Dieser VFO/Transceiver soll senden  
 

• Die Sendezuordnung kann zwischen den VFOs/TCVRn mit der Taste F10 umgeschaltet werden  
• Sollen Empfänger UND Sender von links nach rechts und umgekehrt umgeschaltet werden, drücken 

Sie CTRL-Linkspfeil oder CTRL-Rechtspfeil   
• Während des Sendens kann die Zuordnung nicht geändert werden  
• Ist der VFO dem TX zugeordnet, erscheint eine blasse rote LED, wird aus Senden geschaltet hat die 

LED ein sattes Rot  
• In der roten LED erscheint ein R (Repeat), wenn auf wiederholten CQ-Ruf geschaltet wurde  

9.6 Das Logeingabefenster (The Entry Windows)  

Das Programm hat zwei Eingabefenster , die Sie nutzen müssen , wenn Sie QSOs auf beiden VFOs/TCVRn  machen 
wollen. 

Das  Standardeingabefenster ist immer offen und dem VFO-A (SO2V) oder dem linken Transceiver  (SO2R) 
zugeordnet.  
Das  zweite Eingabefenster ist dem  VFO-B (SO2V) oder dem rechten Transceiver (SO2R) zugeordnet. Sie können 
das zweite Fenster mit einem Backslash \ in das erste Eingabefenster öffnen. 

Nehmen die beiden Eingabefenster zu viel Platz auf dem Bildschirm weg, schieben Sie sie übereinander und schalten 
Sie sie mit dem Backslash oder den CTRL-Pfeiltasten hin und her. Beim SO2R-betrieb öffnet das zweite Fenster 
voreingestellt. Wenn Sie im zweiten und kleineren Fenster  auf View > Hide Buttons  klicken, wird es genauso groß wie 
das erste. Die F-Tasten werden ausgeblendet und es wird im ESM-Modus gearbeitet Das Bild unten zeigt diesen Effekt. 

Die meisten SO2R-Operatior rufen CQ mit dem ersten Transceiver und machen S&P mit dem zweiten. In den Bildern 
sehen Sie diese Einstellung. VFO-A steht im Running-Modus und VFO-B im S&P-Modus. 
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Alle Möglichkeiten, die dem Einzel-Operator zur Verfügung stehen, stehen auch im Modus SO2R/SO2V bereit. Wenn Sie 
z.B. auf einem Band im S&P-Modus abstimmen, werden die DX-Spots in der zugehörigen Bandskala automatisch in das 
Logeingabefenster über dem Rufzeichenfeld eingefügt, wenn Sie in der Bandskala abstimmen. Ein Druck auf die 
Leertaste überträgt das Rufzeichen in das Rufzeichenfeld. Ruft auf dem Running-Transceiver eine Station an, können 
Sie mit dem ‚\’ oder den CTRL-Pfeil-Tasten zwischen den beiden Fenstern hin und her schalten. Sie können die Station 
loggen, das Rufzeichen mit ALT-W oder CTRL-W löschen oder an der Abstimmung weiter drehen, wodurch die Station 
dann automatisch gelöscht wird. Wenn Sie Spot all QSOs Locally frei gegeben haben, wird das Rufzeichen gleichzeitig 
als Spot in die Bandskala eingegeben. Die meisten Nutzer die komfortabel mit Logger arbeiten, tendieren dazu, die 
lokalen Spots im verkleinerten Eingabefenster zu nutzen. Alle wichtigen Informationen werden im verkleinerten Fenster 
angezeigt (siehe obige Beispiele) 

Das zweite Eingabefenster wird geöffnet, wenn Sie auf ein Rufzeichen in der zweiten Bandskala klicken, und es vorher 
noch nicht offen war. 

Für weitere Informationen zum SO2R gehen Sie ins Kapitel SO2R . 

 
Im SO2V-Modus  (ein Transceiver und zwei VFOs) werden  die “normalen” QSOs mit dem VFO-A 
gemacht und die QSOs in das erste (Standard)-Eingabefe nster eingetragen. Zwischendurch kann 
mit dem VFO-B eine zweite Bandskala nach interessant en Spots beobachtet werden und nach dem 
Umschalten dorthin das QSO in dem zweiten Eingabefen ster eingetragen werden. Geben Sie aus 
Versehen das Rufzeichen in das erste Fenster ein, da nn rufen Sie mit dem falschen VFO-A. Wählen 
Sie das richtige Eingabefenster  

9.7 Weitere Möglichkeiten (Other Features)  

• Wenn Sie ein Rufzeichen in das Rufzeichenfeld eintragen, werden in der Statuszeile Angaben 
zu Antennenrichtung, Entfernung, LP-Richtung usw. ausgegeben..  

• Wenn Sie ein Rufzeichen in das Rufzeichenfeld eingeben, die Sie schon gearbeitet haben, 
erscheint die Ausschrift DUPE ! rechts neben dem Rufzeichenfeld. Das Rufzeichen wird 
automatisch gelöscht, wenn Sie den Abstimmknopf weiter drehen.  

• Wenn in dem Rufzeichen, das Sie eingegeben haben ein Fragezeichen enthalten ist (weil Sie 
das Rufzeichen noch nicht komplett aufgenommen haben), steht der Cursor unter dem 
hellgetasteten Fragezeigen und mit einer neuen Eingabe wird das Fragezeichen 
überschrieben. Im Enter Sends Message (ESM)-Modus bleibt der Kursor beim Rufzeichen mit 
? im Rufzeichenfeld und geht nicht ins Nummernfeld, da ein Rufzeichen mit ? nicht geloggt 
werden kann. 
Anmerkung DM3ML : Haben Sie unter Config > Configure Ports.. > Functions Keys  einen 
Haken in das Feld Send Correct Call before End Msg  wird das korrigierte Rufzeichen bei der 
Bestätigung des Empfangs noch einmal und richtig ausgegeben 

• Der Klick in das Nummernfeld hat den gleichen Effekt wie ein Druck auf die Leertaste, wenn 
der Kursor sich im Rufzeichenfeld befindet.  

• Die aktuellen Frequenzen der beiden Bandskalen werden oben im zugehörigen 
Logeingabefeld zusammen mit dem Contestnamen angezeigt und sind auch bei 
geschlossenen Bandskalen zutreffend  

• Wenn Sie über das Band abstimmen und in die unmittelbare Nähe eines Rufzeichens in der 
Bandskala kommen (Abstand einstellbar), wird Ihnen dieses Rufzeichen über dem 
Rufzeichenfeld angeboten. Ist das Rufzeichenfeld leer, können Sie dieses Rufzeichen mit 
einem Druck auf die Leertaste in das Rufzeichenfeld kopieren. Klicken Sie auf das 
angebotene Rufzeichen wird es unabhängig vom Inhalt des Rufzeichenfelds eingetragen.  

• Frequenz in Rufzeichenfeld :  - Die Frequenz des ersten VFOs (A) kann mit einer 
Frequenzeingabe ins Rufzeichenfeld geändert werden. Möglich sind absolute Frequenzen, 
Frequenzänderungen oder Offsets für Splitbetrieb. Dezimal-Kommas oder –Punkte sind je 
nach Ländereinstellung erlaubt, Ein Schrägstrich vor der Frequenzeingabe stellt den VFO B. 
Informieren Sie sich im Kapitel Grundfunktionen  
über Frequenzänderung und Splitbetrieb. 

• Sendeart ändern : Geben Sie CW, LSB, USB, RTTY, AM, FM, DIGI, PSK oder SSTV im 
Rufzeichenfeld ein.  

• Ctrl-P  – Das im Rufzeichenfeld stehende Rufzeichen wird an die Verbindung zum DXCluster 
ausgegeben. Sie werden nach einem Kommentar gefragt. Steht kein Rufzeichen im Feld, wird 
das letzte geloggte Rufzeichen genommen.  

• Ctrl-O  – Wechselt das Operator-Rufzeichen. Beim Multi-User-Betrieb werden Sie am Anfang 
danach gefragt. Voreingestellt ist das Rufzeichen aus dem Stationsinformations-Dialog im 
Setup. Mit OPON im Rufzeichenfeld können Sie den gleichen Dialog öffnen. 

• Auto-Rufzeichenergänzung : Wenn Sie ein Rufzeichen eingeben, das im Check-Feld eine 
eindeutige Übereinstimmung hat, werden die fehlenden Zeichen automatisch ergänzt. Sie 
werden hellgetastet und mit der weiteren Eingabe überschrieben.  

• Auto-CQ  – Mit Alt-R  schalten Sie das automatische CQ an oder wieder ab. Der aktuelle 
Status wird nach der Eingabe in der Statuszeile angezeigt. Wollen Sie ein laufendes CQ 
stoppen,, drücken Sie auf des ESC-Taste.   

� Alt-R  schaltet die Rufwiederholung an oder aus 
� Ctl-R  stellt die Wartezeit vor der Wiederholung in Sekunden oder 

Millisekunden ein 
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� Ist die Wiederholung auf OFF wird der CQ-Ruf nicht wiederholt 
� Ist die Wiederholung auf ON wird der CQ-Ruf wiederholt 

• Shift-Ctrl-Fx  : Zeichnet die SSB-WAV-Datei für die zugehörige F-Taste auf. Wird Shift-Ctrl-
Fx noch einmal gedrückt, wird die Aufzeichnung gestoppt.  Fx kann F1 bis F8 sein.. 

• Ctrl-Alt-Fx  ; Aufzeichnung in einen externen DVK-Speicher 1 bis 4. Fx kann F1 bis F4 sein. 
• ESM-Modus : der ENTER-Modus löst die Sendefolge in einem QSO durch 

aufeinanderfolgenden Druck auf die ENTER-Taste aus. ESM funktioniert sowohl im Running- 
als auch im S&P-Modus. Informieren Sie sich unter  Grundfunktionen.  

• Automatically Spot all S&P QSO's  – Alle S&P-QSOs werden automatisch an den DXCluster 
gemeldet  

• "Quick Edit" (Ctrl-Q/Ctrl-A).  : Schnelles editieren der vorherigen QSOs im Log. Ctrl-Q ruft 
das letzte QSO, Ctrl-A ruft das nächste QSO. Wenn die Textbox im Eingabefenster blau ist, 
befinden Sie sich im Quick Edit – Modus. Das Editieren beginnt mit dem hellgetasteten QSO 
und Sie können von hier vorwärts oder rückwärts gehen. Das markierte QSO wird ins 
Eingabefeld geholt und kann hier editiert werden. Beenden Sie die Eingabe mit ENTER oder 
brechen Sie sie mit ESC ab 

• Das Programm zeigt eine Warnung  an, wenn es der Meinung ist, dass die PC-Uhr falsch geht 
(es prüft die Lokalzeit und die Zeitzone). 

• Stapelspeicher für Rufzeichen :  Sie können empfangene Rufzeichen mit Ctrl-ENTER in 
einen Stapelspeicher laden und sie dann der Reihe nach mit Rufzeichen und zugehöriger 
Frequenz wieder aus dem Stapelspeicher holen. Siehe Grundfunktionen.  

• Beide VFOs im Running-Modus nutzen :  Wenn Sie den Haupt-VFO zum Senden nehmen 
und mit dem zweiten VFO im Splitmodus die Empfangsfrequenz vorgeben, wird nach jedem 
geloggten QSO die RX-Frequenz wieder auf die TX-Frequenz gestellt. Sie können den 
grossen VFO-Knopf dann anstelle des kleinen RIT-Knopfs verwenden, um um die 
Sendefrequenz nach Stationen zu suchen. 

• Automatische Antennenwahl : Wenn Sie einen Antennenwahlschalter an der parallelen 
Schnittstelle installiert und konfiguriert haben, können Sie mit Ctrl-F11 alle für ein bestimmtes 
Band vorgesehenen Antennen durchschalten. Wenn nur eine Antenne für das aktuelle Band 
konfiguriert wurde, wird nicht durchgeschaltet. Schalten Sie auf ein anderes Band, wird die 
Antenne für dieses Band mit der jeweils niedrigsten Ziffer zugeschaltet. Der Namen der 
Antenne wird im Statusfeld angezeigt, wenn Sie umschalten. 

• Alt-'  : Schaltet zwischen einem breiten und einem schmalen Filter in der gewählten Sende 
art(SSB, CW und Digimodes) unabhängig von der vorprogrammierten Einstellung um. Die 
Filtercodes aus dem Handbuch können mit einem rechten Klick in die Bandskala im 
Menüpunkt Set transceiver filter codes   für die verschiedenen im eigenen Transceiver 
eingebauten Codes eingetragen werden. 

• Pause  : Tauscht die Transceiver zusammen mit der Tastatur um 

Erlaubte Zeichen im Nummernfeld (Exchange field validation) :  

CQ Zone  Nur Ziffern, TAB, Leertaste, Rücktaste  

Section  Nur Buchstaben oder Ziffern  

Exchange  Nur Buchstaben oder Ziffern  

Grid  Nur Buchstaben oder Ziffern  

Power  Nur Buchstaben oder Ziffern  

• Rufzeichenprüfung nach K1TTT eingebaut : Ein eingegebenes Rufzeichen wird auf Sinnfälligkeit 
geprüft. Fällt die Überprüfung negativ aus, werden Sie im Check-Fenster gewarnt. Die Bildungsregeln für 
ein Rufzeichen sind in der Datei CALLSIGN.PAT abgelegt. Die Prüfung erfolgt nur auf den HF-Bändern 
(nicht für  WARC) und in CW/SSB. Siehe auch Kapitel  Rufzeichenprüfung 

• Wenn in das Rufzeichenfeld ein SH/DX-Kommando eingegeben wird, wird es in das Packet-Fenster zur 
Bearbeitung heschickt. 

9.8 Funktionstasten (Function Keys)  
9.8.1 Überblick (General)  

Das Programm ordnet 16 programmierbare Texte den Funktionstasten F1-F8 zu. Je acht Texte sind den zwei Sätzen 
Running  und S&P zugeordnet.  
Die Funktionstasten können Funktionen wie CQ, Nummeraustausch, QSO-Ende u.a. über das Menü  Config  > 
Configure Ports, Telnet Address, Others >  Function  Keys  zugeordnet werden. Sie können die Texte für eine 
bestimmte Funktionstaste in einem Stapelspeicher ablegen, die Texte werden dann nacheinander nach jedem neuen 
Tastendruck in voller Länge gesendet (CW und SSB). Für die drei Sendearten CW, SSB und Digimodes gibt es 
getrennte Sätze zu je 16 Texten. Sie sehen den in den F-Tasten abgelegten Texte, wenn Sie mit der Maus 
darüberfahren. 
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9.8.2 Running und S&P-Modus (Running and S&P mode)   

Ist der Running -Modus aktiv, sehen die Running-Texte, haben Sie S&P gewählt, sehen Sie die S&P-Texte.  Drücken Sie 
die Shift-Taste, schalten Sie in das jeweils andere Register und können diesen Text mit der zugehörigen F-Taste rufen. 

Sie sind im Running-Modus, wenn ein Haken im Running-Feld zu sehen ist. Informieren Sie sich unter  Grundfunktionen, 
wie Sie die Modi anwählen. Im Running-Modus sind Sie, wenn Sie selbst CQ rufen oder wieder auf die CQ-Frequenz 
abstimmen. Wenn Sie die Abstimmung von der CQ-Frequenz wegdrehen oder die VFOs tauschen, kommen Sie 
automatisch in den S&P-Modus.  

Sie schalten aus dem S&P-Modus mit Shift-F1  in den Running-Modus. Ab dann rufen Sie mit F1 (ohne Shift) weiter CQ. 

Default Function keys (voreingestellte Tasten)  

F1 CQ key  CQ-Taste 

F2 Exchange key   Nummeraustausch 

F3 End of QSO Key  Ende des QSOs 

F4 My Call Key  Eigenes Rufzeichen 

F5 His Call Key  Fremdes Rufzeichen 

F6 QSO B4 Key  Schon gearbeitet 

F7   

F8 Again Key  Wiederholen ! 

Diese Tasten sind voreingestellt. Sie können Sie in der Konfiguration anders zuordnen. Tragen Sie die 16 Texte für CW  
in dieser Reihenfolge ein. Sie werden in der Tabelle in der Reihenfolge F1 bis F8 und anschliessend Shift-F1 bis Shift-F8 
eingetragen. Bei nichtbelegten Shift-Tasten wird der in der gleichstehenden F-Taste eingetragene Text gesendet. Ist z.B. 
die Taste Shift-F6 nicht belegt, wird der unter F6 eingetragene Text QSOb4 gesendet. Die Belegung der Tasten 
entspricht in erster Näherung dem Programm CT. 

Bitte beachten : Der gesendete Text hängt davon, ob der Running-Modus aktiv ist oder nicht !  

Informieren Sie sich über Einzelheiten zum Running- und S&P-Modus im Kapitel Grundfunktionen (Basic Functions) .  

9.9 Andere Tasten (Other Keys)  

Taste   Funktion   Aktion(en)   

Einfg 
(Mitte)  

His Call Key  & Exchange 
Key   

Sendet Rufzeichen der Gegenstation plus 
Contestnummer (F5+F2) 

; 
(wirkt wie 

Einfg)  

His Call Key  & Exchange 
Key   

Sendet Rufzeichen der Gegenstation plus 
Contestnummer  

Alt-Enter      Loggt das QSO 

' End of QSO Key  & Log 
contact 

Sendet QSO-Ende und loggt das QSO (F3) 

Hintergrund: Die Tasten für ; und ' wurden hinzugefügt um die Eingabe für die OMs zu erleichtern, die blindschreiben und 
die Einfg und +-Taste für die QSOs benutzen. Meist liegen die Tasten auf verschiedenen Tastaturen an verschiedenen 
Stellen, so dass vor allem bei M/M-Stationen mit dieser Belegung eine Erleichterung erreicht wird. 
Anmerkung DM3ML : Im Menü Config > Config Ports... > Function keys können zwei zusätzliche Tastencodes für die 
Aktionen F5+F2 und F3 eingetragen werden. Diese Codes sind von der verwendeten Tastatur abhängig. Bei mir stehen 
die Codes 186 und 222, die aber ganz anderen Zeichen zugeordnet sind, so dass die genannte Aktion bei mir nicht 
ausgelöst wird. 
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9.10 Datei-Menü (File Menu Selections)  

 
Hinweis: Die Datenbasis von N1MMLogger ist eine Access 2000 Datenbasisdatei mit der Erweiterung *.mdb. In jedes 
Datenbasis werden null oder mehrere General- oder Contestlogs abgelegt. Langfristig soll es möglich sein, mit einer 
Datenbasis alle Aktionen wie das Drucken von QSLs oder das Ansehen und Editieren aller QSOs einer Datenbasis 
vornehmen zu können.  

Sie erreichen das Menü für dieses Kapitel aus dem Logeingabefenster über den Menüpunkt File:  

• Choose Contest (Wähle Contest) :   Mit diesem Menüpunkt wählen Sie aus den angebotenen 
Contesttypen einen Contest aus und editieren die Vorgaben für Teilnehmerklasse, Contestnummer usw, 
Siehe auch Contest auswählen 

• New Database (Neue Datenbasis)  :  Erzeugt eine neue Logdatenbasis. Ändern Sie den 
vorgeschlagenen Namen new.mdb  in einen sinnvollen Namen. Ab sofort wird diese Datenbasis beim 
Start als voreingestellt geöffnet. Mit Open Database  können Sie eine andere Datenbasis öffnen. In eine 
Datenbasis passen alle Conteste. Sie sollten nur dann eine neue Datenbasis anlegen, wenn Sie eine 
neue Programmversion testen wollen. Machen Sie regelmässige Backups des N1MMLogger-
Verzeichnisses, sichern Sie jedoch mindestens die Datenbasis mit den realen Contest-QSOs. 

• Open Database  (Datenbasis öffnen ) : Öffnet eine  schon existierende Datenbasis. 
Warnung: Alle eingestellten Werte wie Stationsinformationen, Transceiversteuerung, Telnet-Cluster u.a. 
werden in der aktuellen Datenbasis abgespeichert. Wenn Sie eine neue Datenbasis einrichten, werden 
diese Werte in die neue Datenbasis kopiert. Aktuelle Änderungen werden aber nur in der aktuellen 
Datenbasis gespeichert. Wenn Sie eine ältere Datenbasis öffnen, müssen Sie alle Einstellungen 
daraufhin prüfen, ob sie noch richtig und gültig sind. Sie können diesen Abgleich teilweise mit den 
Export- und Importfunktionen für Einstellungen und Funktionen automatisieren.  

• Copy (and Compact) Database  (Datenbasis kopieren und komprimieren)  : Kopiert die Datenbasis 
ind eine neue Datenbasisdatei und komprimiert sie gleichzeitig. Ändern Sie den vorgeschlagenen 
Namen new.mdb  in einen Namen Ihrer Wahl. Diese Funktion kann genutzt werden, wenn Sie mehrere 
Conteste gelöscht haben oder eine neue CTY.DAT eingelesen haben. Die Original-Datenbasis wird 
nicht geändert und bleibt so lange aktiv, wie Sie nicht mit Open Database die neue Datenbasis 
aufgerufen haben.  
Hinweis : Wenn Sie eine Datenbasis kopieren, wird S ie automatisch komprimiert. Gelöschte 
Conteste und QSOs werden damit endgültig entfernt.   

• Copy This Contest to Another Database  (Diesen Contest in eine andere Datenbasis kopieren ) ; 
Kopiert die Einstellungen und QSOs des aktuellen Contest in eine andere Datenbasis. Falls diese neue 
noch nicht existiert, müssen Sie vorher mit New Database  eine neue erzeugen.  

• Repairing a corrupted database (Defekte Datenbank r eparieren) : Das ist Link zu Webseite von 
Microsoft, auf der steht, wie defekte Access-Datenbanken repariert werden können. Sie können sich 
hier ein Reparaturprogramm Jetcomp.exe holen..  

• Import   
o Import ADIF from file... (Import einer ADIF-Datei ) : Holt die Daten einer ADIF-Logdatei in die 

aktive Datenbasis. ADIF wird zum Austausch zwischen Log- und Contestprogrammen 
verwendet. Ein Contest kann dann nicht importiert werden, wenn die CONTEST_ID nicht 
übereinstimmt. Der exportierte und importierte Contest muss übereinstimmen. Sehen Sie 
unter Oft gestellte Fragen (Frequently Asked Questions)nach, was zu tun ist.  

o Import Call History  (Rufzeichenvorgeschichte importieren ) : Mit dieser Option können Sie 
Informationen zu Rufzeichen wie Name, Provinz, Alter, Locator u.ä. zu einem Rufzeichen von 
früheren Contesten her importieren, falls eine entsprechende Datei vorhanden ist. In RTTY 
gibt es z.B. die Namendatei RTTY_friends. Informieren Sie sich in den Kapiteln Vor dem 
Contest und Conteste auf VHF und höher. Informieren Sie sich über die zur Verfügung 
stehenden Listen und importieren Sie als erstes. Sie überschreiben die aktuelle Callhist-
Tabelle. Für UKW-Conteste gibt es eine europäische Locator-Liste. Ein europäischer Contest 
ist der VHFReg1 für den diese Rufzeichenliste mit QTH-Kennern genutzt werden kann. 

o Import Packet/Telnet Buttons from file... (Daten für die Packet/Telnet-Fenster 
importieren ) . Diese Daten sind in Dateien mit der Erweiterung *.mc abgelegt. Sie können 
Sich für verschiedene Cluster und Standorte getrennte Tastensätze anlegen und bei Bedarf 
holen. 

o Import Function Keys to file...  (F-Tastenbelegung importieren )  : Importiert die 
abgespeicherte Tastenbelegung aus einer *.mc-Datei, die vorher exportiert wurde. Sie können 
diese *.mc-Datei mit einem Editor wie Notepad bearbeiten. Die Gruppen werden getrennt 
importiert :  
  

� SSB Function Keys  – importiert die SSB-F-Tasten 
� CW Function Keys  – importiert die CW-F-Tasten 
� Digital Function Keys  – importiert die Digimode-F-Tasten 

• Export   

 
Wenn Sie unter Save File  nach einem Dateinamen gefragt werden, wird Ihnen ein voreingestellter Name wie 
callsigned.txt  vorgeschlagen. Wenn Sie z.B. N1MM/P waren, geben Sie z.B. N1MM_P.txt ein. Der / wird 
mitunter vom Betriebssystem nicht verstanden.   
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o ADIF  
� Export ADIF to file...  (ADIF-Datei erzeugen ) : Nehmen Sie diese Werkzeug, um 

eine ADIF-Datei der Contest-QSOs zur Übergabe an ein anderes N1MMLogger-
Programm, ein anderes Contest- oder Logprogramm oder ein Labeldruckprogramm 
zu erzeugen. Gelöschte QSOs werden nicht exportiert. Sie können Sie mit 
DELETEDQS exportieren. 

� . Export ADIF to file by date...(QSOs nach Datum exp ortieren) :  Geben Sie für 
die zu erzeugende ADIF-Datei das Anfangs- und Enddatum im Format yyyy-mm-dd 
in Ziffern ein. Der Export beginnt, falls nichts anderes eingegeben wurde, mit 1900-
01-01 (yyyy-mm-dd) oder beim Zeitpunkt des letzten Exports. Für die zweite Zeit 
wird das aktuelle Datum und Uhrzeit vorgeschlagen. Datum und Zeit können 
geändert werden. Diese Funktion ist in erster Linie interessant, wenn Sie aus einem 
grösseren Log ausgewählte Daten z.B. für ein Diplom oder eQSL herausnehmen 
wollen. Gelöschte QSOs werden nicht exportiert, können aber mit DELETEDQS 
ausgegeben werden. 

 

� Export ADIF to file by date from all contests...  (Daten von allen Contesten nach 
Datum exportieren ) : Hier werden alle in der Datenbasis enthaltenen QSOs in 
einem gewählten Zeitraum exportiert, wenn Sie im DX-Modus arbeiten. 
Normalerweise gilt der Export nur für den aktuellen Contest.  Der Export beginnt, 
falls nichts anderes eingegeben wurde, mit 1900-01-01 (yyyy-mm-dd) oder beim 
Zeitpunkt des letzten Exports. Für die zweite Zeit wird das aktuelle Datum und 
Uhrzeit vorgeschlagen. Datum und Zeit können geändert werden. Diese Funktion ist 
in dann interessant, wenn Sie einen grösseren Block an QSOs in ein anderes 
Logprogramm übernehmen wollen. Gelöschte QSOs werden nicht exportiert, 
können aber mit DELETEDQS ausgegeben werden.  

 

� Export ADIF to file by Multi User Station Number (A usgabe der QSOs einer 
Station bei Multi User Betrieb)  : Hier können Sie aus dem DX-Modus heraus alle 
QSOs einer bestimmten Station als ADIF-Datei ausgeben. Die Stationsnummer 
muss vor der Angabe zum ADIF-Dateinamen eingegeben werden.  

o Export Cabrillo to file... (Ausgabe einer Cabrillo- Datei)  : Erzeugt ein Cabrillo-Log für den 
aktuellen Contest. Stellen Sie sicher, dass die Angaben zur Station (Station information ) und 
zum Contest (File/Choose Contest ) richtig sind. Wählen Sie vor der Ausgabe Tools > 
Rescore current  contest . 
Tipp DM3ML : Sehen Sie sich das Log <call>.log mit einem Editor an, ehe Sie es abschicken. 

o Export REG1TEST to file by band...  Erzeugt eine Datei  REG1TEST, die in einem VHF-
Contest in Europa verwenden werden kann. Noch nicht in Betrieb.    

o Export Call History (Rufzeichenvorgeschichte ausgeb en) : Die Tabelle der Rufzeichen 
wird ausgegeben. Die Tabelle kann nur mit Import  Call History  gefüllt werden. 

o Export Packet/Telnet Buttons to file... (Packet/Tel net-Tasten ausgeben) : Diese Daten 
sind in Dateien mit der Erweiterung *.mc abgelegt. Sie können sich für verschiedene Cluster 
und Standorte getrennte Tastensätze anlegen und bei Bedarf holen. Die Einträge können mit 
einem Editor wie Notepad editiert werden. 

o Export to File (Generic).  (Export in Text-Datei ) :  Erzeugt eine Textdatei (*.txt oder *.cab) 
aus den QSO-Daten. Die Datei kann in Tabellenverarbeitungsprogramme oder Datenbanken 
importiert und mit einem Editor bearbeitet werden. Sie ist NICHT ADIF-kompatibel.  
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� Export to File (Generic), order by QSO Time (normal ) - : Erzeugt eine Text-
Datei unter dem Namen <call>.txt aus dem Contestlog, in dem die QSOs der 
Zeit nach und nicht nach Bändern sortiert sind. Manche Contestmanager 
verlangen solch ein Log. Die Datei kann auch in Tabellenprogramme oder 
Datenbanken importiert werden. Die Datei kann mit einem Texteditor bearbeitet 
werden. Sie kann NICHT als ADIF-Datei importiert werden. 

� Export to File (Generic), order by Band – Erzeugt eine Textdatei unter dem 
Namen <call>.txt in der die QSOs per Band und darin der Zeit nach sortiert sind. 
Vor allem für VHF-Conteste werden solche Logs benötigt.  

o Print Score Summary to File  (Ergebnisliste drucken )  : Erzeugt eine druck- und editierbare 
Datei mit den Contestergebnissen. Vorgeschlagen wird der Name <call>.SUM. Die QSO-Zahl 
enthält die Doppelverbindungen. Die Datei kann mit einem Texteditor bearbeitet werden. 

o Export Function Keys to file (F-Tasten-Belegung aus geben)  . Sie können die aktuelle 
Belegung der F-Tasten getrennt nach SSB, CW und Digimodes in einer *.mc-Datei 
abspeichern und Sie später mit  File | Import Function Keys to file...  zurück holen. Die drei 
Sendearten sind getrennt adressierbar und mit einem Editor änderbar :  

� SSB Function Keys  – exportiert die SSB-F-Tasten 
� CW Function Keys  – exportiert die CW-F-Tasten 
� Digital Function Keys  – exportiert die Digimode-F-Tasten 

• Recently used contests/databases  – (Anzeige der zuletzt genutzten Contestdatenbanken ). Es 
werden die 10 zuletzt genutzten Datenbanken angezeigt..  

• Exit   Alt-F4  (Programmende )  : Beendet das Programm. Sind zwei Eingabefenster offen (SO2R) wird 
das Programm nicht beendet. Liegen noch nicht abgespeicherte Verbindungen vor, werden Sie 
gefragt, ob Sie abspeichern wollen oder nicht :   

 

 
Hinweis : Wenn Sie einen ADIF-Export starten und der Contestname die Zeichenketten "RTTY" oder "JARTS" enthält, 
wird als Sendeart generell "RTTY" eingetragen, auch wenn im Log z.B. USB oder LSB steht. 

9.11 Editier-Menü (Edit Menu Selections)  

� Wipe Out Entry Fields  (Eingabefelder löschen) =  Ctrl-W / ALT-W  : löscht alle 
Felder im Logeingabefenster. 

� Edit Last Contact  (letztes QSO editieren) =  Ctrl-Y  : Öffnet ein Dialog-Fenster mit 
allen Einträgen zum letzten QSO  

� Add a Note to Last/Current Contact  (Notiz zum letzten QSOs zufügen) = Ctrl-N  : 
Sie können sich Notizen zum letzten QSO machen  

� Edit Current Contact  (aktuelles QSO editieren ) : Sie können zum aktuellen QSO 
ergänzende Angaben in das Dialogfeld eintragen. Ein Doppelklick in das Log auf 
ein dort gespeichertes Rufzeichen öffnet den gleichen Dialog  

� Quick Edit Previous Contacts (Back) (Schell-Editier en des vorherigen QSOs) =  
Ctrl-Q – Mit CTRL-Q kommen Sie im Log rückwärts, mit CTRL-A  vorwärts. Die 
Änderungen werden im Logeingabefenster gemacht und die Einträge sind blau , 
wenn Sie sich im Schnelleditiermodus befinden. Speichern Sie die Änderungen 
mit ENTER ab oder verwerfen Sie sie mit ESC.  

� Quick Edit Previous Contacts (Forward)(Schell-Editi eren des folgenden QSOs)  
= Ctrl-A - (s.o.) 

� Increase Received NR by 1 (empfangene Nummer um 1 e rhöhen)= Ctrl-U  : 
nützliches Werkzeug, wenn Sie auf eine Station warten, die Seriennummer schon 
eingetragen haben und warten, bis Sie (endlich) dran gekommen sind  

� Find first (suche Rufzeichen) = Ctrl-F  – Suche das in das Eingabefeld 
eingegebene Rufzeichen im Log. Falls negativ, erfolgt eine Ausschrift  

� Find next (suche nächsten Eintrag) = Ctrl-G  – Suche das Rufzeichen an der 
nächsten Stelle. Sie müssen mit CTRL-F angefangen haben.   

9.12 Ansichten-Menü (View Menu Selections)  

Sie erreichen das Menü für dieses Kapitel aus dem Logeingabefenster über View :  
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• Max rates (maximale QSO-Raten)  für  eine Minute (1 minute), 10 Minuten (10 minutes) und eine 
Stunde (60 minutes) in diesem Contest. Diese Daten können mit der Save-Taste in einer Textdatei 
abgespeichert werden. Der Dateiname ist wählbar.  

 

• Off Times (Pausenzeiten) -: Angezeigt wird Beginn und Ende der inaktiven Zeit. Ist der OP bekannt, 
wird er mit angezeigt. Pausen- und Aktive Zeiten werden aufaddiert und in Tagen/Stunden(Minuten . 
Hat der Contest keine vorgeschriebenen Pausenzeiten, sind sie auf 30 min gesetzt . Der angezeigte 
Text kann mit Save in einer Textdatei abgespeichert werden. 

 

• Runs  – zeigt die Spitzenzeiten mit den meisten QSOs/Stunde. Es sind Perioden zwischen den 
Bandwechseln und schließen Pausenzeiten ein. Auch diese Ausgabe kann abgespeichert werden.  

 

• Suspect Calls (möglicherweise falsche Rufzeichen) :   Zeigt nach Prüfung mit der Rufzeichenprüfung 
(Call Checking) möglicherweise falsche oder unklare Rufzeichen. Auch diese Ausgabe kann 
abgespeichert werden. 

• Notes  (Notizen ) : Öffnet ein Fenster mit allen QSOs, zu denen Notizen eingegeben wurden. Geeignet 
um nach dem Contest Notizen des/der Operator nachzulesen. 

• Hide Buttons (F-Tasten verstecken) :  Die F-Tasten werden von der Anzeige abgeschaltet. Auch die 
Running- und Record-Boxen verschwinden. Das Eingabefenster wird dadurch wesentlich schmaler.   

o Im ESM-Modus wird der nächste zu sendende Text in der Zeile mit der Landesinformation 
angezeigt 

o Die CW-Geschwindigkeit wird in der Statuszeile angezeigt. 

• Show Last 10 Spots (zeige die letzten 10 Spots) :  Die letzten 10 DXCluster-Meldungen für das im 
Rufzeichenfeld stehende Rufzeichen werden angezeigt. Ist das Rufzeichenfeld leer, wird das darüber 
stehende Rufzeichen genommen. Ausgelöst wird eine Abfrage beim connecteten DX-Cluster. Eine 
Packet oder Telnet-Verbindung ist für diese Funktion Voraussetzung. 

• Show Buck/Packet   (zeige Rufzeichen-Info) : Die Informationen für das im Rufzeichenfeld stehende 
Rufzeichen werden angezeigt. Ist das Rufzeichenfeld leer, wird das darüber stehende Rufzeichen 
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genommen. Ausgelöst wird eine Abfrage beim connecteten DX-Cluster. Eine Packet oder Telnet-
Verbindung ist für diese Funktion Voraussetzung.  

• Show Station  : wie Show Buck/Packet : eine Stations-Info wird angefordert 

• Show QSL/Packet  : wie Show Buck/Packet : Die QSL-Info wird abgefragt.  

• Show Sunrise/Sunset  : wie Show Buck/Packet : Sonnenauf- und untergang für das Rufzeichen werden 
abgefragt  

• Show DX Current Call or Spot  : DX-Informationen zum aktuellen Rufzeichen werden angezeigt 

• Show QRZ Internet  : Die Internetadresse www.QRZ.com wird nach dem Rufzeichen abgefragt. Eine 
Internetverbindung muss bestehen.  

• Show Buck Local  : Die auf dem eigenen Rechner installierte Buckmaster-Datenbasis wird abgefragt   

• Set Font  : Stellt die Schrifttype im Eingabefenster ein  

9.13 Werkzeug-Menü (Tools Menu Selections)  

Sie erreichen das Menü für dieses Kapitel aus dem Logeingabefenster über Tools :  

• Rescore Current Contest  (Punktzahl neu berechnen ) : Sollte immer dann gemacht werden, wenn die 
Datei  CTY.DAT geändert wurde, QSOs geändert, importiert oder gelöscht wurden oder das Log zur 
Abrechnung ausgegeben werden soll. Die Berechnung läuft relativ lang.   

• Download Latest Check Partial file (Master.DTA)  (Hole die neueste Master.dta-Datei )  : Ruft eine 
voreingestellte Internetadresse auf (Internetverbindung muss bestehen) und holt die verzippte 
Master.dta. Sie muss anschliessend entpackt und im N1MMLogger-Verzeichnis abgelegt werden. 
N1MMLogger unterstützt das CT-Format der Datei. (Anmerkung DM3ML: Die Master.dta enthält aktive 
Contestrufzeichen aus mehreren grossen Contesten) 

• Tune (CW mode) (Abstimmen) =  Ctrl-T  : Schaltet mit gedrückter Taste auf Senden in CW. Beenden 
mit einem weiteren CTRL-T oder ESC.  War CW vorher nicht aktiv, wird auf die vorher eingestellte 
Sendeart zurück geschaltet.  

• Download latest country file (wl_cty.dat)  (Neueste Länderliste aus dem Internet holen ) . Holt die 
neueste Länderliste CTY.dat aus dem Internet. Sie muss anschliessen mit dem Menüpunkt Tools > 
Import country list from downloaded file nach N1MMLogger importiert werden. 

• Import country list from downloaded file  (Länderliste importieren ) : Lädt die neueste Länderliste in 
die Datenbasis. Meist heisst die zu importierende Datei  WL_CTY.DAT, sie kann aber auch einen 
anderen wählbaren Namen haben.  Prüfen Sie unter dem Menüpunkt Help - About N1MM logger 
Vx.x.xx  welche Version bzw. welches Datum der Länderliste aktuell verwendet wird. Duplikate werden 
ignoriert. 
 Verwenden Sie die jeweils neueste Länderliste vor einem Contest oder nehmen Sie die Version, 
die mit dem neuesten Update von N1MMLogger mitgelie fert wird.  

• Add call to country  (Ordne Rufzeichen einem Land zu ) : Mitunter tauchen in Contesten Rufzeichen 
auf, bei denen die Landeszuordnung unklar ist. Mit diesem Menüpunkt können Sie einem Rufzeichen 
ein Land definiert zuordnen. Die Zuordnung ist bis zum nächsten Import country list from 
downloaded file gültig. Mit dieser Funktion können auch Rufzeichen gewertet werden, die 
normalerweise vom Programm zurück gewiesen werden (z.B. R-Rufzeichen aus der Antarktis als DX-
Call) Die Punktzahl wird damit besser berechnet. Geben Sie das offizielle Prefix für das Land in das sich 
öffnende Fenster ein. Nach diesem Eintrag akzeptiert das Programm das Rufzeichen und berechnet 
Punkte und Multi richtig. 

9.14 Konfigurations-Menü (Config Menu Selections)  

Sie erreichen das Menü für dieses Kapitel aus dem Logeingabefenster über Config  

• Configure Ports, Telnet Address, Others  (Schnittstellen, Telnetadresse usw. einstellen ): Menü 
zum Einstellen aller technischen Einstellungen der Hard- und Software  

• Change Your Station Data (Einstellen der Stationsda ten) : Stationsdaten wie Rufzeichen, Name, 
Adresse, geographische Länge und Breite usw. werden hier eingestellt  

• Change Sub Bands –(Subband-Grenzen einstellen) : Mit diesem Menüpunkt können Sie die Bereiche 
für CW, DigiModes und SSB für Ihre IARU-Region einstellen. Die Bereiche werden in der Bandskala 
farbig (magenta) hervorgehoben. Wenn Sie im Menü Configurer > Karteikarte Mode Control > Follow 
band plan  anwählen, folgt die Sendeart der für diese Frequenz geltenden Mode. Der Ablauf ist : #1: 
Digimode, wenn nicht dann #2. CW, wenn nicht dann #3 : SSB. 
Die Tabelle geht vom IARU-Region-2-Bandplan (Nordamerika) aus und muss auf den Bandplan der 
Region 1 umgebaut werden.  
  

o CW Sub Bänder : ist im Beispiel auf CW (Europa) von 7000 bis 7035 eingestellt. Alle 
Frequenzen oberhalb zählen für SS, solange kein Digimode-Subband eingetragen ist. 

o SSB Sub Bänder  : fall nichts eingetragen wird, ist SSB die voreingestellte Sendeart.  
o Digital Sub Bänder : Subbänder für die Digimodes  
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• Enter sends messages (ESM mode) (ENTER-Modus) =  Ct rl-M  : die Meldungen zur Abwicklung eines 
Contest-QSOs werden im ENTER-Modus durch aufeinanderfolgenden Druck auf die ENTER-Taste 
ausgelöst. Die F-Tasten müssen den QSO-Phasen (CQ-Ruf, Nummeraustausch, Bestätigung, 
Nachfrage u.a.) korrekt zugewiesen sein. QSOs können sowohl im Running- als auch im S&P-Betrieb 
im ENTER-Modus abgewickelt werden.  

• Spot all S&P QSO's  (alle S&P-QSOs im DXCluster melden ) : ACHTUNG : Schalten Sie diese 
Funktion ab, wenn Sie nicht den DX-Cluster fluten wollen. Die Funktion wird bei jedem Neustart des 
Programms auf AUS gesetzt. Der Multiplikator wird als Kommentar der Meldung angefügt. 
Ein QSO wird automatisch nur gemeldet, wenn :  

o Spot all S&P QSO's   freigegeben ist UND 
o Sie sich im S&P-Modus befinden UND  
o die Meldung noch nicht in der Bandskala steht  

• QSYing wipes the call & spots QSO in bandmap  (QSY löscht das Rufzeichen im 
Logeingabefenster und spottet  das QSO in der Bandskala ) - Alle in das Rufzeichenfeld 
eingetragene, aber nicht gearbeitete Stationen werden nach einem QSY wieder gelöscht und zusätzlich 
mit der zugehörigen Frequenz und fett  markiert in die Bandskala eingetragen. Diese Funktion wird bei 
einem Programmneustart vom vorherigen Zustand übernommen. Sehen Sie unter Grundfunktionen für 
ein Beispiel nach. Sie haben z.B. VU2PTT auf 21200 eingetragen, sind aber nicht drangekommen und 
haben QSY gemacht. VU2PTT wird fett auf 21200 eingetragen. Weitere Stationen folgten. Gehen Sie 
anschliessend mit Ctrl-Up  und Ctrl-Dwn  durch die Bandskala und versuchen Sie erneut Ihr Glück. 

• Show non-workable spots  (nicht arbeitbare Stationen anzeigen )-: Normalerweise werden die im 
Contest nicht arbeitbaren Stationen in der Bandskala nicht angezeigt. Wenn Sie diesen Menüpunkt 
aktivieren werden diese Stationen angezeigt und Sie können sie übergehen, ohne lange auf das 
Rufzeichen warten zu müssen. 

• Reset Rx freq when running split (RX-Frequenz bei S plit im Running-Modus zurücksetzen)  : 
Wenn Sie den Haupt-VFO zum Senden und den anderen im Splitbetrieb zum Empfangen benutzen, 
wird mit dieser Funktion der RX-VFO nach Ende jedes QSOs wieder auf die Sendefrequenz gestellt. Ihr 
RX-VFO bekommt damit die Funktion einer RIT (Empfängerfeinverstimmung)   

• CQ Repeat (CQ wiederholen) =  Alt-R  : Der CQ-Ruf wird automatisch in einstellbaren Abständen 
wiederholt. Sie sehen die aktuelle Einstellung in der Statuszeile. Sie können das automatische CQ-
Rufen nur mit der Taste ESC abbrechen oder beenden. Die Funktion wird auch beendet, wenn Sie den 
VFO von der CQ-Frequenz weg bewegen oder ein Rufzeichen ins Rufzeichenfeld eingeben. 

• Set CQ repeat time(CQ-Wiederholzeit setzen) =   Ctr l-R :  die Wiederholzeit für einen CW- oder SSB-
CQ-Ruf wird in Millisekunden oder Sekunden eingestellt . Voreingestellt sind 1,8 Sekunden.  

• Call History Lookup (Rufzeichenvorgeschichte prüfen )  : Wenn aktiviert, wird in der Datei für die 
Vorgeschichte nach Namen, Lokator, Sektion, Staat, Alter u.ä. nachgesehen. Voraussetzung ist, dass 
zu dem Contest bzw. den Rufzeichen eine solche Tabelle vorhanden und mit  Import Call History  nach 
N1MMLogger geholt worden ist bzw. die contestrelevanten Daten während des Contest aus den 
früheren QSOs abgespeichert worden sind. Die Tabellensuche verbraucht eine gewisse Menge an 
Rechenleistung.  
Hinweis DM3ML : Auf der Homepage von N1MM ist u.a. eine Datei N1MM-vhf-dbf-20030829.zip zu 
finden, die eine Master.dta-Datei für VHF-Conteste mit einer Menge an europäischen Rufzeichen 
zusammen mit Lokator und Namen enthält. Die Datei kann auf der Contestseite unter File > Choose 
Contest  in der unteren Zeile aktiviert werden. 

• Record QSOs  (QSOs mitschneiden ) : Zeichnet die Empfänger-NF über die Soundkarte bei CW und 
SSB auf, bei anderen Sendearten abgeschaltet. Wählen Sie unter Config > Karteikarte Files (Dateien) 
einen Dateinamen. Weitere Informationen finden Sie unter Tipps und Tricks (Tips and Tricks)  

• Dual Rx always on (Zweit-Empfänger immer an) = Ctrl -F9 : Wählt den Modus für den  FT-1000MP  
mit Ctrl-F12, ob der Zweit-VFO an bleibt oder abgeschaltet wird, wenn von VFO-B auf VFO-A 
umgeschaltet wird.  

• Change Packet/CW/SSB/Digital Message Buttons (F-Tas ten programmieren) =  Alt-K  Die Texte in 
den Tasten von Packet/CW/SSB/Digital message können separat programmiert werden. Je Taste 
können 255 Zeichen eingegeben werden. Mit ALT-K  kommen Sie zu den Tasten der aktuell aktiven 
Sendeart CW/SSB/RTTY.   

o Change Packet/Telnet Buttons  (Packet/Telnet-Tasten ändern ) :  Mit diesem Menü ändern 
Sie die Tasten-Texte im Packet-Fenster. Ein vor einen Buchstaben gesetztes & macht daraus 
eine ALT-Kurzruftaste (Hotkey), z.B. &BYE wird als BYE angezeigt und ein ALT-B im 
Packetfenster trennt die Verbindung.  
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o Change CW Buttons (CW-F-Tasten ändern)  : Ändert den Inhalt der CW-Tasten. Auch hier 
kann mit einem & im Text eine ALT-Kurzruftaste erzeugt werden. Bei mehreren gleich 
belegten Tasten wird die erste im Programm gefundene genommen. Sie sollten selbst auf 
Doppelbelegungen achten.  

o Change SSB Buttons  (SSB-Tasten ändern ) : Es sind entsprechende *.WAV-Dateinamen 
einzutragen. Im Text können Sie mehrere Sonderzeichen verwenden. Informieren Sie sich bei 
den Makros  

o Record CQ SSB message  (CQ aufzeichnen ) : Öffnet die Sprachaufzeichnung (Windows 
Soundrecorder), um den mit der Taste F1 zu sendenden CQ-Ruf aufzuzeichnen.  Der Nutzer 
muss das benötigte Mikrofon bereitstellen. DM3ML :  Es können auch beliebige andere Texte 
aufgezeichnet werden 

o Change Digital Buttons (Digimode-Tasten ändern) :  Ändert den Inhalt der Digimode-F-
Tasten. Mit einem & im Text kann eine ALT-Kurzruftaste erzeugt werden. Bei mehreren gleich 
belegten Tasten wird die erste im Programm gefundene genommen. Sie sollten selbst auf 
Doppelbelegungen achten. Im Text können auch Substitionen durch andere Tasten eingefügt 
werden, wie  {F1} {F2} {GRID} oder mehrere Sonderzeichen mit spezieller Bedeutung. 
Informieren Sie sich bei den Makros   

• Change Telnet Cluster List (Liste der Telnet-DXClus ter ändern) :  Sie können vorhandene Einträge 
editieren oder streichen und  neue hinzufügen. Die Telnet-Cluster werden am Anfang in der 
Konfiguration unter Telnet Cluster  eingetragen.  

• Multi-User Mode  : Startet den Multinutzerbetrieb im N1MM-Computernetz mit Computern, die in einem 
Netz verbunden sind   

• Multi-User Tools  : Werkzeuge für den Multinutzermodus, siehe Multinutzerbetrieb  
o Talk to another station (Nachricht an andere Statio n) =  Ctrl-E  : Sendet eine Nachricht an 

alle oder eine ausgewählte Station im Netzwerk. Die Stationen sind von 0…15 nummeriert.  
o Force Time Sync Now (Zeitsynchronisation) :  Löst die Zeitsynchronisation mit dem Master  

aus. Die Synchronisation wird sonst automatisch aller 5 Minuten vom Start ab gestartet.  
o Set your pass frequency (Anzeige der Arbeitsfrequen z) =  Alt-Z  : Sie teilen anderen 

Stationen die Arbeitsfrequenz der eigenen Gruppe auf einem anderen Band mit und bitten Sie 
die Station auf diesem Band für einen Multi anzurufen. Im Moment wird die Arbeitsfrequenz 
noch nicht angezeigt und nur in CW oder RTTY mit  {PASS n} übertragen. In SSB funktioniert 
die Sache noch nicht.   

o Log QSOs at all stations  (Alle QSO an allen Stationen abspeichern ) : Speichert alle 
Contest-QSOs auf allen PCs im Netz ab. Packetspots und Arbeitsfrequenzen werden auch 
ohne diese Funktion im Netz verteilt  

o Show Connections  (Anzeige der Verbindungs-Info) : Zeigt die Verbindungsinfo  von allen 
Stationen im Netzwerk an 

o Resync Logs  (Logs synchronisieren) : Alle QSOs aller Rechner werden geprüft und u.U. 
nachgetragen  

• Edit Station Computer Names  (Computernamen editieren ) : Anzeige der Computer mit Nummer ab 0 
für den Master zusammen mit ihrer IP-Adresse 

• Change Operator (Operator-Rufzeichen ändern) = Ctrl -O : Wechselt das Rufzeichen des Operators 
an der Multinutzerstation. Die Abfrage erscheint im Multinutzerbetrieb beim Programmstart. Sie können 
das OP-Rufzeichen auch mit OPON im Rufzeichenfeld ändern. 

• Change Exchange Abbreviations  (Abkürzungslisten editieren ) :  Erlaubt es, die Listen für 
verschiedene Abkürzungen, die beim Contestnummernaustausch benutzt werden, zu editieren :   

o Change ARRL Section Abbreviations  : Liste der ARRL-Sektionen  
o Change VE Province Abbreviations  : Liste der kanadischen Provinzen  
o Change PA Province Abbreviations  : Liste der niederländischen Provinzen  
o Change USA State Abbreviations  : Liste der US-Staaten  
o Change CQ WW RTTY Abbreviations  : Liste mit kanadischen Provinzen für den CQ WW 

RTTY Contest.  
o Change QSO Party Abbreviations : Liste der Abkürzungen für die QSO-Party. Nur erreichbar, 

wenn als Contest die QSO-Party gewählt wurde  

• SO2R  
o Dueling CQ's = Ctrl+B : sendet CQ abwechselnd ohne Verzögerung auf beiden Transceivern  
o Resume CQ on Run Radio = Ctrl+X : startet ein  CQ auf dem Run-Transceiver, wenn auf 

dem S&P-Transceiver nicht gesendet wird 
o TX Lockout - : Wählen Sie eine Sendesperre.  

� Multi-TX - : Das ist die Voreinstellung :  Starte CQ auf Transceiver A, Starte CQ 
auf Transceiver B. Beide Geräte sind aktiv > keine Sperre ausgelöst  

� First one wins  (der erste gewinnt ) :  Starte CQ auf Transceiver A > Pause > 
Starte CQ auf Transceiver B. Transceiver B wird ignoriert, weil Transceiver A 
schon aktiv ist..  

� Last one wins  (der letzte gewinnt ) :  Starte CQ auf Transceiver A > Pause > 
Starte CQ auf Transceiver B > das CQ auf Transceiver A wird abgebrochen und 
Transceiver B sendet CQ.  

• Trace Program Execution  : Erzeugt eine Spur (Trace) unter dem Dateinamen (*.trc). Die Erzeugung 
einer Spur wurde bei allen Programmen hinzugefügt, die Makros ausgeben und 
Multinutzerverbindungen verwenden. Falls Sie beim Multinutzerbetrieb oder beim Senden von Makros 
Probleme haben, schalten Sie die Spurerzeugung ein, senden mehrere Makros, schliessen dann das 
Programm und senden mir (N1MM?) die *.trc-Datei, damit ich herausbekommen kann, ob das Problem 
bei N1MMLogger oder bei MMTTY liegt. 



N1MMLogger-Hilfe V.4.0.88 Seite 46 von 227 Übersetzung von Eike, DM3ML 

• WAE : Kommandos nur für den WAE-Contest  
o Toggle WAE QTC mode =  Ctrl-Z  : schaltet zwischen QSOs und Empfang von QTCs um 
o WAE Received QTC Confirmation  : Sendet die progammierte Bestätigung des QTCs in CW 

oder als WAV-Datei in SSB 

9.14.1 Fenster-Menü (Window Menu Selections) 

Sie erreichen das Menü für dieses Kapitel aus dem Logeingabefenster über Windows  : 

• Available Mult's and Q's  : Öffnet eine Liste der aus DXCluster-Meldungen zur Verfügung stehenden 
Multiplikatoren und Stationen 

• Bandmap = Ctrl-B  : Öffnet die Bandskalen rechts und links 

• Check  : Öffnet das Prüffenster 

• CW Key =  Ctrl-K  : Öffnet Eingabefenster zum CW-Senden über die Tastatur. Dieses Fenster wird mit 
einem weiteren CTRL-K wieder geschlossen, der eingegebene Text wird aber zu Ende gesendet. 

 

• Digital Interface  : Öffnet das Fernschreibfenster (RTTY/MMTTY/PSK)   

• Entry Window  : Öffnet das Logeingabefenster 

• Info  : Öffnet das Informationsfenster   

• Log =  Ctrl-L  : Öffnet das Logfenster 

• Multipliers by Band : Zeigt eine Liste der Multiplikatoren je Band oder für alle Bänder 

• Packet : Öffnet das Packet/Telnet-Fenster  

• Score Summary  : Zeigt die Punktzahl je Band  

Mit Ctrl-Tab  können Sie zwischen dem Eingabefenster und dem Packetfenster hin und her schalten. Falls weitere 
Fenster mit Texteingabemöglichkeiten geöffnet sind, kommen Sie in einer Schleife mit Ctrl-Tab  auch in diese Fenster.  

9.15 Hilfen (Help Selections)  

Sie erreichen das Menü für dieses Kapitel aus dem Logeingabefenster über Help  

• Help (Hilfe) = Alt-H  : ALT-H aus einem Fenster mit Eingabemöglichkeit öffnet die zu diesem Fenster 
gehörende Hilfe. Sie müssen die aktuelle N1MMLogger-Hilfe getrennt von der N1MM-Homepage als 
ZIP-Datei holen und in das Verzeichnis von N1MMLogger als *.CHM-Datei entpacken.  

• Search Help using Google (Internet) (Suchhilfe mit Google) : Internethilfe mit Google aufrufen –  

• Key Assignments Help (Hilfe zur Tastenzuordnung) : Ruft das Kapitel  Tastenzuordnungen (Key 
Assignments) der Hilfe auf 

• Manual (Handbuch) :  Bringt Sie zum Handbuch, das als PDF-Datei im N1MMLogger-Verzeichnis 
gespeichert sein muss. Sie müssen das Handbuch getrennt von der N1MM-Homepage holen. 
Zusätzlich benötigen Sie den Adobe Acrobat Reader in einer Version höher als 3. Der Acrobat Reader 
wird zusammen mit dem Handbuch geöffnet. Sie können sich den Acrobat Reader als Freeware unter 
http://www.adobe.com/support/downloads/acrwin.htm  holen. 

• Contest rules for this contest (Contestregeln für d iesen Contest) :  Sie kommen übers  Internet zur 
Website des Contestveranstalters und können die Regeln für diesen Contest lesen 

• ARRL Contest Calendar Page (ARRL-Contestkalender) :   Verbindet Sie übers Internet mit dem 
ARRL contest calendar   

• SM3CER Contest Calendar  : Verbindet Sie übers Internet mit dem SM3CER contest calendar   

• VK4DX Contest Calendar  : Verbindet Sie übers Internet mit dem VK4DX contest calendar .  

• Show Latest Version Number : Geht ins Internet und zeigt die neueste Version auf der Downlloadseite 
an. Angezeigt wird auch die aktuelle Version auf Ihrem PC. 

• Download Latest version  : Holt die neueste Version über das Internet von der N1MMLogger-Seite und 
speichert sie als ZIP-Datei in das N1MMLoggerverzeichnis. Sie müssen dann das Programm schliessen 
und die ZIP-Datei entpacken. 

• N1MM Logger Home Page  : Geht ins Internet zur N1MMLogger-Homepage  

• Download Help (English version)  : Holt die englische Hilfe von der N1MMLogger-Homepage  

• .  
• Yahoo Discussion Group  : Bringt Sie über das Internet zur Yahoo-Diskussionsgruppe  
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• Report Bugs/Request Features/Request Support  : Bringt Sie übers Internet zur N1MMLogger-Seite, 
um Fehler zu berichten oder Anfragen nach neuen Programmeigenschaften zu machen  

• Email Problem Report  : Sendet einen Problembericht per Email an Tom, N1MM. Der Bericht gibt 
detaillierte Informationen über das Problem und Informationen zum verwendeten Programm und zur 
Hardware. Die folgenden Fragen müssen beantwortet werden :   

o Ausführliche Problembeschreibung  
o Eingabe des SMTP-Servernamens (nur beim ersten Mal)  

� Entnehmen Sie den SMTP-Servernamen den Einstellungen Ihres Email-Programms 
unter Server für ausgehende Mail (Outgoing E-mail server ) .  
Beispiel : smtp.freeler.nl oder mailto.t-online.de 

• View Revision History (last downloaded)  : Zeigt die aktuell im N1MMLogger-Verzeichnis 
abgespeicherte Versionsgeschichte an  

• View Error Log : Zeigt das aktuelle vom Programm erzeugte Fehlerlog Errorlog.txt  an. Hier werden die 
die Fehlermeldungen des Programms abgespeichert, die zur Problembehebung herangezogen werden 
können. 

• View database statistics  : Zeigt Statistiken der Datenbank an für Zahl der Zugriffe  (Number of reads), 
Cached reads und Cached reads from read-ahead cache 

• Report Score to 3830  : Meldet Ihre Punktzahl an die 3830 score reporting site  im Internet  

• About N1MM logger Vx.x.xxx  : Zeigt die Versionsinformation mit ihren aktuellen Einstellungen und den 
Antennenturm von Tom (N1MM)  mit einer Cushcraft X9 an der Spitze !  

10. Logfenster (Log Window) 

Das Logfenster sieht etwa so aus :   

 

• In der Überschrift steht der Contestname mit aktueller Zeit und Datum. 
Bei Multi-OP-Betrieb wird der Operator und beim Multi-Multi-Betrieb die Stationsnummer angezeigt. 

• Oben im Feld stehen die letzten QSOs  

• Unten im Feld - gelb hinterlegt - stehen die QSOs mit dem aktuell in das Logeingabefenster voll oder 
teilweise eingegebenen Rufzeichen. Diese QSOs sind nach Band, Rufzeichen und Datum/Zeit sortiert.  

• Die Trennlinie zwischen den beiden Teilen des Fensters ist in Prozenten kailbriert. Wenn Sie das 
gesamte Fenster kleiner oder größer machen, werden beide Teile prozentual verändert. 

• Im Multi-User-Modus ist das Gruppeneditieren nicht gestattet  

Der Fensterbereich zwischen Log und QSOs kann mit der Maus auf den gewünschten Wert gezogen werden. Mitunter ist 
der gelbe Bereich erst nach Ziehen der Trennlinien sichtbar. 

Die Seriennummer werden jeweils ohne führende Nullen angezeigt, auch wenn sie mit führenden Nullen eingegeben 
wurden z.B. 008. Beim Drucken werden die Nullen aber gedruckt. 
  

10.1 Tastenzuordnungen (Keyboard Assignments)  

� Enter (Ctrl-T) : Editiert das markierte QSO  
� Delete (Ctrl-D) – Löscht das markierte QSO  
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10.2 Mauszuordnungen (Mouse Assignments)  

� Linker Mausklick  
� Einfacher Klick in Titelleiste : Sortiert diese Spalte in aufsteigender 

Folge  
� Doppelklick auf ein QSO :  Öffnet Editierfenster für dieses QSO 

� Rechter Mausklick :  
� Rechter Klick auf ein QSO : Öffnet dieses Menü : 

• Quick Edit Contact  – Schnelles Editieren des aktuellen 
QSOs im Logeingabefenster.  Ctrl-Q  schaltet ein QSO 
zurück, Ctrl-A  schaltet ein QSIO nach vorn. Wenn die 
Texteingabefenster im Logeingabefenster blau hinterlegt 
sind, befinden Sie sich im Quick Edit-Modus. Drüclen Sie 
ENTER um die Änderungen abzuspeichern oder auf ESC 
um die Änderungen zu verwerfen und zurück in den 
normalen Log-Mudus zu schalten 

• Edit Contact (Ctrl-T)  : QSO editieren  
• Delete Contact (Ctrl-D)  : QSO löschen   

Warnung : Das Löschen eines QSOs verfälscht die 
Punktberechnung ! Starten Sie danach Tools > Rescore 
Contest  zur Neuberechnung vor der Abgabe eines Logs !  

• Play Contact  : QSO abspielen. Der Menüpunkt ist grau, 
wenn zu diesem QSO keine WAV-Datei angelegt wurde. Ist 
sie schwarz, können Sie die zugehörende WAV-Datei über 
die Soundkarte abspielen. Stellen Sie sicher, dass Sie damit 
nicht gerade Ihren Sender modulieren. Sehen Sie einen 
Umschalter zwischen Mikrofoneingang und Kopfhörer vor.  

• Jump to this frequency  : Schaltet den Transceiver auf die 
zu diesem QSO gespeicherte Frequenz  

• www.qrz.com :  Fragt bei QRZ.com im Internet nach Daten 
für diese Station nach (Name, Adresse etc.) . Eine 
Internetverbindung muss bestehen 

• Change All Contact Timestamps by a Fixed Amount  : 
Ändert alle Zeiteinträge um eine einstellbare Zeitspanne :   

o Setzen Sie die Maus in das Logfenster und 
klicken Sie rechts 

o Wählen Sie Change All Contest Timestamps by 
a Fixed Amount 

o Geben Sie in das sich öffnende Dialogfeld den 
Zeitversatz (+ oder -) in Minuten ein  

Das Datum wird automatisch korrigiert, wenn das QSO auf einen anderen Tag nach 
vorn oder hinten verschoben wird. Bei grösseren Zeitdifferenzen werden Sie den 
Abstand in Minuten aus Tagen, Monaten oder gar Jahren mit dem Taschenrechner 
berechnen müssen. 
Hinweis  : Sie sollten das Log vorher sichern, falls Sie sich bei der Korrektur mal 
verrechnen. 

� Change Operator  : Operator-Wechsel beim Multi-OP betrieb. Voreingestellt ist das 
Stationsrufzeichen. Wenn Sie mehrere Reihen wählen, wird die Änderung auf alle 
Reihen ausgedehnt. Diese Operation kann nicht zurück genommen werden. Sie 
sehen dieses Bild :  

 

� Change Mode  : Sendeart für dieses QSO ändern. Wenn Sie mehrere Reihen 
wählen, wird die Änderung auf alle Reihen ausgedehnt. Diese Operation kann nicht 
zurück genommen werden. Sie sehen das Bild oben.  

� Change Rx Tx Frequency (and band)  : Frequenz/Band für dieses QSO ändern. 
Wenn Sie mehrere Reihen wählen, wird die Änderung auf alle Reihen ausgedehnt. 
Diese Operation kann nicht zurück genommen werden. Sie sehen das Bild oben.  

� Change Station Number  : Stationsnummer bei Multi-Multi-Betrieb für dieses QSO 
ändern. Die Master-Station hat immer die Nummer 0. Wenn Sie mehrere Reihen 
wählen, wird die Änderung auf alle Reihen ausgedehnt. Diese Operation kann nicht 
zurück genommen werden. Sie sehen das Bild oben.  
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� Find all contacts with a station  : Gibt alle QSOs mit dieser Station im aktuellen 
Contest aus 

� Set Start Interpolation Time Row  : Eingabe der Startzeit für eine Zeitinterpolation. 
Siehe Beispiel unter Nach dem Contest  

� Set Stop Interpolation Time Row  : Eingabe der Endzeit für eine Zeitinterpolation. 
Dieser Punkt ist nur dann hellgetastet, wenn schon eine Startzeit eingegeben 
wurden Sie Beispiel unter Nach dem Contest . 

� Rescore from this point on  : Neuberechnung der Punktzahl für diesen Contest 
beginnend vom markierten QSO bis ans Logende 

� Delete custom column widths  : Rücksetzen der individuell eingestellten 
Spaltenbreite auf die voreingestellte Breite 

� Show date – Das Datum wird in der ersten Zeile des Logs angezeigt oder 
abgeschaltet. 

� Select All  : Alle QSOs im Log auswählen z.B. zum Kopieren 
� Copy  (Kopieren) 

� Copy Generic Print String  : QSO als Textzeile (generic) in die 
Zwischenablage kopieren  

� Copy ADIF String  :  QSO als ADIF-Zeile in die Zwischenablage kopieren 
� Set Font : Schrifttypen für das Logfenster einstellen. Diese Auswahl wird nicht 

abgespeichert und gilt nur für die aktuelle Sitzung 
� Help  : Die Hilfe für dieses Fenster wird angezeigt. 

 

11. Bandskalen (Bandmap Window) 

Ihre Bandskala kann etwa so aussehen  :   

.  

 

Die Bandskala repräsentiert einen VFO oder einen Transceiver. Es gibt zwei Bandskalen für einen Transceiver mit 2 
VFOs oder zwei Transceiver mit je einem VFO..  

11.1 Szenario mit einem Transceiver (One radio scenario)  
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Beim Betrieb mit einem Transceiver gehört jede Bandskala zu einem VFO des Geräts. Üblich ist es, die Skala für den 
VFO-A links und die Skala für den VFO-B rechts anzuordnen. Sie können zwischen den VFOs mit einem Mausklick in die 
zugehörende Bandskala oder mit CTRL-Pfeil rechts  bzw. CTRL-Pfeil links  umschalten. Die angewählte Bandskala hat 
einen blauen Kopf und ist damit als aktiv markiert. 

11.2 Szenario mit zwei Transceivern (Two radio scenario)  

Beim Zwei-Transceiver-Betrieb ist die Funktion identisch, nur jetzt werden die Transceiver als Gerät umgeschaltet, Sie 
sollten die Bandskalen auf dem Bildschirm so anordnen, wie die beiden Transceiver relativ zur Tastatur stehen, um die 
Bedienung intuitiv zu machen. 

11.3 Anderes (Other)  

Sie sollten sich die Maus- und Tastenzuordnungen genau ansehen, um mit den Bandskalen vertraut zu werden.  
Wichtig : Die Nutzung der Bandskalen wird von der Kenntnis der Tastenzuordnungen wesentlich beeinflusst !  

Der Text CQ-Frequency wird für die Frequenz angezeigt, auf der Sie im Running-Modus CQ rufen. Der Eintrag erfolgt 
automatisch nach dem Druck auf Shift-F1 aus dem S&P-Modus oder auf F1 nach Einschalten des Running-Modus. 
Eine DXCluster.Meldung (= Spot), die jünger als 3 min ist, wird als NEW (NEU) hinter dem Rufzeichen markiert. Arbeitet 
die gemeldete Station split, wird die zugehörige Empfangsfrequenz mit qsx frequency 3 min nach der Meldung und 
Kennzeichnung mit NEW markiert. Für beide Markierungen zusammen ist nicht genug Platz in der Bandskala. Zusätzlich 
wird zu jeder Station ausserhalb des eigenen Landes die Antennenrichtung angegeben.  
Sie sehen in der Titelleiste der Bandskala, welcher Transceivertyp angeschlossen ist. Manual – A  wird angezeigt, wenn 
kein Transceiver (oder keine CAT) angeschlossen ist oder z.B. Kenwood VFO A,  wenn die Skala zu einem Kenwood-
Transceiver gehört. Die andere Skala ist mit VFO-B markiert. 

Im Kopf der Bandskala wird normalerweise eine Frequenz, die Sende- und Empfangsfrequenz des Transceivers 
angezeigt. Arbeiten Sie split, steht oben die Sendefrequenz und darunter in kleinerer Schrift die Empfangsfrequenz.  

Wenn die Bandskalen geschlossen wurden, steht Frequenz und Sendeart in der Titelzeile des Logeingabefensters vor 
dem Contestnamen. 

Bei einem Contest mit viel Betrieb, wird der CW-Bereich in der Regel zu eng dargestellt. Sie können die Skala mit den +/- 
-Tasten des Nummernfeld der Tastatur auseinander ziehen oder wieder zusammen schieben (Zoom). 
 

11.4 Colors of the incoming spots:  

� Red (Rot ) : neuer Multi > zuerst arbeiten !  
� Blue (Blau)  : neue Station, noch nicht gearbeitet > anrufen !  
� Gray (Grau)  : schon gearbeitet (Dupe) oder nicht zu den Contestregeln passend > 

ignorieren !  
� Bold (Fett )  : selbst gemeldeter Spot (Spot all S&P calls locally aktiviert), im S&P-

Modus ins Rufzeichenfeld eingegeben, aber nicht gearbeitet und weiter gedreht  

11.5 Tastenzuordnungen (Keyboard Assignments)  

•  + -Taste im Nummernfeld :  Zieht die aktive Bandskala auseinander (Zoom +) 

• - -Taste im Nummernfeld : Schiebt die aktive Bandskala zusammen. (Zoom -) 

• Shift mit +-Taste im Nummernfeld : Zieht die nichtaktive Bandskala auseinander  

• Shift mit - -Taste im Nummernfeld : Schiebt die nichtaktive Badskala zusammen.  

11.6 Felderzuordnungen (Button Assignments)  

Diese Felder finden Sie im Kopf der Bandskalen : 

• Narrow  – Schaltet Transceiverfilter zwischen Breit  (Wide ) und Schmal (Narrow ) um. Angezeigt 
wird die aktuelle Einstellung.Toggle the radio filters from Wide to Narrow, or vice versa. The label 
indicates the Anmerkung N1MM  : Hätte ich gewusst, was auf mich zukommt, hätte ich dieses 
Feld nicht programmiert. Es gibt so viele verschiedene Transceiver mit so vielen verschiedenen 
Filtern, dass es nahezu unmöglich ist, eine für alle Transceiver geltende Einstellung zu finden. 
  

• USB – Durchschalten der Transceivereinstellungen in der Reihenfolge USB/LSB  (bandabhängig) 
> RTTY >  CW   

• RIT Offset (-0.08)  -: Löschen des RIT-Offsets.  

• RIT – RIT ein/aus  
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• XIT – XIT ein/aus  

11.7 Mauszuordnungen (Mouse Assignments)  

� Click on frequency (Klick auf Frequenz)   : Springen Sie auf eine bestimmte 
Frequenz mit einem Klick auf die Skala  

� Shift-Click on frequency (Klick + Shift)  : Ein Klick mit gedrückter Shift-Taste in die 
nicht aktive Bandskala bewirkt eine Änderung des VFOs dieser Bandskala auf die 
angeklickte Frequenz ohne Umschaltung der Aktivität. 

� Click on call (Klick auf Rufzeichen)  :  mit einem einfachen Klick auf ein 
Rufzeichen springt der Transceiver auf die zugehörige Frequenz und das 
Rufzeichen wird über dem Rufzeichenfeld zur Anwahl bereit gestellt. Ist das 
Rufzeichenfeld leer, wird dieser Rufzeichen mit der Leertaste in das 
Rufzeichenfeld gesetzt. Mit einem Klick auf das Rufzeichen über dem 
Rufzeichenfenster wird das Rufzeichen in das Eingabefeld übertragen und ersetzt 
auch ein schon darin stehendes Rufzeichen. 

� Double-Click call  (Doppelklick auf Rufzeichen ) : Rufzeichen wird in das 
Rufzeichenfeld übernommen und überschreibt ein darin stehendes Rufzeichen. 
Die Frequenz wird am TCVR eingestellt. Spots, die mit ALT-M als busy  markiert 
waren (Station nicht im Contest z.B.) werden ignoriert.  

� Click dial ticks  (Klick auf Skalenteilung ) : springe zu dieser Frequenz  
� Click frequency label  (Klick auf Frequenzangabe ) : springe zu dieser Frequenz 
� Right-Click call  (rechter Klick auf Rufzeichen ) : ruft eine Liste mit Optionen (meist 

Packet-Funktionen) auf  
� Right Click anywhere else (rechter Klick irgendwo h in) : Öffnet eine Liste mit 

Optionen, von denen einige sich auf ein Rufzeichen beziehen und inaktiv (grau) 
markiert sind 
  

11.7.1 Rechter Mausklick (Right-Click menu)  

Wenn Sie auf ein gemeldetes Rufzeichen mit der rechten Maustaste klicken, öffnet sich ein größeres Menü in der 
Bandskala :  

� Zoom In   : zeige mehr Spots, Skala dehnen, auch mit der +Taste im Nummernfeld  
� Zoom Out  : zeige weniger Spots, Skala stauchen, auch mit der – Taste im 

Nummernfeld  
� Go to Bottom of Band  : Gehen an den Anfang des Subbandes (SSB/CW)  
� Go to Top of Band  : Gehe an das Ende des Subbandes (SSB/CW)  
� Remove Spot : Spot von der Bandskala entfernen  
� Remove All Spots  : Alle Spots auf der Bandskala löschen  
� Show Last 10 Spots  : Zeige die letzten 10 Spots für dieses Rufzeichen  
� Show/Buck Packet  : Zeige Buckmaster-Information für dieses Rufzeichen im 

Cluster. Verwendet  SH/QRZ, falls Dxspider angewählt wurde  
� Show Station  : Zeige Stationsinformation für dieses Rufzeichen im Packet- oder 

Telnet-DXCluster  
� Show QSL/Packet  : Zeige QSL-Information für dieses Rufzeichen im Packet- oder 

Telnetfenster  
� Show Sunrise/Sunset  ; Zeige Sonnenauf- und untergangsinformation für diese 

Station im Packet- oder Telnetfenster ( Diese Info steht auch berechnet im Info-
Fenster)  

� Show Buck/Internet  : Ruft über das Internet QRZ.com und öffnet den Internet-
Explorer  

� Show Buck Local  : Sucht auf der lokalen Buckmaster-CD nach dem Rufzeichen. 
Die Buckmaster-CD muss installiert sein (Anmerkung DM3ML: RAC geht nicht !)  
Hinweis DM3ML  : Diese Rufe funktionieren nur, wenn der Code, der zum 
DXCluster gesendet wird, von Ihrem Cluster verstanden wird, sonst kommt eine 
Fehlermeldung zurück  

� Set transceiver offset frequency  : Transceiveroffsetfrequenz einstellen :  
Funktioniert mit Transceivern, die mit einem Umsetzer (Transverter) verwendet 
werden. Geben Sie die Umsetzerablage in kHz ein, z.B.  116000, wenn Sie vom 
2m-Band ins 10m-Band umsetzen für 144000 - 28000 = 116000. Ein Minuszeichen 
ist erlaubt, wenn Sie nach oben umsetzen. Geben Sie bei Splitbetrieb die 
Transceiverfrequenz und nicht die Transverterfrequenz ein, wenn sie in den 
Splitbetrieb mit ALT-F7 umschalten. 
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� Set transceiver timeout time  : setze Einschaltzeit für jeden Transceiver 
(voreingestellt sind 10 Sekunden) 

� Set transceiver filter codes  : Kodes für die Filter des Transceivers eingeben. 
Sehen Sie im Handbuch nach, welchem Filter welche Zeichenkette zugeordnet 
ist. Bei Kenwood ist es relativ einfach. Bei anderen Transceivern, wie beim FT-
1000MP ist es komplizierter : Hier müssen Sie mehrere durch Zwischenräume 
getrennte Zahlen im Dezimalcode eingeben. Aus 0 8C  wird  0 140.  Mit der 
Eingabe lediglich eines Leerzeichens schalten Sie auf die voreingestellten Werte 
zurück. Möglich sind :   

o SSB Wide 
o SSB Narrow 
o CW Wide 
o CW Narrow 
o Digi Wide 
o Digi Narrow 

• Bring to foreground when made active  : aktive Bandskala in den Vordergrund holen. Haben Sie nicht 
genug Platz auf Ihrem Bildschirm, ziehen Sie die beiden Bandskalen übereinander. Die jeweils aktive 
liegt dann im Vordergrund und die nicht aktive dahinter. 

• Reset Radios  (Transceiver rücksetzen) : Setzt Transceiver manuell zurück, wenn die Verbindung zum 
Transceiver verloren gegangen ist. Wählen Sie Retry   um die Verbindung zum Transceiver wieder 
herzustellen oder klicken Sie rechts in die Bandskala und wählen Sie Reset Radios , um die 
Verbindung erneut aufzubauen. 

 

• Help  -: Ruft Hilfe zu diesem Fenster 

 
Ein Kommando ins Packet-Fenster wird an die jeweils  aktive Verbindung geschickt  

 
Sind Sie mit einem DXSpider-Cluster verbunden, schalten Sie in der Konfiguration auf Format for DX Spider cluster  

11.8 Maus über DX-Spot ziehen  (Hovering with the mouse over a spot)  

Wenn Sie den Mauszeiger auf einen gemeldete Station ziehen, erhalten Sie folgende Informationen :  
 

� Exakte Frequenz, die gemeldet wurde  
� Rufzeichen des Melders  
� Seit der Meldung vergangene Zeit  
� Mit dem Spot gesendeter Kommentar  
� Den Standard-Landespräfix der gemeldeten Station  

11.9 Maus über RX-Skalenpfeil ziehen  (Hovering with the mouse over RX arrow)  
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Wenn Sie den Mauszeiger über den grünen RX-Pfeil ziehen, wird die genaue Frequenz des Transceivers angezeigt : 
The radio is tuned to ...... kHz   

11.10 Beispiel für die Skalennutzung  (Example bandmap usage)  

Von Tom, N1MM : Wenn Sie über das Band abstimmen (S&P-Modus) und in die Nähe einer Station im Bereich 
der konfigurierbaren tuning tolerance  (Abstimmbereich) kommen, wird das Rufzeichen dieser Station über dem 
Rufzeichenfeld im Logeingabefenster angezeigt. Das Programm zeigt Ihnen durch die Farbe, ob Sie die Station 
schon gearbeitet haben (grau), sie neu ist (blau) oder gar einen Multi (rot) darstellt. Sie können damit schneller 
abstimmen. Im WPX-Contest, in dem praktisch alle Calls einen Multis liefern, arbeite ich mich mit den CTRL-Up 
und CTRL-Down-Tasten  durch die Bandskala. Fängt eine Station gerade ein QSO an, schalte ich weiter, ist sie 
kurz vor dem Ende, warte ich und rufe sie an. Wenn ich am Bereichsende bin, gehe ich wieder zurück und rufe die 
Stationen an, die ich noch nicht erreicht habe.  Finde ich mal eine leere Frequenz, rufe ich hier CQ. In Contesten 
mit wertbaren Multis, schalte ich mit CTRL-ALT-Up oder CTRL-ALT-Dwn das Band durch und arbeite erst die 
Multis ab und dann erst andere Stationen. Sinkt die QSO-Rate zu stark ab, wechsele ich das Band. Hier sind die 
schon in der Bandskala stehenden Rufzeichen sehr nützlich. Wenn es zu lange dauert, bis auch bei einer Station 
dran komme, drehe ich weiter. Wenn ich vorher auf QSYing wipes the call & spots QSO in bandmap  
geschaltet habe, werden Rufzeichen, die ich schon im Rufzeichenfeld hatte, fett in die Bandskala eingetragen, so 
dass ich sie später wiederfinde. Ein Rufzeichen über dem Rufzeichenfeld wird mit der Leertaste in dieses Feld 
übernommen. Kommt Ihnen das Verfahren noch etwas fremd vor, informieren Sie sich über die 
Tastenzuordnungen. Hier sollten Sie Zeit investieren. 

11.11 Zu den Spots angezeigte Zeit  (Spots and the time shown)  

Wenn Sie mit dem Mauszeiger über einen Spot ziehen, wird das Alter des Spots in Minuten angezeigt. Die angezeigte 
Zeit hängt vom Format des Spots ab. Es gibt zwei Zeitformate: eins für aktuelle Spots, das andere für Spots, die mit 
SH/DX geholt wurden. Das Programm verarbeitet die beiden Zeiten unterschiedlich :  

� Aktuelle Spots werden mit einer Zeitmarke versehen, die sich aus der Zeit Ihres PC 
umgerechnet in UTC ergibt. Damit werden Zeitdifferenzen der DXCluster 
eliminiert und die Spots in der zeitlichen Reihenfolge des Empfangs geordnet 

� Alte Spots werden nach der Logzeit im DXCluster abgelegt mit der Vorgabe, dass 
sie nicht jünger sein dürfen als die laufende UTC-Zeit des Rechners 

Bei AR-Clustern können Sie die alten Spots mit sh/dx oder sh/fdx abrufen. Es ist zu empfehlen, sie mit sh/dx abzurufen, 
damit sie als alte Spots erkannt werden können. Die Software anderer Cluster bietet ähnliche Möglichkeiten. 
 

12. Packet-Fenster (Packet Window) 

Das Packetfenster kann etwa so aussehen :  

 

Die Inhalte der Tastenfelder unten im Fenster können mit einem rechten Klick darauf oder über das Menü Config > 
Change Packet/CW/SSB/Digital Message Buttons > Chan ge Packet/Telnet Buttons  geändert werden.  Connect- und 
andere Meldungen werden zusätzlich in der Statuszeile des Logeingabefensters angezeigt. Eine Statusinformation wird 
für Telnet im Titel des Telnetfensters ausgegeben. Nach einem Klick auf eine der 12 Tasten im Packetfenster wird der 
Cursor ins Logeingabefenster gesetzt. 
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Alle ankommenden DX-Spots und auch die mit SH/DX angeforderten werden in den Bandskalen angezeigt. Auch eine 
Splitinformation zu einem Rufzeichen wird angezeigt. Nach einem Klick auf so ein Rufzeichen wird der Transceiver – falls 
realisierbar- in den Splitmodus geschaltet. Vom Programm werden diese Teile der DXMeldung ausgewertet :  UP, U, 
DOWN, DN, D und  QSX. Beispiele: QSX 3.838, QSX 4, UP 5, DOWN 2, U 5 usw..  

Unter Telnet kann ein Telnet-DXCluster in der Kopfzeile des Telnetfensters angewählt werden. Der DXCluster in diesem 
Fenster wird unter Konfiguration eingestellt. Mit Close Port  wird die Verbindung wieder getrennt.  

Packet/Telnet hat eine “Tote-Mann”-Funktion, die aller 9 Minuten ein CR zum Cluster sendet. Diese Funktion ist nicht 
konfigurierbar. Setzen Sie eine Meldung ab, zählt der Zähler ab diesem Zeitpunkt neu.  

12.1 Voreingestellter Tasteninhalt  (Initial Button Assignments)  

� BYE    (F1) : trennt Packet-Verbindung  
� CONN (F2) : Verbindet mit dem in der Taste eingestellten DXCluster, z.B. C 

K1TTT  
� DI/N     (F3) :  zeigt neue Nachrichten an (CLX benötigt den Eintrag  

directory/new).  
� SH/DX (F4) : zeigt die letzten 30 DXSpots (sh/dx/30)  
� USERS (F5) : zeigt die Nutzer an (sh/u)  
� WWV    (F6) : zeigt die letzten WWV-Meldungen (sh/wwv) 
� 10M      (F7) : zeigt die letzten 30 10m-Spots  
� 15M      (F8) : zeigt die letzten 30 15m-Spots  
� 20M      (F9) : zeigt die letzten 30 20m-Spots   
� 40M      (F10) : zeigt die letzten 30 40m-Spots  
� 80M      (F11) : zeigt die letzten 30 80m-Spots   
� {MYCALL}  (F12) : Gibt zum Einloggen in einen Telnet-DXCluster das eigene 

Rufzeichen aus. Das Rufzeichen wird aus der Stationsinformation geholt  
 
Sie können maximal 12 Tasten (enstprechend F1 bis F12) für Packet und Telnet nutzen und programmieren. Mehr 
Tasten stehen nicht zur Verfügung. 
 

• Close Port  : Trennt die Telnet-Verbindung 

12.2 Tastenzuordnungen (Keyboard Assignments)  

• Ctrl-C  : Sendet Ctrl-C zum TNC (genutzt bei TAPR TNCs)  

• Ctrl-Z  :  Sendet Ctrl-Z zum TNC (genutzt bei TAPR TNCs)  

• Shift-Escape  : Setzt ein ESC in die Kommandozeile. Erscheint als schwarzes Karo. Wird mit 
ENTER gesendet. Wird für  WA8DED/ TF-Firmware –TNCs benötigt . Das Packet/Telnet-
Fenster muss aktiv und der Cursor in der Kommandozeile des Fensters stehen.  
Hinweis  :  ein ESC ohne Shift setzt den Cursor ins Logeingabefenster. 

12.3 Mauszuordnungen (Mouse Assignments)  

• Linke Maustaste :  
o Einfacher Klick auf einen DXSpot : stellt den Transceiver auf die Frequenz des Spots  
o Shift-click auf einen Spot  : stellt den inaktiven VFO auf die Frequenz des Spots 
o Doppelklick auf einen Spot :  das Rufzeichen wird zusätzlich ins Rufzeichenfeld 

übertragen 
o CTRL+Einfacher Klick : stellt den inaktiven VFO auf die Frequenz des Spots und schaltet 

ihn auf Aktiv 
• Rechte Maustaste : öffnet ein Menü :   

o Configure Ports, Telnet Address, Other : öffnet den Konfigurierdialog  
o Edit Telnet Cluster List  : Öffnet die Liste der Telnet-DXCluster  
o Change Packet/Telnet Buttons  : Öffnet die Liste der Tastentexte der Packet/Telnet-

Tasten  
o Close Port  : beendet Packet- oder Telnetsitzung  
o Specify Comment for All Spots  : Fügt allen eigenen DX-Meldungen einen festen Text 

zu. Gilt nur für den aktuellen Programmstart. Beispiel : PACC  
o Auto logon  : Wenn Sie auf Telnet geschaltet haben, wird ein Auto-Logon mit einem Klick 

auf die Taste rechtsaussen (belegt mit dem eigenen Rufzeichen) erzeugt. Wenn Sie auf 
Packet geschaltet haben, wird mit einem Klick auf die zweite Taste von links  (CONN = c 
<call>) ) eine Verbindung zum Packetcluster hergestellt. Welche Aktion ausgeführt wird, 
hängt davon ab, welches Fenster aktiv ist bzw. welches zuletzt genutzt wurde.  

o Packet Spot Timeout  : Gibt vor, wie lange der Spot in der Bandskala bleiben soll. 
Voreingestellt sind 60 Minuten. Jede ganze Zahl erlaubt. 

o Remove all spots  : Entfernt alle DXSpots aus der Bandskala. Auch die Daten im Fenster 
Bereitstehende Multis werden gelöscht.. 
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o Allow spots from my country only  : Nur aus dem eigenen Land gemeldete Spots 
werden angezeigt  

o Allow spots from my continent only  : Nur aus dem eigenen Kontinent gemeldete Spots 
werden angezeigt  

o Allow only spots from specified call areas  : Nur Spots aus bestimmten 
Rufzeichengebieten werden angezeigt. Eingabe mit dem nächsten Menüpunkt.   

o Enter call areas (currently)  : Gib Rufzeichengebiete mit Leerzeichen getrennt ein. Z.B.  
K1 K2 K3 K4 und dann OK drücken. Löschen durch Eingabe eines Leerzeichens.  

o Allow HF  : Nur Spots unter 30 MHz werden ausgegeben 
o Allow VHF  : Nur Spots über 30 MHz werden ausgegeben  
o Allow WARC : WARC-Spots werden in die zugehörigen Bandskalen ausgegeben  
o Allow spots for this contest's mode(s) only  : Nur Spots in der zum Contest gehörenden 

Sendeart werden ausgegeben.  
o Set Font  : Einstellung der Schrifttype für die Packet/Telnetfenster. Empfohlen werden 

feste Fonts, um die Einträge untereinander darzustellen  
o Copy : Mit der linken Maustaste markierten Bereich des Fensters in die Zwischenablage 

kopieren. Die Markierung verschwindet, bevor Sie Copy anklicken, funktioniert aber 
trotzdem.  

Allow HF/VHF/WARC (HF/VHF/WARC erlauben) : : Mit diesen Kommands wird KEIN Filter für die empfangenen 
DXSpots eingestellt, sondern nur ihre Ausgabe in die Bandskalen und das Fenster für Bereitstehende Multis und QSO 
gesteuert.  Informieren Sie sich im Kapitel DX Clusters über Filter für den Verkehr mit DXClustern. 
 

Hinweis DM3ML  : Die Schalter Allow xx  sind auf AUS voreingestellt. Sie sehen erst DX-Spots, wenn Sie einen Haken 
vor die entsprechende Zeile, z.B. Allow HF  gemacht haben.  

12.4 Spezielle Tasten  (Special keys)  

• Wenn Sie die CTRL (Strg)-Taste beim Klicken auf einen Spot gedrückt halten, wird der Spot in 
das Fenster des aktuell inaktiven VFOs übertragen und dieser aktiviert  

12.5 Makro-Tasten  (Macro keys)  

Sie können die Tasten im Packet/Telnet-Fenster mit Makros belegen. Informieren Sie sich im Kapitel Makros.  

12.6 Telneteinstellungen (How to setup Telnet to access a cluster)  

Um einen bestimmten Telnet-DXCluster einzubinden, gehen Sie so vor :  

1. Wählen Sie den Menüpunkt Config > Change Telnet Cluster List . Tragen Sie Namen des Clusters 
und u.U. die benötigte Portadresse ein, z.B. gb7ujs.shacknet.nu und Portnummer 21.  

2. Wählen Sie aus dieser Liste die neue Adresse für das Telnetfenster mit Config > Configure Ports, 
Telnet Address, Other > Telnet Cluster  

3. Öffnen Sie das Telnetfenster mit einem Klick auf die Karteilkarte im Packetfenster  
4. Klicken Sie auf die Tasten mit Ihrem Rufzeichen (F12). Es wird vorausgesetzt, dass der Telnet-

Cluster Ihr Rufzeichen beim Einloggen haben will. Die Telnetverbindung wird aufgebaut.  

12.7 Telnetcluster editieren/löschen  (How to add/edit/delete a Telnet cluster)  

Sie haben drei Möglichkeiten den Dialog Change Telnet Cluster List  zu erreichen :   

� Rechter Mausklick ins Packet/Telnetfenster und Edit Telnet Cluster List     
� Menü Config > Change Telnet Cluster List    
� Menü Config > 'Configure Ports, Telnet Address, Others >  Edit- Taste   

Wählen Sie 'Change Telnet Cluster List' . Sie können in der untersten freien Zeile einen Telnetcluster Ihrer Wahl 
eintragen oder einen vorhandenen Eintrag editieren. Sie können eine Zeile markieren und dann Delete (Löschen) 
wählen. 

12.8 Unterstützte Packet-Cluster  (Supported Packet clusters):  

• AR-Cluster von AB5K  
• Clusse von OH7LZB (nicht voll unterstützt, gilt nur für ankommende Spots)  
• Um Clusse kompatibler zu machen, geben Sie das Kommando SET/PCMODE YES 

(in Grossbuchstaben !) ein  
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• Nur ankommende Spots werden von N1MMLogger akzeptiert (gibt keine Antwort auf 
List-Kommandos)  

• Das List-Kommando (SH/DX) hat ein abweichendes Format und wird nicht dekodiert  
• CLX von DJ0ZY und DL6RAI  
• DX-spider von G1TLH  
• DX-spider verwendet ein abweichendes  SH/DX-Format. Stellen Sie in der 

Konfiguration das Format for DX-spider support  ein. Dieses Format sendet die 
richtige SH/DX-Anforderung vom Kopf der Bandskalen  

• DXnet von F5MZN (Unbekannt, ob alle Kommandos unterstützt werden)  
• PacketCluster von AK1A  
• Wincluster Lite von KH2D 

12.9 Stationen melden  (Spotting stations) 

Meldungen  an den DXCluster werden vom Logeingabefenster aus gestartet. Die in das Rufzeichenfeld eingetragene 
Station bzw. die letzte geloggte Station werden gemeldet (wenn das Rufzeichenfeld leer ist).   

� Alt-P  meldet die Station ohne Kommentar bzw. mit fest eingestelltem Kommentar 
� Ctl-P  meldet die Station mit Kommentar 
� Spot all S&P QSO's – meldet – wenn angewählt – alle S&P-QSOs 

Die Frequenz der gemeldeten Station wird auf eine Stelle hinter dem Komma gerundet. 

12.10 Weitere Info  (Other info)  

Es ist möglich, einen Telnet-Host zu connecten, wenn die Internetverbindung über ein LAN an einen Proxyserver oder 
einen Router angeschlossen ist. Versuchen Sie zuerst die Verbindung über ein Telnetprogramm unter Windows 
herzustellen. Funktioniert diese Verbindung, läuft die Verbindung auch über N1MMLogger. Port 23 (=Telnet) sollte offen 
sein. 

13. Prüffenster (Check Partial Window) 

Das Prüffenster sieht so oder ähnlich aus :   
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13.1 Eigenschaften (Features)  

� Im Prüffenster werden alle Rufzeichen aus der Datei MASTER.DTA und aus 
dem Log des aktuellen Contests angezeigt, die mit dem in das Rufzeichenfeld 
eingegebenen Rufzeichenteilen nach Buchstaben und Zahlen übereinstimmen  

� Die Rufzeichen werden in Spalten angeordnet  
� Vor der Eingabe des Rufzeichens wird die aktuell aktive Version der Datei  

MASTER.DTA nach Datum und Uhrzeit angezeigt (Bild 1)  
� Wenn Sie 3CE in das Rufzeichenfeld eingeben, werden Rufzeichen angezeigt, 

in denen 3CE vorkommt (Bild 2)  
� Wenn keine Übereinstimmung gefunden wurde, steht UNIQUE im Prüffenster 

(Bild 3)  
� Wenn die eingegebenen Zeichen zum Teil mit einer schon gearbeiteten Station 

übereinstimmen, wird dieses Rufzeichen rot  ausgegeben (hier PA3CEE und 
PA3CWN in Bild 4) 

� Wenn ein eingegebenes Rufzeichen mit einem schon gearbeiteten Rufzeichen 
komplett übereinstimmt, wird dieses Rufzeichen fett und mit 12 pt-Schrift in rot  
oder blau  hervorgehoben, hier PA3C im Bild 4. 

� Wenn das eingegebene Rufzeichen schon gearbeitet wurde, steht im 
Prüffenster ein deutliches DUPE , z.B. PA1M - Dupe  

� Das Prüffenster wird erst durch Eingabe eines einzelnen Zeichens in das 
Rufzeichenfeld gelöscht. Wird das Rufzeichen im Rufzeichenfeld nur gelöscht, 
bleibt das Prüffenster gefüllt. Das Prüffenster wird erst nach Eingabe zweier 
Zeichen neu gefüllt. 

� Alle Daten werden in Großbuchstaben angezeigt, Nicht-Standard-ASCII-
Zeichen werden entfernt. 

13.2 Suchen mit Platzhalter  (Wildcard search)  

Sind ein oder mehrere Zeichen unklar, kann ein ? eingegeben werden. Mindestens zwei zusammenhängende Zeichen 
müssen bekannt sein. N?MM oder N1? starten die Suche, aber M?M funktioniert nicht.  
Das erste Zeichen kann auch ein ? sein, ?1M bringt  KN1M und  N1MM.  

Beispiele :   

PA?M    Passt zu  PA1M, PA7MM usw.  

P?1M Passt zu  PA1M, PG1M, PF1MO usw.  

P?3 Funktioniert nicht, es fehlen zwei zusammenhängende Zeichen  

?1M Passt zu  N1MM, KN1M, PA1M usw.  

13.3 Farbe der Rufzeichen  (Colors of the incoming spots):  

� Rot  : schon auf diesem Band gearbeitete Station (Dupe)  
� Blau  : Station auf einem anderen Band schon gearbeitet, auf dem aktuellen 

Band noch nicht > ANRUFEN !  

13.4 Tastenzuordnungen (Keyboard Assignments)  

� Alt-Y : übernimmt das erste Call aus dem Prüffenster in das Rufzeichenfeld 
des Eingabefensters  

13.5 Mauszuordnungen  (Mouse Assignments):  

• Klick mit der linken Maustaste auf ein Rufzeichen i n der Liste  
o Klick auf das Rufzeichen : Rufzeichen wird ins Logeingabefenster übernommen 

unabhängig vom Inhalt zuvor.  
� Hat das Rufzeichen Leerzeichen, wird nur der erste Teil übernommen 

• Klick mit der rechten Maustaste :   
o Help   : Ruft Hilfe für dieses Fenster  

Im Fenster erscheinen nur Einträge, wenn eine gültige Datei  MASTER.DTA aktiviert worden ist und im N1MMLogger-
Verzeichnis steht.  

MASTER.DTA – Dateien können Sie sich im Internet holen. Wissen Sie keine Adresse, suchen Sie mit  
http://www.google.com.  
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Beachten : Die MASTER.DTA-Datei muss das von N1MMLogger unterstützte CT-Format haben. Es gibt auch andere 
MASTER.DTA-Dateien mit abweichendem Format.  

14. Verfügbare Multis und QSOs (Available Mults and Qs Wi ndow) 

Das Fenster der bereitstehenden Multis und Statione n sieht etwa so aus  :    

                

Das Fenster hat zwei Teile, oben die Bandtasten und unten die Multi-Liste.  

14.1 Bandtasten (The Band buttons)  

Im oberen Teil des Fensters sehen Sie die Bandtasten mit Angaben zu den bandspezifischen DXCluster-Meldungen. 
Links steht die Zahl der gemeldeten Multis/Band und rechts davon die Zahl der noch nicht gearbeiteten Stationen. Die  
roten Zahlen markieren das Band mit der jeweils höchsten Zahl an Multis und Stationen (Qs) . Die Bandtasten orientieren 
sich am Contest, bei HF-Contesten enthalten sie die zugelassenen Bändern (ohne WARC, 160m wahlweise, linkes Bild) 
und auf UKW die V/U/SHF-Bänder mit ihrer Bandbezeichnung (Bild rechts). 
Anmerkung DM3ML : Auf UKW ist bisher nur der VHF-Reg1-Contest für 2m implementiert.  

Das jeweils aktive Band ist fett  markiert.  

14.1.1 Tastenzuordnungen  (Button Assignments)  

• Linker Klick  auf eine Bandtaste  (Left )click on band button) – der linke Transceiver oder 
VFO-A wird auf den ersten Spot des gewählten Bandes gesetzt und für ihn das Eingabefeld 
aktiviert.  

• Rechter Klick  auf eine Bandtaste  (Right click on band button) -  der rechte Transceiver oder 
VFO-B wird auf den ersten Spot des gewählten Bandes gesetzt und für ihn das Eingabefeld 
aktiviert.  

 
Hinweis : Die Transceiver folgen dem Tastenklick nicht automatisch. Wählen Sie den richtigen Transceiver oder 
VFO mit einem rechten oder linken Klick. 

14.1.2 Tastenfarben  (Button background colors used):  

� Pink   :   Neuer Multi auf diesem Band !  
� Türkis  :    Neue Station auf diesem Band, kein Multi !  
� Schwarz  :  Dupe, schon gearbeitet !  
� Grün  :     Neue Zone (wenn Multi, z.B. beim CQWW) ! 

14.2 Multi-Liste  (Multiplier List box)  

Die Liste zeigt die zuletzt über Packet und/oder Telnet empfangenen Multis. Die neueste Meldung steht an erster Stelle 
und schiebt die älteren Meldungen nach unten. In der Liste ist Platz für 20 Multis. 
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14.3 Mauszuordnungen  (Mouse Assignments):  

• Linker Klick auf Rufzeichen  in der Multi-Liste  
o Einzelklick  :  der aktive VFO übernimmt diese Frequenz. Das Rufzeichen 

wird über dem Rufzeichenfeld bereits gestellt  
o Einzelklick+Shift  : Der inaktive VFO übernimmt die Frequenz des 

Rufzeichens  
o Doppelklick  :  der aktive VFO übernimmt diese Frequenz. Das 

Rufzeichen wird in das Rufzeichenfeld eingetragen unabhängig davon, ob 
dort bereits ein Rufzeichen steht.  

 

• Rechter Klick in das Multifenster öffnet ein Auswahlmenü :  
o  Show Active Radio/VFO  : die letzten Multis für den aktiven VFO werden 

angezeigt  
o  Show non-Focus Radio/VFO : die letzten Multis für den nicht aktiven 

VFO werden angezeigt  
o  Show Both Radios/VFOs : die letzten Multis für beide VFOs werden 

angezeigt 
o  Show All Bands  : die letzten Multis aller Bänder werden angezeigt 

(voreingestellt) 
o Help  : Die Hilfe für dieses Fenster wird angezeigt.  

14.4 Weitere Info  (Other info)  

• Dupe-Rufzeichen werden nur dann angezeigt, wenn die Länge des Rufzeichen grösser 
als 2 Zeichen ist  

 

15. QSO editieren   (Edit Contact Dialog) 

Wenn Sie ein QSO editieren wollen, wird dieses Fens ter geöffnet :   

 

Mit diesem Fenster können Sie ein QSO nach dem Abspeichern korrigieren.  
Die Felder Country Prefix , Mult 1  und Mult 2  können NICHT editiert werde, sie werden nach dem Abspeichern des 
QSOs neu berechnet. 
Folgende Sendearten können in das Feld Mode  eingetragen werden : CW, CW-R, LSB, USB, RTTY, RTTY-R, AM, FM, 
PSK31, PKT, PAC2, GTOR, FSK31, PSK63, PSK125, MT63, MFSK8, MFSK16, HFSK, MTTY, THRB, ASCI, HELL, Q15, 
PCW.  
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Das vom Programm geloggte Land ist nicht wichtig, da es im Cabrillo-Log nicht erscheint. Es hat nur Bedeutung für die 
vom Programm berechnete Punktzahl (claimed score). Berechnet Ihr Programm eine inkorrekte Punktzahl werden Sie 
dafür nicht bestraft. 
Anmerkung DM3ML  : Der Contestveranstalter, der ausschliesslich Cabrillo-Logs auswertet, berechnet selbst und 
einheitlich für alle Stationen die endgültige Punktzahl. 

Die Länderinformation wird aber benötigt, damit das Programm benötigte Multiplikatoren bestimmen und auf sie 
aufmerksam machen kann. 

 
Hinweis : Wenn das Programm sich weigert, ein QSO so abzuspeichern, wie Sie es wünschen, loggen Sie es so, wie 
das Programm es sich wünscht oder akzeptiert und editieren Sie es später.  

Beispiel : Eine KG4-Station ruft an und gibt einen US-Staat als Kontrollnummer. Das Programm meint aber, die Station 
würde in Guantanamo sitzen und erwartet eine Zahl als Kontrollnummer. Tragen Sie also eine Nummer in das Log ein, 
speichern Sie das QSO ab und editieren es im Anschluss. Stellen Sie aber sicher, dass Sie sich zum nächsten Contest 
die neueste Datei CTY.DAT oder editieren Sie die Datei, damit der gleiche Fehler nicht wieder vorkommt. Siehe auch 
Tipps und Tricks. 

Wenn Sie ein QSO geändert haben und mit den Up- oder Dwn-Pfeilen zum nächsten QSO gehen wollen, werden Sie 
gefragt :   

 

• Yes : Ja, QSO abspeichern und zum nächsten gehen  

• No : Nein, Änderungen nicht abspeichern und zum nächsten gehen  

• Cancel  : Gehe zurück zum bearbeiteten QSO  

15.1 Tastenzuordnungen (Button Assignments)  

• Update :  Das QSO wird aktualisiert und abgespeichert. Das Fenster wird geschlossen 
und das Programm kehrt zum letzten QSO im Log zurück  

• Delete  : Löscht das QSO aus dem Contest-Log und kehrt zum letzten QSO im Log 
zurück.  

Zur Sicherheit werden Sie nach dem Klick auf die Löschtaste noch einmal gefragt, ob Sie es ernst meinen 
:   

o Yes (Ja), das QSO wird zu den  DELETEDQS 'contest' geschickt 
o No (Nein), das Löschen wird nicht durchgeführt 

 
 

 

o Beim Multi-Multi-Betrieb kann ein QSO nur an der Station gelöscht werden, an der es 
geloggt wurde, sonst erhalten Sie Ausschrift :  

� Message: "You may not delete contacts logged by another station while in Multi-
User mode. Ask station #[radionumber] to delete it." 
"Delete not performed!" 
Sie können das QSO, das von einer anderen Station geloggt wurde, nicht 
löschen. Bitte Sie die Station #[nummer] das QSO zu löschen. Löschen nicht 
ausgeführt ! 

• Help  : Ruft die Hilfe für dieses Fenster   

• Exit : Beenden des Dialogs ohne Änderung  

• Up Arrow  (Pfeil nach oben) : Gehe zum nächsten Logeintrag in Richtung Loganfang und speichere die 
aktuelle Änderung  

• Down Arrow  (Pfeil nach unten) :  Gehe zum nächsten Logeintrag in Richtung Logende und speichere 
die aktuelle Änderung   
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15.2 QSO endgültig löschen  (How to permanently delete a contact?)  

Um ein oder mehrere QSOs zu löschen :  
 

� Wählen Sie den Contest  DELETEDQS   
� File >  Choose contest > DELETEDQS  

� Wählen Sie ein zu löschendes QSO  
� Wenn Sie die Delete  (Löschen)-Taste anklicken, werden Sie 

gefragt   
• Yes (Ja), will delete the qso permanently from the 

DELETEDQS 'contest' (löscht QSO endgültig) 
• No (Nein), Löschen abbrechen 

 

• Alle QSOs löschen  
o Wählen Sie den Contest  DELETEDQS   

� File > Choose contest > DELETEDQS  
o Löschen Sie den Eintrag DELETEDQS mit der Taste Delete .  

� Sie werden nach einer Bestätigung gefragt 

15.3 Wie bekommt man ein QSO zurück ?  (How to place a deleted qso back?)  

Das ist nicht so einfach. Sie können den Contest mit dem Namen DELETEDQS aufrufen und seine QSOs als ADIF-Datei 
ausgeben. In dieser ADIF-Datei müssen Sie dann alle ungewünschten QSOs löschen. Das oder die übriggebliebenen 
QSOs können Sie zu dem aktuellen Contest wieder importieren. 

15.4 Warum nicht gleich löschen ? (Why move and not delete ?) 

Die gelöschten QSOs werden nicht gleich gestrichen, sondern in einen Contest mit dem Namen  DELETEDQS geschickt. 
Hier können Sie es im Notfall wieder retten. Der Grund für dieses Umkopieren liegt bei ACCESS, das den belegten 
Speicherplatz nicht gleich wieder freigibt, so dass man das gestrichene QSO auch an einen anderen Platz schieben 
kann, von dem es erst nach dem endgültigen Löschen und Komprimieren verschwindet.  

16. Info-Fenster (Info Window) 

Das Info-Fenster sieht etwa so aus :   
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Öffnen Sie dieses Fenster mit Window > Info . Es sollte normalerweise zugeschaltet sein. 
  

16.1 Überblick (General)  

Im Fenster sehen Sie folgende Informationen :  

� Informationen zur zu zuletzt gearbeiteten Station mit  : Land, Zone, Kontinent, 
Antennenrichtung für den kurzer Weg, Entfernung in Meilen und Kilometern, 
Antennenrichtung für den langen Weg  

� Ausgwertet wird die Station im Eingabefenster oder falls dieses 
leer ist, das Rufzeichen, das im Rahmen darüber steht 

� ist auch hier kein Rufzeichen eingetragen, wird das letzte 
Rufzeichen, das im Fenster stand genommen 

� Sonnenauf- und Untergang  am Standort der Gegenstation und die dortige Lokalzeit 
� Packet-Information zu diesem Rufzeichen  
� Packet-Talk-Mitteilungen (erscheinen rot ) 
� WWV-Statistik  
� Rateninformation / Zielvorgaben in Farbe / Angaben zum Bandwechsel  
� Rufzeichen des Operators in der unteren rechten Ecke in fetter Schrift.  

Setzen mit Ctrl-O.  
� Zielvorgaben importieren und setzen  
� Multi-Stations-Information (erscheint nur im Multi-Multi-Modus)  
� Nachrichten : zeigt Computername, IP-Adresse und Port 

Die nächste laufende QSO-Nummer wird in der Titelzeile angezeigt, wenn es sich um einen Nummerncontest handelt, 
z.B. : Exch: 59 002 
In Ländern mit mehreren Zeitzonen wie  K, VE, UA und VK wird die Lokalzeit nicht angezeigt. 

16.2 Mauszuordnungen (Mouse Assignments)  

� Rechter Klick ins Fenster öffnet ein Menü mit diesen Punkten, die entweder 
angewählt (Haken davor) oder abgeschaltet (ohne Haken) werden können : 

� Callframe spot  : Zeigt Landesinformationen zum Rufzeichen 
über dem Eingabefeld 

� CountryInfo  : Zeigt Landesinformation zum Rufzeichen im 
Eingabefeld 

� Sunrise/Sunset -; Zeigt Sonnenauf- und untergang bei der 
Station und die Ortszeit  

� Messages  : Zeigt Talk-Meldungen aus dem Packetfenster an 
� WWV Messages  : zeigt WWV – Meldungen an 
� Rates Section  -: zeigt die Ratenleiste  
� Multi-User Section  : zeigt die Multi-User-Leiste 
� Help  : Zeigt die Hilfe für dieses Fenster an  

Wenn Sie die Multi-User-Betrieb aktiviert haben, bekommen Sie mit einem Klick auf das rote  oder grüne  Icon ein 
zusätzliches Menü. Informieren Sie sich unter Multi-User weiter unten. 
 

16.3 Rateninformation (Rate information)  

Die Rateninformation erscheint im unteren Teil des Fensters. Doppel-QSOs werden mitgezählt. Angezeigt wird :   

• Top of rates frame   :  QSOs je Multi  

• Last 10   : Rate der letzten 10 Minuten in QSOs/Stunde  

• Last 100  : Rate der letzten 100 Minuten in QSOs/Stunde  

• Since hh:mm : Rate der letzten Stunde in QSOs/Stunde  

• Since hh:00  : Rate vom Beginn der letzten vollen Stunde in QSOs/Stunde  

• Band Chgs  : Zahl der Bandwechsel seit Beginn des Conteste für Multi-Single-OPs  
o Wird auf 0 zur vollen Stunde gesetzt 
o Zählt Bandwechsel für jeden Computer nur bei Multi-Two 
o Bandwechsel werden nicht gezählt, wenn eine Station auf einem anderen 

Band ein neuer Multi war 

• 10 min band timer  :  Zählt von 10 Minuten abwärts bis 0 nach jedem geloggten 
Bandwechsel 

16.3.1 Hintergrundfarbe (Background colors rate informatio n) 
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Die Hintergrundfarbe der Ratenfelder hängt von den Zielvorgaben für diesen Contest ab :   

� Rot < 50% der Vorgabe  
� Gelb < 51-99% der Vorgabe  
� Grün  100+% der Vorgabe   

16.3.2 Tasten (Buttons)  

� Import Goals  : Raten des laufenden Contest als Zielvorgabe importieren. Falls 
Vorgaben von einem anderen Contest importiert werden sollen, öffnen Sie diesen und 
setzen dann die Zielvorgabe 

� Goal = Zielvorgabe stundenweise von Hand eingeben. Geben Sie die Stunden von 0-
23 und dazu die zu erreichenden QSO-Zahlen ein. Fehlt eine Stundeneingabe, wird 
der Wert von der nächst niedrigeren Stunde genommen 

16.4 Zielvorgabe einstellen (Setting a goal for the cont est)  

Die meisten Leute wollen in diesem Contest mehr QSOs machen als im gleichen Contest des Vorjahrs. Für die meisten 
von uns ist das unser Ziel ! 
Sie können die Zahlen vom Contest des Vorjahres importieren und dann so editieren, das mehr als im letzten Jahr 
heraus kommt. Der Contest muss dazu in ihrer Datenbasis verfügbar sein.  

16.4.1 QSO-Zahlen einstellen  (Setting the QSO numbers)  

Sie können die QSO-Raten für den Contesttag 1 (Sonnabend) und für Contesttag 2 (Sonntag) setzen   

• Import from a previous contest (Import von einem früheren Contest)?  
o Yes (Ja) 

� Sie haben den Contest des Vorjahres geladen  
� Öffnen Sie File > Open Database  und wählen Sie den 

gewünschten Contest   
� Sie können auch die Daten von einem anderen Contest 

importieren  
o No (Nein) 

� Wählen Sie einen neuen Contest mit File > Choose contest >  
Start a new log for a contest 

• Wählen Sie Import Goals  im Info-Fenster 
• Wählen Sie den Tag 1 oder 2   

 

• Wählen Sie Goal =    
In die sich öffnende Tabelle können Sie die Stunde und die zu erreichende QSO-Zahl je Stunde 
eintragen. Die Tabelle ist leer, wenn Sie keinen Contest importiert haben oder Sie hat schon 
Einträge, wenn Sie einen Contest importieren :   

o 24-Stunden-Conteste beginnen am Tag 1 um 12 Uhr und enden am Tag  2 um 11 Uhr  
Hinweis : Diese Angabe bezieht sich auf den PACC, der am Sonnabend um 12 z anfängt  

o 48-Stunden-Conteste beginnen am Tag 1 um 0 Uhr und enden am Tag 2 um 23 Uhr   
Hinweis : Diese Angabe bezieht sich auf Conteste wie CQWW, ARRL DX usw. die um 0 z 
am Sonnabend starten  
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Hinweis : Die Zielvorgabe bezieht sich auf die Datenbasis und nicht auf den Contest in der Datenbasis. Es ist nicht 
möglich, mehrere Zielvorgaben für verschiedene Conteste einer Datenbasis anzulegen. Sie sollten für die jeweils 
grossen Conteste eine eigene Datenbasis anlegen. 

16.5 Multi-User-Info  (Multi-User information)  

16.5.1 Überblick (General) 

Im unteren Teil des Info-Fensters werden die während eines Contests benötigten Informationen angezeigt (siehe auch 
Info-Fensters) :   

 

• Grünes oder rotes Icon   
o Grün : Station verbunden 
o Rot :  Station nicht verbunden 
o Helles Rot : Das Programm war für eine Weile nicht in der Lage, die Station zu connecten  

� Das Programm arbeitet daran, das Problem zu klären. Das Icon wird wieder 
grün, wenn das Problem geklärt ist 

� Tritt das Problem erst während des Contests auf, kann es sein, dass zu viel HF 
auf den Kabeln für den Netzbetrieb ist 

o Mit einem rechten Klick auf die Icons kommen Sie zu diesem Menü :  

• Station  
o Der unter Config / Edit Station Computer names  eingetragene Name wird angezeigt 

• Pass frequency  
o Frequenz auf der die Station anrufende Station hören möchte 

• Run  
o Angehakt : Station ist im Running-Modus 
o Nicht angehakt : Station ist im S&P-Modus 

• Operator  
o Rufzeichen des OPs 
o Das Rufzeichen wird rot,  wenn der OP sendet 

• last 10  
o Rate der letzten 10 QSO's in QSO/Stunde 

• last 100  
o Rate der letzten 100 QSO’s in QSOs/Stunde 

• Frequency 
o Arbeitsfrequenz 

16.5.2 Mauszuordnungen (Mouse Assignments)  
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• Ein Rechter Klick auf das Stations-Icon : zeigt das obenstehende Menü  
• Send Message  : Schickt eine Mitteilung an die Station. Die Mitteilung wird im Info-

Fensters der angewählten Station rot gefärbt angezeigt 
• Target for Call stacking  : Mit Shift-Enter  in den Stapelspeicher geschickte 

Rufzeichen werden in den Stapelspeicher der adressierten Station geschickt. Siehe 
Logeingabefenster  für Infos zum Stapelspeicher 

• Pass current/last QSO : Das laufende QSO wird in das Eingabefenster dieser 
Station geschickt. Ist das Eingabefenster leer, wird das letzte QSO übergeben. 

• Show Status  : Anzeige des Verbindungsstatus der Station. Im Bild unten besteht 
momentan keine Verbindung.  

 

• Close Connection  : Netzverbindung mit dieser Station trennen 

• Open Connection  : Netzwerkverbindung wieder herstellen. Funktioniert nur bei einem roten Icon 

• Prevent Automatic Reconnect Attempts  : automatische Versuche zum Verbindungsaufbau aller 30 
Sekunden durch das Programm abschalten 

• Call for help   : Bei der angewählten Station erscheint die Mitteilung Station x needs assistance  
.(Station xx benötigt Unterstützung). Dadurch kann ein OP um Unterstützung bitten, ohne seinen 
Stationssessel verlassen zu müssen.Bei der Zielstation wird die im Programmverzeichnis vorbereiete 
Datei Assist.wav   abgespielt..  

17. Ergebnisfenster (Score Summary Dialog) 

 
Beispiel vom  CQWW SSB   

 
Beispiel vom  PACC  

 
Beispiel von Europa-Region1-VHF-

Contest  

Öffnen Sie das Ergebnisfenster aus dem Eingabefenster mit Window > Score Summary :  

Das Ergebnisfenster zeigt die Punktzahl des aktuellen Contests mit den je Band erreichten Punkten (bezogen auf eine 
Einbandteilnahme), dann die Gesamtpunktzahl mit Multis. Die Tabellen werden aktualisiert, wenn neue QSOs 
hinzukommen oder QSOs gestrichen werden. 
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Bei den Beispielen sehen Sie im linken und rechten Fenster einen Contest mit einer Sendeart (SSB) und in der Mitte 
einen Contest mit CW und SSB, hier werden die Sendearten getrennt angezeigt. Sie werden in der Summenanzeige 
zusammen berücksichtigt. 
 modes will be shown by band. The points are shown in the caption of the dialog.  

17.1 Mauszuordnungen (Mouse Assignments):  

• Mit einem rechten Mausklick erscheint dieses Menü :    
o Copy all  : Kopiert alle Daten in die Ziwschenablage  
o Print to file  -: Gibt die Daten in eine Datei aus  
o Help  : Zeigt die Hilfe zu diesem Fenster  

 
Hinweis  : Die Zahl der QSOs in der Ergebnisliste wird OHNE Doppelt-QSOs (Dupe) angezeigt. 

 
18. Multis je Band (Multipliers by Band Dialog) 

Die Multi-Tabelle rufen Sie über Window > Multipliers  

   

 

Die Tabelle zeigt  je nach Auswahl alle möglichen DXCC-Länder (Countries )/Zonen/Sektionen (contestabhängig)  mit 
ihrem Prefix per Kontinent Jeder Kontinent hat seine eigene Tabelle. In der Kopfzeile sehen Sie die je Kontinent 
erreichten Multis bezogen auf die maximal möglichen. Die Multis per Band oder Zonen/Sektionen u.a. erreichen Sie über 
das Menü in der Zeile am unteren Rand der Tabelle. Sie können die Anzeige mit einem Laufbalken in der untersten Zeile 
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der Tabelle verschieben. 
Die angezeigten Blöcke hängen von der Art des Contest und der zugelassenen Sendearten (CW, SSB, Mixed) ab. 

Unbekannte Sektionen (z.B. bei ARRL-Contesten) werden unter UNK eingeordnet. .  

• Die Zahl der Blöcke je Band hängt von der Art des Contest ab :  
o CW, SSB, RTTY  : ergibt einen Block je Band 
o MIXED  : ergibt zwei Blöcke je Band :   

� weiss = CW, grau = SSB 

• Die Zahl der Bänder hängt ebenfalls von den Bedingungen des ausgewählten Contests ab 
: 

o meistens werden Sie die Tabellen von sechs HF-Bändern sehen (160-10m). 
o Die Einstellungen werden in der band filter box  im Multi/Band-Dialog (unten in 

der Tabelle) gemacht 

• Sie können in der Auswahl Bänder und Sendearten (Modes) mit einander kombinieren  
o Setzen Sie Mode  auf Auto  wird die Sendeart oder die Sendearten aus dem 

angewählten Contest übernommen  

• Beispiele:  
o Band: Auto  und Mode: Auto  

� voreingestellt für die Conteste, meist 6 HF-Bänder : 160 80 40 20 15 
10  

� z.B. für CQWW, ARRL DX und andere 
� Conteste in einer Sendeart : CW oder SSB 

� 2 Blöcke : z.B. für CW und SSB (mixed Conteste)  
� z.B. für den ARRL 10 Meter-Contest (CW+SSB) 
� weiss = CW, grau = SSB 
� Mixed  gewählt 

o Band: HF+WARC und Mode : SSB  
� 9 Blöcke für die Bänder 160 80 40 30 20 17 15 12 10  
� benötigt für allgemeinen DX-Einsatz (nur in SSB) 

o Bandf:: HF+WARC  und Mode: Mixed   
� 18 Blöcke, je zwei für die Bänder 160 80 40 30 20 17 15 12 10)  
� benötigt  für DX-Einsätze in CW und SSB 

• Großfelderanzeige  
o wird bei einem VHF/UHF-Contest angezeigt 
o mit einem Klick auf ein Großfeld wird dieses in die Mitte des Bildes gerücktt 
o das eigene Großfeld wird in einem dunkleren Grün markiert 

 

18.1 Tastaturzuordnungen (Keyboard Assignments)  

• Ctrl-J : Schaltet zwischen DXCC-Ländern(Countries), CQ-Zonen (Zones), Sektionen 
(Sections) 
      und anderen Fenstern durch  

o Wenn das Multifenster nicht geöffnet ist, wird es geöffnet 

• Ctrl-Shift-J  : Öffnet und minimiert das Multi-Fenster (EIN/AUS) 

• Ctrl-Alt-J  : schaltet die Kontinente durch 
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18.2 Mauszuordnungen (Mouse Assignments  

• rechter Klick in das Fenster :  öffnet Menü  
o Zonen/Länder anzeigen (Show Zones/Countries)  :  

� Länder angewählt : zeigt die Zone für ein gewähltes Land. 
� Zonen angewählt : zeigt die Länder in der angewählten Zone 

o Gearbeitete Rufzeichen anzeigen (Show Calls Worked  ) : Zeigt alle in der 
gewählten Zone oder dem gewählten Land gearbeiteten Rufzeichen 

o Zentrum einstellen (Set Grid center) :  Großfeld für Zentrum im Format ABxx 
eingeben. 

o Hilfe (Help)  : Hilfe für dieses Fenster rufen  

18.3 Tasten am Multifenster (Radio Button Assignments)  

• Country  (Land) : gearbeitete Länder werden grün für das gewählte  Band angezeigt  

• ZN (Zonen) : gearbeitete Zonen werden grün  für das gewählte Band angezeigt  

• Sect  (Sektionen) : gearbeitete Sektionen oder US-Staaten werden grün  für das gewählte 
Band angezeigt  

• Other  (Andere) : andere mögliche Multis werden in grün für das gewählte Band angezeigt  
o in VHF-Contesten werden die gearbeiteten Großfelder angezeigt 

• Band : 
(Auswahl der 
Bänder)   

o Aut
o : 
Ban
dan
zeig
e 
nac
h 
Con
testr
egel
n, 
mei
st 
sec
hs 
Bän
der 

o HF : zeigt die 6 Bänder 160-80-40-20-15-10 an  
o VHF : zeigt die VHF-Bänder ab 50 MHz aufwärts an 
o HF + WARC : zeigt alle HF-Bänder (160-80-40-30-20-17-15-12-10) an  
o einzelne Bänder : von  1.8, 3.5, 7 .... bis 241 GHz 

• - Mode  (Auswahl der Sendearten) :  
o Auto  - : Auswahl nach Contestregeln (CW, SSB, Mixed, Digi)  

� ein Block je Band mit einer Sendeart 
� zwei Blöcke je Band nach Contest (Mixed = CW+SSB)  

o CW : nur ein CW-Block je Band 
o SSB : nur ein SSB-Block je Band 
o Dig  : nur ein DigiMode-Block he Band 
o Rev : schaltet bei Mixed-Mode zwischen SSB und CW je Band (jeweils ein 

Block/Band)d) 

• Reset   : setzt beide Filter auf Auto zurück 

18.4 Farben (Colors)  

• Weiss : wird benötigt > arbeiten !   

• Green  : gearbeitetes Land/Zone/sektion/Großfeld.  

 

19. Stationsdialog (Station Dialog) 
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Sie erreichen den Stationsdialog über Config > Change Your Station Data  :  

 

Dieses Fenster erklärt sich weitgehend selbst. Wichtig für den Funkbetrieb sind das Rufzeichen und die Koordinaten, 
damit die Antennenrichtung richtig berechnet wird. Beachten Sie, dass eine östliche Länge mit einem Minuszeichen 
davor eingetragen werden muss. Die persönlichen Daten werden für die Ausfüllung der Contestlogs benötigt. Mit den 
Angaben über Email-Adresse und Server für ausgehende Post (SMTP-Server) können vom Programm erzeugte 
Fehlermeldungen an Tom, N1MM geschickt werden. 
Hinweis DM3ML : Geben Sie als Nicht-ARRL-Mitglied unter ARRL-Section DX ein und lassen Sie den Club frei. 

Help ruft die Hilfe zu diesem Kapitel. 

 

  

20. Konfiguration (Configurer Dialog) 

Sie erreichen den Konfigurationsdialog über Config > Configure Ports, Telnet Address, Other   . Mit den zahlreichen 
Karteikarten (Tabs) der Konfiguration beeinflussen Sie entscheidend das Verhalten des Programms sowohl bezogen auf 
die Hardware als auch auf die Programmarbeit. Die Daten werden in den Dateien Default Settings.txt  und N1MM 
Logger.inin angespeichert. Wollen Sie den N1MMLogger unter verschiedenen Bedingungen und Einstellungen 
betreiben, sichern Sie jeweils diese beiden Dateien. Die Dateien können bezogen auf de jeweils offene Datenbank über 
Import- und Exportfunktionen eingelesen oder ausgelagert werden. (z.B. für die Funktionstasten, Telnet-DXCluster, 
Länderdaten usw.) 

20.1 Karteikarte Hardware (Hardware tab)  
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Mit dieser Karteikarte stellen Sie alle vom PC gesteuerten Schnittstellen ein. Sie wird für die Transceiversteuerung 
(CAT), das Packet-Interface, die Telnetverbindung über das Internet, die CW-Tastung u.U. für die getrennte PTT-
Steuerung benötigt. Eine Schnittstelle ohne  Transceiver-CAT bekommt den Eintrag  None  . 
 

20.1.1 Schnittstelleneinstellung  (Hardware setup)  

Das Programm unterstützt acht serielle (COM1 bis COM8) und drei parallele Schnittstellen (LPT1 bis LPT3).  Stellen Sie 
für jede benötigte (und vorhandene) Schnittstelle die korrekten Einzelheiten ein. 
 
Radio  : Ersetzen Sie für die Schnittstelle(n), an die Ihr(e) Transceiver angeschlosssen ist (sind), den Eintrag None   durch 
den/die angeschlossenen Transceivertypen 
Digital  : Machen Sie einen Haken an der Schnittstelle, an der ein externes RTTY/PSK-Modem angeschlossen ist (z.B. 
PK-232 oder PTC-2) 
Packet  : Machen Sie einen Haken bei der Schnittstelle, an der der Packet-TNC angeschlossen ist 
Other  :  Sie können weitere Transceiver, PTCs oder TNC anschliessen 
Details  : Bei angewählten Schnittstellen, ist die Taste SET aktiv. Mit ihr werden Baudrate, Datenformat, Belegung der 
Steuerleitungen wie DTR und RTS, Transceiveradresse u.a. abhängig vom angeschlossenen Gerät (Transceiver, TNC 
u.a.) in einem weiteren Menü eingestellt.  

20.2 Mauszuordnungen (Mouse Assignments):  

• rechter Mausklick : ein Menü wird geöffnet  
o Help  (Hilfe) : die zum Fenster gehörende Hilfe wird geöffnet  

20.2.1.1 Einzelheiten (Details)  
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Hier ist ein Transceiver  (kein ICOM-Gerät) angeschlossen 

 

Hier ist Digital  oder Other  für einen seriellen Port gewählt worden 

 

Bei dieser seriellen Schnittstelle wurde DTR=CW und RTS=PTT  
gewählt, die getastet werden sollen 

 

Hier wird die parallele Schnittstelle mit Other  für CW und PTT gewählt 
(Pin 16 und 17 liegen fest) 

Es gibt mehr Einstellungsvarianten als die Bilder zeigen können  : 

• Speed  :  Baudrate an der Schnittstelle. Prüfen Sie das Handbuch des anzuschliessenden Geräts. 
Die Baudrate muss auf beiden Seiten gleich eingestellt werden  

• Parity  : Prüfbit, meist N (kein Prüfbit). Weitere Möglichkeiten E (EveN=gerade) oder O 
(Odd=ungerade). Siehe Gerätehandbuch !  

• Data Bits : Datenbits : Meist 8. Siehe Gerätehandbuch !  
• Stop Bits   : Stoppbits(s), meist 1, mitunter auch 2 (voreingestellt ist 2 für Nicht-ICOM-Geräte). Siehe 

Gerätehandbuch !  
• DTR : Steuersignal “Data Terminal Ready”. Wird für Steuerfunktionen genutzt. Belegt Pin 4 am DB9-

Steckverbinder:  
o PTT : Push to Talk, schaltet Transceiver auf Senden  
o CW : tastet die Tastleitung des Transceivers 
o Always on  : immer an (etwa + 12 V)  (wichtig, wenn Interface über die Schnittstelle 

versorgt wird) 
o Always off  : immer aus  (etwa -12 V) 
o Handshake  : verwendet vom Datenaustauschsprotokoll 

• RTS - Steuersignal “Ready To Send”. Wird für Steuerfunktionen genutzt. Belegt Pin 7 am DB9-
Steckverbinder  

o PTT :  Push to Talk, schaltet Transceiver auf Senden  
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o Always on  :  immer an (etwa + 12 V)  (wichtig, wenn Interface über die Schnittstelle 
versorgt wird) 

o Always off  :  immer aus  (etwa -12 V) 
o Handshake  : verwendet vom Datenaustauschsprotokoll 

• Icom Addr (hex)  : Hexadezimale Adresse eines ICOM-Geräts. Wird nur angezeigt, wenn ein ICOM-
Gerät ausgewählt wurde. Einzugeben ist die Hexa-Adresse ohne H, z.B. 56 statt 56H für einen IC-
746 

• CW Speed  : Startwert für die CW-Geschwindigkeit. Voreingestellt ist 30 wpm. Wird nur angezeigt, 
wenn CW angewählt wurde 

• Radio Nr  : Transceiver, für den die Einstellung gilt.  
o SO2V ( ein Transceiver mit zwei VFOs) :  

� 1 – beide VFOs werden gesteuert 
� 2 –VFO A wird gesteuert, VFO B wird manuell gesteuert 
� Both : beide VFOs werden manuelle gesteuert  
� Vergessen Sie nicht, unter LPT keying für Radio 1 (voreingestellt) auf BOTH 

zu ändern, sonst wird VFO B nicht getastet.  
o SO2R  wählen Sie, ob Transceiver 1 oder 2 an diesen Port angeschlossen ist . 

• PTT Delay (mSec)  : Verzögerung zwischen Umschalten auf Senden und dem ersten CW-Zeichen 
(CW) oder dem Start der WAV-Datei (SSB) 

• Radio PTT  via command : Umschalten auf Senden über die CAT-Schnittstelle. Hier ist die 
Verzögerungszeit auf 40 ms voreingestellt und über PTT delay (mSec) editierbar 

• WinKey :  Ankreuzen, wenn ein WinKey-CW-Interface verwendet wird. Speed, Parity, Data bits oder 
Stop bits werden vom Programm gesetzt. Das kommerzielle Interface Winkey hat eine eigene 
Karteikarte innerhalb der Konfiguration 

• CW/PTT Port Addr  : Portadresse für parallele oder serielle Schnittstelle 
o Wenn sowohl RTS als auch DTR auf PTT gesetzt wurden, gilt für beide die eingestellte 

PTT-Verzögerung (PTT delay). 
o Packet verwendet zum Handshaking RTS + XON/XOFF. 
o Wenn Sie ein aus der Schnittstelle gespeistes Interface verwenden, setzen Sie RTS 

und DTR auf always on  
o Hinweis : die verwendete Portadresse muss mit der von Windows verwendeten 

übereinstimmen ! 
• DVK : Das DVK Interface von W9XT und andere DVK's werden auch für die Aufzeichnung 

unterstützt.  

 
Hinweis : Wenn Sie auf CW schalten und Ihr Transceiver hat zwei VFOs, stellen Sie ihn auf Radio 1. Geben Sie für 
Ihren zweiten Transceiver Radio 2 an und definieren für diesen Transceiver eine zweite Tastleitung.   

20.2.1.2 Telnet-DXCluster (Telnet cluster)  

• Telnet Cluster :  Internetadresse des Telnet-DXClusters für das Packetfenster  

• Edit  : Liste der Telnet-DXCluster anwählen und/oder editieren  

20.2.2 Andere Informationen (Other information)  

Sie können Transceiver-CAT und PTT-Leitung  an der gleichen Schnittstelle anschliessen. 
Wenn Sie den/die  Sender über  LPT1, LPT2 or LPT3 tasten wollen, liegen zusätzliche Informationen an der parallelen 
Schnittstelle an. Siehe Kapitel  Transceiveranschluss für Einzelheiten.  Mit Help erreichen Sie die zugehörige Hilfe. 

20.2.3 Windows NT/2000/XP (32 bit OS)  

Unter den 32-Bit-Betriebssystemen müssen Sie spezielle DLLs laden, damit die parallelen und seriellen Schnittstellen 
unter N1MMLogger richtig arbeiten. Sie benötigen DLPortIO.dll , das in dem Paket dlportio.zip  enthalten ist. Siehe 
Kapitel  Installation .  

Folgend Sie den Angaben im Kapitel 3.2, speziell dem Abschnitt  Automatically Installing the DriverLINX driver. Von dem 
dicken Paket werden nur einige zig Kbytes für einen Rechner unter WinXP benötigt.  

20.3 Karteikarte Dateien (Files tab)  

Mit dieser Karteikarte wird der Pfad zu einem Buckmaster-Callbook eingestellt.   
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20.3.1 Feldbeschreibung (Field descriptions)  

• Callsign database path (Pfad für die Rufzeichen-Datenbank): Verzeichnisnamen für die Buckmaster-
Rufzeichenbasis. Stellen Sie sicher, dass die Adresse vollständig mit den ‘\’ eingetragen ist. Haben 
Sie eine CDROM im Laufwerk, ist die Adresse z.B. E:\HAM0\, beachten Sie den ‘\’ am Ende. Achten 
Sie weiterhin darauf, dass die Datei HAMCAL32.DLL von der CD in das Verzeichnis von 
N1MMLogger kopiert worden ist. Diese Datei steht bei älteren CDs im Verzeichnis \API\WINDOWS 
directory. Auf neueren CDs müssen Sie es suchen. 
Anmerkung DM3ML : Die RAC (flying horse) – CD lässt sich nicht einbinden, sri.  
 

• Recorded wav file path (Pfad für die WAV.-Dateien) : In diesem Verzeichnis werden die 
aufgezeichneten WAV-Dateien auf der Festplatte abgelegt. Es wird ein Unterverzeichnis mit dem 
Contestnamen angelegt- .  

20.4 Karteikarte Funktionstasten (Function Keys tab)  

Mit dieser  Karteikarte wird vor allem die Zuordnung der F-Tasten zu den Bestandteilen eines Contest-QSOs eingestellt :   
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20.4.1 Feldbeschreibung (Field descriptions)  

• Monitor via PC speaker  : CW-Mithörton über den PC-Lautsprecher, OK bei Windows 95, 98, ME, 
aber abgeschaltet bei NT/2000/XP-Maschinen  

• Send Corrected Call  (Before End of QSO Msg) : Wurde während des QSOs das Rufzeichen der 
Gegenstation korrigiert, wird ihr Rufzeichen zusammen mit der End of QSO Message 
(abschliessende Bestätigung) noch einmal wiederholt, z.B. PA1M TU DE N1MM anstelle von TU DE 
N1MM.   
Anmerkung DM3ML : unbedingt zuschalten ! 

• Send Partial Calls  : Nur in CW. Es wird nur der korrigierte Rufzeichenteil (Präfix oder Suffix) 
wiederholt. Falls nicht angewählt, wird das volle Rufzeichen gesendet.  

• Work Dupes  :  Stationen können mehrfach und ohne Aufruf der QSO B4 – Taste gesendet. Normal 
ist, dass Stationen nicht doppelt gearbeitet werden sollen. Siehe Kapitel Sonstiges . 

• Use Contest Word Spacing for  CW : Der Wortabstand wird verkürzt. So besteht z.B. N1MM 599 5 
aus 3 Worten. Bei contest spacing (Kontestabstand) wird der Wortabstand von 7 auf 6 Punktlängen 
verringert.  

• Send leading zeros  in serial numbers (e.g. TT7) : Die Contestnummern werden in CW mit 
eingefügten abgekürzten Nullen (T) auf das Format XXX verlängert. Einstellige Nummer werden auf 
TTX, zweistellige auf TXX erweitert. Aus 007 wird TT7 und aus 69 wird T69, In RTTY werden richtige 
Nullen ergänzt, z.B. statt 45 wird 045 gesendet. Kombinationen der Einstellungen wie 1TT oder 1T9 
werden nicht akzeptiert. 

• Stop Sending CQ  when Callsign changed : Die Eingabe eines Rufzeichens in das Rufzeichenfeld 
des Logeingabefensters stoppt unmittelbar den (wiederholten) CQ-Ruf  

• Fill in his exchange  when sending yours (ESM mode) : Im ESM-Modus bleibt der Cursor im 
Rufzeichenfeld, bis Sie die Leertaste drücken, so dass Sie, während Sie selbst die Kontrollnummer 
senden, die empfangene Nummer eintragen können.  

• String to use on CW  between his call key and exchange key (default is one space) – Zeichenkette 
zwischen Rufzeichen und Kontrollnummer. Normal ist ein Zwischenraum, man kann aber auch ein ' 
ur ' einfügen  

• Keycode of Ins Key Substitude  : Code der Taste der Tastatur, die für die Funktion Einfügen (Ins) 
genommen werden soll (wie im Programm CT). Voreingestellt ist 186, das Semikolon  ;. Das 
Programm kann automatisch einen Code in das Feld einsetzen. Setzen Sie den Mauscursor in das 
Feld und drücken Sie auf die Taste, deren Code übernommen werden soll. Je nach Tastatur und 
Ländercode ergeben sich unterschiedliche Werte. Sie können auch Kombinationen mit Shift, CTRL 
und ALT wählen. Nehmen Sie NICHT das + vom Nummernfeld, das ist schon vergeben. 
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• Keycode of TU/Log Key Substitude  : Code der Taste der Tastatur, die für die Funktion TU/Log Key 
genommen werden soll. Voreingestellt ist 222, das  ' – Zeichen.  Für die Einstellung gilt das im 
vorhergehenden Punkt gesagte. 

•  

In der unten auf der Karte stehenden Feldern werden die programmierten F-Tasten den Bestandteilen eines Contest-
QSOs zugewiesen. Die folgenden Bestandteile können gewählt werden :  

• CQ Key    CQ-rufen 
• Exchange Key   Kontrollnummer senden 
• End of QSO Key  Bestätigung/QSO-Ende 
• His Call Key   Rufzeichen der Gegenstation 
• My Call Key   eigenes Rufzeichen 
• QSO B4 Key= QSO before  schon gearbeitet ! Wird automatisch ausgelöst,  

                                                wenn ein DUPE erkannt wird  
• Again Key   nochmal, bitte wiederholen 

In der Regel braucht die voreingestellte Zuordnung nicht geändert werden. Werden vor allem beim ESM-Modus falsche 
Text gesendet, liegt der Fehler meist bei dieser Zuordnungstabelle. 

20.5 Karteikarte Digimodes (Digital Modes tab)  

 

Mit dieser Karteikarte werden Kontroller (TU=Terminal-Unit) an seriellen Schnittstellen und das Programm (hier MMTTY) 
für die digitalen Sendearten eingestellt :  

20.5.1 Feldbeschreibung (Field descriptions)  

• Digital Interface 1 / 2  
o TU type (Terminal Unit typ) 

� Other (andere) wie  KAM, PK232, PTC und andere externe Kontroller  
� MMTTY : Soundkartenprogramm von Mako, JE3HHT  

o Port, Speed, Parity, Data Bits, Stop Bits, Flow Control : Schnittstelleneinstellungen für 
unter Other angeschlossene Kontroller  
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• MMTTY Window Settings (Fenstereinstellungen)  
o Normal MMTTY Window : Das MMTTY-Fenster wird in normaler Grösse angezeigt 
o Small MMTTY Window: ein kleines MMTTY-Fenster wird angezeigt 
o MMTTY always on Top : Das MMTTY-Fenster ist immer über den N1MMLogger-

Fenster zu sehen 
• DI-1 MMTTY Mode | DI-2 MMTTY mode  

o Bei  MMTTY wird  die Sendertastung über AFSK (über die Soundkarte) oder FSK 
(direkt am Transceiver)  gewählt 

o Bei FSK muss die benötigte Schnittstelle im MMTTY-Setup eingestellt werden. Die 
Wahl über N1MMLogger ist nicht möglich. 

• DI-1 MMTTY Path | DI-2 MMTTY Path  
o Hier ist der Pfad zur MMTTY-Maschine (MMTTY.exe) einschliesslich des 

Programmnamens einzutragen 
o MMTTY kann, aber muss nicht im N1MMLogger-Verzeichnis stehen 
o Mit der Select–Taste kann nach dem Programm gesucht werden 
o DI-1 gilt für das erste Digital-Interface, DI-2 für das zweite Digital-Interface 
o Sie können zweimal MMTTY wählen 

20.6 Karteikarte Anderes (Other tab)  

 

Mit dieser Karteikarte können Sie verschiedene voreingestellte Werte ändern und spezielle Funktionen wählen :  

20.6.1 Feldbeschreibung (Field descriptions)  

• Packet Spot Time (min)   : Gibt die Zeit vor, in der DX-Spots in den Bandskalen 
angezeigt werden. Voreingestellt ist 60min, jede ganze Zahl  ist möglich.  

• Volume level  : Hier kann die Summen-Lautstärke (MAIN)  am Lautsprecherausgang 
der Soundkarte eingestellt werden. Möglich sind Werte zwischen 0 und 65536 
(Maximum). Voreingestellt ist der Wert 40000. Er muss so korrigiert werden, das 
der Transceivers voll- aber nicht übersteuert wird. Stellen Sie den Wert so ein, 
dass die ALC innerhalb ihrer Grenze bleibt. Sie können die Steuerung der 
Soundkarte durch N1MMLogger durch Eintrag von -1 abschalten und müssen die 
Amplitude dann mit den Windowsschieberegler einstellen. Die Vorgabe durch das 
Programm führt zu reproduzierbaren Einstellungen von Contest zu Contest.  
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• Wav Volume level  : Hier stellen Sie den Windowsschieberegler WAV ein. Es gelten 
die gleichen Hinweise wie im Punkt zuvor.  

• Repeat time in millisecs  : Wiederholzeit der CQ-Rufe in CW und SSB (über WAV-
Datei). Voreingestellt sind 1,8 s. Sie können den Wert in Sekunden oder 
Millisekunden eingeben, maximal sind 32767 möglich. Sie können die Einstellung 
auch mit CTRL-R oder Config > Set CQ repeat time im Logeingabefenster 
vornehmen. 

• Default # Spots in SH/DX/#  : Zahl der mit SH/DX aus der Bandskala abgerufenen 
DX-Spots, Voreingestellt ist die Zahl 30. Die editierbaren SH/SX-Tasten im 
Packet/Telnet-Fenster werden davon nicht beeinflusst und sind getrennt 
einstellbar. 

• SSB Tuning Tolerance (Hz)  : Wenn Sie in SSB auf der Bandskala in die Nähe 
eines Spots kommen, wird das Rufzeichen im Eingabefenster bereitgestellt. Mit 
dem unter diesem Punkt einstellbaren Wert geben Sie vor, bei welchem Abstand 
die Übernahme erfolgt. Möglich sind Werte zwischen 0 und 1000 Hz, 
voreingestellt sind 300 Hz. 

• CW Tuning Tolerance (Hz)  : gleicher Wert wie oben, hier für CW 
• RTTY Tuning Tolerance (Hz ) : gleicher Wert, hier für RTTY 
• CW Weight  : stellt das Punkt-Pausen-Verhältnis ein, voreingestellt ist 50.  
• SSB Up/Down Arrow Incr (kHz)  : Abstimminkrement in Hz mit den Pfeiltasten in 

SSB.  
Hinweis : Stellen Sie diesen Wert nie kleiner als der Transceiver machen kann. 
Bei älteren ICOM-Geräten ist dieser Schritt 100 Hz. und damit ziemlich groß. 
Wählen Sie ihn kleiner, passiert nichts. 

• CW Up/Down Arrow Incr (kHz)  : dto. für CW. Hier gilt 10 Hz als kleinster Schritt für 
die meisten Geräte. 

• PgUp/PgDn Incr (kHz) : Abstimminkrement in Hz mit den Bild-Auf/Bild-Ab-Tasten 
• Format for DXSpider Cluster  : Format der richtigen SH/DX-Anforderung für  

DXSpider – Cluster, z.B. sh/dx/30 on 20 . Anstelle von SH/BUCK  wird SH/QRZ 
gesendet. Fragen Sie mit SH/VER beim Cluster an, um welchen Cluster-Typ es 
sich handelt, ein DX-Spider antwortet z.B. mit DX Spider Cluster . Schaltet Sie 
diese Funktion bei einem „normalen“ DXCluster ab.  

•  Auto-Completion Mode : Wenn Sie diese Funktion freigeben, werden 
Rufzeichen sofort komplettiert, wenn Sie bei der Rufzeichenprüfung als 
eindeutig (UNIQUE) erkannt worden sind. Sie können aber weiter eingeben 
und den Vorschlag der Programms überschreiben.  

20.7 Karteikarte Winkey (Winkey tab)  
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Mit dieser Karteilkarte wird die Tastelektronik Winkey  von K1EL eingestellt  

Winkey  ist ein von K1EL und G3WGV entwickelte Tastelektronik, die mit verschiedenen Windows-Programmen 
zusammenarbeitet und in erster Linie die Verfälschung der CW-Tastung durch die Zeitscheibentastung von Windows bei 
Multitasking abstellen soll. Winkey bekommt die Information als ASCII-Zeichen über eine serielle Schnittstelle und 
konvertiert sie in CW. Siehe auch Links zu Hardware  und unterstützte Hardware . Sie benötigen lediglich eine freie 
serielle Schnittstelle, die Sie mit Other  wählen und auf der sich öffnenden Karteikarte einen Haken in das Feld Winkey 
machen. 
Winkey wird dann mit der vorgestellten Karteikarte eingestellt.  

20.7.1 Feldbeschreibung (Field descriptions)  

• Keying Mode  : Art der Tastung wählen :  Iambic A, Iambic A, Ultimatic und Semi-
Automatic. Voreingestellt ist Iambic-B.  

• Pot is wired with two leads  : Geschwindigkeits-POT ist nur mit zwei Drähten 
angeschlossen  

• Pin 5 Function  : Funktion von Pin 5 
• PTT )voreingestellt) 
• , Mithörton 
•  2nd CW.  Voreingestellt ist PTT.   

• Sidetone Frequency  : Mithörton-Frequenz, voreingestellt ist 469 Hz.  
• Autospace  : Auto-Zwischenraum wählen  

20.8 Karteikarte Sendeartensteuerung (Mode Control tab)  
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Mit dem Dialog wird eingestellt, wie die QSOs geloggt werden und ob und wie die Sendeart im Log vom Transceiver 
gesteuert werden kann. 
Vom Bandplan werden im Moment CW und SSB unterstützt.  
Hinweis DM3ML  : Der Bandplan gilt für IARU-Region 2 und sollte editiert werden.  

20.8.1 Feldbeschreibung (Field descriptions)  

• Mode recorded in log  : Sendearteneintrag im Log   
o Use radio mode  : Sendeart vom Transceiver auslesen 
o Follow band plan  : Sendeart aus dem internen Bandplan entnehmen 

(voreingestellt) 
o Use contest mode or bandplan  : hat der Contest nur eine Sendeart, wird 

diese genommen. Bei Mixed wird die Sendeart aus dem Bandplan 
genommen. 

o Use contest or radio mode  : hat der Contest nur eine Sendeart, wird diese 
genommen. Bei Mixed wird die Sendeart vom Transceiver ausgelesen 

o Always : Sendeart wie hier vorgegeben nehmen 
• Mode sent to radio  : Sendeart am Transceiver einstellen   

o Don't change radio mode : Sendeart nicht ändern 
o Follow mode recorded in log  : stelle Sendeart wie in der Tabelle gewählt 

(voreingestellt) 
o Except change Log mode RTTY to  : wähle Sendeart für RTTY 

• Except change (Änderung annehmen):  
o Log mode RTTY to Radio mode : Transceivereinstellung übernehmen, 

wenn das Log auf RTTY eingestellt ist 
o Log mode PSK to  Radio mode  : Transceivereinstellung übernehmen, wenn 

das Log auf PSK eingestellt ist 

20.9 Karteikarte Antennen (Antennas tab)  
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Mit dieser Karteikarte wird vorgegeben,  wann welche Antenne mit dem zu installierenden Antennenwahlschalter auf 
einem Band zugeschaltet werden soll. Der Kode wird über die parallele Schnittstelle an einen Top-Ten-Antennenschalter 
ausgegeben. Einzelheiten finden Sie im Kapitel  Weitere Geräte an der parallelen Schnittstelle.  

Mit CTRL-F11 schalten Sie die für das aktuelle Band spezifizierten Antennen der Reihe nach durch. Ist nur eine Antenne 
vorgesehen, bleibt diese eingeschaltet. Beim Bandwechsel wird immer die Antennen mit dem niedrigsten Code als erste 
angeschaltet. Die gewählte Antenne wird in der Statuszeile des Logeingabefensters mit ihrem unter Antenna  
eingetragenen Namen angezeigt. 

• Code : An das Top-Ten-Gerät ausgegebener Zahlenwert  
• Jeder Code repräsentiert EINE Antenne, nicht das Band 
• Der Code wird als 4-Bit-Wort an den Pins 9,8,7,2 der parallelen 

Schnittstelle ausgegeben 
• Antenna  : Frei wählbarer sinnvoller Antennenname 
• Bands  : Band/Bänder, auf denen die Antenne verwendet werden kann 

• Geben Sie die Bandbezeichnung in MHz ein, z.B. 1.8, 3.5, 7 usw. 
• Eine Antenne kann auf mehreren Bändern genutzt werden  
• Die Bänder sind durch Kommas zu trennen 

20.10 SO2R/V-Unterstützung (SO2R/V Setup)  
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Diese Karteikarte ist noch in Arbeit………………  

21. Contest auswählen (Select Log Type Dialog) 

Wollen Sie Ihren Computer für einen neuen Contest vorbereiten, wählen Sie im Menü File > Choose contest > Start a 
new log for a contest . Dieses Fenster öffnet sich :  
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21.1 Überblick (General)  

Sie sollten sich damit vertraut machen, wie N1MMLogger seine QSOs abspeichert. Die QSOs werden in einer ACCESS-
2000-Datenbank abgelegt. In der Datenbank können mehrere Conteste gespeichert. Die Contest-Information wird in zwei 
Tabellen angeordnet. Eine Tabelle nimmt die QSOs auf, die andere die Contestinformation, wie sie in die vorliegende 
Karteikarte eingetragen wird. In dieser zweiten Tabelle steht auch das Startdatum des Contest. Das Startdatum hat 
keinen Einfluss darauf, welche QSOs mit dem Contest in Verbindung gebracht werden. Wenn Sie ein QSO speichern 
während ein bestimmter Contest ausgewählt wurde, wird es diesem Contest zugeordnet unabhängig davon ob zu dem 
Contest gehört oder nicht. Das Contestdatum wird nur zur Identifikation eines Contests herangezogen.  
 Wenn Sie einen Contest löschen wollen, klicken Sie auf den Contestnamen in der Liste Previous Contest (frühere 
Conteste) drücken Sie dann auf die Löschtaste (Entf ).  

In der Vorlage zu den Contesten sind die richtigen Einträge voreingestellt.  

Log Type : Die Contestart DX können Sie als normales Kurzwellen-Log für alle Tage mit allen Bändern einschliesslich 
der WARC-Bänder  und Sendearten verwenden.   

Die wählbaren Conteste finden Sie unter unterstützte Conteste. 

 
Hinweis  : Stellen Sie sicher, dass Sie jeweils die aktuell e und gültige Länderliste  CTY.DAT verwenden. Sie 
können Sie aus dem Internet mit den Werkzeugen von N1MMLogger aktualisieren .. 
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21.2 Feldbeschreibung (Field explanations) 

 
•  
• Log Type : wählen Sie den gewünschten Contest   
• Start date : Startdatum des Contests  
• Teilnehmerkategorie  (Operator category):   

Möglich sind :  
o SINGLE-OP  
o SINGLE-OP-ASSISTED  
o MULTI-ONE  
o MULTI-TWO  
o MULTI-MULTI  
o SCHOOL-CLUB  
o CHECKLOG  
o SINGLE-OP-PORTABLE  
o ROVER  
o MULTI-UNLIMITED  
o MULTI-LIMITED  

• Bandkategorie  (Band category) :   
Möglich sind :   

o ALL  
o 160M  
o 80M  
o 40M  
o 20M  
o 15M  
o 10M  
o LIMITED  

• Leistungsklasse (Power Category) :   
Möglich sind :  

o HIGH  
o LOW  
o QRP  

• Sendeart (Mode Category):   
Möglich sind :  

o CW  
o SSB  
o RTTY  
o MIXED  

• Overlay Category :   
Möglich sind :  

o N/A 
o ROOKIE 
o BAND-LIMITED 
o TB-WIRES (tri-bander and wires) 
o OVER-50 
o HQ 

Die Overlay Category kann in den Contesten CQ-WPX CW und CQ-WPX-SSB in jeder Kombination mit  ROOKIE, 
BAND-LIMITED, TB-WIRES eingetragen werden. Beim  STEW-PERRY gibt es die OVER-50. Im IARU-HF gibt es die 
bekannten  HQ (Head Quarter = Hauptquartier). 

• Claimed score:  Für diesen Contest von N1MMLogger berechnete Punktzahl  

• Show Rules : Stellt Verbindung zur Internetseite des Contestveranstalters her und gibt die Regeln 
aus (Internet – Anbindung benötigt) 

• Sent Exchange (Kontrollnummer) :  Hängt vom Contest ab und enthält 
contestabhängig die Contestnummer, die Zone, eine Provinz u.ä.   

• In dieses Feld wird nur der Austausch, nicht das RS(T) eingetragen !!  

• Operators:  Tragen Sie hier alle Rufzeichen der Operator ein. Mit der Taste Update 
Ops from Log  erreichen Sie den gleichen Effekt. 

• Update Ops from Log :  Diese Taste holt alle Operator aus dem Log in dieses Feld  
• Soapbox comments ( Kommentare zum Contest) : Wird als Kommentar zu 

Bedingungen oder Ergebnissen dem Log angehängt. Das Feld wird bei Wahl eines 
neuen Contest gelöscht.  

• Master.DTA Filename (Rufzeichendatei) :  Für verschiedene Conteste werden 
verschiedene Master.dta-Dateien (Check Partial File) bereitgestellt. Standard ist die 
mit N1MMLogger mitgelieferte Datei Master.dta. Es sind aber auch Dateien für 
europäische VHF-Conteste oder RTTY-Conteste mit spezifischen Angaben 
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beschaffbar. Mit der Auswahl kann man die für den Contest zutreffende Master.dat-
Datei aufrufen. Sie kann auch einen von Master.dat abweichenden Namen haben, 
muss aber zum Contest passen. Die Master.dta-Dateien enthalten aus Contesten 
bekannte Namen, ergänzt durch Vornamen, WW-Locator, benutzte Bänder u.ä. Mit 
den Werkzeugen von N1MMLogger können die Master.dta-Dateien aktualisiert 
werden.  

• Help  : holt die zu dieser Seite gehörende Hilfe 

• Ok : Einstellungen abspeichern und Seite verlassen 

• Cancel   : Einstellungen verwerfen und Seite verlassen 

22. Statistiken (Statistics) 

Sie erreichen die Statistiken überView > Statistics .  

22.1 Überblick (General)  

Mit dem Werkzeug Statistiken können Sie einen Contest nach allen möglichen Gesichtspunkten auswählen. Sie können 
nahezu alle Datenbankfelder miteinander kombinieren und verschiedene Statistiken aufstellen und drucken. Folgende 
Felder der Datenbank können gewählt werden :  

Feld  Reihe  Spalte  Bemerkungen 

Band       

Operator     Operator im Multi-Betrieb vergleichen  

Hour       

RadioNr     sinnvoll nur bei mehreren Transceivern 

Mode     nur für mixed-Conteste sinnvoll 

CountryPrefix    Stationen je Land oder Prefix 

Zone      

Section    vor allem für US-interne Conteste  

CK    2-stellige Nummer in Sweepstake-Contesten 

Prec    Precedence aus Sweepstakes  

Points      

Mult1    erster Multi im Contest (falls verwendbar) 

Mult2    zweiter Multi s im Contest (falls verwendbar) 

Mult3    dritter Multi im Contest (falls verwendbar) 

WPXPrefix    WPX-Prefix  

GridSquare    Großfeld (vierstellig) 

Run1Run2    bei SO2R-Betrieb verwendbar  

MiscText    Contest spezifische Information  

ContactType    Leer = QSO, "D" = dupe, "N" = nicht arbeitbare Station 

Day    erster oder zweiter Contest-Tag  

Mult & Band      

 
 Hinweis : Alte Conteste haben möglicherweise nicht alle Felder ausgefüllt. 

22.2 Tastenzuordnung (Button Assignments)  

• Row  : Wähle eine Reihe aus  

• Column  : Wähle eine Spalte aus 

• Refresh  : Tabelleninhalt auffrischen. Die Tabellen werden nicht autoamtisch 
aktualisiert, wenn ein QSO dazu gekommen ist oder gestrichen wurde   

o Das Statistikfenster wird mit einem neuen Contest aufgefrischt.  

22.2.1 Dateien-Menü (File Menu)  

• Print  : Druckt die Statistiktabelle. Schriftart kann vom Nutzer gewählt werden. 

• Print to File   : Ausgabe in eine Datei  
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22.3 Beispiele (Example statistics)  

 

 

 
23. RTTY-Überblick (General RTTY information  
23.1 Einführung (General info) 

Stellen Sie am Transceiver ein : :  

• Audio processing (Comp, Kompressor) :  AUS  
• Sprachprozessor (Speech processing) :  AUS  
• Hi boost (Kenwood) : AUS  

• Transceiver auf LSB   
• Auch in Contesten wird ausschliesslich 45 Baud (60 words/min) eingestellt  
• Die Standard –SHIFT ist 170 Hz  
• Stellen Sie am TNC die MARK-Frequenz auf 2125 Hz und SPACE auf  2295 Hz ein  
• Fahren Sie Ihre Endstufe nicht zu hart und stellen Sie   

• 50% der maximalen Leistung ein 
• stellen Sie die NF-Amplitude des TNC so ein, dass die ALC gerade noch 

nicht anspricht (DM3ML)  
• informieren Sie sich unter Geräteanschluss über Tipps zum Interface  

• Der BAUDOT-Zeichensatz enthält nicht alle ASCII-Zeichen wie  ~ * _ @ # = und kann 
diese Zeichen nicht senden und empfangen.  
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23.2 Übliche RTTY-Frequenzen (Common RTTY Frequencies)  

USA (kHz)  USA (kHz)  Europe/Africa (kHz)  

Common DX freq. Common 

1800 - 1840 1830 - 1840  

3605 - 3645 3590 3580 - 3620 

7080 - 7100 7040 7035 - 7045 

10140 - 10150  10140 - 10150 

14070 - 14099,5  14080 - 14100 

18100 - 18110  18100 - 18110 

21070 - 21100  21080 - 21120 

24920 - 24930  24920 - 24930 

28070 - 28150  28050 - 28150 

23.3 Einführung in RTTY (General RTTY info)  

von Rich, VE3IAY (gekürzt von DM3ML) 

Der 5-Bit-Baudot-Kode hat nur Platz für 25 = 32 Zeichen, die für 26 Zeichen und 6 Steuerzeichen verwendet werden. Um 
mehr Zeichen unterzubringen, kann mit drei der Steuerzeichen zwischen zwei (bei manchen Maschinen auch drei) 
Registern zu je 26 Zeichen umgeschaltet werden. Im Buchstabenregister (Bu oder LTRS) werden 26 Alphazeichen und 
im Ziffernregister (Zi, FIGS) werden 10 Zahlen und 16 Satzzeichen (Punkt, Komma, Doppelpunkt usw.) untergebracht. 
Ein drittes Register gibt es bei Maschinen für Fremdsprachen wie Russisch.  
Wie die anderen Zeichen kann durch QRM oder QSB auch ein Steuerzeichen für die Registerumschaltung verloren 
gehen. Dabei werden dann Ziffern als Buchstaben ausgegeben, aus 599 wird TOO,  aus 73 wird UE und aus der 
Seriennummer 012 wird PQW 

Mit Hilfe von Computerprogrammen ist es möglich, diese Klemmer bei mechanischen Maschinen am PC zu beheben. Je 
nach Programm wird in einem zweiten Empfangsfenster der Text im anderen Register ausgegeben oder bei einem Klick 
auf ein falsch kodiertes Wort erscheint das Wort im Kode des anderen Registers. Mit MMTTY im Stand-alone-Modus 
kann ein Wort umkodiert werden. Im digitalen Fenster von N1MM können Sie den gleichen Effekt mit einem Rechtsklick 
ins DI-Fenster bewirken und dann die Maus auf das falsch kodierte Wort setzen.  

Eine weitere Vorsichtsmassnahme ist die USOS-Funktion, bei der bei jedem erkannten Zwischenraum (Space) 
zwangsweise in das Buchstabenregister (LTRS) zurück geschaltet wird. Jede neue Zifferngruppe muss dann wieder mit 
einem Umschaltkommando ins Ziffernregister (FIGS)eingeleitet werden. 
Wenn bei 599-123-123 das Zi-Kommando nicht erkannt wird, kommt TOOAQWEAQWE heraus. Wenn Sie aber 599 123 
123 123 mit USOS, wird vor jeder Zahlengruppe ein FIGS-Kommando eingefügt und in der Regel höchsten eine 
Dreiergruppe verfälscht.  
Eine als TOOQWE mitgeschriebene Kontrollnummer muss dann mit den oben genannten Werkzeugen in 599123 
umgewandelt werden. 

23.4 Informationen zu MMTTY (MMTTY info)  

• NOTCH : Schaltet das Notch-Filter ein/aus. Mit einem rechten Klick in den 
Wasserfall setzen Sie die Notchfrequenz. Sie können mit einem zweiten 
Klick auf eine andere Frequenz ein zweites Notchfilter einschalten. 

• Demodulator selection   (Wahl des Demodulators) :   
• IIR :  Infinite Impulse Response  
• FIR - Finite Impulse Response (meist verwendet)  
• PLL - Phase Lock Loop filter 

• Mark frequency selection  : MARK-Frequenz,  Standard auf HF ist 2125 
Hz (USA).  

• Shift width selection  : Frequenzhub (Shift) zwischen MARK und SPACE. 
Standardwert 170 Hz. Bei LSB ist die MARK-Frequenz  2125 Hz und die 
SPACE-Frequenz  2295 Hz.  Die MARK-Frequenz ist die jeweils höhere auf 
der HF-Seite und markiert die RTTY-Frequenz bei Skeds, DXSpots u.ä.  

• AFC :  Automatic Frequency Control (automatische Frequenznachführung). 
Dient der Feinabstimmung und Nachstimmung bei driftenden Signalen.  

• NET : Netzbetrieb. Sende- gleich Empfangsfrequenz. Normal = EIN. 
Ausschalten, bei Splitbetrieb oder stark driftender Gegenstation.  
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• BPF (Bandpassfilter) :  Schaltet das Sende-TX-BPF zu und ab (unnötig bei 
FSK-Betrieb)  

• REV : Invertiert die MARK-SPACE-Lage bei Empfang. Senden immer in der 
Normallage (DM3ML : bei USB am Transceiver TX UND RX invertierten) .  

• SQL : Empfangsschwelle (Squelch) ein- oder ausschalten. Signale unter 
der Squelch-Schwelle werden nicht dekodiert. Mit dem Squelch kann man 
schwache Signale unterdrücken und verhindern, dass Müll ausgegeben 
wird.  

• ATC : Automatische Schwellensteuerung (Automatic Threshold Control) : 
Regelt die NF-Amplitude der Soundkarte in Abhängigkeit vom 
Eingangssignal  

• HAM : voreingestellte Werte für Amateurfunkbetrieb werden eingestellt : 
MARK-Frequenz, Shift,  Bandbreite BW,  Baud-Rate,· LPF,· AV.,· 
Demodulator.   

23.5 Einige RTTY-Links (Some RTTY links)  

RTTY  

• RTTY contesting (by AA5AU) http://www.rttycontesting.com/  
o Nice tutorial 'Getting started on RTTY'. 

• SM3CER Contest Service  http://www.sk3bg.se/contest/  

• World RTTY Contest Scene (by DJ3NG)  http://www.rtty-contest-scene.com/  

• RTTY.com   http://www.rtty.com/  

• Jim's Gazette  http://www.n2hos.com/digital/  

MMTTY  

• Infos und Download-Seiten von MMTTY auf der Webseite von Ken, VE5KC : 
http://www.qsl.net/mmhamsoft/  

• Internetgruppe von KB4IJ at http://groups.yahoo.com/group/MMTTY  

24. RTTY-Unterstützung (RTTY Support) 

Das RTTY-Interface des N1MMLoggers arbeitet mit MMTTY und JEDEM externen Kontroller zusammen. Die 
Kommandos für die Kontroller (TNCs) wurden im N1MMLogger nicht hart programmiert, sondern werden vom Nutzer 
vorgegeben. 
  

 
Hinweis : Gehen Sie bei Problemen zum digitalen Teil der FAQs   

24.1 Die digitale Schnittstelle  (The Digital Interface)  

Die digitale Schnittstelle von N1MMLogger kann zusammen mit einem externen TNC oder dem Soundkartenprogramm 
MMTTY genutzt werden. Sie können die digitale Schnittstelle über den Menüpunkt Window > Digital Interface  öffnen :  
Das Fenster des Fernschreib-Interfaces für einen TNC sieht so aus :  
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Dieses Fenster gehört zu MMTTY  mit Spektrum und XY-Scope :.  
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Dieses Fenster zeigt die Mitschrift eines QSOs im oberen Teil (RX-Fenster). Ist ein zweites RTTY-Interface in der 
Konfiguration eingestellt worden, kann über dieses Fenster mit einem Menüpunkt das zweite Interface geöffnet werden.  
Die genaue Frequenz wird in der Kopfleiste des Fensters angezeigt und aus der Transceiverfrequenz +/- NF-Frequenz 
berechnet.  

Das Interface hat zwei Fenster :   

• Oberes Fenster = Empfangsfenster:  Ein im Empfangsfenster ausgegebenes 
Rufzeichen kann durch einen Einfachklick ins Logeingabefenster übertragen werden. 
Lassen Sie dem Klick einen Druck auf die Leertaste folgen, wird das Rufzeichen 
zusätzlich in das Grab-Fenster übertragen, aus dem es mit einem Klick ins 
Logeingabefenster gesetzt werden kann. Mit eingeschaltetem Bu>Zi-Konverter 
(LTRS/FIGS Converter) können Sie – wenn Sie z.B. statt 599 nur TOO sehen, mit der 
Maus über diesem Text die Buchstaben in Ziffern konvertieren und die 
Kontrollnummer doch noch entschlüsseln. 
Wenn Sie auf die farbige Fläche links im Fenster klicken, können Sie die 
Textausgabe in das RX-Fenster anhalten (Pause), das Fenster wird gelb und Sie 
können den Text mit dem Scrollbalken durchrollen. Die letzten 2000 Zeilen stehen 
Ihnen zur Verfügung. Wenn Sie wieder in die farbige Fläche links klicken wird der 
inzwischen eingelaufene Text am Ende des bisherigen Textes ausgegeben. 

• Unteres Fenster = Sendefenster : Wenn Sie auf die TX-Taste drücken, wird der 
Cursor in das Sendefenster gesetzt und gesendet, was Sie in dieses Fenster 
eingeben. Die Fenstergrösse ist auf 2 Zeilen festgelegt und kann nicht geändert 
werden. 
Gilt nur für TNC-Nutzer : Wenn Sie nicht auf Senden geschaltet haben, wird alles was 
Sie hier eingeben an den TNC gesendet. Sie können also auch Kommandos an den 
TNC schicken um Einstellungen zu ändern.  

• Rufzeichenfenster und Grab -Taste  : Wenn in einem der Empfangsfenster ein 
Rufzeichen gefolgt von einem Zwischenraum festgestellt wird, wird es in das 
Rufzeichenfenster eingetragen. Wenn Sie die Taste Grab  (=greifen) anklicken, wird 
dieses Rufzeichen über dem Rufzeichenfeld im Logeingabefenster bereitgestellt. Im 
Rufzeichenfenster werden die letzten vier Rufzeichen angezeigt. Das jeweils zuletzt 
empfangene Rufzeichen steht hellgetastet oben in der Liste. Auch DUPE-Rufzeichen 
werden in diesem Fenster angezeigt.  

• Makrotasten (Macro buttons) : Die 24 Makrotasten können Sie mit 
vorprogrammierten Texten belegen. Für die Programmierung steht ein Satz von 
Makros zur Verfügung.  Sie können die Tasten über das Menü Setup > Settings aus 
dem Digitalen Fenster heraus oder über einen Rechtsklick auf die gewünschte Taste 
programmieren Die Tastengrösse wird nach der Fenstergrösse eingestellt.  

• Clr RX  : Löscht das Empfangsfenster  
• TX :  schaltet auf Senden. Diese Taste erscheint nur, wenn MMTTY gewählt wurde  
• RX: beendet die RTTY-Sendung und schaltet den Transceiver auf Empfang. Auch 

diese Taste erscheint nur in Zusammenhang mit MMTTY  
• Grab  : Übernimmt das angewählte Rufzeichen in das Logeingabefenster. Die 

Übergabe ist nur mit der Maus möglich. Ein weiterer Klick überschreibt das vorher 
übernommene  Rufzeichen.  

Sie können zwei RTTY-Fenster zur gleichen Zeit offen haben. Sie öffnen das zweite Fenster aus dem ersten digitalen 
Fenster heraus mit einem Klick auf Open 2nd RTTY Window . Mit dieser Möglichkeit können Sie MMTTY und einen TNC 
parallel laufen lassen oder zwei Transceiver mit zwei TNCs betreiben. Sie müssen aber die Makrotasten im zweiten 
Fenster getrennt vom ersten Fenster programmieren, sie stimmen nicht überein. 

 
Der Mauscursor (Focus) wird autoamtisch in das Loge ingabefenster gesetzt, wenn Sie auf ein Rufzeichen im 
Empfangsfenster klicken . 

24.2 Einstellmenü (Setup Menu Selections)  

24.2.1 Anwahl MMTTY  (Selection: MMTTY) 

• Setup  
o Settings  : stellt das digitale Interface ein (s.u.) 
o SoundCard  : gilt für das zuerst geöffnete MMTTY-Fenster  

� Receive Mixer  : Öffnet das Windowsfenster zur Einstellung des 
Empfangspegels. Das Menü erscheint nur, wenn MMTTY gewählt wurde  

� Transmit Mixer  : Öffnet das Windowsfenster zur Einstellung des 
Sendepegels.   

o Setup MMTTY : Öffnet das MMTTY-Einstellmenü.  Das Menü erscheint nur, wenn 
MMTTY gewählt wurde  

o AFC On/Off with CQ  : falls gesetzt, wird die AFC nach CQ oder dem QSO-Ende 
eingeschaltet 

o NET On/Off with Run Change  : schaltet die NET-Funktion von MMTTY im S&P-
Modus an und im Runnning-Modus ab 
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o Auto Update TRX Offset w/Mark Freq.  : Führt den Transceiver-Offset nach, wenn 
sich die MARK-Frequenz ändert. Gespeichert wird die MARK-Frequenz bei AFSK-
RTTY. 

• Mode  
o RTTY : schaltet auf RTTY 
o PSK – schaltet auf PSK  

• Open 2nd Rtty Window  : Öffnet das in der Konfiguration auf der Karteilkarte Digimodes eingestellte 
zweite digitale Interface, z.B. PTC zusätzlich zu MMTTY 

• Help  : zeigt die Hilfe an  

24.2.2 Anwahl: externer TNC  (Selection: OTHER)  

• Setup  
o Settings  : Einstellung des Interfaces für den TNC (s.u.) 
o Load TNC Settings File  : eine vorher abgespeicherte Datei "SETTINGS.TXT" kann für 

den TNC geladen werden. Mitgeliefert wird eine Datei von Rick, N2AMG, für den PK-
232 

• Mode  
o RTTY - schaltet auf RTTY Select RTTY as mode 
o PSK - schaltet auf PSK  

 
• Help  : zeigt die Hilfe an 

24.3 Tastaturzuordnungen (Keyboard Assignments)  

• Alt-T  : schaltet zwischen RX und TX um, bei TX steht der Cursor im Sendefenster  
• Alt-G  : Rufzeichen übernehmen ( Grab callsign) .  
• CTRL+Pfeil links/rechts  :  wenn 2 Transceiver und 2 digitale Fenster konfiguriert wurden, schaltet 

CTRL+Pfeil links/rechts von einem aktiven Digital-Interface auf das andere um. Das digitale Interface 
1 (DI1) gehört zu Transceiver 1 und Bandskala A und das digitale Interface (DI2) gehört zu 
Transceiver 2 und Bandskala B. 

24.4 Einfügetaste (Insert key Assignments)  

    Modus 
     

Enter Sends 
Message 

(ESM mode)  
    Die Einfg-Taste oder das ‘;’ bewirkt :  

RUN 

und  

S&P 

AUS 

• Hole das Rufzeichen aus der Liste, falls das Rufzeichenfeld leer ist oder verwende 
das eingetragene Rufzeichen 

• Sende-Kontrollnummer ausfüllen 
• KEIN DUPE:  Sende F5 (Hiscall) + F2 (Exchange) 

oder   
DUPE: Sende nichts 

RUN  EIN 

• Hole das Rufzeichen aus der Liste, falls das Rufzeichenfeld leer ist oder verwende 
das eingetragene Rufzeichen 

• Sende-Kontrollnummer ausfüllen 
• KEIN DUPE:  Sende F5 (Hiscall) + F2 (Exchange  

oder  
DUPE 
WorkDupes aktiv : F5 (Hiscall) + F2 (Exchange) senden 
WorkDupes abgeschaltet : Taste F6 (Dupe) senden  

• Cursor geht in das Feld zum Kontrollnummernempfang  
• F8 helltasten 

S&P  EIN  

• Hole das Rufzeichen aus der Liste, falls das Rufzeichenfeld leer ist oder verwende 
das eingetragene Rufzeichen 

• Sende-Kontrollnummer ausfüllen 
• NO DUPE: F4 (Mycall) senden 

oder  
DUPE 
WorkDupes aktiv : F5 (Hiscall) + F2 (Exchange) senden 
WorkDupes abgeschaltet : F6(Dupe) senden 

• Cursor geht in das Feld zum Kontrollnummernempfang  
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Wenn die Einfg -Taste oder das Seminkolon ; gedrückt wird und das Rufzeichenfeld nicht leer ist, wird der Text F2+F5 
gesendet. Ist das Rufzeichenfeld leer, wird ein Rufzeichen aus der Grab-Liste geholt. Wenn ein Rufzeichen aus der 
Grab-Liste übernommen wurde, wird es in dieser Liste gelöscht. Wenn das empfangene Rufzeichen schon im 
Logeingabefenster steht, wird es nicht in die Grab-Liste eingetragen. 

24.5 Mauszuordnungen  (Mouse Assignments)  

• Linker Mausklick 
o Ein einfacher Klick  auf ein Rufzeichen setzt das Rufzeichen über das Rufzeichenfeld 

im Eingabefenster  
o Ein einfacher Klick auf die empfangene Kontrollnummer setzt sie in das zugehörige 

Fenster des Logeingabefensters. Vorher muss aber ein Rufzeichen eingetragen 
worden sein. 

• Rechter Mausklick in das RX- oder TX-Fenster bringt ein Menü :  
o Clear RX : Löscht Empfangsfenster Clear the receive window  
o Clear TX  : Löscht Sendefenster  
o Output to Text File  : empfangener Text wird als Datei abgespeichert. Die Namen der 

Dateien sind je nach Fenster und Sendeart bezeichnet mit PSKCH1.txt, PSKCH2.txt, 
RTTY1.txt, und RTTY2.txt. 

o LTRS/FIGS Convert  : Wandelt mit Maus berührten Text in das jeweils andere 
Register, z.B. aus TOO wird 599  

o Help  : ruft die Hilfe für dieses Fenster 
• Rechter Mausklick in das GRAB- Fenster öffnetein Menü : 

o Clear List  : Löscht die Liste  
o Clear Selected Call :  löscht ein gewähltes Rufzeichen 

24.6 Konfiguration der Makrotasten im Logeingabefenster  (Konfiguring the Entry window function keys)  

Wählen Sie im Logeingabefenster das Menü Config > Change Packet/CW/SSB/Digital Message Butto ns > Change  
Digital Buttons  . Dieses Fenster öffnet sich :  

 

24.7 Makrotasten (Macro keys)  

• Maximal 24 Tasten können mit Makros belegt werden  
• Mit einem rechten Mausklick auf eine Taste kommen Sie in das Editiermenü für die Tasten  
• Die Tasten unterstützen alle Makros, aber sie unterscheiden nicht nach Running- oder S&P-Modus  
• Sehen Sie auf jedem Fall je eine Taste mit dem Code für den TNC zum Schalten auf Senden und 

Rückschalten auf Empfang vor  
• Die Tasten im PSK-Fenster und im Logeingabefenster unterstützen ebenfalls die Makros. Siehe 

Makros    
• Informieren Sie sich über spezifische Markros in den Kapiteln TNC-Interface und MMTTY-Interface.  

24.7.1 TNC-Interface  (The TNC interface)  

Das TNC-Interface akzeptiert alle Makros, die im Packet-Fenster und an anderen Stellen des Programms verwendet 
werden. Zusätzlich können folgende CTRL- und Tastencodes in dieser Schreibweise verwendet werden :   

{CTRL-A}  {CTRL-B}  {CTRL-C}  {CTRL-D}  {CTRL-E}  {CTRL-F}  {CTRL-G}  
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{CTRL-H}  {CTRL-I}  {CTRL-J}  {CTRL-K}  {CTRL-L}  {CTRL-M}  {CTRL-N}  

{CTRL-O}  {CTRL-P}  {CTRL-Q}  {CTRL-R}  {CTRL-S}  {CTRL-T}  {CTRL-U}  

{CTRL-V}  {CTRL-W}  {CTRL-X}  {CTRL-Y}  {CTRL-Z}  {ESC}  {ENTER}  

Im TX-Fenster können ebenfalls alle CTRL-Tasten verwendet werden. Anstelle der ESC-Taste muss die Kombination 
Shift+ESC eingesetzt werden. Ein einfaches ESC setzt den Cursor in Logeingabefenster.  
Für den TNC ist eine spezielle Taste vorzusehen : Die allererste Taste muss mit dem Abbruch-Kommando (Abort) belegt 
werden. Ich habe mit dem Text ABORT bezeichnet und sie rot eingefärbt. Immer dann, wenn Sie während des Sendens 
auf die ESC-Taste drücken, wird dieses Makro an den TNC gesendet und unterbricht die Sendung sofort. 
Berücksichtigen Sie weiterhin, dass immer dann, wenn Sie ein Makro, das einen Text und kein Kommando enthält, der 
TNC vorher erst auf Senden geschaltet werden muss. Sonst hat er Probleme, die Ausgabe zu verstehen. Die 
Textausgabe muss in der Regel mit einem CTRL-Code eingeleitet und zum Rückschalten auf Empfang mit einem 
weiteren CTRL-Code beendet werden. 
Sie können auch getrennt Makros zum Schalten auf Senden und zum Rückschalten auf Empfang anklicken und den zu 
sendenden Text in das TX-Fenster eingeben. 

24.7.2 MMTTY-Interface (The MMTTY interface)  

• Die Makros für das Programm MMTTY unterscheiden sich von den Makros für einen TNC. Auf 
Senden wird mit dem Makro {TX} und auf Empfang mit {RX} geschaltet. 

• Unter MMTTY kann jede Sendung mit ESC abgebrochen werden  
• Die TX- und RX-Tasten im TX-Fenster können bei der freien Eingabe ins TX-Fenster zum 

Umschalten genommen werden 
• MMTTY lädt beim Neustart jeweils die letzte verwendete Einstellung von der letzten Nutzung des 

Programms 
• Digital-Interface einstellen (Setting up the Digital interface) 

Wenn Sie den Menüpunkt Settings  im digitalen Fenster anklicken, öffnet sich dieses Fenster :   
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• PSK Waterfall Color palette (PSK-Wasserfall-Farbpal ette) :  Sie könne die 12 Farben für den 
Wasserfall Ihren Wünschen anpassen. Die Farben laufen vom schwächsten Signal links bis zum 
stärksten rechts. Diese Farben sind editierbar und aktiv, wenn im Wasserfall die Version User 
Defined (Nutzer definiert) gewählt wird. Sie kann mit der Taste Default  auf den voreingestellten 
Wert zurück gesetzt werden. 

• Waterfall Color  (Farbe des Wasserfalls) wählbar :   
o Grey Scale (Grauskala) 
o Default Color (voreingestellte Farben) 
o User Defined (Nutzer definiert)  

• Smoothing  (Glättung) : einstellbar zwischen 0 und 10  

• Gain  (Verstärkung) : stellt Signalamplitude für Spektrum bzw. Wasserfall ein 

• Squelch Speed  ( Reaktionsgeschwindigkeit des Squelchs) : Wählbar zwischen langsam, schnell 
und variabel. Unter variabel   ist ein Wert zwischen 0 und 200 einstellbar. 

• Squelch Level  (Squelchschwelle) : Signale unterhalb der einstellbaren Schwelle werden nicht 
dekodiert. Bei 0 ist der Squelch unwirksam und alle Signale einschliesslich des Rauschens 
werden in Zeichen umgewandelt. 

• AFC Search Range  (Arbeitsbereich der automatischen Frequenznachstimmung) : Bereich in Hz, 
in dem einem driftenden Signal gefolgt wird  

• Use Doppler AFC  (Doppler-AFC verwenden) 

• RX Search Range (Fangbereich bei Empfang) : Bereich in Hz, in dem um den angeklickten 
Punkt im Wasserfall nach einem Signal gesucht und darauf eingerastet wird 

• # of PSK channels  : zu verwendende PSK-Kanalzahl, möglich sind 2, 3 oder 4.  
• RX/TX Font Size (Schriftgrösse) : einstellbar 8pt, 10pt, or 12pt 
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• PSK/RTTY Window Colors  (Fensterfarben) : für die PSK- und RTTY-Empfangs- und 
Sendefenster wird hier die Hintergrundfarbe eingestellt 

• SndCard Clock Adj  (Abgleich des Soundkartentakts)  

• CW ID : Falls freigegeben wird nach jeder Sendung der eingetragene Text in CW gesendet 

• PSK Soundcard Select : Verwendete Soundkarte, wenn mehr als eine Karte im PC eingebaut ist 

• RX Window Font Selection   : Einstellung von Schriftart und –größe. Drücken Sie die Taste Set 
Font  , um ins Einstellfenster zu kommen. 

• Send Space on Callsign Mouse Click  : In das Logeingabefenster kann ein Zwischenraum beim 
Klick auf ein Rufzeichen gesendet werdenn. Freigabe mit diesem Menüpunkt. 

• (MMTTY) Send HamDefault on Run to S&P change  : Falls freigegeben, wird beim Umschalten 
von Run auf S&P die MARK-Frequenz auf den voreingestellten Wert zurückgesetzt. 

• {MMTTY-PSK) Turn AFC Off when switching to S&P  : Falls freigegeben, wird die AFC  für 
MMTTY-PSK beim Übergang von Run zu S&P abgeschaltet. 

• {PSK} Do not send Squelch tail  : Abschaltung des TX-Nachlaufs bei PSK, um einen 
schnelleren Betriebsablauf zu bewirken. 

• Save Configuration  : Einstellungen abspeichern. Falls das Abspeichern nicht geschieht, klicken 
Sie auf das Kreuz rechts oben um das Fenster zu schliessen. 

 

• Digital Macro Set  : aktualisieren der Makros und der Tastentexte 
o Wählen Sie im Menü Select  das zugehörige Interface  PSK, MMTTY 1, Other 1, 

MMTTY 2, Other 2  
o Klicken Sie auf die Makrotaste, deren Text geändert werden soll 
o Geben Sie den Text in das Feld Macro Text ein 
o Geben Sie in das Feld Macro Caption  den Text für den Tastennamen ein 
o Klicken Sie auf Save Macro , wenn Sie zufrieden sind  
o Die Taste trägt den gewählten Tastennamen  
o Im Fenster Available Macros  stehen die vom Programm zur Verfügung gestellten 

Makros. Wählen Sie erst eine zu programmierende Taste, um die Makros zu sehen.  
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o Unterhalb des Felds für die CW ID befinden sich zwei zusätzliche Tasten, die für TX 
und RX  programmiert werden. Geben Sie die zutreffenden Codes den TNC ein. Die 
Tasten sind nur bei Other1 oder Other2 zu sehen.  

o Wenn Other1 oder Other2 gewählt wurde :   
� RX  : Empfangs-Makro  
� TX  : Sende-Makro  
� ESC : Abbruch  

o Load Macros  : Mit dieser Taste kann ein abgespeicherter Makro-Satz 
(Dateierweiterung *.mc) geladen werden  

o Save Macros  : Speichern Sie den editierten Makrosatz als Datei *.mc ab  
o # of Macros  : Anzahl der angezeigten Tasten wählbar mit  0, 8, 16 oder 24  
o Macro Text : Eingabefeld für das aktuelle Makro   
o Macro caption  : Name der Taste  
o Available Macros  : zur Verfügung stehende Makros. Mit einem Klick werden 

sie in das Textfeld übertragen 
o Save Configuration  : Speichern und Schliessen der Konfiguration. Soll sie 

nicht gespeichert werden, klicken Sie auf das Kreuz ganz rechts oben im 
Fenster 

Alle Änderungen müssen mit der Taste Save Configuration  gespeichert werden. Die Taste befindet sich unten auf dem 
Fenster. Alle Änderungen werden gespeichert, sobald das Fenster geschlossen wird.  

24.8 Externen TNC testen  (Test your External TNC)  

Testen Sie zuerst die Kommunikation zwischen PC und TNC mit einem einfachen Terminalprogramm. Zu Windows wird 
das Programm Hyperterm mitgeliefert, mit dem Sie die serielle Schnittstelle, an der Ihr TNC angeschlossen ist, testen 
können. Notieren Sie sich die an der COM-Schnittstelle eingestellten Werte (Baudrate, Datenformat). Sie sollten unter 
Hyperterm mit dem TNC kommunizieren und RTTY mitschreiben können.  

Das Interface wurde mit drei kommerziellen TNC getestet und arbeitete einwandfrei. Andere TNC sollten ebenfalls 
problemlos funktionieren, wenn Sie die entsprechenden Kommandos in den Makros einsetzen.  

24.8.1 KAM  

• Starten Sie Hyperterm mit 9600 Baud, 8-Databits, keine Parität,1 Stopbit und keine ‚Flow control‘ 
• Schließen Sie den KAM an die angewählte Schnittstelle an und schalten ihn ein  
• Erscheint die Nachricht "Press (*) zum Setzen der Baudrate, drücken Sie "*"   
• Geben Sie Ihr Rufzeichen auf Anfrage ein 
• Schalten Sie mit “RTTY” auf RTTY  
• Stellen Sie XFLOW = ON ein.  
• Jetzt ist alles bereit. Legen Sie ein RTTY-Signal an. Das dekodierte RTTY-Signal sollte auf dem 

Bildschirm ausgegeben werden  
• Gehen Sie auf eine freie Frequenz. Geben Sie Ctrl-C gefolgt von "T" auf der Tastatur und einen zu 

sendenden Text ein. Schalten Sie mit Ctrl-C und a "R" wieder auf Empfang.  
• Bei Problemen lesen Sie im KAM-Handbuch nach  
• Verlassen Sie das Terminalprogramm und starten Sie N1MMLogger 

•  
So sehen die RTTY-Einstellungen in RTTY für den KAM-TNC aus :  

AUTOCR 0 AUTOLF ON AUTOSTRT OFF 

BKONDEL ON CD SOFTWARE CRADD OFF 

DIDDLE ON ECHO ON FILTER OFF 

FSKINV OFF INVERT OFF LFSUP OFF 

LOWTONES OFF MARK 2125HZ RBAUD 45 

SHIFT 170 SPACE 2295HZ USOS ON 

XFLOW ON XMITECHO ON     

24.8.2 SCS PTC 

• Testen Sie den PTC mit einem anderen Digimodeprogramm wie  ALPHA (by DH7RG), XPWIN (By 
KF7XP), LOGGER (by K4CY)  
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• Setzten Sie den PTC auf SERBAUD 19200  (nicht AUTO  !) > schalten Sie den PTC aus  
• Starten Sie N1MMLogger und stellen Sie mit ‚ Config > Configure Ports, Telnet Address, Other > 

Digital Modes‘ das ‚Digital Interface 1‘ auf OTHER, und stellen Sie den verwendeten COM-Port auf 
19200 Baud, N-8-1-none. Setzen Sie das ‚Digital Interface 2‘ auf ‚NONE‘  

• Starten Sie den N1MMLogger und unter ‚Window ‘ das RTTY/MMTTY Interface.  
• Stellen Sie sicher, dass der PTC an der programmierten Schnittstelle steckt und schalten Sie den 

PTC ein. Nach dem Einschalten des PTC muss seine Startmeldung mit dem Prompt ‚cmd:‘ 
erscheinen. Falls nicht, müssen Sie den Anschluss überprüfen. 

• Gehen Sie in das untere (weiße) Fester und geben Sie über die Tastatur ‚ESC+Shift bau 45‘ gefolgt 
von ENTER ein. Der PTC schaltet auf RTTY (sehen Sie auf die Anzeige am PTC) . Mit ‚ESC-Shift  
term 1‘ gefolgt von  ENTER gibt der PTC den im Eingabefenster eingegebenen Text beim Senden im 
Empfangsfenster wieder aus (delayed echo). 

 

 
Hinweis : ESC ohne Shift schaltet den Kursor ins Eingabefenster. Geben Sie das ESC als Shift-ESC ein. Ein ESC im 
PTC-Eingabefenster wird als schwarzes Quadrat dargestellt.   

 
 

• Jetzt ist alles bereit. Legen Sie ein RTTY-Signal an. Das dekodierte RTTY-Signal sollte auf dem 
Bildschirm ausgegeben werden  

• Geben Sie zum Test einen zu sendenden Text ein und schalten Sie mit CTRL-Y auf Senden. Der 
Text wird gesendet  und erscheint als Echo im Empfangsfenster 

• Im RTTY-Fenster sind weitere Fixtest-Tasten bereitgestellt. Die erste (oben links) MUSS das Abort-
Kommando zum Abbruch der AUTO-CQ-Funktion enthalten. Klicken Sie mir der rechten Maustaste 
auf das Tastenfeld, wählen Sie im sich öffnenden Menü den ‚Digital Macro Set = OTHER 1‘ mit 
{ESC}dd}ENTER}{ESC}bau 45{ENTER} oder mit {ESC}CLR{ENTER} 

• Programmieren Sie eine weitere Taste zur Umschaltung des PTC in den RTTY-Modus mit dem 
Namen RTTY und dem Macro {ESC}dd{ENTER}{ESC}bau 45{ENTER}{ESC}term 1{ENTER} 
Verwenden Sie dieses Macro, wenn Sie N1MMLogger starten und/oder wenn Sie den PTC 
einschalten. 

• Belegen Sie eine weitere Taste mit dem Namen TX/RX und dem Macro {CTRL-Y}, dann können Sie 
auf Senden und zurück auf Empfang schalten. 

• Programmieren Sie die anderen Tasten nach Ihren Vorstellungen. Sie werden für den Contest selbst 
nicht oder nur zum Senden zusätzlicher Texte benötigt. Sie können mit den Macros wie  
!, *, DATE, TIME etc. und {CTRL-Y} ganze QSO-Texte erzeugen 

• Unter Makros finden Sie Beispiele für solche Texte 
 

24.8.3 PK-232 

• Stellen Sie sicher, dass der PK232 auf ‚Autobaud‘ und ‚RTTY‘ geschaltet ist  
• Starten Sie das Windowsprogramm Hyperterm und setzten Sie es auf 1200 Baud, 8- Datenbits, keine 

Parität, 2 Stopbits und ‚no flow control‘.  
• Schließen Sie den PK232 an die unter Hyperterm gewählte Schnittstelle an  
• Schalten Sie den PK232 ein  
• Geben Sie ein paar "*" ein, so dass Ihr PK232 die 1200-Baud-Rate erkennt  
• Schalten Sie den PK232 auf RTTY durch Eingabe von "BAUDOT" . Er zeigt als OPMODE jetzt BAUDOT 

an.  
• Drehen Sie den Schwellenregler (Threshold) im Uhrzeigersinn bis die LED leuchtet  
• Schalten Sie die Software auf XFLOW = ON (Handshacking)  
• Geben Sie auf einer freien Frequenz ein X gefolgt von anderen Zeichen ein, die Sie senden wollen. 

Beenden Sie wieder auf Empfang mit Ctrl-C und "R".  
• Bei Problemen lesen Sie im PK232-Handbuch nach 
• Verlassen Sie das Terminalprogramm und starten Sie N1MMLogger.  

 

24.9 Kontroller einstellen 
24.9.1 PK-232 mit N1MMLogger einstellen (Setting up the PK -232) 

John VK4WPX / VK4CEJ  

Es ist sehr einfach, den  PK-232 für RTTY einzustellen :  

• Gehen Sie zu Config > Configure Ports, Telnet addresses, Other  
• Klicken Sie auf die Hardware-Karteikarte  
• Machen Sie an einer freien COM-Schnittstelle (hier COM2)  einen Haken in das Feld Digital  
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• Klicken Sie jetzt auf die Karteikarte Digital Modes und stellen Sie die Werte für das  Digital Interface 1 
ein : .  

• Hier sind für den PK-232 eingestellt : 9600 Baud, kein Prüfbit (N), 8 Datenbits und 1 Stoppbit (8N1), kein 
Protokoll (none) 
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Anschliessend können Sie die Texte für die F-Tasten und die Makro-Tasten eingeben :  

• Ersetzen Sie in einem existierenden Makro die Einstellung für das Makro {TX}  mit  {CTRL-
C}Xmit{ENTER}  

• Vergessen Sie das {ENTER}  am Schluss nicht  
• Sie können auch alle {TX} or {RX} durch ein {CTRL-D} ersetzen 
• Beispiel für Taste F1 = CQ mit dem Makro  {CTRL-C}Xmit{ENTER}CQ CQ CQ DE * * * K{CTRL-D}  
• Beispiel für Taste F5 = Sende Rufzeichen der Gegenstation : {CTRL-C}Xmit{ENTER}!  
• Mit diesem Makro bleibt der Transceiver auf Senden, schalten Sie bei Bedarf mit CTRL-D von Hand 

wieder auf Empfang  

24.9.2 KAM einstellen (Setting up the KAM ) 

Sie müssen drei Schritte vornehmen, um den KAM mit N1MM-Logger zu koppeln :   

1. Port-Konfiguration  
o beim KAM sollten die Kontrollmarken auf digital stehen 

2. Schnittstelle Digital configuration  
o Stellen Sie unter Configure > Hardware  eine freie Schnittstelle auf  9600 

Baud, N,8,1 und none 
3. Makros für den KAM  

o Umschalten auf Senden {TX} :  {CTRL-C}T  
o Umschalten auf Empfang {RX}: {CTRL-C}E  
o Abbruchkommando {ESC} :  {CTRL-C}R  
o Beispiel für ein CQ-Makro :   

� CQ macro: {TX} CQ CQ CQ DE W3PP W3PP W3PP KKK {RX} 

24.9.3 HAL-DXP38 einstellen (Setting up the HAL DXP38) 

Brian, K3KO 
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Mit den folgenden Einstellungen können Sie den  HAL DXP38 TNC in FSK mit N1MMLogger betreiben. AFSK ist im 
Prinzip möglich, ich würde es aber nicht empfehlen. Die Implementation ist nicht sehr elegant, sie erfüllt aber ihren 
Zweck. Sie können den eingebauten Abstimmindikator über Makros ansprechen. Ich bedanke mich bei N2AMG für die 
Zuarbeit bei der Anpassung der HAL-Kommandos 
N1MMLogger und der DXP38 können nur im Kommando-Modus miteinander kommunizieren. Eine Fehlerprüfung – und 
korrektur ist nicht zu erwarten. Es wird vorausgesetzt, dass der DXP38 beim Einschalten seine interne Software lädt. 
Eine Aktualisierung dieser Software muss extern und mit den HAL-Programmen erfolgen. Die neuesten Dateien LOD und 
.S28 können Sie von der HAL-Seite http://www.halcomm.com holen. Eine Aktualisierung ist vor allem bei PTT-Problemen 
zu empfehlen. Verwenden Sie die Sendearten LSB RTTY für FSK oder LSB für AFSK..  

24.9.3.1 Hardware-Einstellungen (Hardware Set-up) 

Der DXP38 sollte vorher mit einem bekannten Programm wie WF1B, HAL oder einem anderen als funktionierend 
bekanntem Programm getestet werden, um sich den Ärger mit der Hardware und Software zu ersparen. Dann kann die 
N1MMLogger-Einstellung wie folgt vorgenommen werden :  

• PTT und FSK-Leitungen zwischen PC und Transceiver anschliessen 
• TNC mit COM-Schnittstelle verbinden (COM1 bei HAL-Software)  
• RX-NF an den Eingang des DXP-38 anschliessen  
• Stromversorgung anschliessen 
• Falls benötigt AFSK-Ausgang an den Transceiver anschliessen (nur bei AFSK-Betrieb)  
• Handbuch des DXP-38 nach Einzelheiten abfragen. Der Transceiver muss auf  FSK RTTY (LSB) oder 

LSB für AFSK stehen.. 

24.9.3.2 Programmeinstellung für N1MMLogger (Software Setup in N1MM logger) 

Im N1MMLogger müssen drei Bereiche für den HAL DSP38 eingestellt werden. Stellen Sie sicher, dass N1MMLogger die 
hexadezimalen Kommandos für den DXP38 unterstützt (ab Version 3.0.187 und später).  

Schnittstellenkonfiguration 
• Für den DXP38 müssen die Signale  DTR/RTS immer auf always on stehen. 

 
Digitale Konfiguration 

• Wählen Sie eine freie Schnittsstelle und stellen Sie  9600 Baud, N,8,1 und no handshaking. ein. 
o Wenn möglich, sollten Sie COM1 nehmen, ich habe es mit COM2 aber nicht probiert. Ich 

habe auch nicht zwei Kanäle gleichzeitig probiert. 
o bei mir läuft der DXP38 an der ersten Schnittstelle und MMTTY an der zweiten 

Schnittstelle  
 

Makros für den DXP38 
 

• Die Makros gelten für die 24 Makrotasten, nicht für die Funktionstasten..  
Wichtig : Dieser Prozess ist fehlerträchtig. Sichern Sie die MDB-Datei von N1MMLogger. Mitunter 
erscheint die Fehlermeldung  type mismatch. Sie ist nicht korrigierbar und zwingt dazu, die ganze 
Programmierung von N1MMLogger neu zu machen. Haben Sie die Datei gesichert, können Sie den 
Zustand von vorher wieder herstellen. Zu empfehlen ist auch eine schrittweise Makroerzeugung mit 
zwischengeschalteter Sicherung.   
 

• Kommandostruktur :  
 
Der  HAL DXP38 erwartet Kommandos im Format von zwei hexidezimalen Bytes. Das erste Byte ist eine 
hexidezimale 80 und das zweite Byte das eigentliche Kommando als hexidezimale Zahl. Bei einigen 
Kommandos folgt ein zweiter Satz von zwei Bytes mit den Parametern. Diese Kommandos sehen aus 
wie  {H8084} auf der Makroliste,  Die {} sagen N1MMLogger,   dass es sich um eine Funktion und nicht 
um Text handelt. Das H definiert die Zffern als Hexa-Zahl und sendet sie zum DXP38. Die erste Zahl ist 
immer eine 80.  
Hinweis : Es sind nur 0-9 und A-F erlaubt. Jeder andere Buchstaben zwischen den {} erzeugt den schon 
erwähnten type mismatch  und nicht vorhersehbare Folgen. Stehen Zeichen nicht zwischen {} werden 
sie als Text an den DXP38 geschickt und der TNC wird auf Senden geschaltet. DerTNC kehrt nur dann 
auf Empfang zurück, wenn das Makro {RX} erkannt wird. 

o Kommandofehler : ( anstelle von { , anstelle von 0 (Null) l (kleines L) anstelle von 1 
 

• Macro programming  
• Klicken Sie rechts auf eine leere Makrotaste. Das Makro-Editierfenster öffnet sich. Tragen Sie die 

Makros in der Form {H80xx} ein . Achten Sie auf die Syntax : ein H mit vier Hex-Ziffern. Speichern 
Sie due Makrodatei und die Konfiguration am. Das Beispiel steht unter dem Namen Other1.mc. .  

 
• Sie finden die HAL-Kommandos im Handbuch von DSP4100 TNC auf der HAL-Webseite 
• Der Ausdruck weiter unten zeigt ein Beispiel :   

� Das ESC-Makro unter TX und RX  
� Das INIZE-Makro unter Initialisierung.  
� Die Kommandos stehen auf einer Zeile, werden aber vom Editor zweizeilig 

dargestellt 
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� Das letzte Kommando schaltet auf Empfang (hexadezimal). Initialisert wird :  
FSK, BAUDOT, 45 Baud, normaler FSK-Mark, normale Töne, USOS ein, Zi-
Register ein, gleiche TX/RX-Polarität, Diddles ein, Squelch bei 15, PTT-
Verzögerung 200 ms für Senden und 100 ms fü Empfang, TX-Echo ein und 
Abstimmanzeige an.  

� Der Squelch-Pegel kann in dtrei Stufen eingestellt werden. Das zweite Wort des 
Makros enthält den Kode 80nn. nn ist der Squelch-Pege zwischen Null und 99. 
Die Einstellung hängt vom Transceiver ab und muss angepasst werden.  
RXnorm und RXinv erlauben die Invertierung des Empfangssignals. Mit  Echo y 
(echo yes) und Echo n (echo no) wird die Ausgabe des gesendeten Texts im 
Empfangsfenster gesteuert.  

� Fnar, Fmid, Fwide setzen die Filterbreite auf (55Hz, 75Hz, 100Hz).  
� B45 setzt die Baudrate auf 45 Baud. Erlaubt sind mit dem Kommando 800x mit  

x =1, 2, 3, 4, 5 die Baudraten  50, 57, 75, 100, 110 Baud. 
� Mit Tun on und Tun off  wird die Abstimmanzeige geschaltet. Die 

Abstimmanzeige bezieht sich auf eine einstellbare Mittenfrequenz. Probleme 
gibt es bei Einstellung dieser Mittenfrequenz.  

� Turn On using {H805D}  
� Turn Off using {H804D}  

�  

 

Beispiel – Makro von der N1MMLogger – Seite unter O ther files :  

*,- 
INIZE,{H8084}{H8085}{H80D1}{H80C0}{H80DB}{H80D3}{H805B}{H8089}{H80E3}{H8002}{H80ED}{H80
01} 
                     {H80E8}{H8037}{H8000}{H805D}{H8059}{H800E} 
*,- 
RXinv,{H804C} 
RXnorm,{H805C} 
Echo y,{H8059} 
*,- 
*,- 
SQlow,{H80E8}{H8015} 
SQmid,{H80E8}{H8037} 
SQhigh,{H80E8}{H8045} 
B45,{H80E4}{H8000}{H800E} 
*,- 
Echo n,{H8049} 



N1MMLogger-Hilfe V.4.0.88 Seite 101 von 227 Übersetzung von Eike, DM3ML 

*,- 
Tun Off,{H804D} 
Fnar,{H80EB}{H8000} 
Fmid,{H80EB}{H8001} 
Fwide,{H80EB}{H8002} 
*,- 
*,- 
*,- 
*,- 
Tun On,{H805D} 
TX,{H800D} 
RX,{H800E} 
ESC,{H8006} 

Erststart :  

• Starten Sie zuerst N1MM logger :  
Öffnen Sie den Empfangsschirm des TNC. Schalten Sie dann den DXP38 an. Ist die Verbindung zum 
PC in Ordnung, erscheint ein @ auf dem Schirm. Editieren Sie dann die Makros und sichern Sie sie. .  

• Weitere Starts :  
Schalten Sie den DXP38 ein. Starten Sie  N1MMLogger. Klicken Sie auf das Makro INIZ . Sie sollten 
den Ablauf der Initialisierung auf dem Schirm verfolgen können (siehe Bild oben). Sie können jetzt die 
Funktionstasten editieren. Setzen Sie ohne Einschränkung jeweils eine {RX} an das Ende. Nur das 
Rufzeichen im S&P-Modus kommt ohne{RX} aus. Die Rufzeichenübernahme (Grab) und die 
Insert(Einfg)-Taste funktionieren wie im CW-Contest.  
Beachten : Die Ini-Makris schalten den TNC auf Senden. Die anderen Makros machen das nur dann, 
wenn Sie Text, Leerzeichen oder {TX} enthalten. 

24.9.3.3 Bekannte Probleme (Known problems) 

Ich habe folgende Probleme gefunden :   

Start:  Mitunter verstehen sich DXP38 und N1MMLogger nicht. Der TNC nimmt die Initialisierungs-Kommandos nicht an. 
Schalten Sie den TNC aus und warten Sie  45 Sekunden. Beenden Sie N1MMLogger. Starten Sie den TNC und  warten 
Sie seine interne Initalisierung ab. (LED-Anzeige beachten). Starten Sie N1MMLogger wieder. Möglicherweise hatte ich 
das Problem nur mit COM3 und Ihnen passiert es nie.. 

Beenden : Jedes zweite Mal schaltet der DXP38 auf Senden, wenn ich N1MMLogger beende. Sie sollten den  DXP38 
als erstes ausschalten.  

24.10 MMTTY laden, konfigurieren und testen (Download, co nfigure and test MMTTY)  

24.10.1 MMTTY laden 

• Holen Sie sich die neueste Version von MMTTY von der Seite  http://www.qsl.net/mmhamsoft/  
Die Versionsnummer muss mindestens 1.64  sein 

• Installieren Sie MMTTY in ein eigenes Verzeichnis auf Ihrem PC  
• Installieren Sie MMTTY nicht in das N1MMLogger-Verzeichnis, wenn Sie eine Version von früher als 

7.Juli 2002 haben. Wenn Sie aus dieser Version MMTTY deinstallieren, wird auch N1MMLogger 
gelöscht. MMTTY-Versionen ab 1.164 haben einen neuen Installer und haben das Problem nicht mehr. 

• Die jeweilige NewExe von N1MMLogger enthält die Datei  XMMT.ocx, die für MMTTY Version 1.64 oder 
höher benötigt wird,  jeweils im Update. 

 
 

24.10.2 MMTTY konfigurieren 

FSK-Tastung (FSK KEYING)   

• Stellen Sie in der N1MMLogger-Konfiguration aus der Karteilkarte Digital Modes ein  :   
• MMTTY als Interfacetype 
• Das Verzeichnis, in dem MMTTY steht, falls es nicht in das N1MMLogger-Verzeichnis installiert wurde 
• Klicken Sie unter DI-1 MMTTY Mode auf FSK 
• Machen Sie in der N1MMLogger-Konfiguration auf der Karteilkarte Hardware  einen Haken in die Spalte 

digital bei der COM-Schnittstelle, die Sie für MMTTY verwenden wollen  
• Speichern und verlassen Sie MMTTY, wenn es schon offen ist, sonst bekommen Sie eine 

Fehlerausschrift wegen des neuen COM-Ports 
• Öffnen Sie über Windows > Digital Interface  das MMTTY-Programm und gehen Sie im digitalen Fenster 

zu Setup > Setup MMTTY  
• Wählen Sie im MMTTY-Setup die Karteikarte TX die Schnittstelle für die FSK-Tastung.  
• Schliessen das Setup-Fenster und auch das digitale Fenster. MMTTY speichert die Einstellungen.  
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• Ab sofort lädt MMTTY die gewählte Einstellung selbst 

RIGblaster für FSK mit N1MM/MMTTY verwenden  

Bei MMTTY wird  FSK über die Leitung TXD getastet. Sie brauchen den Jumper beim Rigblaster nicht zu ändern. Testen 
Sie die Einstellung vorher mit einem alleinstehenden (stand alone) MMTTY.  Testen Sie dann die Zusammenarbeit mit 
N1MMLogger. Falls Sie Ihren Kommando über ein PTT-Kommando per CAT einschalten können, nehmen Sie diese 
Möglichkeit.  
 

AFSK-Tastung (AFSK KEYING)  

• Stellen Sie in der N1MMLogger-Konfiguration aus der Karteilkarte Digital Modes ein     
• MMTTY als Interface 
• Das Verzeichnis, in dem MTTY steht, falls es nicht in das N1MMLogger-Verzeichnis installiert wurde 
• Klicken  Sie unter DI-1 MMTTY Mode auf AFSK 
• Machen Sie auf der Karteikarte Hardware einen Haken bei der COM-Schnittstelle in der Spalte Digital , 

die Sie für MMTTY verwenden wollen 

Wollen Sie MMTTY mit zwei Transceivern zweifach laufen lassen, müssen Sie zwei verschiedene Schnittstellen 
definieren. Die Schnittstelle für den zweiten Port muss eine höhere Nummer haben, als die erste. Siehe auch Kapitel 
SO2R  

24.10.3 MMTTY testen (Testing MMTTY)  

Testen Sie MMTTY als selbstständiges Programm ausserhalb von N1MMLogger. .  

24.10.4 MMTTY-Tipps  (Tips using MMTTY)  

RTTY  abstimmen 
•  
• Bringen Sie mit dem VFO die beiden gelben Linien im Spektrum auf Übereinstimmung mit den beiden 

Spitzen im Spektrum des empfangenen Signals  
• Stellen Sie sicher, dass Sie die HAM-Einstellung mit einem Klick auf diese Taste angewählt haben. Hier 

werden Baudrate, Shift und bevorzugte Mark-Frequenz voreingestellt  
• Prüfen Sie, ob Sie den TCVR auf LSB gestellt haben 
• Öffnen Sie das X-Y-Oszilloskop  
• Schalten Sie die AFCab, wenn starke Signale die Abstimmung auf ein gewünschtes Signal  verhindern 

und stimmen Sie von Hand ab  
• Bei starken Signalen in der Nachbarschaft helfen die eingebauten Notch- und Bandpassfilter  

Periodischer Verlust der NF-Anzeige im MMTTY-Fenste r und Abbruch der RTTY-Dekodierung 

• Meldet Ihnen MMTTY ab und zu einen ‚lost sound‘ und schreibt kein RTTY mehr mit, müssen Sie die 
Priorität für MMTTY erhöhen. Gehen Sie zu ‚Options > Setup MMTTY > MISC‘ und erhöhen Sie die 
Priorität von "high" auf "highest". 

Wann sollten Sie die AFC  verwenden ? 

• Wollen Sie, dass MMTTY ein RTTY-Signal selbst optimal einstellt, schalten Sie die AFC ein. 
• Ist AFC UND NET eingeschaltet, folgt Ihr Sendesignal dem empfangenen Signal. Mitunter zieht Sie eine 

wandernde Station aber ein Stück mit, im S&P-Mode ist das zu dulden. 
• Schalten Sie NET ab und AFC an, wenn Sie im Running-Mode sind. Eine anrufende Station wird dann 

eingefangen, auch wenn Sie nicht genau auf Ihrer Frequenz anruft. Haben Sie Schwierigkeiten mit 
starken Station neben dem eigenen Kanal, schalten Sie die AFC wieder ab.  

• Eine nette Option ist  AFC On/Off with CQ : Hier wird die AFC in Erwartung eines Anrufs nach einem CQ 
und einem TU+QRZ? zugeschaltet 

Wann sollten Sie NET zuschalten (NET option: NET On/Off with Run Change)  ? 

• Sind Sie im S&P-Modus wird NET eingeschaltet. Ihr Signal folgt der Gegenstation  
• Sind Sie im Running-Modus, haben sich die Gegenstationen nach Ihnen zu richten und NET ist 

ausgeschaltet  

24.11 N1MMLogger konfigurieren  (Configure the Logger)  

24.11.1 Konfigurieren des TNC/MTTY  (Configure the TNC/ MMTTY) 
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Dieses Bild zeigt zwei digitale Schnittstellen für MMTY (#1) und TNC (#2) 

• Starten Sie N1MMLogger  

• Öffnen Sie das Menü Config> Configure Ports, Telnet Address, Other'  

• Öffnen Sie die Karteikarte Digital Modes .  
o Wählen Sie MMTTY und/oder Other  . Bei Other müssen Sie einen externen TNC 

konfigurieren  

24.12 Schritte zum Einstellen eines TNC  (Steps to set up your TNC)  

• Wählen Sie unter Digital Modes  
• Interface : Other  
• Parameter einstellen : z.B. Com 4,9600,8,N,1 RST-Xon  
• Konfiguration abspeichern 
• Digital Interface über Window > Digital Interface starten   
• Erzeugen sie auf der ersten Taste oben links das Makro für den ABORT mit einem rechten Klick auf die 

Taste, z.B. beim PK-232 : {CTRL-C}R{ENTER}   und speichern Sie das Makro  
• Sie sollten RTTY-Signale mit 45 Baud und 170 Hz Shift mitschreiben können. Erzeugen Sie ein Makro 

zum Umschalten auf Senden und testen Sie es und geben Sie Text in das TX-Fenster ein und/oder 
erzeugen Sie weitere Makros,  wie z.B.  ein CQ für den PK-232 : X{ENTER} CQ CQ CQ TEST DE 
{MYCALL} {MYCALL} K {CTRL-D} 

24.13 In RTTY senden  (Make a RTTY transmission)  

• Sie brauchen Platz auf dem Bildschirm. Minimieren Sie das Packet/Telnet-Fenster.  
• Öffnen Sie mit Window > Digital Interface das RTTY-Fenster. Ziehen Sie das Fenster nach Grösse und 

Lage an einen Ort Ihrer Wahl  
• Bei MMTTY werden zwei Fenster geöffnet, einmal das digitale Fenster zur Textein- und Ausgabe und 

zum anderen das Abstimmfenster der MMTTY-Maschine. Bei einem TNC wird nur das Digital-Fenster 
geöffnet.  

• Mit einem linken Mausklick wird ein Rufzeichen gegriffen (GRAB). Mit einem rechten Mausklick öffnet 
sich ein Menü. 
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• Mit der Taste Einf (Insert) wird das Rufzeichen hellgetastet und zusammen mit der Contest-
Kontrollnummer gesendet (F5+F2).  

• Ein Doppelklick auf ein Rufzeichen in der Rufzeichenliste schickt das Rufzeichen ins Logeingabefenster 
• Ein Rufzeichen wird automatisch hellgetastet, wenn es vom Programm als Rufzeichen erkannt wird. 

Dazu muss vor und nach dem Rufzeichen ein Leerzeichen stehen. Erscheint das Rufzeichen am Anfang 
einer Zeile, wird es nicht erkannt. 

• Die roten und grünen Linien im Spektrum zeigen in den optimalen Arbeitsbereich an. Die rote Linie steht 
bei 1500 Hz und die grünen bei 1000 und 2000 Hz. 

24.14 Name einfügen  (Name lookup)  

Das Programm hat die Möglichkeit, aus einer vorhandenen Datei den Namen der Partnerstation zu entnehmen und 
bereitzustellen. Gehen Sie dazu so vor :  

• Importieren Sie eine Datei mit Rufzeichen und Namen   
• Die bekannte Datei Friend.ini von WF1B kann direkt importiert werden  
• Eine Textdatei die so gebaut ist, kann importiert werden :  
• Rufzeichen, Name  
• Z.B. :  N1MM, Tom  
• Wählen Sie im Menü Config > Call History Lookup und dort den Namen der Datei 
• Jetzt können Sie das Makro {NAME} in Ihre Texte einbauen  
• Hinweis : der Name wird aus der Call History table übernommen, nachdem nach der Rufzeicheneingabe 

die Leetaste gedrückt wurde ! 

Beispiel zur Übernahme von Friend.ini  aus dem WF1B-Programm  

• Wählen Sie File > Import >  Import Call History 
• Wählen Sie die Datei Friend.ini nachdem Sie unter Dateityp auf All files (*.*) geschaltet haben. Sonst 

sehen Sie sie nicht... 
• Suchen Sie die Datei und klicken Sie auf Öffnen . Die Datei mit Rufzeichen und zugehörigem Namen 

wird importiert. 
• Hinweis : Ein Import zerstört alle vorher abgelegten Informationen. Wollen Sie Informationen mischen, 

exportieren Sie erst die aktuelle Datei mit  
File > Export >  Export Call History , kopieren Sie mit einer weiteren Datei extern z.B. mit Notepad 
zusammen und importieren Sie die Datei dann wieder.  

• In der Statuszeile des Logeingabefensters wird der Status während des Imports und zum Abschluss die 
Zahl der importierten Rufzeichen angezeigt 
 

24.15 Empfangenen Text in Datei ausgeben (Outputting RX d ata to a text file)  

Sie können für eine spätere Auswertung den empfangenen Text wie folgt in eine Datei ausgeben :  

• Möglichkeit 1: Klicken Sie rechts ins RX-Fenster und wählen Sie  output to Text File 

• Möglichkeit 2 : Bei MMTTY ist das etwas komplizierter. Gehen Sie in das Verzeichnis von  MMTTY und 
starten Sie es alleinstehend. Klicken Sie auf File/Log RX  und schliessen Sie das Programm wieder. 
Jetzt können Sie MMTTY wieder unter N1MMLogger  MMTTY erzeugt eine Datei unter einem Namen 
mit Datumsangabe wie  031103.txt, jeweils für jeden Tag neu. Siekönnen diese Dateien später 
durchsehen. 
 

24.16 SO2R 

N1MMLogger unterstützt SO2R auch für RTTY. Sie können entweder zwei MMTTY-Fenster, zwei TNC-Fenster oder ein 
Fenster jeweils für MMTTY und einen TNC öffnen. Einzelheiten zur Soundkarteneinstellung u-ä. finden Sie unter SO2R 
und MMTTY . 

24.17 Weitere Möglichkeiten  (Other Features)  

• Wenn Sie die CTRL-Taste während des Klicks auf ein Rufzeichen drücken, wird es direkt in das 
Rufzeichenfeld des Logeingabefensters übernommen  

• Simulieren Sie Im ESM-Modus nicht die Leertaste, klicken Sie nur ins Rufzeichenfenster 
• "-" werden von den Kontrollnummern abgetrennt 
• Die CQ-Wiederholzeit zählt bei MMTTY vom Ende des letzten Rufs, bei TNCs aber vom Absenden des 

Makros an den TNC. Hier müssen Sie die Zeit deutlich länger einstellen, sonst hört Ihr TNC nicht mehr 
auf, CQs zu senden 

• Nach dem Makro {RX} wird automatisch ein CR/LF angefügt 
• Während des Sendens können keine Rufzeichen aus dem RX-Fenster gegriffen (grab) werden 
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Stellen Sie bei einem TNC die CQ-Wiederholzeit auf 9 oder 10 s, damit er in Ruhe auf Empfang gehen kan n.  

 
Sie sollten dem ABORT-Makro für Ihren TNC ein Komma ndo zum Löschen des Puffers zufügen, sonst wird 
beim nächsten Umschalten auf Senden der verbleibend e Text zusätzlich zum neuen Text gesendet.  

 
Schalten Sie beim TNC-Betrieb die Option Turn off Stop Sending CQ when Callsign changed this  auf der 
Karteikarte Function keys   ab. Sonst wird jedes Mal, wenn Sie das Rufzeichen  ändern, das ABORT-Kommando 
an den TNC geschickt.  

 
25. Überblick zu PSK  (General PSK information) 
25.1 Einführung (General info) 

Bitte stellen Sie an Ihrem Transceiver ein : 
 

• Kompressor AUS 
• Frequenzgangbeeinflussung (.B. High Boost bei Kenwood) AUS  
• Transceiver auf LSB 
• NF-Pegel : so einstellen, dass ALC gerade noch NICHT anspricht  
• Übersteuern Sie weder Transceiver noch Endstufe (hier Leistung auf 50% reduzieren)  
• Verwenden Sie Kleinbuchstaben, sie sind bei PSK kürzer und es geht schneller 
• Ein PSK-Kanal benötigt maximal 100 Hz  
• Filtereinsatz :   

o Vorhandenen sollten sein : 2.4 KHz / 250 Hz /100 Hz –Filter  
o 2.4 KHz beim S&P-Modus   
o 250 Hz und 100 Hz – Filter im Running-Modus  

25.2 Digimodefrequenzen (Common Digital Frequencies)  

Diese Frequenzen gelten für die IARU-Region 2 : 

Band  Digital Frequencies (kHz)  

160 meter   

80 meter 3575 - 3585 / 3620 - 3640 

40 meter 7060 - 7080 

30 meter 10130 - 10145 

20 meter 14065 - 14090 

17 meter 18100 - 18110 

15 meter 21060 - 21090 

12 meter 24920 - 24930 

10 meter 28110 - 28125 

25.3 PSK-Frequenzen ( Common PSK Frequencies)  

Für PSK31 wurden jeweils die Bandanfänge des Digimodebereichs im Bandplan vorgeschlagen.  Von dieser Frequenz 
werden 2..3 kHz für PSK nach oben belegt. 
Anmerkung DM3ML :  Eine Ausnahme bildet das 10m-Band, bei dem von RTTY-Bereich für Einsteiger in den USA 
ausgegangen wurde, 

PSK Frequency (kHz)  Remarks  

1838.15   

3580.15   

7035.15 7080.15 in Region 2. 

10142.15 WARC, no contesting 

14070.15   

18100.15 WARC, no contesting 
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21080.15   

24920.15 WARC, no contesting 

28120.15   

25.4 Populäre PSK-Conteste  (Popular PSK contests)  

Date Contest  Remarks  

Third Saturday of April TARA PSK31 Contest - Spring Wakeup Website 

First weekend of September Quick PSK63 Contest  Website 

  Any more annual contests?   

 
26. PSK-Unterstützung (PSK Support) 

 
Gehen Sie bei Problemen zu dem digitalen Teil der FAQs .  

26.1 PSK-Schnittstelle (The PSK Interface)  

Für PSK wird das Programm  PSKCore von Moe Wheatley, AE4JY, verwendet. Unterstützt werden  PSK31 und PSK63. 
Für N1MMLogger werden nur zwei DLLs im N1MMLogger-Verzeichnis benötigt : PSKCore.dll and XMMT.ocx. Beide 
Dateien werden jeweils mit den Updates erneuert. 

Auf PSK wird im digitalen Fenster mit dem Menü Mode  umgeschaltet.   

 

Das Fenster des PSK Interfaces ist in 5 separate Bereiche geteilt, die von oben nach unten erklärt werden . Die exakte 
Arbeitsfrequenz aus Transceivereinstellung +/--NF-Frequenz steht in der Kopfzeile des Fensters:  
 

• Empfangsfenster 1 und 2 : Beide Fenster arbeiten in der gleichen Weise. Rufzeichen können aus beiden 
Fenstern in das Grab-Fenster (s.u.) geholt werden. 
Die Fenster haben an der linken Seite eine Farbkennzeichnung, die zwei Zwecken dient : 

• Das aktuell aktive Fenster ist ROT gekennzeichnet, das zweite Fenster GRÜN  
• Mit einem Klick auf diese Leiste können Sie die Eingabe in das Fenster anhalten, den Text durchrollen 

lassen, ihn markieren und kopieren. Die Leiste ist dann GELB (Gelb) und nimmt  bei einem weiteren 
Klick wieder seine Standardfarbe an und der in der Zwischenzeit eingelaufene Text wird ausgegeben. 

 
Sie können ein Rufzeichen im empfangenen Text durch einen Mausklick in das Rufzeichenfeld des Eingabefensters 
übertragen oder es aus dem Grab-Fenster rechts unten durch Anklicken des Call und dann der Taste Grab holen. Wenn 
im Text ein Rufzeichen gefolgt von einem Leerzeichen erkannt wird, wird es farbig markiert und fortlaufend in das Grab-
Fenster eingetragen. Das oberste Call ist das jeweils neueste, die älteren wandern nach unten . 
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Sie können auch jede empfangene Kontrollnummer durch einen Doppelklick im RX-Fenster in das Exchangefeld im 
Eingabefenster übertragen. 
Sie können durch einen linken Klick in das Spektrum oder den Wasserfall eine andere Station anwählen. Mit einem 
Mausklick wird das Rufzeichen in das Rufzeichenfeld übertragen. 
Die beiden Empfangsfenster können mit der Maus auf der Trennlinie in der Grösse verändert werden.  
 

• Sendefenster  : Wenn Sie auf die TX-Taste drücken geht des Cursor in das Sendefenster und alles, was 
Sie dort eingeben, wird gesendet. Die Grösse des Sendefensters ist fest und beträgt zwei Zeilen  

• Rufzeichenliste und “Grab ” :  Wenn im Empfangsfenster ein Rufzeichen festgestellt wird, wird es ind 
die Rufzeichenliste geschrieben. Mit einem Druck auf die Taste Grab wird es in das Logeingabefenster 
übertragen. In der  Rufzeichenliste stehen maximal vier Rufzeichen, das neueste steht an erster Stelle 
und ist hellgetastet. Mit einem rechten Mausklick auf diese Liste können Sie ein Rufzeichen oder die 
ganze Liste löschen. 

• Clr RX:  Löscht beide Empfangsfenster. Sie  können die Fenster separat mit einem Rechtsklick und dem 
sich öffnenden Menü löschen. Im Running-Modus wird dieses Menü nicht geöffnet, dort wird mit einem 
Rechtsklick in eins der Fenster die F-Taste F2 gesendet. Wollen Sie trotzdem in das Lösch-Menü, 
müssen Sie rechts in das Sendefenster klicken. 

• TX : Schaltet auf Senden und setzt den Cursor ins Sendefenster. Siehe Transceiveranschluss für die 
Schnittstellenkonfiguration  

• RX : Schaltet auf Empfang, nachdem der Sendepuffer gesendet wurde. Einen sofortigen Abbruch 
erreichen Sie mit der ESC-Taste. 

• Swap  : Umschalten zwischen den beiden Empfangsfenstern. Das aktive Fenster hat einen roten Balken 
an der linken Seite, das inaktive einen grünen. Sie können beim Contest  im inaktiven Fenster auf eine 
Station klicken und nach dem Senden sofort auf diese Station umschalten und sie anrufen 

• Makrotasten  :  Sie haben 24 programmierbare Tasten zur Verfügung, die Sie mit Setup >  Settings oder 
mit einem rechten Klick auf eine Taste editieren können. Die Breite des Tastenfelds hängt dynamisch 
von der Fenstergrösse ab. 

• Grab : Überträgt das jüngste Rufzeichen aus der Rufzeichenliste in das Rufzeichenfeld des 
Logeingabefensters. Ist das Rufzeichenfenster gefüllt, kann ein Rufzeichen nur noch mit der Maus 
überschrieben werden.  

 

• PSKCore.dll – Fenster  :  = Wasserfall/Spektrumfenster zur Arbeit mit der PSK- DLL. Die beiden 
farbigen Cursoren gehören zu den beiden Empfangsfenstern. Der gelbe Cursor gehört zum RX-Fenster 
1 und der rote Cursor zum Empfangsfenster 2. Der Cursor für das Fenster 1 wird mit einem linken 
Mausklick und der für das Fenster 2 mit einem rechten Mausklick auf dem gewünschten Signal 
positioniert. 
Die genaue Arbeitsfrequenzfrequenz wird oben im digitalen Fenster angezeigt. 
  

• Im restlichen Textfeld  werden die Frequenzen beider Empfangsfenster und die Sendefrequenz 
angezeigt. Die in beiden Fenstern gemessenen IMD-Werte (Intermodulationsabstand) werden 
ausgegeben und immer dann erneuert, wenn ein Signal ohne Information (idle signal) empfangen wird. 
  

o RX1 Frq  :  Empfangsfrequenz des Empfangsfensters 1  
o RX2 Frq  :  Empfangsfrequenz des Empfangsfensters 2   
o TX1 Frq  :  Sendefrequenz für das Empfangsfenster 1  
o TX2 Frq  :  Sendefrequenz für das Empfangsfenster 2   
o AFC:          ON (EIN) oder OFF (AUS)  
o NET:         ON (EIN) oder OFF (AUS)   

 
• Steuerfeld :   

o TX: schaltet auf Senden und setzt den Cursor ins Sendefenster 
o RX : schaltet auf Empfang, wenn alle Zeichen aus dem Sendepuffer gesendet worden 

sind. Abbruch des Sendens mit ESC möglich 
o BPSK31 : schaltet die Sendearten durch. Möglich sind  BPSK31, QPSK-U31, QPSK-L31, 

BPSK63, QPSK-U63 und QPSK-L63.  
o Swap  : tauscht das Senderecht zwischen den beiden Empfangsfenstern aus. ROT = 

Fenster sendebereit, GRÜN = nur Empfang  
o Zoom  : Dehnung der Frequenzskala (Zoom)  
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� Zoom x1 - 0 Hz - 3000 Hz 
� Zoom x2 - 0 Hz - 1500 Hz 
� Zoom x3 - 0 Hz - 1000 Hz 
� Zoom x4 - 0 Hz - 750 Hz 

o Left / Right Arrows  : Signalsuche im Spektrum mit Links- oder Rechtspfeil  

26.2 Tastenzuordnungen (Keyboard Assignments) 

• Alt-T  : Schaltet zwischen TX und RX hin und her  
• Alt-G  : Rufzeichen greifen (Grab)  
• Ctrl-Arrows  : CTRL+ Rechts- oder Linkspfeil schaltet bei zwei Transceivern und zwei digitalen Fenstern 

zwischen den Interfaces DI1 (Bandskala A)  und DI2 (Bandskala B) um  

26.3 Einfg (Insert)-Taste  (Insert key Assignments)  

    Modus 
     

Enter Sends 
Message 

(ESM mode)  
    Die Einfg-Taste oder ‘;’ bewirkt :  

RUN 

und  

S&P 

AUS 

• Hole das Rufzeichen aus der Liste, falls das Rufzeichenfeld leer ist oder 
verwende das eingetragene Rufzeichen 

• Sende-Kontrollnummer ausfüllen 

• KEIN DUPE:  Sende F5 (Hiscall) + F2 (Exchange) 
oder   
DUPE: Sende nichts 

RUN  EIN 

• Hole das Rufzeichen aus der Liste, falls das Rufzeichenfeld leer ist oder 
verwende das eingetragene Rufzeichen 

• Sende-Kontrollnummer ausfüllen 

• KEIN DUPE:  Sende F5 (Hiscall) + F2 (Exchange  
oder  
DUPE 
WorkDupes aktiv : F5 (Hiscall) + F2 (Exchange) senden 
WorkDupes abgeschaltet : Taste F6 (Dupe) senden  

• Cursor geht in das Feld zum Kontrollnummernempfang  

• F8 helltasten 

S&P  EIN  

• Hole das Rufzeichen aus der Liste, falls das Rufzeichenfeld leer ist oder 
verwende das eingetragene Rufzeichen 

• Sende-Kontrollnummer ausfüllen 

• NO DUPE: F4 (Mycall) senden 
oder  
DUPE 
WorkDupes aktiv : F5 (Hiscall) + F2 (Exchange) senden 
WorkDupes abgeschaltet : F6(Dupe) senden 

• Cursor geht in das Feld zum Kontrollnummernempfang  

Wenn Sie Einfg (Insert) oder ‚;’ drücken und das Rufzeichenfeld nicht leer ist, wird der Text der F-Tasten F5 und F2 
gesendet. Ist das Rufzeichenfeld leer, wird das Rufzeichen aus der Grab-Liste in das Rufzeichenfeld übernommen und 
dann F5 + F2 gesendet.  
Wenn ein Rufzeichen aus der Grab-Liste übernommen wurde, wird es in dieser Liste gelöscht. Wenn das empfangene 
Rufzeichen schon im Logeingabefenster steht, wird es nicht in die Grab-Liste eingetragen. 

26.4 Mauszuordnungen (Mouse Assignments  

 
• Linker Mausklick 

o Ein einfacher Klick  auf ein Rufzeichen setzt das Rufzeichen über das Rufzeichenfeld im 
Eingabefenster  

o Ein einfacher Klick auf die empfangene Kontrollnummer setzt sie in das zugehörige 
Fenster des Logeingabefensters. Vorher muss aber ein Rufzeichen eingetragen worden 
sein. 
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• Rechter Mausklick in das RX- oder TX-Fenster  
o Clear RX1 : Löscht das Empfangsfenster 1 
o Clear RX2:  Löscht das Empfangsfenster 2 
o Clear TX :  Löscht das Sendefenster  
o Output CH1 to Text File  : empfangener Text aus dem Kanal 1 wird als Datei PSKCH1.txt. 

abgespeichert.  
o Output CH2 to Text file  : empfangener Text aus dem Kanal 2 wird als Datei PSKCH2.txt 

abgespeichert. 
o Help  : Hilfe zu dieser Seite wird geholt 

 
• Rechter Mausklick in das GRAB-Fenster 

o Öffnet ein Menü:  
� Clear List  : Löscht die Liste  

� Clear Selected Call  : löscht ein gewähltes Rufzeichen) 

26.5 Konfiguration der Makrotasten im Logeingabefenster (Configuring the Entry window function keys)  

Im Logeingabefenster sehen Sie acht Tasten, die doppelt belegbar sind, also 16 Funktionen bilden können  
Der erste 8er-Satz ist im Running-Modus aktiv, der zweite 8er-Satz im  S&P-Modus 
In den Tasten können die gleichen Makros wie unter PSK und RTTY verwendet werden  
Die Funktionstasten können editiert werden mit dem Menü Config >  Change Packet/CW/SSB/Digital Message 
Buttons >  Change Digital Buttons  

Hier sehen Sie einen Vorschlag zur Definition der Tasten :   

 

Tastentitel  Zu sendender Text  

&CQ CQ CQ CQ DE * * * K 

&Exchange 5NN # 

&My Call * 

&His Call ! 

&TU TU DE * 

RY ryryryryry 

QSO Tnx OM fer Call... 

26.6 Makrotasten bei PSK  (Macro keys on the PSK interface)  

Maximal 24 Tasten können mit Makros belegt werden  
Mit einem rechten Mausklick auf eine Taste kommen Sie in das Editiermenü für die Tasten  
Die Tasten unterstützen alle Makros, aber sie unterscheiden nicht nach Running- oder S&P-Modus  
Sehen Sie auf jedem Fall je eine Taste mit dem Code für den TNC zum Schalten auf Senden und Rückschalten auf 
Empfang vor  
Die Tasten im PSK-Fenster und im Logeingabefenster unterstützen ebenfalls die Makros. Siehe Makros    

26.7 Einstellmenü  Setup Menu Selections  
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26.7.1 Auswahl (Selection): PSK 

• Setup  
o Settings  : stellt das digitale Interface ein (s.u.) 
o SoundCard ( Soundkarte) 
o Empfangspegel (Receive Mixer) : zeigt die Windowsschieberegler  zur Einstellung des 

Empfangspegels 
o Sendepegel (Transmit Mixer ) : zeigt die Windowsschieberegler für den Sendepegel 
o AFC On/Off with CQ  : Falls gewählt, wird AFC nach CQ und TU zugeschaltet 
o NET on/Off with Run Change  : Schaltet die NET-Funktion bei S&P auf EIN und bei Run 

auf AUS 
o Auto Update TRX Offset w/Mark Freq .: Nachziehen der Transceiverfrequenz, wenn die 

NF-Frequenz geändert wird (Align-Funktion) (noch nicht in Betrieb)   
• Mode  

o RTTY : Sendeart RTTY   
o PSK : Sendeart  PSK  

• Help :  zeigt Hilfe-Datei 

26.7.2 Digitales Interface einstellen (Setting up the Digi tal interface)  

Mit dem Menüpunkt Settings  öffnet sich dieses Menü :   

 

• PSK Waterfall Color palette (PSK-Wasserfall-Farbpal ette) :  Sie könne die 12 Farben für 
den Wasserfall Ihren Wünschen anpassen. Die Farben laufen vom schwächsten Signal links 
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bis zum stärksten rechts. Diese Farben sind editierbar und aktiv, wenn im Wasserfall die 
Version User Defined (Nutzer definiert) gewählt wird. Sie kann mit der Taste Default  auf den 
voreingestellten Wert zurück gesetzt werden. 

• Waterfall Color  (Farbe des Wasserfalls) wählbar :   
o Grey Scale (Grauskala) 
o Default Color (voreingestellte Farben) 
o User Defined (Nutzer definiert)  

• Smoothing  (Glättung) : einstellbar zwischen 0 und 10  

• Gain  (Verstärkung) : stellt Signalamplitude für Spektrum bzw. Wasserfall ein 

• Squelch Speed  ( Reaktionsgeschwindigkeit des Squelchs) : Wählbar zwischen langsam, 
schnell und variabel. Unter variabel   ist ein Wert zwischen 0 und 200 einstellbar. 

• Squelch Level  (Squelchschwelle) : Signale unterhalb der einstellbaren Schwelle werden nicht 
dekodiert. Bei 0 ist der Squelch unwirksam und alle Signale einschliesslich des Rauschens 
werden in Zeichen umgewandelt. 

• AFC Search Range  (Arbeitsbereich der automatischen Frequenznachstimmung) : Bereich in 
Hz, in dem einem driftenden Signal gefolgt wird  

• Use Doppler AFC  (Doppler-AFC verwenden) 

• RX Search Range (Fangbereich bei Empfang) : Bereich in Hz, in dem um den angeklickten 
Punkt im Wasserfall nach einem Signal gesucht und darauf eingerastet wird 

• # of PSK channels  : Nummer der zu verwendenden PSK-Kanäle. Möglich sind  2, 3 oder 4.  
• PSK/RTTY Window Colors  (Fensterfarben) : für die PSK- und RTTY-Empfangs- und 

Sendefenster wird hier die Hintergrundfarbe eingestellt 

• SndCard Clock Adj  : Abgleich des Soundkartentakts  

• CW ID : Falls freigegeben wird nach jeder Sendung der in das Feld CWID-String eingetragene 
Text in CW gesendet 

• PSK Soundcard Select : Verwendete Soundkarte, wenn mehr als eine Karte im PC eingebaut 
ist 

• RX Window Font Selection  : Ändert Schrift und Farbe im RX-Fenster. Klicken Sie auf Set 
Font  , um in das Auswahlfenster zu kommen. 

• Send Space on Callsign Mouse Click  : falss freigegeben, wird ein Leerzeichen gesendet, 
wenn das Rufzeichen ins Eingabefenster mit einem Mausklick übertragen wird  

• (MMTTY) Send HamDefault on Run to S&P change  :  Falls freigegeben, wird MMTTY auf 
die Mark-Frequenz der HAM-Voreinstellung geschaltet, wenn von Run auf S&P umgeschaltet 
wird  

• {MMTTY-PSK) Turn AFC Off when switching to S&P  : Falls freigegeben, wird die AFC bei 
MMTTY-PSK auf AUS geschaltet, wenn von Run auf S&P geschaltet wird 

• {PSK} Do not send Squelch tail   : Abschaltung des Sender-Nachlaufs bei PSK, um einen 
schnelleren Betriebsablauf zu erzielen 

• Save Configuration   : Abspeichern der Einstellungen. Sollen die Einstellungen nicht 
gespeichert werden, klicken Sie auf das Kreuz in der oberen rechten Ecke, um das Fenster zu 
schliessen  

•  
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• Digital Macro Set  : aktualisieren der Makros und der Tastentexte 
o Wählen Sie im Menü Select  das zugehörige Interface  PSK, MMTTY 1, Other 1, 

MMTTY 2, Other 2  
o Klicken Sie auf die Makrotaste, deren Text geändert werden soll 
o Geben Sie den Text in das Feld Macro Text ein 
o Geben Sie in das Feld Macro Caption  den Text für den Tastennamen ein 
o Klicken Sie auf Save Macro , wenn Sie zufrieden sind  
o Die Taste trägt den gewählten Tastennamen  
o Im Fenster Available Macros  stehen die vom Programm zur Verfügung gestellten 

Makros. Wählen Sie erst eine zu programmierende Taste, um die Makros zu sehen.  
o Unterhalb des Felds für die CW ID befinden sich zwei zusätzliche Tasten, die für TX 

und RX  programmiert werden. Geben Sie die zutreffenden Codes den TNC ein. Die 
Tasten sind nur bei Other1 oder Other2 zu sehen.  

• Load Macros  : Mit dieser Taste kann ein abgespeicherter Makro-Satz (Dateierweiterung *.mc) 
geladen werden  

• Save Macros  : Speichern Sie den editierten Makrosatz als Datei *.mc ab  

• # of Macros  : Anzahl der angezeigten Tasten wählbar mit  0, 8, 16 oder 24  

• Macro Text : Eingabefeld für das aktuelle Makro   

• Macro caption  : Name der Taste  

Alle Änderungen werden mit einem Klick auf die Taste Save Configuration  abgespeichert und werden nach Schliessen 
des Fensters wirksam. 

26.8 Senden in PSK  (Make a PSK transmission)  

• Sie brauchen Platz auf dem Bildschirm. Minimieren Sie das Packet/Telnet-Fenster.  
• Öffnen Sie mit Window > Digital Interface das PSK-Fenster. Ziehen Sie das Fenster nach Grösse und 

Lage an einen Ort Ihrer Wahl  
• Mit einem linken Mausklick wird ein Rufzeichen gegriffen (GRAB). Mit einem rechten Mausklick öffnet 

sich ein Menü. 
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• Mit der Taste Einf (Insert) wird das Rufzeichen hellgetastet und zusammen mit der Contest-
Kontrollnummer gesendet (F5+F2).  

• Ein Doppelklick auf ein Rufzeichen in der Rufzeichenliste schickt das Rufzeichen ins Logeingabefenster 

26.9 Anderes (Other)  

• Die Frequenzanzeige im Wasserfall und Spektrum  folgt der aktuellen Transceiverfrequenz  
• Die zuletzt verwendete PSK-Mode wird abgespeichert und bei einem Neustart wieder aktiviert  
• Wenn Sie bei PSK eine Fehlerausschrift beim Start bekommen, starten Sie c:\windows\system\regsvr32 

/u PSKCore.dll (de-regstrieren) und anschliessend  c:\windows\system\regsvr32 PSKCore.dll um die 
Datei PSKCore.dll erneut zu registrieren. Starten Sie das Programm upgrade.bat, das sich im 
N1MMLogger-Verzeichnis befindet und diese Kommandos ausführt.  

• Während des Sendens können Rufzeichen im RX-Fenster nicht übernommen (grab) werden  
 

27. Vor dem Contest (Before the Contest) 
 

 
• Rufzeichenvorgeschichte prüfen (Call History Lookup)  
• Funktionstasten importieren und exportieren (Importing and exporting message Function keys  
• Den CQWW-Contest (und andere) vorbereiten (Getting ready for CQWW (and other contests)  
• WAV-Dateien für Funktionstasten in SSB-Contesten aufzeichnen (How to record Wav files for the 

Function keys used in SSB contests.  

27.1 Rufzeichenvorgeschichte prüfen (Call History Lookup ) 

Für zahlreiche Conteste gibt es Dateien, die Rufzeichen und Daten von Stationen enthalten, die in den Contesten des 
letzten Jahre aktiv waren. Mitunter enthalten Sie nur die Rufzeichen aktiver Stationen, mitunter aber auch den Namen 
(friends.ini für RTTY-Stationen), das Alter (für den AA-Contest) oder WW-Lokatoren (für einen UKW-Contest). Bei 
N1MMLogger kann die Datei als allgemeine Master.dta -Datei importiert werden. Es gibt aber auch contestbezogene 
Dateien. Informieren Sie sich, ob zu dem Contest Ihrer Wahl eine spezielle Rufzeichendatei vorhanden ist.  

Die Rufzeicheninformation (Call history) wird in einer separaten Tabelle in jeder Datenbank abgelegt. Diese Tabelle 
heisst CallHist. Vor dem Contest muss diese Tabelle aus einer Master.dta-Datei aufgebaut werden:  

• Config > Call History Lookup  
• Geben Sie in der Konfiguration die Verwendung der Call History table frei.  

Die Freigabe kostet einige Rechenleistung, denn bei jeder Rufzeicheneingabe wird in der Tabelle 
nachgesehen.. Die Rufzeichentabelle muss vor dem Contest mit Import Call History' gefüllt werden. In 
der Tabelle können Name, Lokator, US-Staat, Alter abgelegt werden. Die Tabelle hat zusätzlich für 
weitere Daten, die aber das Loggen nicht beeinflussen. 

• File > Import > Import Call History  
• Bei vielen Contesten ähneln sich die ausgetauschten Kontrollnummern oder man kann z.B. den Namen 

– wenn er bekannt ist – in ein Makro einbauen. Bei europäischen UKW-Contesten wird der Lokator der 
Gegenstation benötigt, der meist von früheren Contesten bekannt ist und schon vor dem QSO zum 
Antennendrehen verwendet werden. Siehe Infos zu Conteste auf VHF und höher. Wenn Sie eine neue 
Master.dta-Datei importieren, werden die alten Einträge gelöscht. Wenn Sie die alte Tabelle 
aufbewahren wollen, sichern Sie sie vorher. 

• File > Import |> Export Call History  
• Exportiert den Inhalt der Call History table.  Die Tabelle kann nur mit dem Menüpunkt Import Call History 

gefüllt werden 

Hinweis : Aktuell gibt es keine Möglichkeit, von einem Contest-Log eine Call History table  zu füllen. Das Füllen der 
Tabelle ist nur über den Import einer Textdatei möglich. 
Anmerkung DM3ML : Die Master.dta-Dateien sind in der Regel einfache Textdateien, in denen die Datensätze mit 
ENTER und die Daten in den Sätzen durch Kommas getrennt sind. 

27.1.1 Erzeugen einer Lokatorliste für den Import  (Creating a locator lookup file for importing in Cal lHist table)  

Die Importfunktion erwartet eine Textdatei, die je Zeile eine Information in der unten erklärten Form enthält. Eine Zeile 
(ein Datensatz) muss mindestens das Rufzeichen enthalten, alle anderen Felder sind optional. Jedes Feld muss durch 
ein Komma abgetrennt sein 

Die Reihenfolge ist Rufzeichen, Name, Grid1, Grid2, Section, State, CK, Geburtsdatum  
Als Trennzeichen sind zugelassen : Komma, Semikolon,  Leerzeichen oder ein äquivalentes Zeichen. Die Trennzeichen 
(delimiter) dürfen in der Datei gemischt werden, müssen aber in einem Datensatz gleich sein.  

Fehlt ein CK muss es als -1 eingegeben werden, gültig sind CKs von 00 bis 99 (Siehe ARRL Sweepstakes).  
Das Geburtsdatum wird für den All-Asian-Contest benötigt um das aktuelle Alter ausrechnen zu können. Dieses Datum 
muss im Universalformat, z.B. als 1980-12-31 eingegeben werden. 
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Beispiel für eine Rufzeichendatei (Call history file) : 

Nur Name benötigt     Lokator benötigt     State benötigt    

N1MM, Tom    PI4GN,,JO33II,JO33jf,    N1MM,Tom,,,,CT   

N2AMG;Rick    PA5DD=Uffe=JO22ic=    K3ZO;Fred;;;; MD   

WW3S=Jamie    PA1T,Timon,JO33jf,     

Oder mit Geburtsdatum :  

K1CC,RICH,FN31,FN32,,,-1,1900-01-01 
KG1D,LES,,,,,-1,1900-01-01 
N1MM,TOM,FN31,,CT,CT,61,1949-10-01 
# Kommentarzeile mit # beginnend 
W1RM,PETE,,,,,-1,1900-01-01 

• Das Rufzeichen wird unbedingt benötigt 
• Fehlen Namen oder Lokatoren ist trotzdem ein Komma zu setzen  
• Wird nur der US-Staat (State) benötigt, der relativ weit hinten steht, sind mehrere (vier oder fünf) 

Kommas zu setzen (siehe Beispiel) 
• Die Zahl der Datensätze ist nicht begrenzt. Bei UKW-Contesten werden bis zu 50 000 Datensätze 

eingelesen, ohne dass eine Verzögerung beim Suchen festzustellen ist. Eine spezielle VHF-Contest-
Datei erzeugt von PA1M steht unter Other Files auf der N1MMLogger-Webseite zur Verfügung (und 
funktioniert sehr gut (DM3ML)). 

• Wenn der Cursor im Runfzeichenfeld steht, drücken Sie die Leertaste, um ein Rufzeichen in der Callhist 
lookup table zu überprüfen. Ein Tab funktioniert nicht. 

• Sie können mit # Kommentare in die Call History-Datei einfügen (s.o.). 

Tipp 1 von Kenny, K2KW  

Für OMs, die ruhiger leben wollen, empfehle ich EXCEL, um die Daten in das richtige Format zu bringen. Sie können z.B. 
ein altes Log als Textdatei nach EXCEL importieren (Externe Daten importieren) und in Spalten anordnen. Löschen Sie 
die nicht benötigten Spalten, ordnen Sie die vorhandenen Spalten nach der Vorgabe um und fügen Sie leere Spalten ein, 
um das Format wie vorgegeben zu erfüllen. Geben Sie diese Datei dann wieder als ASCII-Text (CSV.Format) aus. Diese 
Datei hat das gewünschte Format mit den benötigten Kommas. 

Tipp 2 von Tom, N1MM  

Wenn Sie aus N1MMLogger ein Log im generic  – Format mit Copy in die Zwischenablage kopieren, können Sie sie ohne 
grosse Umwege nach EXCEL einfügen. 

27.2 Funktionstasten importieren und exportieren  (Importing and exporting message Function keys)  

Die CW-Tasten und die SSB-WAV-Dateien können, so weit sie nicht contestspezifisch sind, zwischen den Contesten hin- 
und her kopiert werden. Haben Sie die Tasten für einen bestimmten Contest erzeugt haben,   File > Export > Export 
Message Keys to File > CW Keys (for example)  . Die Tasteneinstellung wird in einer Makro-Datei abgespeichert. Sie 
können diese Datei mit File > Import > Import Message Keys from File > (se lect file) von einem anderen Contest aus 
wieder importieren und für diesen Contest anpassen. 

27.3 Den CQWW-Contest (und andere) vorbereiten (Getting r eady for CQWW (and other contests))  

Spitzencontester arbeiten eine Checkliste vor einem Contest ab, damit dann alles funktioniert. Fügen Sie die folgenden 
Punkte der Checkliste zu :  

• Machen Sie ein paar dutzend QSOs vor dem Contest. 
Machen Sie 12 QSOs im Running-Modus und 12 im S&P-Modus. Starten Sie die CQ-Funktion, um in 
den Running-Modus zu kommen. Wenn das nicht klappt, überprüfen Sie die Tastenzuordnung in der 
Function Keys-Karteikarte der Konfiguration. 

• Wollen Sie die eine oder mehrere Funktionen des Programms nutzen, prüfen Sie die Funktion : 
• Enter sends messages (Loggen mit ENTER-Folgen) 
• Autocompletion (automatische Rufzeichenergänzung) 
• Multi-op (Multi-OP-Contest) 
• Send leading zeros (führende Nullen ergänzen) 
• Send corrected call (korrigiertes Rufzeichen wiederholen) 
• Radio interface (CAT-Steuerung) 
• Packet connection (Verbindung zum Packet-DXCluster) 
• Telnet connection (Verbindung zum Internet-DXCluster) 
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• Holen Sie sich die neueste Datei CTY.DAT, installieren und testen Sie die Datei. Im About-Fenster 
können Sie die aktuell installierte Version abfragen 

• Holen Sie sich die neueste oder zum Contest passende MASTER.DTA-Datei im CT-Format und 
speichern Sie sie im N1MMLogger-Verzeichnis. Die aktuelle Version können Sie im About-Fenster 
abfragen  

• Bereiten Sie die für den Contest benötigten SSB-WAV-Dateien vor und testen Sie sie  
• Enstören Sie Ihre vielen Kabel gegen eindringende HF 
• Stellen Sie sicher, dass Sie die Contestseite richtig ausgefüllt haben. Beim CQWW-Contest steht im 

Kontrollfeld (Exchange) lediglich Ihre Zone 
• Editieren Sie die Funktionstasten passend zum Contest und testen Sie sie 
• Geben Sie die Prüf-QSOs in ein Cabrillo-Log aus und überprüfen Sie die Richtigkeit der Angaben 

(Teilnehmerklasse, Leistung usw.) 
• Synchronisieren Sie Ihre Computerzeit mit dem Internet, z.B. mit dem Programm Dimension 4. 

(Freeware). Wiederholen Sie die Synchronisation während des Contests. 
• Drucken Sie sich das Kapitel Tastenzuordnungen (Key Assignments) aus der N1MM-Hilfe aus und legen 

Sie es neben die Station. Sie können die Datei auch von der N1MM-Webseite unter Other Files holen. 
. 

73, & GL in the contests 

Tom Wagner - N1MM 

27.4 WAV-Dateien für Funktionstasten in SSB-Contesten au fzeichnen ( How to record Wav files for the 
Function keys used in SSB contests)  

Hier sind die Empfehlungen von Tom, N1MM. :  

• Ich verwende Cool Edit 96,  es gibt auch neuere Versionen  
• Zeichnen Sie alle benötigten WAV-Dateien auf einmal (!) hintereinander und jede Datei mindestens 

zweimal  auf. Arbeiten Sie in einem ruhigen Raum ! 
• Lassen Sie am Anfang der Aufzeichnung einen leeren Bereich von 5 s.  
• zeichnen Sie auf !  
• Speichern Sie die Aufzeichnung als Roh-Datei ab  
• Starten Sie die Geräuschreduzierung (Noise reduction) von Cool über die gesamte Datei.  
• Speichern Sie die Datei unter einem Namen z.B. „Rauschreduziert“ ab Save the recording as "Noise 

reduced CQ".  
• Experimentieren Sie mit dem Equailizer, senken Sie die Bässe ab und heben die Höhen an > Speichern 

Sie wieder unter einem neuen Namen, wenn Sie zufrieden sind 
• Sie können auch ein gewisses Mass an Kompression testen, aber ich empfehle es nicht  
• Teilen Sie die Datei in die benötigten Teile und nehmen Sie jeweils die beste Version bei 

Mehrfachaufzeichnung. Speichern Sie die WAV-Dateien unter einem treffenden Namen (CQ.wav, 
QRZ.wav, QSOb4.wav usw.)   

Wenn Sie alle Sätze hintereinander und in einem Stück abspeichern, vermeiden Sie die Pops am Anfang und Ende der 
Aufzeichnung, die Sätze haben etwa die gleiche Lautstärke und den gleichen Klang. Ich empfehle Cool Edit 2000, fragen 
Sie nicht warum, holen Sie es sich.  

Die WAV-Dateien sind für den Contest im Verzeichnis N1MMLogger/WAV abzulegen. Sinnvoll ist es, Ihnen einen zu den 
Tasten passenden Namen zu geben, z.B. cq.wav   n1mm.wav   59.wav   etc.  

Bei mir heissen Sie :   
     CQ           wav\cq.wav  
     N1MM      wav\n1mm.wav  
     Exch        wav\59.wav  

Diese Empfehlungen kommen von Uffe,  PA5DD :  

Ein weiteres nettes Freeware-Programm ist Audacity . Mit diesem Programm können Sie alle Audio-Dateien auf die 
gleiche Spitzenamplitude bringen. 
Zur Vorbereitung habe ich zusammen mit den anderen bearbeiteten WAV-Dateien einen 10s langen 800Hz-Ton 
aufgezeichnet und ihn unter dem Namen Cal.wav der Taste F7 zugeordnet. Diesen Ton starte ich bei abgeschaltetem 
Sprachprozessor und stelle damit die Aussteuerung des Transceivers ein. So bin ich sicher, dass meine Sprachdateien 
im Aussteuerungsbereich des Transceivers liegen. Danach schalte ich den Sprachprozessor wieder zu und drehe nur 
noch ein ganz kleines bisschen weiter auf, um auf der sicheren Seite zu liegen. 

Auch Mario, S56A, N1YU hat ein paar Tipps :   

• Ich habe die Dateien  CQ CONTEST FROM S56A S56A CONTEST, S56A, THANKS S56A, THANKS 
599 15 hintereinander aufgesprochen. Damit kann ich den WW-Contest weitgehend automatisieren.  



N1MMLogger-Hilfe V.4.0.88 Seite 116 von 227 Übersetzung von Eike, DM3ML 

• Ich habe den 20 dB MIC-Vorverstärker an Soundblaster eingeschaltet und vor dem eigentlichen Text ein 
paar Wort gesprochen damit sich die ALC einschwingen konnte. Die Abtastrate habe ich auf 8 bit und  
11K eingestellt.  

• Anschliessend habe ich die Dateien mit einem Graphic equalizer bearbeitet, der auf eine untere 
Grenzfrequenz von 125 Hz , 0 dB bei 250 und 500 Hz,  +7 dB bei 1 KHz, +14 dB bei 2 kHz  und - 18 dB 
bei  4 kHz eingestellt war  

• Das Signal wurde anschliessend normalisiert. Es ergibt sich kein HIFI-sound aber eine gute SSB-
Modulation  

 
Die WAV-Dateien sind für den Contest im Verzeichnis N1MMLogger/WAV abzulegen. Sinnvoll ist es, Ihnen einen zu den 
Tasten passenden Namen zu geben, z.B. cq.wav   n1mm.wav   59.wav   etc.  

Bei mir heissen Sie :   
     CQ           wav\cq.wav  
     N1MM      wav\n1mm.wav  
     Exch        wav\59.wav  

Rufzeichen buchstabieren (Letters)  

Für dieses Kapitel gibt es keine offizielle Anleitung ! 

DM3ML : Die Option funktioniert aber und ich gestatte mit, ein paar Tipps abzugeben:  

Das Rufzeichen der Gegenstation kann in SSB aus WAV-Dateien für Buchstabierwörter, Zahlen und Sonderzeichen, die 
im Verzeichnis N1MMLogger/Letters  abzulegen sind, zusammengebaut werden. Die Dateien heissen für Buchstaben 
A.wav bis Z.wav und für Ziffern 0.wav bis 9.wav zuzüglich der Sonderzeichen wie ? = query.wav oder / = stroke,wav. 
Für das Verzeichnis letters sind auf der N1MM-Homepage unter Other Files  Beispiele von CT1AOZ und VK4CEJ zu 
finden. Logprogramme wie DX4WIN enthalten zur Ansage von Rufzeichen ebenfalls WAV-Dateien für die 
Buchstabierworte wie ALPHA, BRAVO, CHARLIE usw. 
Zweckmässig ist es aber, sich seinen eigenen Satz wie oben beschrieben herzustellen.  
Trägt man in die Taste F5 für das Rufzeichen der Gegenstation das Makro ! ein, wird das in das Rufzeichenfeld 
eingetragene Rufzeichen aus den WAV-Dateien zusammengebaut.  
Das Buchstabieren geht nicht ganz so flüssig wie bei einem schnellen OP. Hat es aber dem OP zum Contestende die 
Stimme total verhagelt,  kann er sich auf diese Art weiterhelfen. 
Die Ausgabe der Contest-Nummer kann nicht automatisiert werden. Nur bei Contesten wie dem WW mit „5914“ oder 
dem WAG mit „59+DOK“  ist eine feste Belegung der Taste F2 mit einer WAV-Datei möglich. 

 

 
Hinweis  : Wenn Sie Ansagen mit WAV-Dateien verwenden, schalten Sie die Windows-Sounds  unter Systemsteuerung  
> Sounds ab. 

  

28. Während des Conteste  (During The Contest) 
28.1 Das Szenario ( The scenario) 

Lange vor dem Contest haben Sie sich in die Tastenzuordnung, die Grundfunktionen , die Programmeinrichtung, das 
Logeingabefenster eingearbeitet und die Zehn Schritte im Schnelldurchlauf  durchlaufen. Sie haben das Handbuch 
mehrfach gelesen, alle Optionen durchgespielt und alle offenen Fragen geklärt. 
Sie haben Wochen vor dem Contest Ihre WAV-Dateien erzeugt, die CW-Texte editiert, die Datenbank für den Contest 
vorbereitet und die Technik mit allen Kabeln, Transceivern, Endstufen und Antennen ausführlich getestet. 
Sie kennen alle Programmfunktionen, wissen,  wie Sie Band, Geräte und Sendearten wechseln. Das Programm und 
seine Bedienung sind kein Geheimnis mehr für Sie. Ihr einziges Ziel ist es, soviel QSOs und Multis wie möglich zu 
arbeiten. 
Sie haben eine durchdachte Strategie für den Contest. 
Das Handbuch liegt zwar neben der Station, Sie brauchen es aber nicht mehr. Die Tabelle mit den Tastenzuordnungen 
hängt in Sichthöhe, aber Sie finden die Tasten blind und ohne Nachdenken. 

Sie haben die beim Testen festgestellten Programmmacken schon lange vorher an N1MM gemeldet, die Bugs sind 
behoben und das Programm arbeitet fehlerfrei. 

  
Nichts kann Ihnen passieren, Sie sind vorbereitet !  

28.2 Bugs  
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Stellen Sie einen Bug fest, melden Sie ihn bitte umgehend, sogar während des Contests,  an N1MM. Tom macht selbst 
bei vielen Contesten mit, ist aber auch während der Conteste dabei, Ihnen einen Tipp zur Lösung zu geben oder einen 
Programmfehler zu beheben und eine verbesserte Version 

Wenn Sie ein Problem mit einem bestimmten QSO haben, gehen Sie so vor : 

• Drücken Sie ALT-N und notieren Sie sich das zum QSO aufgetretene Problem, z.B. „steht nicht in 
master.dta“  

• Starten Sie nach dem Contest View > Notes und sortieren Sie die Notizen in aller Ruhe. 

  

29. Nach dem Contest  (After the contest..) 
 

Ein Contest ist erst mit dem Ausrechnen der Punkte und dem Abschicken des Logs zu Ende. Folgende Abschnitte 
enthält dieses Kapitel  : 
 

• Eingabe nach dem Contest  
• Zeiten im Log um einen festen Betrag verschieben 
• Cabrillo-Logs erzeugen 
• Logs an die ARRL/CQ schicken  
• Der ARRL-Contest-Robot 
• QSL-Karten drucken  
• Contestlog in das Stationslog importieren  
• Eingabe nach dem Contest (Post-Contest QSO Entry) 

Sie wollen die QSOs nach dem Contest von einem Papierlog nach N1MMLogger eingeben ? Hier bekommen Sie ein 
Werkzeug, dem Sie im Schnelldurchgang die QSOs mit einer Interpolation von Datum und Uhrzeit eingeben können 
(vorausgesetzt, der Contestveranstalter rechnet Ihnen nicht jede falsche Minute vor). Das Werkzeug ist sehr gut 
brauchbar, wenn Sie einen grösseren Stapel an QSOs eingeben müssen. Bei ein oder zwei QSOs reicht auch der alte 
Weg… 
 
 Warnung : Machen Sie eine Kopie von Ihrem Log und verwenden Sie nur die Kopie zur Weiterbearbeitung. Sie 
können die eingesetzte Zeitinterpolation nicht auto matisch rückgängig machen. Seien Sie gewarnt ! 

29.1.1 QSOs eingeben (Enter QSOs)  

Folgendes Verfahren wird vorgeschlagen : 

• Geben Sie Frequenz oder Band ein, drücken Sie ENTER 
• Geben Sie Rufzeichen und Contestnummer hintereinander und bis zum nächsten Bandwechsel ein 

• Geben Sie bei einem Bandwechsel die neue Frequenz ein und  fahren Sie mit der Eingabe bis zum 
nächsten Bandwechsel fort 
 

Beispiel : 

7000 {enter} 
W1ABC 35 CT {enter} 
W2XYZ 55 MA {enter} 
14000 {enter} 
W5JOE 42 TX {enter} 
etc.  

29.1.2 Zeit/Datum ändern  (Change time/date)  

Ändern Sie Datum und Uhrzeit der von Hand eingegebenen QSOs wie folgt :   

• Setzen Sie die Maus auf das erste QSO und klicken Sie es einmal an. Es wird hellgetastet 
• Klicken Sie dann rechts auf das Log 
• Wählen Sie aus dem Menü Set Start Interpolation Time Row (Starte Zeitinterpolation) 
• Geben Sie die gewünschte Zeit ein und klicken auf  OK 
• Setzen Sie die Maus auf das letzte QSO in diesem Block und klicken Sie es einmal an. Es wird hellgetastet 
• Klicken Sie dann rechts auf das Log 
• Wählen Sie aus dem Menü Set Stop Interpolation Time Row (Beende Zeitinterpolation) 
• Geben Sie die gewünschte Zeit für das Blockende ein und klicken Sie auf OK 
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Hinweis:  Das Programm interpoliert die Zeit zwischen Start und Ende des QSO-Blocks. Es gibt keine Undo-
Möglichkeit. Sie sollten daher eine Logkopie machen, bevor Sie die Interpolation starten. Teilen Sie die QSOs, vor allem 
dann, wenn Sie eine oder mehrere grössere Pausen gemacht haben, in die entsprechenden Gruppen, um trotz der 
vereinfachten Eingabe den Zeitrahmen Ihres Ausgangslogs angenähert zur erreichen. 

29.2 Zeiten im Log um einen festen Betrag verschieben (C hange All Contact Timestamps by a Fixed 
Amount)  

Mitunter haben Sie durch eine falsche Computereinstellung Ihr ganzes Log um eine oder mehrere Minuten oder Stunden 
verschoben. Sie können diesen Fehler für das komplette Log reparieren :  
 

• Klicken Sie rechts ins Log 
• Wählen Sie im Menü Change All Contest Timestamps by a Fixed Amount  
• Geben Sie im sich öffnenden Fenster die gewünschte Verschiebung (Offset time  ) in +/- Minuten ein   

Ändert sich durch die Zeitkorrektur das Datum, wird es automatisch geändert. Bei grösseren Verschiebungen sollten 
Sie die Differenz in Minuten mit dem Taschenrechner ausrechnen. 

 
Hinweis:  Sie können schnell einen Fehler machen. Sichern Sie das Log, bevor Sie die Zeitkorrektur starten.. 

29.3 Cabrillo-Logs erzeugen  (How to create Cabrillo files)  

Inzwischen wird das Cabrillo-Log bei vielen grossen Contesten zur Abrechnung angefordert. Sie können ein Cabrillo-Log 
so erzeugen :  

• Wählen Sie das Menü File > Export > Export Cabrillo to file ...  
• Ein Cabrillo-Log unter dem Namen <call>.log  wird im N1MMLogger-Verzeichnis erzeugt  
• Für <call> wird das unter Station information mit Config > Change Your Station Data eingetragene 

Rufzeichen verwendet . Im Kopf des Cabrillo-Logs werden die Daten aus diesem Fenster und die bei File > 
Choose Contest  vorgegeben Contestangaben verwendet. Stellen Sie sicher, dass die Angaben richtig 
sind. 

• Sie sollten vor Erzeugen des Logs die Frage nach der Neuberechnung (rescore ?) mit JA  beantworten. 
• Sehen Sie sich das Cabrillo-Log mit einem Texteditor wie Notepad vor dem Absenden noch einmal an und 

korrigieren Sie u.U. Fehler im Kopf des Logs 
 

Anmerkung DM3ML : Der Contestveranstalter berechnet die Punkte/QSO, Multis und Endpunktzahl aus dem 
eingeschickten Cabrillo-Log selbst auf seinem Rechner. Die im Cabrillo-Log stehende Claimed Score  kann, aber muss 
nicht die korrekte eigene Punktzahl sein 

Im Kapitel Technische Information finden Sie weitere Informationen zu weiteren vom Programm erstellbaren Dateien wie 
Cabrillo-Logs, Contest-Deckblatt (Summary sheet) oder ADIF-Log. 

29.4 Logs drucken (How to print the log)  

N1MMLogger hat keine eingebaute Druckfunktion für das Log, aber verschiedene Werkzeuge zur Übergabe an ein 
Druckprogramm. Gehen Sie zu File > Export  und geben Sie das Log entweder als ADIF-Datei zum Export in ein 
anderes Logprogramm oder z.B. als CSV-Datei zum Export nach EXCEL oder WORD aus. Sie können auch eine 
Ergebnisübersicht (summary sheet) machen und diese mit einem Editor wie Wordpad bearbeiten und ausdrucken. 

29.5 Statistik auswerten (How to get statistics)  

Das Programm hat nicht allzuviel Statistikwerkzeuge. Zu empfehlen sind folgende Möglichkeiten : The program does not 
have many statistics by itself. Below some possibilties.  

• Exportieren Sie das Log als ADIF-Datei in ein Logprogramm und werten  Sie es damit aus  
• Verwenden Sie das Cabrillo-Format, das von vielen Contestveranstaltern akzeptiert wird  
• Verwenden Sie das brillante Werkzeug von I8NHJ's (frei!) , um das Log zu analysieren. Weitere 

Informationen finden Sie im Kapitel I8NHJ web interface 

Anmerkung DM3ML : Die Statistik von N1MMLogger ist inzwischen stark ausgebaut worden. Gehen Sie zu View > 
Statistics  und klicken Sie die verschiedenen Kombinationen durch. 
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29.6 Logs an die ARRL/CQ schicken ( Submitting E-mail logs for ARRL/CQ contests)  

ARRL und CQ verlangen zwei Dateien für jeden Contes t :  

• Das Cabrillo-Log file bezeichnet mit <call>.LOG , z.B. : N1MM.log  
• Erzeugt mit File > Export > Export Cabrillo to file  
• Logdeckblatt bezeichnet mit <call>.SUM , z.B. : N1MM.sum  
• Erzeugt mit File > Export > Print Score Summary to File 

Logs per Email abschicken  :  

• Beide Dateien sind NICHT als Text der Email, sonder als Anhang (Attach ) zu schicken. Sehen Sie sich die 
beiden Dateien , vor allem den jeweiligen Kopf, vorher mit einem Texteditor an. 

• Der Email – Betreff (subject) muss lauten : 
• ARRL: Contest, Rufzeichen, Klasse, Leistung   

z.B.  ARRL DX CW N1MM SOA HP 
• CQ: Rufzeichen, Sendeart (SSB oder CW). 

z.B.  N1MM CW 
• Informieren Sie sich auf der ARRL- und CQ-Website oder in der Contestausschreibung über die richtige 

Email-Adresse:  
• ARRL at http://www.arrl.org/contests/email.html 
• CQ at http://www.cqww.com 
• Sie bekommen vom automatischen Beantworter, dem Robot, eine Bestätigung oder einen Hinweis auf 

einen Formfehler. Korrigieren Sie den Formfehler, senden Sie das Log erneut, bis sie die Bestätigung 
bekommen. Heben Sie die Bestätigung auf.  

• Logs, die nach dem Endtermin eingehen, können nur als Checklog gewertet werden  

29.7 Der ARRL-Contest-Robot (ARRL Contest Robot)  

Die ARRL will Logs seit mehreren Jahren als Cabrillo-Dateien haben. Die Logs sind als Anhang (Attachment) per Email 
zu senden!  

So sieht eine Antwort des ARRL-Contest-Robots aus :   

(This is an automated response).  

Thank you for your participation in the contest and for submitting your log in Cabrillo format. While the robot appears to 
be able to process your log, it appears to have discovered irregularities in your log. These do not affect its ability to be 
processed but correcting these problems will help ensure the entry is properly scored. These irregularities appear in a 
report at the bottom of this message. You are encouraged to review and fix these irregularities. You may then re-send it 
to dxcw@arrl.org. You may have to resubmit your log two or three times to get everything just right. Don't worry, the robot 
replaces the previous file as long as the callsign remains the same. We want to make sure that we have your information 
right! If you have any questions regarding this, please contact me at n1nd@arrl.org or by phone at 860-594-0232.  

Your tracking number is [3044.dxcw]. Please save this receipt until verifying that your log appears on the Logs Received 
web page at  

http://www.arrl.org/contests/claimed/  

Thanks for your cooperation. 73  

Dan Henderson, N1ND 
ARRL Contest Branch Manager  

ARRL DX CONTEST LOG WARNING MESSAGE REPORT FROM THE ROBOT 
CATEGORY-OVERLAY: N/A  

Line 7 was discarded. The CATEGORY-OVERLAY: tag is not used in ARRL contests. You may delete this line from your 
log.  

Hier wurde die Zeile 7 im Kopf des Logs (die Kategorie OVERLAY)  zurückgewiesen. Der Einsender wird gebeten, diese 
Zeile zu streichen und das Log noch einmal einzusenden Sie können das auch mit Ihrem Log machen, bis Sie die 
deutlich kürzere und positive Empfangsbestätigung erhalten.  

29.8 QSL-Karten drucken (Printing QSL cards)  
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N1MMLogger hat KEIN Werkzeug zum Abhaken der QSLs nach gesendet/empfangen und zum Drucken von QSL-
Aufklebern. Ich (N1MM) habe das mit Absicht gemacht. N1MMLogger ist ein Contestprogramm, kein Programm zum 
allgemeinen Loggen. Hätte ich den Versuch unternommen, es allen Recht zu machen, wäre weder ein gutes 
Contestprogramm noch ein gutes Logprogramm herausgekommen. Ich habe das Programm lediglich um eine allgemeine 
Logmöglichkeit (Dxpedition)  erweitert. 
Ich empfehle z.B. das Programm LOGGER von K4CY auf der Seite  http://www.qsl.net/kc4elo. 
Wer QSL-Aufkleber drucken will, ist mit dem Programm BV von DF3CB bestens bedient . 

Beide Programme importieren Contest-Logs von N1MMLogger im ADIF-Format und verarbeiten Sie weiter. 

29.9 Contest-Log in das Stationslog importieren (Importi ng a contest into your general logging program)  

Franki, ON5ZO  

N1MMLogger kann zwar zum DX-Loggen verwendet werden, aber es ist nicht als Logprogramm geschrieben worden. Es 
hat keine Funktionen zur QSL-Verwaltung oder Diplomstatistik, Sie sollten Ihre QSOs aus N1MMLogger in ein 
Logprogramm Ihrer Wahl exportieren.  
N1MMLogger gibt die QSOs eines Contests auf Wunsch in eine ADIF-Datei aus. Sie können diese ADIF-Datei 
anschliessend – falls gewünscht – mit einem einfachen Texteditor wie Notepad oder Wordpad bearbeiten und anpassen.. 
Informieren Sie sich unter   http://www.hosenose.com/adif/adif.html über das Format eines ADIF-Logs, die 
Schlüsselworte, Feldtrenner usw. 
Moderne Logprogramme können die ADIF-Logs in der Regel ohne Änderung importieren. Nur dann, wenn Sie z.B. die 
unter dem ADIF-Schlüsselwort <POINTS:3>178 abgelegten 178km in einem UKW-Contest einer Logspalte COMMENT 
zuordnen wollen, können Sie mit der Ersetz-Funktion aus dem ADIF-Schlüsselwort POINTS das ADIF-Schlüsselwort 
COMMENT machen. 
Oder Sie können z.B. 300 Contest-QSOs als ADIF-Datei übernehmen und als Kommentar zu jedem QSO den Eintrag 
<COMMENT>QSO in ARRL DX CW 2002   einbauen. Wenn Sie die QSOs ins „grosse“ Log importieren, haben Sie den 
entsprechenden Kommentar. Oder Sie können, wenn Sie einen ARRL-Contest mitgemacht haben, den als 
Kontrollnummer aus den USA gesendeten Staat in die Logspalte State  umleiten. 
Ich speichere keine Normal-QSOs in N1MMLogger und fahre keine Conteste mit meinem normalen Log, aber führe 
anschliessend alle QSO in einem General-Log zusammen und kennzeichne die QSOs. 

30. Hilfe und Handbücher (Help files and Manuals) 

Sie erhalten Hilfe für N1MMLogger auf drei Wegen :  

• Gehen Sie im Internet zur  N1MMLogger-Homepage( www.n1mm.com ) und wählen Sie View Help files  
• Holen Sie sich von der gleichen Seite die Windowshilfe N1MMLoggerHelp.chm und speichern Sie sie in das 

N1MMLogger-Verzeichnis  
• Holen Sie von der gleichen Seite sich das Handbuch als PDF-Datei N1MMLogger.pdf Sie können das 

Handbuch mit dem Adobe Acrobat Reader (Version 3 oder höher) lesen oder es ausdrucken. Speichern Sie 
das Handbuch im N1MMLogger-Verzeichnis.  

Beide Hilfen, die CHM-Hilfe-Datei und das PDF- Handbuch sind vom Programm aus erreichbar. Sie erhalten folgendes 
Angebot für Hilfen : 

Englisch ist die jeweils aktuellste und neueste Version   

• Help file  
o Holen Sie sich die Hilfe aus dem Internet  
o Holen Sie sich die Windows-Hilfe  (1.6 MB)  

 

• Handbuch 
o Holen Sie sich das Handbuch im PDF 

Format mit einem rechten Klick (3 MB)  
 

• Versionsinformation  
o Lesen Sie die Versionsnummer jeweils am 

Fuss der Titelseite  
 

• Weitere Informationen  
o Zehn Schritte im Schnelldurchlauf (Ten Easy 

Steps to Successful Logging) 
 
 

Französisch  

Der größte Teile der Hilfe wurde von Patrick, TK5EP,ins Französische übersetzt 
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• Siehe französische Hilfe im Internet  

Deutsch  

Die komplette Hilfe wurde von Eike, DM3ML, im November 2003 ins Deutsche übersetzt. Die Hilfe kann 
im PDF-Format von der Download Help page geholt werden 

• Hilfe im PDF-Format (zipped) (version 3.0.109 okt-nov 2003) 
mit einem Rechtsklick holen  (2.9 MB)  

P.S, Die vorliegende Übersetzung V4.0.88 wird an der gleichen Stelle zu finden sein (DM3ML) 

Italienisch  

Den Schnelldurchlauf hat Max, I8NHJ , ins Italienische übersetzt :  

• Take the Quick Tour / Una Panoramica del Programma (July 
2002)  

Polnisch  

Alle  Dateien wurden von Andy VA3PL in Juni 2004  ins Polnische übersetzt :  

Hilfe  

• View Polish Help on the web  

• Download Help as Windows Help file (Version 3.0.193 8 
luty 2004) (1.8 MB)  

Handbuch  

• Download Manual in PDF format (Version 3.0.193 8 luty 
2004) (use right-click to download) (2.8 MB)  

Versionsinformation   

• Show the version of the Help file and manual (go to the 
bottom of the page)  

Spanish   

Alle dateien wurden von Fernando LU9UOL im November 2002 ins Spanische übersetzt 
Der Schnelldurchlauf ( Quick Tour) wurde von Fernando, LW2DX , im April 2001 ins Spanische übersetzt 

Hilfe  

• View Spanish Help on the web  

Andere Informationen  

• Take the Quick Tour  

   

30.1 Oft gestellte Fragen zur Hilfe  (Frequently Asked Questions)  

Frage: Was ist die neueste Version von Hilfe und Ha ndbuch ?   

Sie sehen auf dem Titelblatt der Hilfe und des Handbuch das Ausgabedatum und die Version. Die englischen Hilfen sind 
jeweils die neuesten.   
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Frage : Warum haben Hilfe und Handbuch nicht die ne ueste Versionsnummer ?   

Die Hilfen werden getrennt vom Programm aktualisiert, in der Regel aller paar Wochen  

• Sie müssen sich selbst die neueste Version der Hilfe von der N1MMLogger-Seite im Internet holen. Sie sind 
nicht Bestandteil der regelmässigen Updates  

• Passt die Hilfe nicht zur aktuellen Versionsnummer, holen Sie sich die am nächsten dazu aktualisierte 
Version  

• Grössere Programmänderungen werden im N1MMLogger-Reflektor angekündigt, kleinere finden laufend 
statt  

• Hilfe und Handbuch werden zusammen zum gleichen Datum aktualisiert  

Frage: Wie erreiche ich die Hilfe ?  

• Verwenden Sie die Taste Alt-H, nicht F1  
• Stellen Sie sicher, dass die Hilfe im N1MMLogger-Verzeichnis abgespeichert ist  
• Holen Sie sich die neueste Version der Hilfe (s.o.)  
• Die in der Grundinstallation mit N1MM.zip enthaltene Hilfe ist überholt und sollte aktualisiert werden.  
• Das Handbuch muss grundsätzlich getrennt geholt werden. 

 

31. Tipps und Tricks (Tips and Tricks) 
 
Dieses Kapitel gibt einige Tipps und Tricks für die Programmnutzung. Die Tipps sind – wenn nicht anderes angegeben -  
von Tom, N1MM.   

31.1 Bandskalen, Eingabefenster und ihre Geheimnisse (Ba ndmaps, Entry windows and the mysteries 
thereof...)  

Zwei Logeingabefenster 
 
Mit zwei Logeingabefenster ist die Bedienung des Programms komplizierter. So können Sie arbeiten :  

• Schalten Sie den Eingabekursor mit der Taste  \  zwischen den Fenster um  
• Schalten Sie den Eingabekursor UND das sendeaktive Fenster mit den Pfeiltasten CTRL+LINKS und 

CTRL+RECHTS hin und her 

Mit einem VFO auf dem einen Band und dem anderen auf dem gleichen oder einem anderen Band schalten Sie mit 
CTRL-UP oder CTRL-DWN von Spot zu Spot im Hauptfenster (VFO-A) und mit CTRL-Shift-UP oder CTRL-Shift-DWN im 
zweiten VFO von Spot zu Spot. Hat Ihr Transceiver einen Zweitempfänger (FT1000MP, Orion..) können Sie beide Spots 
zur gleichen Zeit hören. Schalten Sie mit CTRL-F12 um, ob sie nur den zur Tastatur gehörenden RX-VFO oder beide 
hören wollen. 
Mit den Zweitempfänger beim Orion und FT-1000/MP können Sie mit dem Haupt-VFO auf einen Station abstimmen und 
auf sie warten und währenddessen mit CTRL-Shift-UP oder –DWN auf dem zweiten VFO schon eine andere arbeiten 
oder die nehmen, die zuerst frei ist. In der Klasse SOA  (Single OP assisted) können Sie das auf zwei Bändern und in der 
Einband-Klasse auf zwei Frequenzen im gleichen Band machen. 
 

Bandskalen 

 Der Klick auf einen DX-Spot in einer Bandskala, aktiviert die Tastatur und den VFO für diesen Spot und setzt das 
Rufzeichen über das Eingabefenster. Ein Doppelklick macht das gleiche, setzt aber das Rufzeichen gleich ins 
Rufzeichenfeld 

Studieren Sie das Kapitel Tastenzuordnungen und drucken Sie es aus. Sie werden N1MMLogger besser nutzen können. 
Glauben Sie mir !  

31.2 Start der Contestsaison (Start of the contest seaso n) 

Mit dem CQWW SSB beginnt die Contestsaison und das Programm wird kritisch geprüft, ob Bugs und 
Leistungsprobleme inzwischen behoben worden sind. 

Programm testen 
Bitte fangen Sie mit dem Testen rechtzeitig im Herbst an. Machen Sie eine Kopie Ihrer Contestdatenbank ham.mdb und 
nehmen Sie einen grossen Contest aus dem letzten Jahr zum Testen. Einen grossen Contest deshalb, weil viele 
Probleme erst bei grossen Datenmengen auftreten. Ich bin auf Ihre Testergebnisse angewiesen, wenn ich Fehler 
abstellen und das Programm verbessern will.  
Darf ich Ihnen einen Testleitfaden empfehlen ? Hier ist einer  : TestPlan.wri. Wir würden uns freuen, wenn Sie an 
Verbesserungen mitarbeiten würden.  
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Tastenzuordnungen (Key Assignments) 
Informieren Sie sich über Änderungen bei der Tastenzuordnung. Hier können Sie am schnellsten sehen, was das 
Programm kann. 
 

 ESM 
Wenn Sie viel in CW oder RTTY arbeiten, sollten Sie sich unbedingt mit dem ESM-Modus (loggen mit der ENTER-Taste) 
vertraut machen. Dieser Modus vermeidet Fehler und sendet immer genau den Text, der gebracht wird und das einfach 
durch einen Druck auf die ENTER-Taste. Es dauert eine Weile, bis Sie sich daran gewöhnt haben. Sie sollten nicht in der 
letzten Minute vor dem Contest damit anfangen. Glauben Sie mir, wer mit ESM vertraut ist, liebt es…. 
  

Zwei Logeingabefenster auf einmal   
Auch diese Technik sollten Sie rechtzeitig ausprobieren. Als Referenz : 
\ schaltet die Eingabe und CTRL-LINKS und –RECHTS zusätzlich die Senderechte zwischen den Fenstern um. 
Mit CTRL-Fn und CTRL-ENTER können Sie auch auf dem Transceiver senden, der nicht aktiv geschaltet wurde.  

Optionen bei der Konfiguration  
Informieren Sie sich über die vom Normalen abweichenden Optionen in der Konfiguration : 

• SO2V/SO2R (zwei VFOs/zwei Transceiver) 
• Send corrected call  (Wiederholung bei korrigiertem Rufzeichen) 
• Send partial calls  (nur zum Teil empfangene Rufzeichen senden) 
• Stop sending CQ when callsign changed  (CQ abbrechen, wenn ein Rufzeichen eingegeben worden ist) 
• Fill in his exchange when sending yours  (ESM Mode) (empfangene Kontrollnummer eingeben während 

die eigene gesendet wird) 
• Config > Spot all S&P calls locally   (S&P-Rufzeichen lokal melden) 

Tom Wagner - N1MM 

31.3 Rufzeichen automatisch komplettieren  (Autocompletion mode(  

Zum Contestende hören Sie eine Menge an Rufzeichen, die Sie vorher auf dem gleichen oder einem anderen schon 
gehört oder gearbeitet haben, 
Wenn Sie die Autocompletion mode  in Config > Karteikarte Other  freigegeben haben, füllt das Programm schon nach 
Eingabe der ersten Zeichen eines Rufzeichens das Rufzeichenfeld mit einem vollständigen – im Log gefundenen – 
Rufzeichen aus, wenn keine andere Variante mehr möglich ist. Die ergänzten Teile des Rufzeichens sind dabei 
hellgetastet und sie können Sie überschreiben oder löschen. Wenn Sie die Leertaste drücken, wird das Rufzeichen – 
auch nach Teileingabe – übernommen. 
Testen Sie, ob Ihnen diese Funktion helfen kann oder Sie stört. Sie sollten aber einen Contest mit vielen Rufzeichen 
nehmen. 

31.4 Log editieren (Log Editing)  

Sie haben sicher während eines Contests schon QSOs editieren müssen. Wollen Sie ein früheres QSO editieren, 
drücken Sie CTRL-Q und wenn sie weiter zurück wollen, wieder CTRL-Q. Mit CTRL-A  können Sie wieder vorwärts 
gehen. Diese Tasten ignorieren Stationen, die von anderen OPs gearbeitet wurden. Sie können ausserdem das 
Logeingabefenster zur Korrektur verwenden, das während der Korrektur eine andere Hintergrundfarbe hat, Verlassen Sie 
die Schnellkorrektur mit ESC. 

31.5 Land nicht gefunden (kein Multi) (Country not found  when logging contact (no mulitpier credit))  

• Zuerst : Laden Sie die neueste Datei wl_cty.dat unmittelbar vor dem Contest   
• Oder : Wählen Sie das Werkzeug Tools > Add Call to Country. und weisen Sie einem bekannten Land das 

unbekannte Prefix oder Rufzeichen zu 
• Oder : Machen Sie mit ALT-N eine Notiz zu dem QSO und reparieren Sie das Problem später. Sehen Sie 

unter  View > Notes unter den Notizen nach. Eigene Einträge in der Länderdatei werden beim Laden der 
nächsten Version überschrieben.   

31.6 Mit F1 immer CQ rufen (Having F1 always send CQ)  

Die Taste F1 sollte auf jeden Fall – und unabhängig vom Modus – einen CQ-Ruf auslösen und in den Running-Modus 
schalten. Mit diesem Trick können Sie dieses Verhalten erreichen :  
N1MMLogger schaltet das Programm immer dann in den Running-Modus, wenn es ein CQ in einem Text oder einem 
Tastentitel (Button caption) findet. Sie müssen also ein CQ-Makro auf einer der S&P-Tasten erzeugen. Machen Sie es 
auf F1, schalten Sie automatisch von S&P in den Running-Modus. Wenn Sie am Transceiver von der CQ-Frequenz 
wegdrehen, schaltet das Programm automatisch wieder in der S&P-Modus. 
Gehen Sie so vor :  
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• Config > Change Packet/CW/SSB/Digital Message Buttons > Change CW Buttons (oder SSB Buttons) 
• Auf F1 im S&P-Modus  ist normalerweise F1 {MY CALL} voreingestellt und Ihr Rufzeichen wird gesendet 
• Ändern Sie den Tastennamen im  S&P-Modus  für F1 (neunte Zeile) auf F1 CQ  und übernehmen Sie für 

diese Taste den CQ-Text von F1 in der ersten Zeile  
• Die F1-Taste im  Running-Modus  in der 1. Zeile bleibt unverändert, also F1 CQ gefolgt vom CQ-Text in CW 

oder der CQ-WAV-Datei in SSB  

Hinweis : In  ESM und S&P-Modus wird mit der ENTER-Taste als erstes nach wie vor Ihr Rufzeichen gesendet (Taste 
F4)  

31.7 Empfehlungen zum S&P auf einem neuen Band (How I re commend to S&P on a new band)  

• Sehen Sie in das Fenster Verfügbare Multis und QSOs und prüfen Sie, ob neue Multis zu arbeiten sind. 
• Tasten Sie sich mit ALT-CTRL-UP/DWN  durch die Multis im Bandplan. 
• Sie werden den Vorgang mehrfach wiederholen müssen. Halten Sie sich nicht zu lange bei einem 

Rufzeichen auf, an das Sie nicht gleich herankommen.   
• Arbeiten Sie mit CTRL-UP/DWN die im Bandplan gemeldeten Stationen ab. Finden Sie dazwischen eine 

freie Frequenz, rufen Sie selbst CQ. Je nachdem, ob es läuft oder nicht, gehen Sie wieder zu S&P zurück 
oder rufen weiter CQ.  

• Haben Sie das Angebot in der Bandskala abgearbeitet, starten Sie den manuellen Suchlauf. Schalten Sie 
die Option QSYing wipes the call. ein. Falls eine Station schwierig zu arbeiten ist, wird sie auf Ihrem PC fett 
markiert in die Bandskala eingetragen und sie können es mehrfach versuchen. Verbrauchen Sie nicht zu 
viel Zeit mit der Jagd auf eine Station.  

• Tragen Sie auch die lauten Stationen in die Bandskala ein, die nicht im Contest mitmachen oder nach den 
Regeln nicht gearbeitet werden können. Sie sparen dann beim Suchen Zeit und müssen sie nicht wieder 
identifizieren.  

31.8 QSO schnell editieren  (Quick Edit)  

Falls Sie ein Rufzeichen falsch eingegeben haben und es schnell ausbessern wollen, wenn es schon im Log steht, 
können Sie die Taste CTRL-Y (Edit last contact) nehmen, aber dieser Dialog ist relativ kompliziert und dauert zu lange in 
der Hitze des Contests.   

Es gibt mit Quick-Edit (CTRL-Q) eine bessere Möglichkeit. Quick-Edit holt das letzte QSOs ins Logeingabefenster, wo sie 
es editieren können. Mit ENTER wird das QSO abgespeichert, mit ESC wird die Änderung verworfen. Die Felder im 
Logeingabefenster werden dabei blau hinterlegt um Sie darauf hinzuweisen, dass Sie im Quick-Edit-Modus sind. Sie 
wollen drei QSOs zurück ? Drücken Sie CTRL-Q dreimal. Sie sehen im Logfenster, bei welchem QSO Sie sind. 
 

31.9 Contestziele setzen  (Setting contest goals)  

Sie wollen den Contest gewinnen ? Ein Weg dahin ist, sich Contestziele zu setzen. 
Sie können diese Contestziele mit QSOs/Stunde in eine Tabelle eintragen und erhalten im Infofenster Informationen 
darüber, ob Sie die gestellten Ziele erreichen oder dahinter liegen. Die vier Fenster mit den aktuellen Raten sind rot bei 
weniger als 50%, gelb zwischen 50 und 100% und grün wenn Sie über den Zielen liegen.. Die Werte gelten für die 
programmierte Stunde (oder mehrere Stunden) bis zum nächsten gesetzten Ziel. 
Vielleicht fangen Sie erst einmal damit an, die Raten des Vorjahres zu verbessern ? 
Das Programm unterstützt dieses Vorhaben. Öffnen Sie das Jahr des gleichen Contests vom letzten Jahr. Klicken Sie 
dann auf Import Goals im Infofenster. Wählen Sie den Tag 1 oder 2 und drücken Sie dann auf ENTER. Ihre Zielvorgaben 
sind jetzt so eingestellt, wie sie beim letzten Contest erreicht wurden. Starten Sie dann den neuen Contest für dieses 
Jahr. Die Zielvorgaben bleiben solange bestehen, bis Sie sie neu editieren (mit Edit Goals ), löschen oder eine neue 
Datenbank mit LOAD A NEW DATABASE  anlegen (nicht nötig !) 

31.10 Probleme während des Contests   (Problems during a contest)  

Sollten folgendes machen : 

1. Stellen Sie sicher, dass Sie eine frühere Version des Programms haben, das in der Vergangenheit störungsfrei 
gearbeitet hat  

2. Testen Sie das Programm eine ausreichende Zeit vor dem Contest mit den Sende- und Betriebsarten, die Sie im 
Contest nutzen wollen. Speichern Sie ein paar Test-QSOs ab. Gehen Sie alle Fenster durch, die Sie nutzen wollen. 
Testen Sie das Packet/Telnetfenster, falls Sie es nutzen wollen. Holen Sie sich den Testplan von  
http://groups.yahoo.com/group/N1MMLogger/files/TestPlan.wri 
und arbeiten Sie ihn durch. 
Sollten Sie Probleme feststellen, melden Sie sie bitte so schnell als möglich, damit sie noch vor dem Contest behoben 
werden können. 
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3. Sehen Sie auf der Update-Seite von N1MMLogger im Internet nach. Wir lösen auch Probleme während eines Contest. 
Echte Fehler werden umgehend abgestellt, kleinere Probleme werden nach dem Contest geklärt. 

31.11 Abstimmen mit den Pfeiltasten  (Using up/down to tune)  

Sie können Ihren Transceiver mit den Pfeiltasten nach oben und unten abstimmen, wenn Sie im S&P-Modus arbeiten. 
Am geeignetsten ist diese Abstimmung für das Abarbeiten von DX-Spots. Sie können auch im Running-Modus mit den 
Pfeiltasten arbeiten, wenn Sie den Splitbetrieb einschalten und die Tasten als RIT verwenden. 
Stellen Sie die Schrittweite der Abstimmung mit den Tasten auf der Karteikarte Other  in der Konfiguration ein. 
 

31.12 CW-Tipps  (CW Tips)  

CW-Makrotipp :  Es gibt Rufzeichen, bei denen die Verwechselung vorprogrammiert ist. Nehmen Sie z.B. als  6Y2A am 
Contest teil, steht in vielen Logs das Call BY2A. Um den Unterschied deutlich zu machen, schreiben Sie Ihr eigenes 
Rufzeichen im Menü Config >  Change Packet/CW/SSB/Digital  Message Buttons> Change CW Buttons nicht mit 
dem Makro * , sondern als  >6<~Y2A.  
Ergebnis : die 6 wird 2 WPM langsamer gesendet als der Rest des Rufzeichens und ein zusätzlicher halber 
Zwischenraum wird zwischen die 6 und Y2A eingefügt, so dass das Rufzeichen besser zu verstehen ist. Probieren Sie 
andere Kombinationen mit  <, >, oder ~ aus, um weniger Fehler zu provozieren. 

Contestabstände : Wenn Sie unter  Config > Change Ports, Telnet Address, Other > Func tion Keys  die Box Use 
Contest Spacing for CW  auf ON setzen (voreingestellt), wird der Wortabstand von 7 auf 6 Punktlängen verringert. So 
wird z.B. der 3-Wort-Text N1MM 599 5 schneller gesendet. 

31.13 Stationen doppelt arbeiten  (Working Dupes)  

Wenn Sie im S&P+ESM-Modus Stationen doppelt arbeiten wollen, ändern Sie den Inhalt der Taste F6 "QSO B4" auf Ihr 
Rufzeichen * um. Wenn Sie ENTER eingeben um einen Station anzurufen, wird Ihr Rufzeichen einmal gesendet, nehmen 
Sie dann zum nächsten Anruf die Taste F4, wenn Sie beim ersten Anruf nicht drangekommen sind. Wenn die Station für 
Sie zurückkommt und Sie die empfangene Kontrollnummer eingetragen haben, wird Ihre Contestnummer gesendet. 

31.14 Haltezeit für DXSpots  (Packet Spot Timeout)  

Meist reichen 30 Minuten für die DXSpots in der Bandskala aus, ehe sie automatisch gelöscht werden. Wenn viel los und 
die Bandskala mit Spots überladen wird, verkürzen Sie die Zeit auf 20 min. Für Testzwecke können Sie die Zeit auch auf 
1000 min hochsetzen. Ist Ihr Rechner etwas schwach, sollten Sie die Zeit kürzer einstellen, damit er weniger zu 
bearbeiten hat. 

31.15 Programm als Single-OP effektiv nutzen  (ow should I really use this program if I am SOA?)  

SOA = Single Operator Assisted  

Versuchen Sie diese Techniken:  

• Holen Sie sich vom DXCluster mit sh/dx/100  genug Spots, um die Bandskalen zu füllen 
• Wählen Sie im Fenster Available das Band mit den meisten Meldungen. 
• Arbeiten Sie in diesem Band mit den Tasten  Alt-Ctrl-Up  und Alt-Ctrl-Down  alle Multis auf diesem Band 

ab. Halten Sie sich nicht zu lange bei überlaufenen Stationen auf.  
• Klicken Sie dann das Band mit Ctrl-Up  und Ctrl-Down  durch und arbeiten Sie den Rest der Stationen (no-

mults). Sollten Sie eine ruhige Frequenz zwischen den Stationen finden, setzen Sie sich darauf,  schalten 
Sie in der Running-Modus und rufen Sie CQ.  

• Kommt keiner mehr, gehen Sie wieder auf die Jagd nach Multis und QSOs auf diesem Band. 
• Jetzt können Sie auf ein anderes Band gehen und die Prozedur wiederholen oder Sie können diese Technik 

ausprobieren : 
Schalten Sie Spot all S&P Calls Locally  auf EIN. Suchen Sie das Band nach Stationen ab, die Ihnen noch 
fehlen. Geben Sie die Rufzeichen in das Rufzeichenfeld des Logeingabefensters ein. Wenn Sie 
weiterdrehen, wird das Rufzeichen in der Bandskala eingetragen und fett markiert. Neben Sie dann die 
CTRL-UP/DWN-Tasten , um die selbst-gemeldeten Stationen abzuarbeiten. 

• Passt die Station nicht zu Ihrem Contest, können Sie die Frequenz als busy  mit ALT-M  markieren und die 
Station später übergehen. Sie können auch Ihren mitfunkenden Nachbarn markieren und wissen dann, dass 
der Lärm 2 kHz tiefer nur von ihm kommen kann  

31.16 Station mit unvollständigem Call im Log suchen (How  to find a worked station in the log when I 
missed parts?  

Sie können ein gearbeitetes Rufzeichen auf drei Wegen im Log wiederfinden :  
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• Nach der Eingabe von drei Zeichen wird die Station automatisch angezeigt  
• Kennen Sie von N1MM nur N?M ist diese Eingabe ausreichend um auf N1MM oder jede andere Station mit 

N?M zu kommen.  
• Fehlt Ihnen das Präfix können Sie  es durch einen * ersetzen. *1MM bringt N1MM und jede Station mit 1MM 

im Rufzeichen  
Kombinationen sind möglich :   
 

• *1?M bringt N1MM und K1MR, J41YM  und andere  
• *3? oder *3* bringt alle Stationen mit einer 3 im Rufzeichen  
• *3*Z bringt alle Stationen mit einer 3 und einem folgenden Z irgendwo im Rufzeichen wie  K3ZO, VA3UZ 

usw.  

Wenn Sie mit einem * in einer SQL-Datei suchen, braucht Ihr Rechner eine ganze Weile dazu 

31.17 Datenbanken und Conteste  (Databases versus Contests)  

N1MMLogger benötigt nicht für jeden Contest eine neue Datenbank (data base). Beachten Sie bitte folgende Definitionen 
:  

Datenbank (Database)  : eine Datenbank im Access-2000-Format mit der Dateierweiterung *.mdb kann jede beliebige 
Anzahl von Contesten aufnehmen 
Contest  : ein Satz von QSOs in dieser Datenbank. Die QSOs sind einer Tabelle mit dem Namen DXLOG abgespeichert. 
Jeder Datensatz hat eine ContestNr mit dem er  dem Eintrag ContestInstance zugeordnet ist. 

Ich selbst habe eine “offizielle” Datenbank für meine 14 000 Contest-QSOs. Natürlich habe ich für Testzwecke und für die 
Datensicherung weitere Datenbanken, aber sie werden nicht unbedingt benötigt. Sollten Sie allerdings eine Dxpedition 
mit über 25 000 QSOs planen, sollten Sie eventuell doch eine neue Datenbank einrichten. 

 
Noch einen Tipp : Die Funktion Copy (and compact) Database  werden Sie sicher selten oder gar nicht verwenden. Sie 
sollten Sie aber gelegentlich starten, um Ihre Datenbank von freien Stellen zu befreien. Diese freien Stellen entstehen, 
wenn Sie QSOs oder ganze Conteste löschen. Die freien Stellen werden nicht automatisch wieder freigegeben. Sie 
brauchen das Datenbank-Werzeug aber nur aller 6 Monate oder dann, wenn Sie eine Datenbank sichern wollen, zu 
starten. 
 

Sichern Sie Ihre Datenbank regelmässig ! Ein guter Zeitpunkt dazu ist, wenn Sie Daten löschen oder neue Daten 
importieren. Sind die Daten einmal weg, werden Sie sie nicht wiederfinden. 

31.18 QSOs löschen (speziell für Mulit-Stationen)  (Deleting qso's (especially important for Multi-User ) 

Dieser Punkt ist vor allem für die Multi-User interessant.  

Zur Unterstützung der Multi-User habe ich den DELETEDQS –Contest eingeführt. Wenn ein QSO mit der Entf -Taste 
oder mit ALT-D  gelöscht wird, verschwindet er nicht sofort, sondern wird in den DELETEDQS – Contest überführt. 
Suchen Sie doch noch nach einem oder mehreren gelöschten QSO(s) können Sie den DELETEDQS-Contest als ADIF-
Datei exportieren, die gewünschten QSOs herauskopieren und in den aktuellen Contest wieder importieren. Diese 
Möglichkeit ist vor allem für den Multi-Userbetrieb interessant, wo schneller Doppel-QSOs entstehen. Sie können diese 
QSOs ruhig im Log stehen lassen, weder das Cabrillo-Log noch der Veranstalter stört sich an diesen QSOs. Sie können 
u.U. die Punktzahl verbessern, werden aber – wenn es wirklich Doppel-QSOs sind – aus der Wertung gestrichen. 

31.19 QSY löscht QSOs und Spots in der Bandskala (QSYing wipes the call & spots QSO in bandmap)  

Haben Sie schon beobachtet, dass das Logprogramm Doppelrufzeichen in dei Bandskala einträgt ? Das macht es dann, 
wenn Sie ein Rufzeichen in das Eingabefeld eintragen. Das Eingabfeld wird dann gelöscht, aber das Rufzeichen wird in 
die Bandskala eingetragen. Wenn Sie die Option QSYing wipes the call & spots QSO in bandmap  aktivieren, wird 
diese Meldung gelöscht. Wenn Sie eine Station hören, die gerade beschäftigt ist, wird sie fett  in die Bandskala als 
Eigenmeldung eingetragen und Sie können mit  Ctrl-Up/Down  zu ihr zurückkehren.  

31.20 Abkürzungen senden  (Exchange abbreviations)  

Bei manchen Contesten müssen Sie z.B. ihre Provinz oder Sektion senden und Sie als Kontrollnummer in einem 
vorgeschriebenen Format ins Log eintragen. Wenn Ihnen oder Partnerstationen diese Vorgaben nicht gefallen und Sie 
oder die Gegenstation lieber statt CT ein CONN senden, können Sie mit dem Menü Config > Change Exchange 
Abbreviations   diese vom Standard abweichenden in eine Zuweisungstabelle eintragen, die aus dem empfangenen 
CONN automatisch ein CT macht.  

31.21 Bandskala überfüllt  (Too many calls on the bandmaps!)  



N1MMLogger-Hilfe V.4.0.88 Seite 127 von 227 Übersetzung von Eike, DM3ML 

Ist Ihre Bandskala vor lauter Rufzeichen kaum noch zu entschlüsseln, können Sie sie mit den Tasten + und – im 
Nummernfeld der Tastatur strecken oder wieder zusammenschieben. Sie können auch rechts in die Bandskala klicken 
und Zoom in  oder Zoom out  wählen. Sie können auch „nicht arbeitbare Stationen“ grau markiert mit ALT-M  in die  

31.22 Grayline-Öffnungen beachten  (Gray line openings)  

Achten Sie darauf, ob Ihr Sonnenauf- oder untergang mit dem Sonnenunter- oder aufgang der Gegenstation 
übereinstimmt. Sie müssen dazu Ihre Koordinaten richtig im Stationsdialog eingetragen haben. Sie sehen die Angaben 
für die eigene Standort unter Help > About  in der dritten Zeile von unten und für die Gegenstation im Info -Fenster, wenn 
Sie das Rufzeichen in Eingabefenster eingetragen haben. Beachten Sie dabei, dass sich die Zeiten für die Gegenstation 
auf einen in der Datei cty.dat abgelegten zentralen Punkt des jeweiligen Landes oder Rufzeichengebiets bezieht. 

31.23 QSO-Bestätigung  (QSO confirmation)  

Einige Contestregeln verlangen eine Bestätigung des richtigen Empfangs der Kontrollnummer. Dazu reichen „QSL", "TU" 
oder "R" vollkommen aus. Es wird NICHT verlangt, dass Sie die empfangene Kontrollnummer wiederholen. Diese 
Wiederholung ist nur in Ausnahmefällen nötig, z.B. wenn die Gegenstation stark gestört ist. 

31.24 Warten auf die Seriennummer  (Serial Number contest)  

Wenn Sie bei einer stark beschäftigten Gegenstation, die Sie unbedingt arbeiten wollen, auf das QSO warten, können 
Sie schon immer die Seriennummer in das Kontrollnummernfeld eintragen und jedes Mal, wenn jemand anderes dran 
gekommen ist, diese Nummer mit CTRL-U um Eins erhöhen, bis Sie es doch geschafft haben.. 

31.25 Transceiver nicht eingeschaltet  (Dead radio at startup)  

Haben Sie einen für N1MMLogger vorbereiteten Transceiver noch nicht eingeschaltet, lehnt das Programm es ab, ein 
QSO dafür zu loggen. Dadurch werden Falscheingaben verhindert. Soll der Transceiver tatsächlich ausgeschaltet 
bleiben, entfernen Sie ihn aus der Konfiguration. 
Haben Sie den Transceiver eingeschaltet, sollte seine Frequenz nach spätestens 10 s in der Bandskala erscheinen. 
Passiert das nicht, gehen Sie in die Konfiguration auf die Hardware-Karte und klicken Sie auf OK. Sie brauchen 
N1MMLogger nicht neu zu starten.  

31.26 Programmgeschichte lesen  (Read the update log)  

Zu jeder neuen Version wird eine Datei RevisionHistory.htm  oder UpdateLog.wri  mitgeliefert.  
UpdateLog.wri kann mit Notepad gelesen werden. Die RevisionHistory.htm kann auf N1MMLogger heraus oder mit 
einem Internetbrowser gelesen werden. 
Anmerkung DM3ML : Bei mir war UpdateLog.wri nur bis Version 3.0.49 geführt, aber RevisionHistory.htm ist auf dem 
neuesten Stand. 

Sie können dieser Auflistung entnehmen, was neu an einer neuen Version ist, was geändert und welche Fehler 
abgestellt wurden und ob eventuell eine Option wieder herausgenommen wurde.  
Die jeweils neueste Datei enthält den neuesten Stand und die Entwicklungsgeschichte bis dahin, so dass Sie die Dateien 
nicht aufheben müssen. Lediglich die Version 1 wurde aus der Geschichte gestrichen. 

31.27 Packet/Telnet-Tasten einstellen ( Packet/telnet button setup)  

Nachstehend gebe ich meine Einstellung der Tasten im Packet/Telnet-Fenster als Beispiel an. Sie sind auf meinen 
Standort in New England bezogen, zeigen Ihnen aber, was alles möglich ist :  

NE only  heisst NUR  New England  (W1 & W2). Der jeweils erste Eintrag ist das Kommando, der zweite die 
Tastenbeschriftung und ein vorgestelltes & macht aus der Taste eine Kurzruftaste (Hot key) mit ALT+Buchstabe nach 
dem & aus dem Packet/Telnetfenster heraus. Die vorgeschlagenen Tastenkodes beziehen sich auf meinen lokalen 
DXCluster. 

Sie finden auch Beispiele anderer Stationen bezogen auf ihren örtlichen DXCluster. Sie können auch CW-Spots in einem 
SSB-Contest oder SSB-Spots in einem CW-Contest unterdrücken. Sie können mit Tools > Clear All Spots  alle 
Meldungen löschen, wenn die Bandskala zu unübersichtlich wird. Sie können danach ein Filter neu definieren und die 
Bandskala mit SH/DX/100 wieder auffüllen. 
 

BYE &BYE 
C K1TTT &CONN 
DI/N DI/N 
SH/DX/30 &SH/DX 
SH/U &USERS 



N1MMLogger-Hilfe V.4.0.88 Seite 128 von 227 Übersetzung von Eike, DM3ML 

SH/WWV &WWV 
set/filters dxorigstate/off Clear NE 
set/filters dxorigcty/off Yes DX 
set/filters dxorigstate/pass ny,nj,ct,ri,ma,nh,vt,me NE only 
set/filters dxorigcty/pass k,ve, xe No DX 
set/filters vhf/reject No VHF 
{MYCALL} {MYCALL}  

31.28 Schlafkrankeit des PC  (Slow PC syndrome)  

Einige Laptops von  COMPAQ & Toshiba unter Win98 werden mitunter sehr langsam nachdem Sie einen Piep (z.B. beim 
CW-Monitor) abgegeben haben Die PC-Uhr geht 10 mal langsamer als normal. Diese Schlafkrankheit lässt sich nur mit 
einem Rechner-Neustart bekämpfen. 
Schalten Sie dann  Monitor via PC speaker unter  Config > Configure Ports > Function Keys ab und starten Sie den 
Rechner neu. Der Fehler ist dann verschwunden. 
 
73 Uffe PA5DD  

31.29 ARRL Sweepstakes  

Sweepstakes sind ARRL-interne Conteste und haben eigene Regeln. Der Nummernaustausch ist fünfteilig und besteht 
aus (call, nr, prec, ck, section). N1MM hat nicht fünf Textfelder sondern nur zwei vorgesehen. In die erste Box kommt das 
Rufzeichen, in die zweite der Rest (alle fünf) : 
Nachstehend finden Sie ein paar Beispiele (gekürzt von DM3ML) :  

261 A 55 CT - 261A 55 CT 
12B Q CT 61 - 12B 61 CT 
12B Q CT 61 EMA 44 - 61Q 44 EMA 
CO CT 12 13 B - 12B 13 CT 
12A W1XX CT 66 - 12A W1XX 66 CT 
(W1XX überschreibt das Rufzeichen im Rufzeichenfeld) 

31.30 Using N1MMLogger for regular logging  

Sie können N1MMLogger auch zum normalen DX-Loggen verwenden, obwohl es primär nicht dafür geschrieben worden 
ist.  Es fehlen die üblichen Werkzeuge zur Diplombearbeitung und der QSL-Verwaltung. Wollen Sie diese Informationen 
bearbeiten. müssen das Log von N1MMLogger als ADIF-Datei exportieren und in eins der üblichen DX-Logprogramme 
importieren  
N1MMLogger erfüllt die Vorschriften der ADIF-Konventionen. Die ADIF-Dateien können mit einem üblichen ASCII-Editor 
geöffnet und bearbeitet werden. Geeignet sind alte DOS-Editor-Programme, Notepad oder Wordpad. Die QSO-Daten 
werden in einer Kombination von Schlüssellwörtern, Längenangaben und QSO-Daten wie Call, Band, Rapport usw. 
abgelegt. Informieren Sie sich auf der ADIF-Seite  http://www.hosenose.com/adif/adif.html über Einzelheiten. 
Sie können eine N1MMLogger-ADIF-Datei nachträglich und vor der Übernahme in ein anderes Logprogramm bearbeiten. 
Nehmen wir als Beispiel eine ADIFDatei mit 300 QSOs aus dem ARRL DX CW-Contest- 2002. Der Contestname soll 
jedem QSO zugeordnet werden. Bei ADIF gibt es für Kommentare das Schlüsselwort COMMENT. Ersetzen Sie im ersten 
QSO den Eintrag <COMMENT> durch die Zeichenkette <COMMENT:22> >QSO in ARRL DX CW 2002 und ersetzen 
dann alle restlichen 299 COMMENT-Einträge durch diese Zeichenkette. Im neuen Log erhalten dann alle 300 Contest-
QSOs diesen Kommentar.  
Oder trennen Sie aus der Kontrollnummer <SRX> in einem ARRL-Kontest den US-Staat heraus und ordnen Sie ihn dem 
ADIF-Schlüsselwort <STATE> zu.  
Ich selbst logge keine Schwatz-QSOs mit N1MMLogger und keinen Contest mit meinem Standardlog, importiere aber die 
Contest-QSOs in mein Standardlog 

Good luck, have fun and 73! 
Franki ON5ZO 

31.31 QSOs mitschneiden (Recording QSO's)  

Sie können mit N1MMLogger alle QSOs über die Soundkarte  mitschneiden und sie sich hinterher wieder anhören : . 

• Wählen Sie  Record QSOs  im Menü  Config'  
• Schliessen Sie die NF vom Transceiver (am besten von einer ACC-Buchse) am Mic--Eingang der 

Soundkarte an. Wenn Sie Ihre eigene Stimme ebenfalls aufzeichnen wollen, müssen Sie den Monitor am 
Transceiver einschalten. Sie können die Pegel auf der Karteikarte Other des Config-Menüs einstellen.die 
NF vom Radio an den Mic-Eingang der Soundkarte anschliessen. Es gibt weitere interessante Programme, 
siehe Links.  

• Die Aufzeichnung eines neuen QSOs beginnt, nachdem das vorherige QSO geloggt worden ist. Es endet 
mit dem Abspeichern des aktuellen QSOs. 

• Die Aufzeichnung wird beendet, wenn 5 Minuten lang nichts eingegeben wurde  
• Jedes QSO bekommt seinen eigenen Dateiname.wav mit Rufzeichen, Datum und Uhrzeit, z.B. N1MM 10-

26-03 - 22 47 45.wav" 
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• Die WAV-Dateien werden in einem Verzeichnis unter dem aktuellen Contestnamen abgelegt, z.B. . 
C:\Program Files\N1MM Logger\CQWW\.... 

• Die WAV-Dateien können aus dem Programm mit einem rechten Klick ins Log und auf Play contact 
abgespielt werden. Mit ESC wird das Abspielen gestoppt.  

• Sie können die WAV-Dateien natürlich mit einem beliebigen Wiedergabeprogramm abspielen 
• Sie benötigen etwa 1 GB für einen 24-Stunden-Contest (40-50 MB je Stunde). Sie können die WAV-Dateien 

auf MP3 komprimieren, können das aber nicht machen, wenn Sie gleichzeitig CQ mit WAV-Dateien senden 
wollen. Sie können es aber nach dem Contest machen. Stellen Sie genug Speicherplatz auf der Festplatte 
zur Verfügung. 

• Die Aufzeichnung wird beendet, wenn weniger als 40 MB freier Speicherplatz auf der Festplatte festgetellt 
werden. 

• Die Aufzeichnungsfunktion wird ausgeschaltet, wenn von SSB auf CW umgeschaltet wird, sie wird dabei 
aber nicht ganz abgeschaltet  

• Hinweis : Das Aufzeichnen wird mit einem Programmneustart abgeschaltet. Sie müssen es von Hand 
zuschalten. Ihre Festplatte wird also nicht unbeabsichtiigt zugemüllt. 

• Die Aufzeichnung erfolgt mit 11025 Hz, 8 Bit, mono. 
• Testen Sie die Aufzeichnung vor dem ersten ernsthaften Einsatz. Sie müssen einige Tests und 

Einstellungen machen, ehe alles richtig funktioniert. 
 

32. Conteste auf VHF und höher (VHF and Up contesting) 

In N1MMLogger wurde eine Sektion speziell für Contester auf VHF und höher eingebaut, Die unterstützten Bänder gehen 
bis hoch zu S/EHF mit 10, 24, 47, 76, 142 and 241 GHz  

 

Die Tabelle zeigt die gearbeiteten Großfelder. Klicken Sie auf das eigene Großfeld. Es wird dann als Zentrum der 
Übersicht eingestellt. 

32.1 UKW-Optionen  (VHF options)  

32.1.1 Rufzeichenprüfung (Call History Lookup) 
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Bitte informieren Sie sich über die Rufzeichenprüfung auch im Kapitel  Vor dem Contest . 

Die Rufzeichenprüfung ist sowohl auf HF als auch auf VHF und höher einsetzbar. Auf jeden Fall muss die zu 
verwendende Master.dta-Datei passend zum Contest geladen werden, um z.B. OP-Namen bei RTTY (Datei friends.ini), 
das Alter (Geburtsdatum) beim All Asian Contest oder WW-Lokatoren auf UKW zur Verfügung zu haben. Für die 
Rufzeichenprüfung wird in der Contestdatenbank eine separate Tabelle aufgebaut. Die Tabelle heisst Call-Hist. Die 
Menüs im Logeingabefenster dienen dem Import und dem Export in und aus dieser Tabelle. Im Moment gibt es (noch) 
kein Werkzeug, um ein Contestlog direkt in die Call-History-Tabelle zu laden. 

Die Rufzeichenprüfung (Call history lookup) wird mit dem Menüpunkt Config > Call History Lookup  freigegeben. In 
einem VHF-Contest gibt sie zu einem gefundenen Rufzeichen maximal zwei Lokatoren und den Namen (falls 
gespeichert) aus. 

Hinweis : Im Moment ist die einzige Möglichkeit die Call-Hist-Tabelle zu laden der Import einer passenden Master.dta-
Datei. Die Master.dat-Datei lässt sich als Textdatei lesen und bearbeiten.. 

32.1.2 Master.dat-Datei für UKW  (VHF master.dta file)  

Für Kurzwelle gibt es verschiedene  Master.dta-Dateien, die in der Regel die Rufzeichen aktiver Contester enthalten und 
aus den Logs grosser Conteste kompiliert werden. Einige Dateien werden zusammen mit der Länderdatei cty.dat auf der 
Webseite von N1MM  bereitgestellt. Unter Other files  ist auch die RTTY-Datei friends.ini zu finden. Für UKW sind 
ebenfalls Dateien vorhanden und als Beispiel abrufbar. Alex, VE3NEA, hat ein gutes Freeware-Programm zur Erzeugung 
einer Master.dta-Datei geschrieben. 
Anmerkung DM3ML : Ich habe mir zum Marconi-Contest 2003 von dieser Seite die Datei Master-vhf-29082003.dta  
geholt, die sehr umfangreich und gut war. 

32.1.3 Transverterunterstützung (Transverter support)  

Unter N1MMLogger  kann man mit Set transceiver offset frequency  den KW-Transceiver als Nachsetzer eines UKW-
Umsetzers laufen lassen. Setzen Sie z.B. vom 2m-Band ins 10m-Band um, geben Sie als Offset-Frequenz den Wert 
116000 (Differenz in kHz) ein. Wenn Sie zwei Transceiver verwenden und zwei Bandskalen haben, können Sie getrennte 
Offsets für jeden Transceiver eingeben. Der Offsetwert wird abgespeichert und steht beim nächsten Programmstart 
wieder zu Verfügung. 

32.2 Beispiel für einen Contest (Example contest setup)  

Ergänzungen sind willkommen ! 

Erzeugen Sie (Tage) vor dem Contest   

32.2.1 Erzeugen Sie Tage vor dem Contest (Create (days) be fore the contest)  

• Eine neue Master.dta-Datei   
o Verwenden Sie das Werkzeug von Alex, VE3NEA 

• Eine Datei mit den Windows-Einstellungen   
o Mit File >  Export > Export Windows Settings to file … 
o Geben Sie der Datei einen Namen, z.B. VHFwindows.txt 

• Eine Datei mit den Programmeinstellungen   
o Mit File > Export > Export Program Settings to file … 
o Geben Sie Ihr einen Namen z.B. VHFprogramsettings.txt 

• Eine  Datei mit den Texten der F-Tasten in CW und SSB  
o Beim Start:  

� Mit File >  Export > Export Function Keys to file … > SSB Function Keys  
• Geben Sie ihr einen Namen z.B. VHFssbfunctionkeys.mc 

o Mit File > Export > Export Function Keys to file … > CWFunction Keys  
• Geben Sie ihr einen Namen z.B.VHFcwfunctionkeys.mc 

o Aktualisieren Sie die Dateien falls nötig 
o Sehen Sie sich noch einmal die Makros an  

• Eine Datei mit den Packet/Telnet-Tasten  
o Beim Start : File > Export > Export Packet/Telnet Buttons to fil e... 
o Aktualisieren Sie die Datei falls nötig 
o Geben Sie Ihr einen Namen z.B. VHFpacketbuttons.txt 
o Sehen Sie sich noch einmal die Makros  wie {GRIDSQUARE} an  

• Eine Master.dta-Datei für den UKW-Contest  
o Erzeugen und/oder editieren Sie die Datei mit Rufzeichen, Name, Lokator u.a. 
o Geben Sie Ihr einen Namen z.B. VHFlookup.txt 

• Informieren Sie sich über die Rufzeichenprüfung  
• Die WAV-Dateien für SSB für CQ, QRZ? U.a.  

o Erzeugen Sie WAV-Dateien für jeden OP 
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• Sehen Sie sich das Makro  {OPERATOR} im Kapitel Makros an  
• Eine Länderdatei  (cty.dat) 

32.2.2 Vor dem Programmstart  (Before starting the program)  

• Kopieren Sie die Master.dta-Datei in das N1MMLogger-Verzeichnis 
• Kopieren Sie die WAV-Dateien aller Ops in das Unterverzeichnis N1MMLogger\WAV  
• Schalten Sie den rechnerinternen Windoqws-Sound ab, wenn Sie die WAV-Dateien verwenden 
• …. 

32.2.3 Nach dem Programmstart  (After starting the program)  

• Prüfen Sie, ob die richtige Datenbank verwendet wird und öffnen Sie bei Bedarf mit  
o File >  open Database  die  VHF database (falls vorhanden und benötigt) 

• Import  
o Sie brauchen den Import nur einmal machen, wenn immer die gleiche Datenbank verwendet 

wird  
o Jede Datenbank kann viele Conteste mit tausenden von QSOs verarbeiten. Sie brauchen nicht 

für jeden Contest eine neue Datenbank einrichten ! 
o Aktualisierte Dateien, wie z.B. die Master.dta -Datei, müssen vor jedem Contest importiert 

werden :  
• Programmeinstellungen   

o Mit File > Import > Import Program Settings from file .. 
o Verwenden Sie die oben erzeugte Datei  z.B.: VHFprogramsettings.txt 

• Windowseinstellungen   
o Mit File >  Import >  Import Windows Settings from file .. 
o Verwenden Sie die oben erzeugte Datei  z.B. : VHFwindows.txt 

• F-Tasten-Makros für SSB und CW   
o Mit File >  Import >  Import Function Keys to file ...>  SSB Function Keys  

� Verwenden Sie die oben erzeugte Datei  z.B.: VHFssbfunctionkeys.mc 
o Mit File > Import > Import Function Keys to file ... > CW Function Keys  

� Verwenden Sie die oben erzeugte Datei  z.B : VHFcwfunctionkeys.mc 
o Packet/Telnet-Tasten  > Mit File >  Import > Import Packet/Telnet Buttons from file...  

� Verwenden Sie die oben erzeugte Datei  z.B : VHFpacketbuttons.txt 
• Rufzeichenprüfung   

o Mit File >  Import >  Import Call History  
� Verwenden Sie die oben erzeugte Datei  z.B : VHFlookup.txt 

• Länderdatei  
o Mit Tools >  Reload CTY.DAT  

• Nachdem Sie die Dateien geladen haben :   
o Überprüfen Sie die Stationsdaten mit  Config >  Change your Station Data 
o Überprüfen Sie die Koordinaten und den Lokator, denn mit dieser Einstellung wird die 

Entfernung, die Punkte und die Antennenrichtung berechnet 
o Prüfen Sie die Contesteinstellung mit  File > Choose contest 
o Prüfen Sie ob die Felder richtig ausgefüllt sind  

• Geben Sie die Kontrollnummern-Konfiguration richtig ein. Sie hängt vom Contest ab. Bei UKW-Contesten 
wird meist die Contestnummer und der Lokator gegeben (siehe  Einstellungen für VHF-Conteste) 

• Wenn Sie einen Transverter benutzen, stellen Sie mit Set transceiver offset frequency  die Offset-Werte 
für die Bandskalen A und B ein 

• .... 

Ich wünsche Ihnen Spaß im Contest !  

Zusatz DM3ML : Die Berechnung der Antennenrichtung und der Entfernung funktioniert unabhängig von einer geladenen 
Master.dat-Datei nur, wenn ein Haken hinter Config > Call History Lookup  gesetzt ist. Rufzeichen und Lokator müssen 
eingetragen sein und mit der Leertaste abgeschlossen werden. Ist eine Master.dta-Datei – hier die sehr gute Datei 
Master-vhf-ddmmyyyy.dta -  geladen, wird schon nach der Eingabe des Rufzeichen das Lokatorfeld mit dem der Datei 
entnommenen Lokator gefüllt. Er muss beim Kontrollnummernaustausch aber auf Richtigkeit überprüft werden. Hat man 
den Lokator der Gegenstation schon aufgenommen und will die exakte Antennenrichtung wissen, muss in das 
Rufzeichenfeld ein zum Lokator passendes Präfix z.B. DL für einen JO-Lokator oder G3 für einen IO-Lokator  
eingetragen und mit der Leertaste abgeschlossen werden, ehe die richtige Richtung ausgerechnet wird, sonst erscheint 
eine Fehlerausschrift mit dem Hinweis „IO passt nicht zu DL“. Liegen diese Angaben nicht vor, wird die Entfernung und 
die Richtung mit den Koordinaten für das Präfix aus der Datei cty.dat und unbrauchbar für einen UKW-Contest  
berechnet. Enthält die Master.dat-Datei zusätzliche Angaben wie den Namen oder verwendete Bänder, werden Sie im 
Logeingabefenster zusammen mit Richtung und Entfernung blau über der Statuszeile angezeigt. Sie scheinen aber für 
Makros wie {NAME} nicht verwendbar zu sein. 
Im Contestbetrieb mit zwei Transceiver auf verschiedenen Bändern werden die QSOs auf den beiden Bändern getrennt 
mit Kontrollnummern ab 001 gezählt, aber zusammen abgespeichert. Hier sind zwei Eingabefenster offen, je eins zu 
einem Band. Das Band kann im Available-Fenster mit einem linken (VFO-A, linker TCVR) oder einem rechten Mausklick 
(VFO-B, rechter TCVR) gewählt werden. Die Nutzung zweier ICOM-Transceiver über den ICOM-Bus an einer 
Schnittstelle ist nicht möglich, hier sind getrennte CAT-Interfaces an getrennten COM-Schnittstellen zu verwenden.   
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33. Liste der Tastenzuordnungen / Kurzfassung (Key Assi gnments Short List) 

Running Tasten  S&P Tasten  
; oder insert = sendet Call und Rapport 
' = sendet TU und speichert das QSO ab  
Alt-R = CQ-Wiederholung EIN/AUS  
Ctrl-R  = CQ-Wiederholzeit einstellen   

Alt-Z = Passfrequenz einstellen 
Alt-G = Call aus dem Stack holen  
Shift-F1 = umschalten in den Running-Modus 

Generelle Tasten  DXSpots und Bandskala   
SPACE oder TAB  = umschalten zwischen den Logfeldern 
Ctrl-O = Operator ändern (oder OPON ins Rufzfeld)  
Ctrl-N = Notiz zum QSO zufügen  
Ctrl-W  oder Alt-W = Eingabefelder löschen  
Ctrl-D =letztes QSO löschen!  
Enter = loggen ! (siehe ESM.Modus)  
Alt-H =  Hilfe anzeigen  
Ctrl-Q/A = Schnelledit des letzten Rufzeichensl  
Alt-Q = Nachricht editieren  

Keypad +/- = Bandskala strecken oder stauchen  
Alt-P = DXSpot senden  
Ctrl-P = DXSpot mit Kommentar senden  
Alt-D = DXSpot entfernen  
Ctrl-up/dn Pfeile = gehe zur nächsten Station  
Alt-Ctrl-up/dn Pfeile = gehe zum nächsten Multi   
Ctrl-Tab = von und zum Packet-Fenster  
Alt-Q  = gehe zur letzten CQ-Frequenz  

 
Transceiversteuerung  ESM Mode  

F10 = vertausche VFOs  
Alt-Q = zurück zur CQ-Frequenz 
Shift-F12 = zurück zur letzten Frequenz 
Ctrl-Bild hoch/runter = Band hoch oder runter  
CW/USB/LSB/RTTY eingeben = Sendeart ändern  
Ctrl-Enter = Splitfrequenz setzen  
Alt-F7  = Splitfrequenz oder Offset zur aktuellen Frequenz 
setzen 
Alt-'  = zwischen schmalen und breitem Filter umschalten 
Pause oder Ctrl-RA/LA = Sendeaktivität umschalten  
\ = Fensteraktivität wechseln, aber nicht senden  

Ctrl-M = ESM ein/aus  
Insert/; = sende Rufzeichen und Nummer  
Enter = sende TU und logge das QSO  
Enter = starte neues  CQ   
Alt-Enter = loggen ohne Senden   

SO2R  Specifische Transceiver  
Backslash ( \ )  = Empfang zwischen TCVRn umschalten  
Pause ; für beide TCVR TX/RX/Fenster umschalten  
F10 = Sendeaktivität umschalten 
Ctrl-Enter  = Sendet nächste ESM-Msg auf dem anderen 
TCVR 
Ctrl-F1 to F8  = Sendet zugehörige F-Taste auf dem anderen 
TCVR 
Ctrl+B : CQ im Duell 
Ctrl+X : CQ wieder auf dem Run-Transceiver  

FT-1000MP  
Ctrl-F12   : beide Transceiver umschalten  
Ctrl-F9   : Sub-RX an/aus  

TenTec Orion   
Ctrl-F12  : Umschalten Main/links- Sub/rechts und Aktiv an beiden 
Ohren . 
Shift-`  : Umschalten Stereo/Mono ( LPT pin 5).  

 

CW  SSB RTTY VHF 

F11/12 = CW-Geschwdkeitl 
Ctrl-K = CW-Fenster aktiv  
Esc = Senden abbrechen  

Ctrl-Shift-Fx =  
Fx aufzeichnen 
Esc = Senden abbrechen 

Alt-G = Call vom Stack holen 
Alt-T = RX/TX umschalten  
Ctrl-Pfeile : DI1/2 umschalten 
Esc = Senden abbrechen  

Alt-=  = eingebene Info suchen 
Alt-minus  = Felder umschalten 
Ctrl-E  = Msg an Stn schicken 
Alt-Z  – Passfrequenz setzen  
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34. Tastenzuordnungen (Key Assignments) 
 
Die Tasten sind von allen Hauptfenstern aus wirksam ! 

34.1 Allgemeine Tasten ( General Key Assignments)  

• Leertaste (Space)  : schaltet im Logeingabefenster von Feld zu Feld und füllt leere Felder mit 
voreingestellten Werten wie die Rapporte 59/599 und übernimmt Informationen von früheren QSOs (oder 
aus der Master.dta-Dateien). Die Leertaste ist die bevorzugte TAB-Taste.  

• Tab:  schaltet vorwärts von Eingabefeld zu Eingabefeld OHNE voreingestellte Werte  
• Shift-Tab  :  schaltet rückwärts von Eingabefeld zu Eingabefeld   
• Alt-H :  Zeigt diese Hilfe (in englisch) an. Ein ALT-H aus einem bestimmten Fenster ruft die zu diesem 

Fenster gehörende Hilfe  
• Ctrl-Tab  : schaltet zwischen Logeingabefenster und Packetfenster hin und her  
• Ctrl-F11  :  schaltet die zum aktuellen Band gehörenden Antennen durch. Die angewählte Antenne wird in 

der Statusleiste angezeigt.  
• Alt-F4  : Beendet das Programm. Sind zwei Logeingabefenster offen (SO2R-Betrieb) wird das Programm 

nicht beendet. Sie werden in jedem Fall nach einer Bestätigung gefragt. 

34.2 Tasten in der aktiven Bandskala ( Active Radio/Bandmap Control Key Assignments) 

• Ctrl-Down Arrow  (Strg+Pfeil nach unten) : Gehe zum nächst höheren DX-Spot, der kein DUPE ist.   
• Ctrl-Up Arrow  (Strg+Pfeil nach oben) : Gehe zum nächst tieferen DX-Spot, der kein DUPE ist  
• Alt-Ctrl-Down Arrow   (ALT+Strg+Pfeil nach unten) : Gehe zum nächst höheren Multi-Spot  
• Alt-Ctrl-Up Arrow  (ALT+Strg+ Pfeil nach oben) : Gehe zum nächst tieferen Multi-Spot  
• Ctrl-Left arrow  (Strg+Pfeil nach links) : Gehe mit Eingabefenster und Senderecht zum linken VFO (VFO-A) 

oder Transceiver (bei SO2R)  
• Ctrl-Right arrow  (Strg+Pfeil nach rechts) :  Gehe mit Eingabefenster und Senderecht zum rechten VFO 

(VFO-B) oder Transceiver (bei SO2R)   
• Ctrl-Page Up  (Strg+Pfeil Bild nach oben) : Gehe ein Band höher. WARC-Bänder werden im Contest 

übersprungen  
• Ctrl-Page Down ( Strg+Pfeil Bild nach unten) : Gehe ein Band tiefer.  WARC-Bänder werden im Contest 

übersprungen   
• Up Arrow  (Pfeil nach oben) : Frequenz in SSB 100 Hz oder in CW 20 Hz tiefer  
• Down Arrow  (Pfeil nach unten) : Frequenz in SSB 100 Hz oder in CW 20 Hz höher  
• Page Up  (Pfeil Bild nach oben) : Frequenz 10 kHz tiefer  
• Page Down  (Pfeil Bild nach unten) : Frequenz  10 kHz höher  
• Numeric keypad +  (plus) (Taste + im Nummernfeld) : Dehne Bandskala (Zoom +) 
• Numeric keypad -  (minus) (Taste + im Nummernfeld) : Komprimiere Bandskala (Zoom -)  
• Pause  : schalte auf den inaktiven VFO oder TCVR um  
• F9 : Setze Offsetfrequenz gegenüber der aktuellen Frequenz für den aktiven VFO/TCVR. Kann auch mit 

einer Eingabe eines numerischen Werts in das Rufzeichenfeld des Logeingabefensters realisiert werden. 
Siehe auch Frequenz ändern   

• Alt-F7 : Setze Splitfrequenz oder den Offset zur aktuellen Frequenz für den aktiven TCVR. Informieren Sie 
sich im Kapitel Grundfunktionen darüber. 

• Ctrl-Enter  (Strg+ENTER) : Definiert einen ins Rufzeichenfenster eingegebenen Zahlen Wert als 
Splitfrequenz  

• Alt-S:  Setzt den Empfänger wieder auf die Sendefrequenz, aber der Splitbetrieb bleibt aktiviert. Hat die 
gleiche Funktion wie die Option  Reset RX freq when running split , die wie ALT-S nach jedem geloggten 
QSO wirkt, wenn Sie im Running-Modus nach  

• Ctrl-S  :  Schaltet – wenn Sie Split arbeiten – den Empfänger zwischen der Split-Empfangsfrequenz und der 
Sendefrequenz hin und her (Listening here and 3805..).  

• F10 : Schaltet zwischen den VFOs bzw. den TCVRn hin und her (Radio 1 <> Radio 2).  
• Pause  : Schaltet zwischen Transceivern und der Eingabe um 
• Alt-Q : Springt zu letzten CQ-Frequenz auf diesem Band in der aktiven Bandskala  
• Alt-Shift-Q  : Springt zur letzten CQ-Frequenz auf einem anderen Band in der nicht aktiven Bandskala  
• Alt-Ctrl-Q  : Springt zur zuletzt benutzen CQ –Frequenz auf einem beliebigen Band und schaltet diese 

Bandskala auf aktiv  
• Ctrl-T  : Abstimmen. Schaltet auf CW mit gedrückter Taste. Ende mit ESC oder erneutem CTRL-T.  
• Shift-F12  : Schaltet auf die letzte Frequenz zurück  
• Alt-'  (ALT+Apostroph) : schaltet zwischen schmalem und breiten Filter in der gewählten Sendeart (SSB, 

CW und Digimodes) hin und her. (Anmerkung DM3ML: falls diese Funktion auf Ihrem Rechner wegen 
Unterschieden in der Tastaturbelegung nicht funktioniert, nehmen Sie die Maus und klicken Sie auf das Feld 
Wide/Narrow in der Bandskala 

 
 

FT-1000MP  
 
• Ctrl-F9  :  Wählt den Modus der Zweit-Empfängerumschalters Ctrl-F12  

o Angewählt : Zweitempfänger bleibt an (grüne LED blinkt) 
o Nicht angewählt : der Zweitempfänger wird ausgeschaltet (LED aus)  

• Ctrl-F12  : Zweitempfänger an/aus  
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TenTec Orion   
 

• Ctrl-F12  : schaltet zwischen Haupt/links und Zweit/rechts und aktiv auf beiden Ohren um  
• Shift-`  (Shift-singlequote) : Schaltet zwischen Stereo/Mono um ( LPT pin 5).  

34.3 Tasten in der inaktiven Bandskala  (Non-Active Radio/Bandmap Control Key Assignments)  

• Ctrl-Shift-Down Arrow  :  Gehe zum nächst höheren DX-Spot 
• Ctrl-Shift-Up Arrow  : Gehe zum nächst tieferen DX-Spot  
• Alt-Shift-Ctrl-Down Arrow  : Gehe zum nächst höheren Multi-Spot  
• Alt-Shift-Ctrl-Up Arrow  : Gehe zum nächst tieferen Multi-Spot  
• Alt-Shift-Q  : Gehe zur letzten CQ-Frequenz in der inaktiven Bandskala  
• Ctrl-Shift-Page Up  : Gehe ein Band höher  
• Ctrl-Shift-Page Down  :  Gehe ein Band tiefer  
• Shift - Nummernfeld +  (plus) : Inaktive Bandskala strecken.  
• Shift - Numeric keypad -  (minus) : Inaktive Bandskala stauchen  

34.4 Tasten im Logeingabefenster ( Logging Key Assignments)  

• Ente r  
o Speichere QSOs ab, wenn der ESM-Modus ausgeschaltet ist 
o Sende passenden QSO-Text, wenn der ESM-Modus eingeschaltet ist. Was aktuell gesendet 

wird, hängt vom Status des QSOs ab  
• Space  : empfohlene TAB-Funktion  

o Cursor springt vom Rufzeichenfeld ins Kontrollnummernfeld  zurück  
o Voreingestellte Werte werden in die anderen Felder eingetragen 
o Falls das Rufzeichenfeld leer ist, aber ein Rufzeichen darüber angeboten wird, wird es ins 

Rufzeichenfeld eingetragen  
• Alt-Enter:  Sendet QSO-Ende-Text und speichert QSO ab. Im ESM-Modus wird das QSO lediglich geloggt 

und nichts gesendet  
• Insert (Einfg) : Sendet F5 (His Call) plus F2 (Kontrollnummer)  
• Hochkomma  : Sendet TU und loggt das QSO  (siehe unten) 
• Alt-W oder Ctrl-W  ;alle Eingabefelder löschen   
• Ctrl-Y  : letztes QSO editieren  
• Ctrl-D  : letztes QSO löschen   
• Alt-O  : QSO in Bandskala setzen  
• Alt-M  : aktuelle Frequenz als belegt (busy) kennzeichnen  
• Alt-D  : entfernt aktuellen Spot von der Bandskala, wenn das Rufzeichen in oder über dem Rufzeichenfeld 

steht oder Sie hier CQ-rufen (Running-Modus) wollen  
• Alt-P  : Aktuelles Rufzeichen als DX-Spot über die bestehende Packet/Telnet-Verbindung senden  
• Ctrl-F  : Rufzeichen im Rufzeichenfeld im Log suchen  
• Ctrl-G  : nach CTRL-F weitersuchen  
• Ctrl-M  : ESM-Modus an- oder ausschalten  
• Ctrl-N  : Notiz zu einem aktuellen QSO oder zum QSO davor eingeben  
• Ctrl-Q  : Quick- Edit-Modus, gehe zum letzten oder rückwärts zu einem QSO im Log und gib Änderungen ins 

blaue Eingabefenster ein.  Beenden mit ENTER oder ESC.  
• Ctrl-A  : Quick-Edit-Modus : gehe vorwärts im Log, sonst wie CTRL-Q  
• Ctrl-U  : Kontrollnummer im Eingabefenster um EINS erhöhen 
• Shift-Enter  : Rufzeichen in den Stapelspeicher schicken. Siehe Kapitel Grundfunktionen  
• Alt-U  : schaltet zwischen Running- und S&P-Modus hin und her 
• Alt-K  : Ruft das Editiermenü für die Packet/CW/SSB/Digital- F-Tasten   
• Alt-Y  : holt das erste Rufzeichen aus dem Check-Fenster in das Rufzeichenfeld  

Testen Sie vor allem die Satzzeichen (Hochkomma, Einfg u.a.). Sie sind mitunter auf einer deutschen Tastatur anders 
belegt. Mit der Konfiguration können Sie diesen Zeichen einen Kode Ihrer Wahl auf der Tastatur zuweisen. Gleiches gilt 
für die folgende Tabelle :  

 

Taste   Sendet die F-Tasten   Aktion  

Einfgt 
  

Rufzeichen der Gegenstation +Contestnummer   Rufzeichen der Gegenstation +Contestnummer .  

; /Semikolon) 
(wie Einfg-Taste)  Rufzeichen der Gegenstation +Contestnummer  Rufzeichen der Gegenstation +Contestnummer  

Alt-Enter      QSO loggen 
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' Ende des QSOs + Loggen des QSOs  Ende des QSOs + Loggen des QSOs .  

34.5 Tasten für QSO-Texte ( Message Key Assignments)  

Mit den F-Tasten F1 bis F8 können Sie programmierte Texte senden. Die Texte können für den Running-Modus (obere 
acht Zeilen) und den S&P-Modus (untere acht Zeilen) editiert werden. 

Den Tasten ist jeweils eine feste Funktion innerhalb eines Contest-QSOs zugewiesen und voreingestellt. Informieren Sie 
sich darüber im Kapitel Funktionstasten.  

Voreinstellung  

F1  CQ key   

F2  Exchange key   

F3  End of QSO Key   

F4  My Call Key   

F5  His Call Key   

F6  QSO B4 Key   

F7    

F8  Again Key   

 
• ESC : Beendet das Senden in allen Sendearten sofort  
• Ctrl-R  :  Einstellen der CQ-Wiederholzeit in Sekunden oder Millisekunden (1,8 oder 1800) 
• Alt-R  : Automatisches CQ-Rufen einschalten. Ausschalten mit ESC.  
• Shift-Ctrl-Fx  : Zeichnet die SSB-WAV-Datei für die zugehörige Taste mit dem Windows-Audiorecorder auf. 

Ein Druck auf die gleiche Taste stoppt die Aufzeichnung. Fx steht für F1-F8. 
• Ctrl-Alt-Fx  : Zeichnet WAV-Dateien für einen externen  DVK-Speicher auf. Fx steht für F1 – F4.  

34.6 Tasten für CW  (CW Key Assignments)  

• F11 : Gebegeschwindigkeit um 2 wpm verringern  
• F12 : Gebegeschwindigkeit um 2 wpm erhöhen  
• Ctrl-K  : Ein- und Ausschalten des Eingabefensters für das Senden von CW-Text. Ein eingegebener Text wir 

bis zum Abschluss gesendet. Der TCVR wird automatisch auf Senden und wieder auf Empfang geschaltet  

34.7 Fenster für Multis je Band (Multipliers by band win dow keys)  

• Ctrl-J  : Schaltet zwischen Ländern, Zonen, Sektionen und Other (Anderes) durch. Wenn das Fenster nicht 
offen ist, wird es geöffnet 

• Ctrl-Shift-J  : Öffnet oder minimiert das Fenster für Multis je Band  

• Ctrl-Alt-J  : schaltet die Kontinente durch . 

34.8 Tasten für Multi-Stationen-Betrieb (Multi-user keys) 

• Ctrl-E  : Sende Nachricht an andere Station im Netzwerk  
• Ctrl-O  : Operatorwechsel 
• Alt-Z  : Pass-Frequenz an alle angeschlossenen Stationen senden 

34.9  Loggen mit ENTER Enter (Sends Message' mode (ESM))  

• Ctrl-M  : schaltet ESM-Modus an und aus  

   Running Modus    S&P-Modus  
Rufzeichenfeld  Nummer-RX-Feld  

Enter sendet:  Enter sendet:  

LEER LEER CQ (F1) Eigenes Call (F4) 
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Neues Rufzeichen  LEER oder ungültig 

Call der 
Gegenstation + 

Num 
(F5 + F2)  

Eigenes Call (F4) 

Neues Rufzeichen (wdh) LEER oder ungültig  Again? (F8) Eigenes Call (F4) 

Neues Rufzeichen  
Gültig, vor 
gesendeter 
Nummer  

Call der 
Gegenstation + 

Num 
(F5 + F2)  

Nummer (F2) 

Neues Rufzeichen  
Gültig, nach 
gesendeter 
Nummer  

QSO-Ende + Log 
(F3 + Log It)  

QSO-Ende+ 
QSO abspeichern 

Doppeltes Rufzeichen LEER oder ungültig  QSO B4 (F6) QSO B4 (F6)- 

Doppeltes Rufzeichen  
Gültig (vor 
gesendeter 
Nummer ) 

QSO B4 (F6) Nummer (F2) 

Doppeltes Rufzeichen 
Gültig (nach 
gesendeter 
Nummer)  

QSO-Ende + Log 
(F3 + Log It)  

QSO-Ende+ 
QSO abspeichern  

Dupe (das 1.Mal) 
Work Dupes gesperrt  LEER oder ungültig  

Call der 
Gegenstation + 

Num 
(F5 + F2)  

QSO B4 (F6) 

Dupe (wiederholt) 
Work Dupes gesperrt  

LEER oder ungültig  Again? (F8) QSO B4 (F6) 

Dupe, 
Work Dupes zugelassen  

Gültig(vor 
gesendeter 
Nummer)  

Call der 
Gegenstation + 

Num 
(F5 + F2)  

Nummer (F2) 

Dupe, 
Work Dupes zugelassen  

Gültig (nach 
gesendeter 
Nummer ) 

QSO-Ende + 
Abspeichern  

QSO-Ende + 
QSO abspeichern 

34.10 Tasten für Packet/Telnet  (Packet/Telnet Key Assignments)  

• Ctrl-P  : Station an den DXCluster melden mit Kommentar (Eingabefeld öffnet sich). Steht keine aktuelle 
Station im Rufzeichenfeld, wird die zuletzt abgespeicherte Station genommen 

• Left-click  (linker Mausklick auf ein Rufzeichen) : Stelle den aktiven Transceiver(VFO auf diese Station  
• Shift-Left-click  (Shift+linker Mausklick) : Stelle den inaktiven Transceiver/VFO  auf diese Station   
• SH/DX : Eingabe in das Rufzeichenfeld des Logeingabefensters wird ans Packetfenster weitergegeben 

34.11 Tasten für SO2R  (SO2R Key Assignments)  

• Backslash ( \ )  : Öffnet zweites Eingabefenster, wenn nur ein Eingabefenster offen ist   
o Ein Transceiver :  schaltet RX und TX hin und her  
o Zwei Transceiver : schaltet RX hin und her   

• F10 : schaltet Senderecht hin und her 
• Ctrl-Left arrow  (Strg+Pfeil links) : setzt linken Transceiver/VFO auf aktiv  
• Ctrl-Right arrow  (Strg+Pfeil recht) :  setzt rechten Transceiver/VFO aktiv  
• Pause  : Vertauscht beide Transceiver und das Eingabefeld  
• CTRL-Enter  :  sendet nächsten ESM-Text auf dem anderen Transceiver, wenn ESM aktiv ist  
• Ctrl-F1 to F8  : Sendet zu dieser Taste gehörenden Text an den anderen Transceiver 
• Ctrl+B  = CQ-Duell : sendet abwechselnd CQ ohne Verzögerung auf beiden Transceivern  
• Ctrl+X  : Wiederholt den CQ-Ruf am Running-TCVR, wenn am S&P-TCVR nicht gesendet wird  

34.12 Tasten in RTTY  (RTTY Key Assignments)  

Taste  Tastenname  Gesendeter Text  

F1 &CQ CQ TEST DE * 
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F2 &Exchange  5NN # 

F3 &His Call  ! 

F4 &My Call  * 

F5 &TU TU DE * 

F6 Call/Exch  ! 5NN # 

F7       

 
• Alt-T  : Sende-Empfangsumschaltung 
• Alt-G  : Rufzeichen übernehmen (Grab)  
• Ctrl-Arrows  (Strg+Pfeile links/rechts) :  Schaltet von einem aktiven DI1-Interface auf eine anderes. DI1 

bleibt dem VFO-A (TCVR 1, Bandskala A) zugeordnet und DI2 dem VFO-B (TCVR2, Bandskala B) 

 

34.13 Tasten für die Großfelder (Gridsquare Key Assignmen ts (VHF and up))  

• Alt-=  = Sucht eingegebene Informationen für das Rufzeichen und das Lokatorfeld 
• Alt-minus  = schaltet zwischen Rufzeichensuche (call history) und eingebenem Lokator hin und her  

34.14 Tasten für Fenster  (Window Key Assignments)  

• Ctrl-Tab  : Schaltet zwischen Eingabefenster und Packet-Fenster hin und her  
• Ctrl-B  : Ruft Bandskala  
• Ctrl-K  : Ruft CW-Eingabegenster  
• Ctrl-L  : Ruft Logfenster   
• Ctrl-J   : Ruft Multifenster und schaltet Länder, Zonen, Sektionen und anderes durch, wenn Fenster geöffnet 

ist  
 

35. Oft gestellte Fragen (Frequently Asked Questions) 
35.1 Fehlermeldungen und Fragen zum Programm  (Program errors and requests) 

F. Wo kann ich das Programm herbekommen ?   

A. Gehen Sie zu Programm holen (Downloading the software) und holen Sie sich das Programm aus dem Internet von 
der Seite www.n1mm.com  
  

F. Wie werde ich mit dem Programm vertraut ?   

• Lesen Sie das Handbuch! 
• Lesen Sie mindestens die Kapitel Zehn Schritte im Schnelldurchlauf  , Logeingabefenster , Grundfunktionen  

und Tastenzuordnungen  durch 
• Sie sollten sich die Tastenzuordnungen ausdrucken und die Tasten durchprobieren 
• Verwenden Sie das Programm zum Ausprobieren im DX-Modus als Logprogramm,ehe Sie in einen Contest 

gehen 
• Bereiten Sie einen Contest vor und fahren Sie ein paar Blind-QSOs, um sich hineinzufinden 
• Halten Sie das Handbuch bereit und sehen Sie bei Problemen nach 
• Haben Sie immer noch Probleme ? Schreiben Sie sich beim N1MM-Reflektor  ein und fragen Sie erfahrene 

OMs. 

F. Das Programm gibt eine Fehlermeldung aus. Was so ll ich machen ?   

A. Wenn das Programm eine Fehlermeldung ausgibt oder plötzlich abbricht, kann ein Programmfehler oder ein Problem 
an Ihrem Computer vorliegen. Hier sind ein paar Tipps, wie Sie das Problem bestimmen und den Fehler melden können :  

• Versuchen Sie nachzuvollziehen, was den Fehler bewirkt hat  
• Können Sie den Fehler reproduzieren ?  
• Kopieren Sie eine „saubere“ Datei N1MM Logger.ini,init  in Ihr Verzeichnis an die Stelle Ihrer INI-Datei. 

Sichern Sie funktionierende Einstellungen regelmässig.  Ein Run-time-error kann meist durch eine 
Neuinstallation des Programms nicht behoben werden. 

• Besteht der Fehler, schicken Sie bitte einen Bericht an N1MM und dazu so viel Information wie möglich:  
o Betriebssystem?  
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o CPU-Geschwindigkeit und -Typ?  
o RAM-Bestückung ?  
o Welches Log haben Sie gewählt  (DX, CQWW CW etc.)?  
o Welchen Transceiver haben Sie angeschlossen ?  
o Wann tritt das Problem auf ?  
o Hat das Programm in einer früheren Version schon funktioniert ?  
o Was funktioniert, was nicht ? Weitere Infos ?  

Geben Sie die Daten in der  bug form auf der N1MMLogger-Webseite  

F. Das Programm bringt eine Fehlermeldung. Hilft Lö schen und  Neuinstallieren ? 
 

A. Kopieren Sie eine „saubere“ Datei N1MM Logger.ini,init  in Ihr Verzeichnis an die Stelle Ihrer INI-Datei . Eine 
Neuinstallation hilft nur dann, wenn sich Probleme mit anderen Programm bei der gemeinsamen Nutzung von DLL-
Dateien ergeben haben. In diesem Fall kann eine Neuinstallation helfen, muss aber nicht. Die Kopie der Datei N1MM 
Logger.ini,init  l öscht Ihre Einstellungen. Sichern Sie daher funktionierende Einstellungen regelmässig. 

F. Das Programm hat Probleme, eine Datenbank zu öff nen...  

A. Microsoft hat ein Werkzeug zum Reparieren von beschädigten Datenbanken. Sichern Sie vorher Ihre Datenbank 
mit einer Kopie.  Der Name der Datenbank ist  ham.mdb  , solange Sie noch keine neue angelegt haben. Der Link zu 
dem Werkzeug ist  

http://support.microsoft.com/default.aspx?scid=kb;EN-US;q273956 

Verwenden Sie die Version 4. 

F. Warum gibt es die Option XYZ hier nicht ??!!   

A. Wenn Sie nicht wenigstens in die Tastenzuordnungen gesehen haben, fragen Sie lieber noch nicht.  

F. Warum gibt es kein Feld für den QSL-Manager ?   

A. N1MMLogger ist kein Logprogramm, sondern ein Contestprogramm. Sie können sich mit ALT-N Notizen zu jedem 
QSO machen und Sie nach dem Contest auswerten. 
 

F. Mir scheint, N1MM hat Favoriten. Manchen antwort et er auf ihre Fragen, anderen nicht ..?   

A. Sie haben recht, er hat Favoriten. Wollen Sie einer werden ? Befolgenden Sie diese Regeln :  

• Lesen Sie die Hilfe durch, bevor Sie Probleme melden. Versuchen Sie zuerst zu verstehen, was das 
Programm machen soll  

• Geben Sie statt einer allgemeinen Fehlermeldung vom Typ „Ich starte das Programm und kurz darauf bricht 
es zusammen“ eine genaue Beschreibung des Problems mit Angaben zum Betriebssystem, Computer, 
Transceiver, Programmversion, dem angewählten Programmteil  und der Eingabe, die den Fehler auslöst. 
Solche Fehler lassen sich in aller Regel schnell lösen. Die erste Fehlermeldung ist dagegen wertlos.  

• Fragen Sie nicht nach Optionen für ein allgemeines Log. N1MMLogger ist ein Contestprogramm.  
• Installieren Sie das Programm nicht zu ersten Mal mitten im CQWW und beschweren sich dann, dass Sie 

nicht klar kommen. Alles schon passiert !  
• Fehlermeldungen aus der Hitze eines Contests werden bevorzugt bearbeitet. Falls es ernsthafte und 

contestbezogene Fehler sind, werden sie möglichst umgehend behoben.  

• Beachten Sie bitte, das N1MMLogger ein kostenloses Projekt ist. Helfen Sie mit bei der 
Programmentwicklung (anstatt zu meckern)  

F. Der Contest, bei dem ich mitmachen will, steht n icht auf der Liste. Was soll ich machen ?  

A. N1MMLogger hat nicht die Möglichkeit, einen eigenen Contest zu definieren. Fragen Sie über den N1MM-Reflektor 
an, ob der Contest nicht in die Liste aufgenommen werden kann. Sie können entweder einen schon vorhandenen 
Contest nehmen oder die QSOs als normales DX loggen. Meist stimmen die Multis nicht, aber Doppel-QSOs werden 
gemeldet. Mitunter müssen Sie für einen speziellen Contest eine angepasste CTY.dat-datei laden, z.B. für den PACC-
Contest. Verlangt der Contestveranstalter ein Cabrillo-Log, dann sucht er selbst die Multis im Log und berechnet die 
Punktzahl.  

F. Ich bekomme unter Win98SE die Meldung'Out of mem ory’ trotz großem Speichers  
('Out of memory' message under Win98SE with large R AM)  
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A. Wenn Sie die Meldung 'Out of memory' unter Win98SE mit großen RAM (512MB) bekommen, gehen Sie zum 
Microsoft support im Internet. Sehen Sie unter Q253912 nach.  Sie bekommen den Hinweis, der System.ini den Eintrag  
MaxFileCache= <size in kB> - hier 512 MB – zu ergänzen- Für ein Shareware-Programm wurde der Eintrag von 
MaxFileCache = 98304 kB empfohlen. Damit wird das Problem gelöst.  

F. Fehler und mögliche Lösungen  

Fehlermeldung mögliche Lösung  

Eingabfenster(Program_Initialize) - 
3265  

Datenbank defekt. Wählen Sie eine neue Datenbank oder reparieren Sie die aktuelle. 

Run time error ´32555´Radio 
number error"  Fehlerhafte Einträge in der N1MM logger.ini > wählen Sie eine “saubere” Datei.  

Run-time error - Automation error 

Dieses Problem tritt mit OLEAUT32.DLL oft bei Windows 95 auf. Versuchen Sie eine neuere 
Version dieser Datei zu installieren, Ihre Version ist zu alt für N1MMLogger. Nehmen Sie die Datei 
von Windows 98 oder holen Sie sich die VBRUN60SP6.EXE von der N1MM-Website (Other Files) 
und wählen Sie dort aus dem linken Menü. Sie können sich auch Dateien vom Microsoft Download 
center holen: 
Versuchen Sie, die N1MMLogger.ini gegen eine saubere Version auszutauschen. Sie verlieren zwar 
eine Menge an Ihren Einstellungen, lösen aber in der Regel viele Probleme. Oft sind die COM-
Schnittstellen falsch konfiguriert.  

Error 429 bei neuer Version  
Der Fehler 429 wird meist durch eine falsche Version der Datei CW IF.exe im N1MMLogger-
Verzeichnis. Stellen Sie sicher, dass alle NewexeV.x.xx.zip-Dateien in das originale Verzeichnis 
installiert (und die alten überschrieben) werden.  

Run Time error 339 - Component 
RICHTX32.OCX...... 

Installieren Sie  Richtx32.zip von der  N1MM-Website aus dem Menü Other Files. Lesen Sie die 
Instruktionen zu dieser Datei !  

Error message" DLPORTIO.DLL 
missing 

Holen Sie sich die Datei Port95nt.exe. Dieser Schnittstellentreiber organisiert die Arbeit der 
Schnittstellen mit N1MMLogger. Lesen Sie unter  Installation nach. Sie können auch getrennt die 
Datei dlportio.zip holen. Sehen Sie im Kapitel 3.2  der DLPORTIO.pdf nach, wie Sie vorgehen 
müssen.  Installiert wird nur der Treiber DriverLINX (11 kB).  

Fehler beim Telnet-Aufruf : A Telnet 
Communications Error Occurred. 
Error: 10061 Connection is forcefully 
rejected 

Mitunter werden Sie vom angewählten Telnet-DXCluster abgewiesen. Ein Grund kann sein :  
- Die Zahl der zugelassenen Nutzer ist erreicht. 
- Sie haben einen falschen Port angegeben 
- Das DXCluster-Programm arbeitet nicht fehlerfrei.  
- Der DXCluster wurde gerade wieder hochgefahren und ist noch nicht für Nutzer bereit.. 

35.2 Installation / Aktualisieren  (Installation / Upgrading)  

F. Wie N1MMLogger aktualisieren ?   

A. Zu N1MMLogger werden regelmässig aktualisierte NewExeV......zip bereitgestellt. Sie können  alle Änderungen vorher 
übergehen. Die jeweils neueste NewExe.. enthält alle benötigten Änderungen. Holen Sie sich die NewExe...zip und 
entpacken Sie in das N1MMLogger-Verzeichnis über die vorhandenen Dateien. 
 

 F. Warum ist die Hilfe veraltet und trifft nicht z u ?   

A. Die aktuellen Hilfen werden parallel zum Programm, aber getrennt davon und nicht direkt daran gebunden aktualisiert. 
Die jeweils neuesten Hilfen stehen als Windows-Hilfe (*.chm) und als Handbuch (*.pdf) auf der N1MM-Webseite zur 
Verfügung.  

Q. Wo bekomme ich die neueste Länderdatei her ?   

A. Die Länderdatei, die vom Programm benötigt wird, heisst CTY.DAT und steht im N1MMLogger-Verzeichnis. Sehen Sie 
unter Installation und Auffrischen  (Installation and Upgrading)  nach, wie Sie zu einer neueren Version von CTY.DAT 
kommen.  

F. Ich habe DLPORTIO installiert, kann aber immer n och kein CW über die Parallel/Serial-Ports machen ( NT, 
Windows 2000 & XP)    

A. Versuchen Sie DLPORTIO.DLL zu installieren. Falls es immer noch nicht geht, kopieren Sie  DLPORTIO.DLL und 
DLPORTIO.SYS in das N1MMLogger-Verzeichnis. Manchmal geht es dann. 
Anmerkung DM3ML : Bei mir musste DLPORTIO aus dem entzippten Paket richtig installiert werden. DLPORTIO.DLL 
und DLPORTIO.SYS müssen dazu zusammen mit dem Programm install.exe  in ein Verzeichnis kopiert werden. Danach 
ist install.exe  zu starten. Es übernimmt die Registrierung und Kopie der beiden Programme. 

Q. Ich bekomme eine rote Ausschrift im Eingabefeld "no cw port configured ".   
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A. Gehen zur Konfiguration und stellen Sie eine CW-Schnittstelle ein. Das kann eine serielle oder parallele Schnittstelle 
sein.  

F. Ich habe grosse Schwierigkeiten mit der CAT-Steu erung. Bei anderen Programmen arbeitet sie probleml os, 
unter N1MMLogger aber z.T. sehr langsam und verzöge rt  

A. Wird Ihr CAT-Adapter aus der Schnittstelle versorgt ? Setzen Sie DTR und RTS auf "always on" ! 

35.3 Programmeigenschaften (Program features)  

F. Woran erkenne ich, ob ich im Running-  oder S&P- Modus bin ?  

A. Das Logeingabefenster hat im Running-Modus einen weissen Hintergrund und im S&P-Modus einen hellgelben. Im 
Running-Modus ist im Feld mit der Bezeichnung Running (links im unteren Drittel des Eingabefensters) ein Haken, im 
S&P-Modus ist das Feld leer. 

F. Wenn ich in die Nähe einer Station in der Bandsk ala abstimme, erscheint ihr Rufzeichen über dem 
Rufzeichenfeld. Muss ich das Rufzeichen noch einmal  eingeben ?  

A. Nein, drücken Sie auf die Leertaste und – falls das Rufzeichenfeld leer ist – wird das Rufzeichen on das 
Rufzeichenfeld eingetragen. Sie können die Leertaste als TAB-Taste verwenden.  

F. Gibt es eine Möglichkeit zu vermeiden, dass der Cursor mit der TAB-Taste in Felder wie RST springt,  die 
normalerweise nicht geändert werden ?   

A. Ja. Verwenden Sie die Leertaste. Sie sollte im Eingabefeld als TAB-Taste verwendet werden. Informieren Sie sich 
unter Tastenzuordnungen .  

F. Warum erscheinen die Rufzeichen der Stationen, d ie ich schon gearbeitet habe, nicht im 
Rufzeichenprüffenster (Check window) ?  

A. Sie erscheinen im unteren Teil des Logs (u.U. Trennlinie zum Log hochziehen). Haben Sie sie auf dem gleichen Band 
schon gearbeitet, werden Sie als DUPE gemeldet.  

Q. Die CQ-Wiederholung funktioniert nicht mit VFO B   

A. Stellen Sie sicher, dass Sie ALT-R für beide VFOs eingegeben haben. Schalten Sie SO2R-CQ-Option ab.  

Q: Ich bekomme die Frequenzen problemlos in mein Lo g. Wie kann ich aber die möglichen Multis und Stati onen 
neuen Frequenzen zuordnen ? 

 A. Beim allgemeinen Log werden die Stationen unter WARC, VHF  und HF  eingeordnet. Eine Änderung ist nicht 
möglich. 

Q: Kann ich das Log so ändern, dass ich z.B. den WW -Lokator zusätzlich eintragen kann ?  

A. Die Eingabe – und Logfelder können nicht geändert werden. Sie sind im Programm unter VB6.0 festgeschrieben. 

 
 F: Wie kann ich die Bänder für das allgemeine Log festlegen ? Ich bin üblicherweise auf allen Bändern  zwischen 
160m bis 3cm (10GHz) QRV.  

A. Schliessen Sie den Transceiver über die CAT an den PC an. Das Programm liest die Frequenz aus oder geben Sie 
die gewünschte Frequenz ins Rufzeichenfeld ein und drücken Sie ENTER 

Q: Wie kann ich N1MMLogger dazu bringen, die Kontro llnummern mit den in Europa üblichen führenden Null en 
in CW auszugeben ?  

A. Gehen Sie in die Konfiguration und  dort zur Karteikarte Function Keys . Machen Sie einen Haken in das Feld Send 
leading zeros in serial numbers  . Die Nullen werden als Ts gesendet. 

F: Kann ich die Telnet-Totzeit (Telnet timeout) für  eine Verbindung zu einem DXCluster verändern  

A. Nein, sie ist nicht einstellbar. 
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Q. Bei mir funktioniert die CW-Tastung über LPT1 mi t anderen Windows- und DOS-Contestprogrammen   

A. Stellen Sie die Schnittstellenadresse von LPT1 entsprechend der Angabe unter Drucker-Schnittstelle in der 
Systemsteuerung von Windows ein, Gehen Sie zu . Ihre Portadresse ist z.B.  3BC. Tragen Sie diesen Wert in der 
Konfiguration von N1MMLogger ein. Voreingestellt ist 378 .  

Q: Serielle Schnittstellen für PTT/CW:  Auf den  CO M-Schnittstellen ist Pin 4 (DTR) für PTT oder CW ei nstellbar, 
aber Pin 7 (RTS) nur für PTT. Gibt es einen Grund d afür, dass RTS nicht für CW verwendet werden kann ?  

A. Nein, es gibt keinen speziellen Grund dafür, aber keins der etablierten Contestprogramm verwendet einen anderen 
Standard. 

F. In den ARRL Sweepstakes ignoriert das Programm z weistellige Nummern. Wie bekomme ich trotzdem eine 
solche Nummer ins Log ?   

A. Geben Sie entweder 033 anstelle von 33 ein oder hängen Sie einen Buchstaben dran wie 33B. Ich denke über eine 
Programmänderung nach.  

F. Wenn ich ein falsches Rufzeichen eingebe und es korrigiere, ändert sich der Inhalt des Kontrollnumm ernfelds 
nicht.  
Beispiel vom CQWW:  Ich gebe HA1M und das Kontrollnummernfeld wird mit einer 15 gefüllt. Ich korrigiere das 
Rufzeichen in PA1M, aber die 15 anstelle einer 14 bleibt stehen. Ist das ein Fehler ?  

A. Das ist der normale Ablauf. Wenn das Kontrollnummernfeld einmal gefüllt ist, bleibt der Inhalt stehen. Löschen Sie das 
Feld und drücken Sie auf die Leertaste. Jetzt wird der richtige Wert eingetragen. 
 

F. Welche Kontrollnummer wird wann gesendet ?   

A. Es gibt zwei Möglichkeiten : Wurde für das letzte QSO z.B. die Nummer 133 gesendet und wurde ein neues 
Rufzeichen in das Rufzeichenfeld eingetragen, wird die Nummer 134 gesendet. Ist noch kein neues Rufzeichen 
eingetragen worden, wird die alte Nummer 133 gesendet und Sie können sie noch einmal senden, falls die Gegenstation 
danach fragt. 
 

F. Manche Stationen senden das RST schneller als di e Kontrollnummer. Kann ich das mit N1MMLogger auch 
machen ?   

A. Sie können die Gebegeschwindigkeit gegenüber den gewählten Werten mit ‘<’ um 2 Wpm erhöhen und mit ‚>’ um 2 
Wpm verringern. Setzen Sie das RST in eckige Klammern, z.B.  <<<5NN>>>, dann wird es schneller gesendet und 
anschliessend das Tempo auf den Wert vorher zurückgesetzt. 
 

F. Ich bin mit einem DXCluster verbunden und gebe sh/dx/30  ein, aber in den Bandskalen werden keine 
Rufzeichen angezeigt.   

A. Da kann einiges falsch laufen. Prüfen Sie zuerst, ob die Ausgabe von DXCluster-Meldungen freigegeben ist. Klicken 
Sie rechts in Packetfenster und machen Sie Haken vor die Zeilen Allow HF.(WARC, VHF).  Stellen Sie sicher, dass die 
Spots nicht älter als die in der Konfiguration (Karteikarte Other ) eingestellte Verfallszeit sind. Überprüfen Sie die 
Zeitangaben und das Datum Ihres Clusters und die Zeiteinstellung Ihres PC in Windows (nicht in N1MMLogger). Ihr 
Rechner sollte in diesem Fall auf die Lokalzeit (nicht auf GMT) eingestellt sein. Beachten Sie auch, dass Cluster ohne 
Internetanbindung mitunter nicht sonderlich aktuelle Meldungen auf Vorrat haben.  

F. Wie kann ich eine Station im DXCluster melden ?   

A. Die Meldung erfolgt aus dem Eingabefenster heraus. Falls das Rufzeichenfeld leer ist, wird das letzte Rufzeichen 
zusammen mit der geloggten Frequenz genommen:  

• Alt-P  meldet die Station ohne Abfrage  
• Ctl-P  fragt nach einem zusätzlichen Kommentar. 

Es ist auch möglich, alle geloggten Stationen zu melden. Sie müssen sich dazu im S&P-Modus befinden und die Station 
darf noch nicht in einer Bandskala stehen. (DM3ML: nicht zu empfehlen !). 

F. Wenn ich SH/DX eingebe, werden nur ON-Stationen an gezeigt  
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A. Sie haben in der Konfiguration einen DX-Spidercluster angewählt (Karteikarte Other ).  Er wird mit SH/DX on 20  
anstelle von SH/DX 20 angesprochen. Ihr Cluster deutet das als Anfrage nach ON-Stationen. Entfernen Sie den Haken 
aus dem Feld Format for Spider Cluster . 

F. Ich würde gerne eine Statistik-Übersicht haben. Wo finde ich Sie ?   

A. Wenn Sie über die Statistiken von N1MMLogger  weitere Statistiken erzeugen wollen, empfehle ich Ihnen ein gutes 
Programm auf der Webseite von I8NHJ Dieses Programm können Sie im Hintergrund während des Contests laufen 
lassen und Sie können es Ihren Wünschen anpassen. Es ist vollkommen unabhängig von N1MMLogger, entnimmt seine 
Daten aber der *-mdb-Datenbank. Sie brauchen einen IIS-Web-Server unter (NT W2K XP) auf einem Ihrer PCs, aber auf 
die Statistik kann von jedem Rechner zugegriffen werden. 

F. Meine Freunde würden gern die Dateien für die Di gital/ssb/cw-Tasten von mir übernehmen. Gibt es ein e 
Möglichkeit, diese Daten bequem zu übergeben oder m üssen sie sie neu eingeben ?  

A. Exportieren Sie die Funktionstasten mit  File > Export > Export Function keys to file  mit SSB/CW/Digital function 
keys . Importieren Sie die erzeugte Datei auf einem anderen Computer mit  File > Import > Import Function keys to 
file , wählen Sie SSB/CW/Digital function keys .  

F. Wie starte ich ein wiederholtes CQ?   

A. Setzen Sie mit CTRL-R die Wiederholzeit und schalten Sie mit ALT-R  den Wiederholmodus an oder wieder ab. 
Starten Sie mit F1 einen CQ-Ruf. 

F. In der Liste fehlt eine ARRL-Sektion oder die Ab kürzung dafür. Kann ich Sie hinzufügen ?  

A. Ja, gehen Sie zu Config > Change Packet/CW/SSB/Digital Message  Buttons  und wählen Sie die zu ändernde 
Liste.  

F. Ich möchte vom S&P-Modus mit F1 auf CQ und autom atisch in den Running-Modus umschalten...   

A. Dazu muss ein CQ im Tastennamen oder im Text stehen. Ändern Sie die F1-Taste im S&P-Bereich von F1 {my call}  
in F1 CQ und tragen Sie den CQ-Text für F1 ein. 

F. Wo wird die aktuelle Punktzahl angezeigt ?  

A. Sie wird in der Statuszeile des Logeingabefensters angezeigt. In der Mitte stehen QSOs und Multis, die Punkte stehen 
rechts.  

F. Wird meinen Sonnenauf- und untergang irgendwo an gezeigt ?  

A. Ja, klicken Sie auf Help > About N1MM. Die Zeiten werden in UTC und der Lokalzeit ausgegeben. 

F. Ich bin nicht sicher, ob die Punktzahl stimmt. W as kann ich machen ?   

A. Gehen Sie zu Tools > Rescore. Die Neuberechnung dauert eine Weile, machen Sie diesen Schritt in einer ruhigen 
Zeit im Contest oder danach.  
Senden Sie ein Cabrillo-Log an den Veranstalter berechnet er die Punkte selbst (ARRL, CQ u.a.), sonst müssen Sie es 
selbst überprüfen und u.U. editieren.  

F. Wie kann ich einen F-Tasten-Text ändern, ohne ih n neu schreiben zu müssen ?   

A. Sie können den Text wie unter Windows üblich editieren, neuen Text hinzufügen, alten löschen oder überschreiben. 
Klicken Sie mit der Maus an die gewünschte Stelle und führen Sie die Änderung aus. Verlassen Sie den Text mit einem 
ENTER. 

F. Das Programm sagt, dass es keine Datei Master.dt a u.ä. finden kann.   

A. Die Dateien müssen im N1MMLogger-Verzeichnis stehen. Stellen Sie sicher, dass Sie den N1MMLogger aus dem 
gleichen Verzeichnis starten.   

F. Wenn ich N1MMLogger starte, ändert es die am Tra nsceiver eingestellte Sendeart ((LSB/USB/CW)  

A. Das hängt vom gewählten Contest ab. Wollen Sie am CQWW-Contest teilnehmen, schaltet das Programm 
automatisch auf CW oder bei einem Telefoniecontest auf SSB. Sind beide Sendearten im Contest erlaubt, passiert 
nichts.  
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F. Wie kann ich einen Test-Contest aus der Datenban k löschen, den ich nicht mehr brauche ? 

A. Eine Datenbank ist eine *.mdb-Datei und sie enthält mehrere Contest  

• Sie können die Datenbank ganz löschen, wenn Sie sicher 
sind, dass sie nichts brauchbares enthält. Haben Sie sich 
geirrt, können Sie sie auch wieder aus dem Papierkorb 
holen, wenn sie dort noch ist.  

• Gehen Sie zu File > Choose Contest , markieren Sie den 
Contest in der Contestliste und drücken Sie auf Entf 
(Delete)  auf der Tastatur. Ein einmal gelöschter Contest 
kann nicht wieder hergestellt werden. 

F. Wie kann ich die Zeile in einer F-Tasten-Tabelle  löschen ?   

A. Klicken Sie in das zu der Zeile gehörende graue Feld ganz links, Sie sehen einen rechtsgerichteten Pfeil, und drücken 
Sie die Entf (Delete)- Taste.  

F. Wie kann ich ein Logdeckblatt (Summary Sheet) er zeugen ?   

A. Wählen Sie im Menü File  > Export > Print Summary Sheet to File . Sie werden nach dem Namen gefragt. Sie 
sollten [callsign].sum  wählen, z.B.  N1MM.sum . 
Die Ausgabe erfolgt als ASCII-Textdatei, die mit einem Editor bearbeitet werden kann.  

F. Warum ändern die Richtungspfeile nach oben z.B. Ctrl-Page-Up die Frequenz nach unten und die Pfeile  nach 
unten die Frequenz nach oben ?  

A. Das hängt mit den Bandskalen zusammen. Bei ihnen ist die niedrigere Frequenz oben und die höhere unten. Die 
Pfeile beziehen sich auf die Bandskalen und ihre Teilung.  

F. Ich habe Notizen zu einigen Rufzeichen eingegebe n. Wie finde ich sie wieder ?   

A. Die Notizen finden Sie im Kommentarfeld, wenn Sie das QSO editieren. Wenn Sie ein langes Log und mehrere 
Notizen suchen, geben Sie am besten das Log als ADIF-Datei aus und suchen dann mit einem Editor nach ADIF-Feldern 
mit der Bezeichnung <COMMENT…  
 

 F. Wie kann ich CW als Voreinstellung eingeben ? I ch arbeite nur in CW und benötige USB und LSB nicht . 
  

A. In einem CW-Contest stehen Sie automatisch auf CW. In einem allgemeinen Log z.B.  DX "contest", können Sie die 
Sendeart im Contest-Dialog auf CW einstellen.  

.  

F. Ich möchte an einer QSO-Party mobil teilnehmen. Wie muss ich das Programm einstellen ?  

A. Tut mir leid, eine Änderung des Countys ist nicht möglich.  

35.4 Digitale Sendearten  (Digital modes)  

F. Das Rufzeichen, das ich anklicken wollte (grab) ist im Empfangsschirm schon durchgerollt. Wie komme  ich 
noch heran ? 

 
 A. Klicken sie auf den grünen Streifen und setzen Sie das Fenster in den Pause-Zustand. Rollen Sie den Inhalt des 
Fensters zurück und klicken Sie auf das Rufzeichen. Klicken Sie dann wieder auf den grünen Streifen und der 
inzwischen eingelaufene Text wird ausgegeben.  

F. Ich bekomme die Nachricht "lost sound" im MMTTY- Wasserfall   

A. Ihr Rechner ist möglicherweise mit der Kombination von MMTTY und N1MMLogger etwas überfordert. Erhöhen Sie 
die Pufferzahl in der Misc-Einstellung von MMTTY.  

F. Das Fenster der MMTTY- RTTY-Maschine liegt immer  über den anderen Fenstern. Muss das sein ? 
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A. Nein, entfernen Sie unter Config > Configure Ports, Telnet Address, Other >  Digital Modes den Haken aus 
MMTTY always on Top . Hier können Sie auch die Fenstergrösse des MMTTY-Fensters auf Normal  oder Small   (ohne 
Steuerfeld) einstellen. 
  

F. Auf dem Schirm meines langsamen PCs passieren me rkwürdige Dinge   

A. Meist flackert der Bildschirm beim RTTY-Empfang. MMTTY benötigt mindestens einen PC mit 133MHz Taktfrequenz. 
N1MMLogger geht von einem Rechner mit 233 MHz aus. Liegt Ihr Rechner darunter können solche Probleme auftreten.  

F. Ich bekomme beim Start von RTTY einen Run Time e rror 7 - Out of memory   

A. Sie benötigen für MMTTY die Datei XMMT.ocx im N1MMLogger-Verzeichnis . Die NewExe enthält die für MMTTY 
1.64 und höher benötigte Datei XMMT.ocx.  

F. Datei nicht gefunden beim digitalen Interface   

A. Prüfen Sie, ob die nachstehenden Dateien im Verzeichnis Windows/System oder System32 bzw. N1MMLogger-
Verzeichnis vorhanden sind :   

• Regsvr32.exe :  Steht im Systemverzeichnis Windows/System oder System32 
• PSKCore.dll : Steht im N1MMLogger-Verzeichnis   
• MMTTY.exe - Steht im N1MMLogger-Verzeichnis   
• XMMT.ocx - Steht im N1MMLogger-Verzeichnis   
• MMTTY.ini - Steht im N1MMLogger-Verzeichnis  bzw. wird von MMTTY erzeugt 
• Userpara.ini - Steht im N1MMLogger-Verzeichnis  bzw. wird von MMTTY erzeugt  

F. Ich kann PSK oder RTTY mit  MMTTY senden, sehe a ber kein Empfangssignal in meinem Wasserfall oder T ext 
im Empfangsfenster  

Überprüfen Sie Ihre Geräteeinstellung. In der Regel ist die Einstellung der Soundkarte unter Windows schuld. Verbinden 
Sie den Soundkartenausgang line out  mit dem Mikrofoneingang Mic  mit einem kurzen Kabel. Können Sie dann Ihr 
eigenes Signal mitschreiben, liegt das Problem bei Ihrem Interface, sonst ist entweder Ihre Soundkarte nicht in Ordnung 
oder der Mic-Eingang ist unter Windows nicht freigegeben. Gehen Sie zu Systemsteuerung > Sound und Audiogeräte 
> Sounds > Aufnahme  und prüfen Sie ob der der MIC-Eingang nicht mit Ton aus  abgeschaltet und der Lautstärkeregler 
aufgezogen ist.  Versuchen Sie auch einen Test mit einem anderen Programm. 
 

F. Die Frequenzanzeige stimmt nicht mit den ankomme nden Spots in der Bandskala überein  

Wenn Sie mit MMTTY in der Normallage arbeiten, muss Ihr Transceiver auf LSB stehen. Mitunter haben Sie trotzdem 
eine feste Ablage, die Sie nur durch folgenden Trick umgehen können :  

• Schalten Sie für RTTY auf LSB  

• Setzen Sie die MARK-Frequenz auf z.B. 2000Hz  

• Klicken Sie rechts in die Bandskala und wählen Sie 
Transceiver offset -2   

• Jetzt stimmen die Frequenzen 

Anmerkung DM3ML : Die Markfrequenz wird von MMTTY aus der CAT-Anzeige (Träger bei SSB) plus (bei USB) bzw. 
minus (bei LSB)  MARK-NF-Frequenz ausgerechnet und an N1MMLogger übergeben. Sie sollte in der Regel stimmen. 

F. Mitunter werden CRLFs als Block angezeigt, ohne dass der Cursor in die nächsten Zeile geht  

A. : Es gibt Probleme mit Richtext-Dateien auf der Webseite, derenZeilenschaltung mitunter als Block dargestellt wird, Es 
gibt zwei Makros {ENTER} and {ENTERLF}.. Mitunter wird die Zeilenschaltung nicht richtig ausgeführt. Klicken Sie auf 
die Pausenleiste, gehen Sie zurück im Text und versuchen Sie herauszubekommen, was im Text fehlt. Ein weiterer Klick 
bringt Sie wieder zurück. 

35.5 Die YAHOO-Diskussionsgruppe  (Yahoo Discussion Group)  

F. Bekommen Sie zuviel Emails von der Yahoo-Gruppe ?   

A. Machen Sie es so :   
Gehen Sie zu  http://groups.yahoo.com/group/N1MMLogger  und wählen dort Edit my membership . Der Link dazu 
befindet sich rechts oben. Sie haben folgende Wahl :   
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• Individual e-mail's : Sie bekommen alle Emails  
• Daily digest : Sie bekommen die Emails des Tages in einem Paket  
• Only special announcements : Sie bekommen nur die wichtigen Emails des Gruppenmoderators  
• No e-mail : Sie bekommen keine Emails, können sich aber die Emails mit dem Menüpunkt Messages nach 

wie vor ansehen  

Klicken Sie nach der Änderung auf save changes . Sie können die Email-Flut auch mit Filtern oder Umlenkung in 
spezielle Verzeichnisse organisieren. Lassen Sie Ihre YAHOO-ID nicht hängen, dann bekomme ich (N1MM) unnötige 
Emails, die ich löschen muss.  

F. Bekommen Sie keine Emails mehr von der Gruppe ?   

A. Dann hatten Sie sicher Probleme mit Ihrer bei Yahoo eingetragenen Email-Adresse und es sind mehrere Emails 
zurückgewiesen worden. Yahoo bricht das Versenden der Emails an eine Adresse ab, wenn mehrere Zurückweisungen 
erfolgt sind. Haben Sie Ihr Problem geklärt, gehen Sie zu Edit My Membership und aktivieren Sie Ihre Adresse wieder. 
Ich (N1MM) streiche eine Email-Adresse, wenn die Liste der zurückgewiesenen Emails zu lang wird. Bitte achten Sie 
selbst darauf und editieren Sie den Eintrag bei Yahoo rechtzeitig, wenn Sie Ihre Adresse wechseln. 
  

F. Ich habe Probleme mit dem Downloaden von Dateien  bei Yahoo   

A. Hier gibt es verschiedene Fehlerursachen :   

• Haben Sie noch genug Platz auf der Festplatte ? 10MB ist ein guter Wert. 
• Klicken Sie mit rechts auf die Datei und wählen Sie „Speichern unter..“   
• Schalten Sie unter Netscape das Netscape Smart Download ab   
• Schalten Sie u.U. einen eventuellen 'download manager’  ab und versuchen Sie es noch einmal….  
• ...  

35.6 Anderes (Other)  

F. Das Programm sendet immer mit VFO-A, wie kann ic h mit dem VFO-B senden ?  

A. Das Programm hat zwei Eingabefenster, eins für VFO-A (immer offen) und ein zweites für VFO-B. Wollen Sie mit dem 
VFO-B senden, müssen Sie die Eingaben dafür in das zweite Eingabefenster machen. Das zweite Fenster kann mit 
einem Backslash \  in das erste Eingabefenster geöffnet  werden.  
Anmerkung DM3ML : Nehmen Sie CTRL+Pfeil links, wenn’s mit dem Backslash auf einer deutschen Tastatur nicht 
funktioniert. 

F Beim Import einer ADIF-Datei aus einem anderen Pr ogramm werden die Seriennummern nicht importiert  

• Sehen Sie mit einem Editor in der ADIF-Datei nach, ob Sie die Felder für die Seriennummern enthält  
• Verwendet es STX und SRX?  
• Unter N1MMLogger sieht das Format so aus :  

o <SRX:1>3   z.B. für die empfangene Nummer 3 oder <SRX:3>567 für 567 
o <STX:1>8  für die gesendete Nummer 8 oder <STX:4>1234 für 1234  

� Stimmt bei den Nummern bei der Importdatei dieses Format nicht, müssen Sie sie 
u.U. editieren. Hier helfen die Funktionen Suchen und Ersetzen in einem Texteditor.  

F. Mein CW wird zerhackt, hilft mir das Gerät Winke y ?  

A. Winkey nimmt Ihrem PC die Arbeit mit der Tastung von CW ab und reduziert Ihre CPU-Belastung mit dieser Arbeit auf 
Null. Die Daten werden als ASCII-Zeichenkette über die serielle Schnittstelle an Winkey gesendet und dort in CW-
Zeichen umgesetzt. Wenn Ihr PC in SSB einwandfrei funktioniert und nur in CW Probleme hat, können Sie das Problem 
mit Winkey komplett lösen. 
  

F. Vom Programm kommt die Meldung "Radio not workin g"  

A. Diese Meldung erscheint, wenn das Programm vom Transceiver eine Frequenz Null oder eine ungültige Sendeart 
gemeldet bekommen hat. Dieser Effekt kann durch HF auf der Schnittstelle oder eine falsche Konfiguration ausgelöst 
werden. Falls Ihr CAT-Interface von der Schnittstelle gespeist wird, setzen Sie die Signale DTR und RTS auf „immer 
eingeschaltet“ (always on). Auch die Anwahl des Handshake-Protokolls kann zu Fehlern führen. 
 

F. Das Programm akzeptiert die Kontrollnummer der G egenstation nicht   
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A. Hier kann ein Programmfehler oder ein Operatorfehler vorliegen. Geben Sie eine Kontrollnummer ein, die das 
Programm akzeptiert und editieren Sie anschliessend mit CTRL-Y das QSO . 
 

F. Der Transceiver läst sich ordentlich mit einer T aste oder einer Elbug tasten, aber nicht mit der pa rallelen 
Schnittstelle des PC  

A. Eigentlich müsste alles gehen. Funktioniert das Interface mit anderen Programmen ? Wir nehmen an, dass Sie das 
Interface an LPT1 gesteckt haben. Gehen Sie zur Systemsteuerung > System > Hardware > Gerätemanager > 
Anschlüsse (COM+LPT) > LPT1 > Ressourcen und überprüfen Sie, welcher E/A-Bereich dort eingetragen ist. Normal ist 
für LPT1 die Adresse 378 und für LPT2  die Adresse 278. Prüfen Sie nach, ob diese Adresse auch in Karteilkarte 
Hardware der Konfiguration für den CW/PTT-Port von N1MMLogger eingetragen ist. 
 

F. Woher weiss ich, dass Dlportio ordentlich gelade n ist?  

A. Gehen Sie unter Windows zu Systemsteuerung  > System > Hardware > Gerätemanager > Ansicht > Geräte nach 
Verbindung + Ausgeblendete Geräte anzeigen und stellen Sie fest ob der  Driver LINX I/O Driver  angezeigt.   

F. Wie kann ich den BCD-Kode an der LPT-Schnittstel le nachmessen?  

A. Nehmen Sie ein Digitales Voltemeter und verbinden Sie den Minuspol mit der PC-Masse. Messen Sie die Pegel an 
den Pins 2,7,8 und 9 den Pegel nach (0V=0 und +5V=1) und vergleichen Sie ihn mit der Kodetabelle des 
Antennenwahlschalters.  
 

F . Woher weiss N1MMLogger die Zeitdifferenz zwisch en PC-Zeit und UTC? 

A. Das Programm sieht in der Windows-Zeiteinstellung nach. Windows kennt die Rechnerzeit und die eingestellte 
Zeitzone unter Berücksichtigung von Sommer-/Winterzeit und rechnet daraus die aktuelle UTC-Zeit aus. 

F. Welche Zeit soll ich am Computer einstellen ?   

A. Es gibt zwei Optionen :   

• Fahren Sie Ihren PC mit Lokalzeit und achten Sie darauf, dass 
die Umschaltung von Sommer- auf Winterzeit und zurück 
richtig erfolgt. Die GMT-Zeit sollte ohne Sprung durchlaufen.  

• Fahren Sie Ihren PC mit GMT, wählen Sie aber GMT für 
Monrovia/Casablanca, denn London hat Sommer/Winter-Zeit. 

F. Ich habe den falschen Contest gewählt, wie kann ich das ändern ? Kann ich die QSOs konvertieren, od er 
muss ich sie von Hand neu eingeben ?  

A. Es gibt eine Möglichkeit. Im Beispiel wird von DX nach CQWW SSB konvertiert : 

• Sichern Sie Ihre Datenbank  
• Exportieren Sie das Log als ADIF-Datei 
• Editieren Sie die ADIF-Datei mit der Ersetz-Funktion eines Editors, bis Sie die Spalten haben, die Sie 

brauchen.  
• Wollen Sie sicher gehen, ob das Log passt, erzeugen Sie ein Testlog für einen CQWW-SSB-Contest, geben 

Sie es als ADIF-Datei aus und vergleichen Sie es mit dem zu konvertierenden Log.  
• Ändern Sie die Contest-ID von z.B. <CONTEST_ID:2>DX  in  <CONTEST_ID:7>CQWWSSB.  

Hinweis : Bei den CQWW-Contesten möchte N1MMLogger den ID-Eintrag CQWWSSB oder CQWWCW, 
nicht CQWW wie von manchen Konvertierungsprogrammen erzeugt sehen.  

• Starten Sie einen neuen CQWW-SSB-Contest mit choose contest  
• Importieren Sie die modifizierte ADIF-Datei in den neuen Contest  
• Starten Sie nach dem Import Tools > Rescore Contest, damit die Punkte stimmen  

F Wie kann ich einen einzelnen Contest aus der Date nbank auf eine andere Datenbank (oder einen anderen  PC) 
kopieren ?   

A. Exportieren Sie das Contestlog mit File > Export > ADIF >  Export ADIF to file  in eine ADIF-Datei. Sie können diese 
Datei bei Bedarf mit einem ASCII-Editor editieren. Sie können die ADIF-Datei in ein Logprogramm oder einen anderen 
PC mit N1MMLogger über  File > Import > Import ADIF file  wieder einlesen. 
Wenn Sie das Contestlog über ADIF in Ihr normales Stationslog einlesen, können Sie es wie normalen QSOs nach 
Länderstand, QSL-Status usw. verarbeiten. 
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F. Ich verwende ADIF, aber mein Logbuchprogramm imp ortiert es nicht  

A. Versuchen Sie herauszubekommen, wo der Fehler liegt. ADIF-Dateien sind mit normalen Texteditoren wie Notepad 
und Wordpad lesbar und können auch bearbeitet werden. Meist klemmt es in der Auslegung der ADIF-Spezifikationen. 
Jeder Eintrag im ADIF-Log besteht aus dem Schlüsselwort, der Längenangabe und der eigentlichen Information zu 
diesem Schlüsselwort, z.B. <call:5>ON5ZO <band:4>160M   bedeutet dass das Rufzeichen 5 Zeichen lang ist und 
ON5ZO lautet, der auf dem Band 160m gearbeitet wurde. 
Manchmal erwartet das importierende Programm den Lokator als <grid>  und nicht als <gridsquare>  oder möchte 
arrl_sect  lesen, wenn state  angeboten wird. Sie können mit einem Editor und der Ersetzfunktion alle nicht akzeptierten 
Schlüsselworte editieren und global ersetzen. 
 

A. Mein PC hat etliche Zeit während des Contests ve rloren   

A. Das ist ein Windowsproblem, das bei intensiver Contestnutzung auftritt. 10min Verlust in 48 Stunden Contest wurden 
schon beobachtet. Stellen Sie u.U. die Contestuhr während des Contests oder rufen Sie im Internet ein Normaluhr auf. 
Die Programme  Dimension 4  und About Time sind solche Hilfsmittel. 

F. Dimension 4 und AboutTime erzeugen einen Fehler unter  Windows XP ('error binding socket address')   

A. Unter Windows XP haben  Dimension 4  und About Time  einen Konflikt mit dem internen Zeitynchronisierprogramm 
von Windows XP. Dimension 4  und About Time  können so eingestellt werden, dass sie wesentlich öfter die Zeit 
synchronisieren als das interne Programm von Windows XP.  

Schalten Sie das Windows-interne Programm timesync  ab und stellen Sie Dimension 4  und About Time  so ein :.  

• Starten Sie die Systemsteuerung und gehen Sie dort zu Datum und 
Uhrzeit . Schalten Sie auf der Karteilkarte Internetzeit  die Option 
Synchronisieren mit einem Internetzeitserver  ab. 

• Gehen Sie in der Systemsteuerung  zu Verwaltung > Dienste  umd 
schalten Sie den Windowszeitgeber auf deaktiviert. 
 

F. Die interne Windows XP-Zeitsynchronisierung star tet nur einmal am Tag. Kann ich sie öfter starten ?  
  

A. Sie können die Einstellung in der Registry ändern, Sie ist nicht so komfortabel wie Dimension 4 .  

• Starten Sie  Regedit 

• Gehen Sie zu: 
HKEY_LOCAL_MACHINE\SYSTEM\ControlSet001\Services 
\W32Time\TimeProviders\NtpClient  

• Wählen Sie "SpecialPollInterval"  

• Die einstellbaren Werte sind in Sekunden :   
� Voreingestellt : 604800 (einmal je Woche)  
� jeden Tag = 86400 (seconds) 
� jede Stunde = 3600 (seconds) 

F . Wie kann ich N1MMLogger auf mehrere Disketten b ringen, um es auf einem anderen Computer zu install ieren 
? 
A.  
Antwort 1 : Holen Sie sich die Basisidatei N1MM.zip in 5 Teilen von der N1MM-Webseite unter Other Files und speichern 
sie diese Teile auf Disketten 

Antwort 2 : Holen Sie sich die grosse Datei N1MM.zip auf Ihre Festplatte. Geben Sie diese Datei dann mit dem 
Programm WINZIP auf Disketten aus, WINZIP organisiert die Aufteilung auf die Disketten und muss auf dem Gast-PC 
vorhanden sein, um die geteilten Teile wieder zusammenzusetzen.  
 

36. Unterstützte Hardware (Supported Hardware) 
36.1 Winkey 

Winkey ist ein externer CW-Geber der von K1EL und G3WGV entwickelt wurde. Er wird mit ASCII-Zeichen gespeist und 
gibt sie exakt getastet wieder aus. Mit Winkey werden die Probleme, die bei der CW-Tastung mit Windows in einer 
Multitaskingumgebung auftreten (Zeitscheibenverteilung) vermieden. Über Einzelheiten informieren Sie unter Links zu 
Hardware (Hardware links). 
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Winkey wird über eine serielle Schnittstelle angeschlossen und auf der Karteilkarte Winkey  konfiguriert:   

• PC-Geschwindigkeit ist unabhängig von der Tastgeschwindigkeit  
• Wählbarer Mithörton 
• CT-Abstände unterstützt 
• Änderungen der Gebegeschwindigkeit werden in der Statuszeile angezeigt 
• Vier Gebearten werden unterstützt : Iambic A, Iambic B, Ultimatic und Semi-Automatic (Bug). Voreingestellt 

ist Iambic B. 
• Die Tastung vom PC wird unterbrochen, sobald die Taste berührt wird  
• Unterstützt die Rufzeichenkorrektur 
• Die Gebegeschwindigkeit wird mit einem Potentiometer eingestellt. Mit N1MMLogger wird die CW vom PC 

eingestellt. Sie können mit der Taste zusätzlich und unabhängig vom PC QRS/QRQ machen oder Text 
senden. 

• Sie haben die Wahl für  
• CW-Ausgang 
• Mithörton 
• PTT  
• Zwei Transceiver werden getastet. Umschaltung mit Pin 5 und Pin 3 für zwei Transceiver 
• Es wird nur Winkey V4 und höher unterstützt. Eine Warnung erscheint, wenn eine nicht unterstützte Version 

angeschaltet wird 

Im Eingabefenster links sehen Sie Informationen zu Winkey :  

• Winkey paddle speed =  

• Winkey Version =  

• Winkey buffer 2/3 full  

 
Speisen Sie Winkey mit einer externen Batterie und nicht über die Schnittstelle. So können Sie auch bei einem 
Rechnerabsturz den Sender tasten 

 
Für Winkey brauchen Sie eine separate COM-Schnittstelle 

36.1.1 Warum Winkey ? (Why Winkey?)  

Winkey ist ein getrennter Rechner mit Interface. Er bekommt seine Information als ASCII-Zeichenfolge über die serielle 
Schnittstelle vom PC und setzt sie in saubere CW um. Probleme mit der Rechnerbelastung und der 
Zeitscheibensteuerung auf einem Windowsrechner entfallen. Ebenfalls entfallen die Schnittstellenprobleme an modernen 
Rechner, die kaum noch „alte“ Schnittstellen haben. In der Regel kann CW über einen Umsetzer von USB  auf serielle 
Schnittstelle nicht gemacht werden.  Das Produkt von K1EL kann zusätzlich als getrennter CW-Geber auch bei einem 
Rechnerabsturz verwendet werden. 
 

36.2 RigBlaster  

CW und digitale Einstellung  

Setzen im Inneren des RigBlaster Plus die Jumper im Block P5 mit der Bezeichnung  D9 und D12 als RTS auf PTT und 
DTR auf KEY. Stellen Sie die Schnittstzelle für den RigBlaster unter N1MMLogger auf der Karteikarte DIGITAL auf  
OTHER. Wählen Sie in der Konfiguration DTR (pin 4) für CW und RTS (Pin 7) für PTT. Sie können damit von 
N1MMLogger aus CW tasten und das PTT-Signal für die Soundkartenprogramme MMTTY, SSTV, PSK, Voice Key 
Express u.a. schalten.  

SSB-Einstellung  

� Serielle Schnittstelle im Configurer :   
� COM2 oder eine andere Schnittstelle 
� DTR: Always OFF 
� RTS: PTT  

� Am Rigblaster :   
� Setzen Sie den Tx/Auto switch auf 

Auto.  
� Soundkartenpegel einstellen auf  

� Volume level (ungefähr): 40000.  
� Wav Volume level (ungefähr): 40000.  
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Mit dieser Einstellung wird das Mikrofon beim Senden einer WAV-Datei stummgeschaltet und die VOX arbeitet bei einer 
WAV-Datei.  

36.3 Banddekoder von Top Ten Devices  (Top Ten Devices  automatic band decoder)  

Wenn Sie den Banddekoder von Top Ten Devices nutzen wollen, müssen Sie die Antennentabelle in der Konfiguration 
(Karteikarte Antennas) richtig ausgefüllt haben. Siehe auch Weitere Geräte an der parallelen Schnittstelle  

36.4 Transverter (Transverters)  

Wenn Sie unter N1MMLogger einen Transverter einsetzen, können Sie die Offset-Frequenz mit  Set transceiver offset 
frequency  mit einem rechten Klick in die Bandskala eintragen. Wollen Sie einen KW-Transceiver auf 28 MHz hinter 
einem 2m > 10m –Umsetzer betreiben, geben Sie 116000 als Offset-Frequenz ein. In der Bandskala wird 144-166 MHz 
angezeigt und Ihr Transceiver läuft von 28-30 MHz. Die Offsetfrequenz ist für beide Bandskalen getrennt einstellbar, so 
dass Sie in einem Contest zwei verschiedene Transceiver mit Transvertern auf unterschiedlichen Bändern betreiben 
können. Die Offset-Werte werden mit Programmende abgespeichert und stehen beim Neustart wieder zur Verfügung. 

36.5 CW-Dekoder  (CW decoders)  

N1MMLogger hat keinen eingebauten CW-Dekoder und unterstützt keine externen CW-Dekoder. 

36.6 Rotorsteuerung (Rotators)  

Rotorsteuerungen werden vom Programm (noch) nicht unterstützt.  

37. Unterstützte Conteste (Supported Contests) 
37.1 Allgemeines Log (General contest logging (all modes )) 

Conteste  gehen Sie zu  Bemerkungens  

DX (General log)  Setup  Gesendetes/empfangenes RST Sent RST, Name. Kommentar 

DXPEDITION  Setup  Nur gesendetes/empfangenes RST 

DXSATELLIT  Setup  Call, Lokator und Satellit  

VHFDX  Setup  Gesendetes/empfangens RST, Contestnummer, WWLokator 

37.2 Unterstützte HF-CW/SSB-Conteste  (Supported HF CW/SSB contests are ☺☺☺☺ 

Bei allen Contesten werden beide Seiten unterstützt (Ausnahmen sind vermerkt)  
Die Angaben wurden nicht übersetzt, sie sprechen für sich bzw. sind den deutschen Contestausschreibungen zu 
entnehmen (DM3ML) 

Contest  Jump to   Website   Remarks  

All Asian DX contest CW / SSB  Setup  Website  
CW - Third Saturday of June (48 hours) 
SSB - First Saturday of September (48 hours)  

All Asian DX contest CW / SSB  Setup  Website  
CW - Third Saturday of June (48 hours) 
SSB - First Saturday of September (48 hours)  

ARCI QRP Contests  Setup  Website  This contest supports 7 ARCI QRP contests  

ARI International DX Contest  Setup  Website  Per version 4.0.63  

ARRL 10 Meter contest  Setup  Website     

ARRL 160 Meter contest  Setup  Website     

ARRL Field Day contest  Setup  Website  
Dupe Sheets not always required for this contest, see ARRL Field Day 
Setup instructions. Info by Dan Henderson, N1ND from the ARRL 
contest branch. 

ARRL International DX contest CW /Phone  Setup  Website     

ARRL International DX contest Phone  Setup  Website     
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ARRL November Sweep Stakes CW / SSB  Setup  Website     

Asia-Pacific Sprint Contest  Setup  Website  In Spring, Summer, Fall (2 hours)  

Baltic contest  Setup  Website  
Every year the last but one weekend in May - one week before WPX CW 
Contest  

CQ World-Wide 160 Meter DX Contest - CW / Phone  Setup  Website     

CQ World Wide DX contest - CW / SSB Setup  
Website1 
Website2 

CW - Last full weekend of November (48 hours) 
SSB - Last full weekend of October (48 hours)  

CQ World Wide WPX contest - CW / Phone  Setup  Website     

CIS DX contest  Setup  Website  Commonwealth of Independent States  

CNCW Spanish contest  Setup    Website  Local Spanish CW contest  

Cup of the Russian Federation (RFC) contest  Setup     Internal Russian contest in January.  

DARC 10 meter contest  Setup  Website  2nd full weekend in January.  

DARC Weihnachtswettbewerb (XMAS contest)  Setup  Website  December 26  

European Sprint - CW / Phone  Setup  Website  In April and October (both modes) (4 hours)  

FOC Marathon  Setup  Website  First full weekend in February  

Helvetia Contest  Setup  Website     

HA DX contest  Setup  Website  3rd full weekend of January  

Holyland contest  Setup  Website     

High Speed CW Contest (HSC CW)  Setup  Website     

IARU Radiosporting contest HF  Setup        

IARU Region 1 Fieldday contest  Setup     According rules for Belgium, Germany, Great Britain, Netherlands, 
Switzerland, Ireland (only CW) and Russia (UA, UA2, UA9).  

IOTA  Setup  Website     

King of Spain contest  Setup  Website     

Michigan QRP Contest  Setup  Website  
This contest supports 4 Michigan QRP contests 
Select ARCI contest (same rules)  

NA Sprint - CW / SSB  Setup  Website  

CW: First Sunday in February 
SSB: Sunday of first full weekend in February  

CW: Sunday following first Monday in September 
SSB: Second Sunday following first Monday in September  

North American QSO Parties (NAQP) - CW / SSB  Setup  Website  
CW: Second full weekend in January 
SSB: Third full weekend in January  

NRAU-Baltic contest  Setup  Website  2nd full weekend in January.  

Oceania contest CW / SSB  Setup  Website  
SSB: First weekend in October 
CW: Second weekend in October  

PACC contest  Setup  Website  First full weekend of February  

RAC Canada Day and Winter contest  
RAC Canada Winter Contest  Setup  Website  Both contests have the same rules.  

REF DX contest  Setup  Website  
CW: last weekend of January 
SSB: last weekend of February  

RSGB Jubilee  Setup        

Russian District Award Contest  Setup  Website     

Russian DX  Setup  Website     

Russian YL/OM contest  Setup  Website  Website in Russian  

SAC  Setup  Website     
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SP DX contest  Setup  Website  First full weekend of April (15:00-15:00 GMT)  

Stew Perry Topband Distance Challenge  Setup  Website  Last full weekend of December  

UBA DX Contest CW/SSB  Setup  Website  
SSB: last weekend of January 
CW: last weekend of February  

UK DX Contest - CW/SSB  Setup  Website     

WAEDC-Contest  Setup  Website  The starter for the new Contest season.  

Worked All Germany (WAG) contest  Setup  Website  October, third full weekend  

37.3 QSO-Parties  (QSO Parties (CW/SSB))  

The QSO parties below are supported. There are some scoring anomalies though. 
The QSO parties use a configuration file named 'County.sec' with the used sections per qso party.  
See the Setup for more information.  

37.3.1 United States  

QSO party  QSO party  QSO party  QSO party  

Alabama (AL)  
   
Website  

Alaska (AK)     Arkansas (AR)  Website   California (CA)  Website  

Delaware (DE)  
   
Website  

Florida (FL)  Website  Setup  Georgia (GA)  Website  Hawaii (HI)  Website   

Indiana (IN)  Website  Illinois (IL)  Website  Kansas (KS)     Kentucky (KY)  Website   

Louisiana (LA)  Website  
Maryland DC 
(MD)  Website  Michigan (MI)  Website  Minnesota (MN)  Website  

Missouri (MO)  Website  Montana (MT)   Nebraska (NE)  Website   
New England 
(NEWE)  Website  

North Carolina 
(NC)  

Website 
   

New Jersey (NJ)  Website  Nevada (NV)  Website  Ohio (OH)  Website  

Oklahoma (OK)  Website  Oregon (OR)  Website  Pennsylvania (PA)  
Website 
Setup  

South Carolina (SC)  Website  

South Dakota (SD)     Tennessee (TN)  Website  Texas (TX)  Website   Vermont (VT)  Website  

Virginia (VA)  Website  Wisconsin (WI)  Website  
Washington State 
Salmon Run Contest 
(WA)  

Website  West Virginia (WV)  Website   

37.3.2 Canada  

QSO party  

Ontario (ON)  Website  

37.4 Unterstützte UKW-Conteste  (Supported VHF CW/SSB contests are ☺☺☺☺ 

Contest  Jump to  Website  Remarks  

ARRL January VHF Sweepstakes  Setup  Website  January  

ARRL June VHF QSO Party  Setup  Website  June  

ARRL September VHF QSO Party  Setup  Website  September  

IARU Region 1 50 MHz contest  Website  Only 50 MHz - June  

IARU Region 1 144 MHz September contest  Website  Only 144 MHz - September  

IARU Region 1 UHF/Microwaves October contest  

Setup  

Website  UHF and Microwaves - October  
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Other Region 1 VHF and up contests   Website  VHF and up - March, May, July  

Marconi CW contest 144 MHz / 50 MHz  Setup  Website     

REF Departments contest 50 Mhz  Setup  Website  Only 50 MHz  

UKSMG sporadic-E competition  Setup  Website     

  

37.5 Unterstützte RTTY/PSK-Conteste  (Supported RTTY/PSK contests are ☺☺☺☺ 

All contests are supported 'both' sides unless specifically mentioned.  

Contest  Jump to  Website  Remarks  

ANARTS WW RTTY contest  Setup  Website  Second full weekend of June  

Anatolian RTTY contest  Setup  Website  Third full weekend in May  

ARRL RTTY Roundup  Setup  Website  First full weekend of January (not on January 1)  

BARTG RTTY Spring contest  Setup  Website  Third full weekend in March  

BARTG RTTY Sprint contest  Setup  Website  End of January  

CQ World Wide DX contest - RTTY  Setup  Website  Last full weekend of September (48 hours)  

CQ World Wide WPX contest - RTTY  Setup  Website  Second full weekend of February  

CIS DX RTTY contest  Setup  Website  Commonwealth of Independent States  

DL-DX RTTY contest  Setup  Website  First full weekend of July  

EA RTTY contest  Setup  Website  First full weekend of April  

JARTS WW RTTY contest  Setup  Website  Third full weekend in October  

OK DX RTTY Contest  Setup  Website  Third full weekend in December  

Quick PSK63 Contest  Setup  Website  
PSK63. Uses SARTG rule. 
First Saturday of September  

NA Sprint - RTTY  Setup  Website  
Sunday of second full weekend in March 
Sunday of second full weekend in October  

North American QSO Parties (NAQP) - RTTY  Setup  Website  Last full weekend in February  

SARTG New Year RTTY Contest  Setup  Website  January 1st  

SARTG WW RTTY Contest  Setup  Website  Third weekend in August  

SCC RTTY Championship  Setup  Website  Last full weekend in August  

SP DX RTTY contest  Setup  Website  4th full weekend of April  

Russian DX RTTY contest  Setup  Website  RTTY. First Saturday of September  

TARA Grid Dip contest  Setup  Website  RTTY and PSK. First Saturday of August  

TARA PSK Rumble  Setup  Website  PSK31. First Saturday of October  

UK DX Contest - RTTY  Setup  Website  Second full weekend of July  

XE RTTY contest  Setup  Website  First full weekend of February  

Volta RTTY Contest  Setup  Website  Second full weekend in May  

WAEDC RTTY Contest  Setup  Website  Second full weekend in September  

 
38. Contest-Einstellungen (Contest Setup Instructions) 
38.1 Überblick (General) 
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Ist der Contest für eine bestimmte Sendeart (SSB, CW oder RTTY) ausgeschrieben, wird der gesendete Rapport 
automatisch an die Sendeart angepasst. Wenn Sie z.B. CQWWSSB für den CQ World Wide SSB Contest wählen, 
schaltet das Programm auf SSB. Ändern Sie diese Einstellung nicht, sonst gibt es Probleme mit dem Cabrillo-Log und 
auch mit dem Programm. 
Wenn der Contest SSB und CW zulässt,  wählen Sie bei mode die Einstellung mixed . Hier wird nicht automatisch in den 
SSB- oder den CW-Bereich des jeweiligen Bandes geschaltet.  

N1MMLogger ist ein Contestprogramm, Sie können aber mit der Contestart DX  auch ein allgemeines Log führen oder an 
einem Contest teilnehmen, der in der Liste nicht enthalten ist. DUPES sind möglich und eine Kontrollnummer ist nicht 
unbedingt nötig. 
Wenn Sie ein Contestlog in Ihr normales Logprogramm übernehmen wollen, geben Sie das Log als ADIF-Datei aus und 
importieren Sie dieses Log in Ihr Logprogramm.  
Anmerkung DM3ML : Eine weitere Möglichkeit ist der Export als Textdatei im generic -Format.  

Die gelöschten QSOs werden in einem Contest mit dem Namen  DELETEDQS abgelegt. Sie können sich aus diesem 
Contest gelöschte QSOs wieder holen, wenn Sie ihn als ADIF-Datei ausgeben und mit einem Editor bearbeiten.  

Die nächsten laufende Kontestnummer wird in der Titelzeile des Info-Fensters angezeigt, wenn Kontestnummern im 
Contest ausgetauscht werden, z.B. Exch: 59 002  

Die höchste empfangbare Contestnummer ist 32767 (für Conteste mit Seriennummer)   

Im Multi-User-Modus werden die Seriennummern je Band vergeben. Der WPX-Contest unterstützt diesen Modus.  

 
Hinweis  : Lesen Sie vor jedem Contest die aktuelle Ausschreibung des Veranstalters. Informieren Sie sich, wie Sie das 
Programm einstellen müssen, welche Daten ausgetauscht werden und welche Arbeitszeit vorgeschrieben ist..  

38.2 Allgemeine Logs  (General contest logging)  

38.2.1 DX log 

Window: Select Log type  

• Log Type: DX  
• Mode Category: Mixed If you want to have the possibility making SSB and CW contacts.  

For general or DX logging.  

• Entered qso's in General log (or DX log) don't need to have an exchange.  
• Dupes are shown by the word Dupe! but the qso can be logged.  

38.2.2 DXpedition  

Window: Select Log type  

• Log Type: DXPEDITION  
• Mode Category: Mixed If you want to have the possibility making SSB and CW contacts.  

For DXpedition logging.  

• Entered qso's in the DXPEDITION log don't need to have an exchange.  
• Dupes are shown by the word Dupe! but the qso can be logged. 

38.2.3 DX satellite  

Window: Select Log type  

• Log Type: DXSATELLIT  

• Mode Category: Mixed If you want to have the possibility making SSB and CW contacts.  

For Satellite logging.  

• Entered qso's in the DXSATELLIT log don't have an exchange and don't need to have a 
grid.  
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• When a grid is entered it needs to be 4 or 6 characters long.  

• Dupes are shown by the word Dupe! but the qso can be logged. 

38.2.4 VHFDX 

Window: Select Log type  

• Log Type: VHFDX  

• Mode Category: Mixed If you want to have the possibility making SSB and CW contacts.  

For VHF and up logging.  

• Entered qso's in the VHFDX don't need to have a grid.  

• When a grid is entered it needs to be 4 or 6 characters long.  

• Dupes are shown by the word Dupe! but the qso can be logged. 

• Bearing info is shown in the log window and saved in the Misc field. 

• Distance info is shown in km in the log window and saved in the Points field. 

38.3 HF CW/SSB contests  

38.3.1 All Asian CW / SSB 

The All Asian contest can be used by Asian stations and DX stations.  

• Window: Select Log type  
� CW  

� Log Type: ALLASIACW  
� Sent Exchange: Your age   Example: 

34  
� XYL and YL stations may 

give 00 

• SSB  
o Log Type: ALLASIACW  
o Sent Exchange: Your age   Example: 34  

� XYL and YL stations may give 00 

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are an Asian 
station or a non-Asian station.  

38.3.2 ARCI QRP Contests & Michigan QRP Contest  

Supported per version 4.0.63  
The ARCI contest supports 7 ARCI QRP Contests and the Michigan QRP Contest.  
 

• Window: Select Log type  
o Log Type: ARCI  
o Mode Category:  

� CW  
• for Spring QSO party ; HootOwl Sprint ; Summer Homebrew Sprint ; Fall 

Qso Party ; Holiday Spirits ; Michigan QRP Contest 
� SSB  

• for Winter Fireside 
� MIXED  

• for Topband Sprint 
• Sent Exchange:  

o First Part  
� State abbreviation for USA stations. Example: CT  
� Province abbreviation for VE stations. Example: ONT  
� Country abbreviation for non US or VE stations. Example: DL  

o Second Part  
� ARCI number for ARCI members 
� Send power for non-ARCI members 

• Log Window: Mult = DXCC     Mult2 = Section (State or Province)  
• Power is recognized being having a not fully numeric member/power field. 100W is power, 100 is member 

number  
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• There is a check on provinces and states, no check on countries. The program will give a proposal for the 
country prefix if non VE or K.  

• No calculations made for power multi or Bonus Points, this has to be done by the operator after the contest 
on the summery sheets.  

• Select CW, SSB or Mixed as 'mode Category 'to have the multiplier window work correct. 
• It is allowed stations to work each other in the contests in both modes even when only CW or SSB is 

allowed according the rules. I assume the operator knows the rules...  

38.3.3 ARI International DX Contest  

The ARI International DX contest can be configured for Italian stations and DX stations.  
 

• Window: Select Log type  
o Log Type: ARIDX  
o Sent Exchange:  

� 001 for non-Italian stations  
� Your Province for Italian stations  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are an Italian 
station or a DX station.  

38.3.4 ARRL 10 Meter contest  

The ARRL 10M contest can be used by K/VE stations and DX stations.  
 

• Window: Select Log type  
o Log Type: ARRL10M  
o Sent Exchange:  

� Your state/province - for K/VE stations Example: NY  
� 001 - for DX stations (non K/VE)  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a DX station or a W, KH6, KL7, VE station.  

38.3.5 ARRL 160 Meter contest  

The ARRL 160M contest can be used by K/VE stations and DX stations.  
 

• Window: Select Log type  
o Log Type: ARRL160 (not ARRL160M if shown)  
o Mode Category: CW  
o Sent Exchange:  

� ARRL/RAC section - for ARRL/RAC stations Example: VI  
� <nothing> - DX stations don't need to enter anything here (non K/VE), DX stations 

only send a report, no further exchange.  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a DX 
station or an ARRL/RAC station.  

The ARRL/RAC stations are: K, VE, KL, KC6, KG4, KH1, KH2, KH3, KH4, KH5, KH6, KH7, KH8, KH9, KP1, KP2, KP3, 
KP4 and KP5. 
The contest module accepts for /MM and /AM stations as ITU zones: R1, R2 or R3.  

38.3.6 ARRL Field Day contest  

The ARRL Field Day contest can only be used by US (K, KL and KH) & Canada stations (i.e. there are more FD contests 
outside the US & Canada which are not supported).  
 

• Window: Select Log type  
o Log Type: FD  
o Sent Exchange:  

� Your Class   Your section  
 

Here is word from Dan Henderson from the ARRL contest branch on using Cabrillo for your log submission.  

Field Day is not included in the Cabrillo format. It has no way to mark/indicate power sources, GOTA station callsign's, 
bonus points, NTS traffic messages, etc. Also, Field Day only requires Dupe Sheets, not full logs. It is perfectly 
acceptable to include the Cabrillo log in lieu of the Dupe Sheets, but Field Day must have a completely filled out 
Summary sheet that includes all necessary information. This can be done with a "reasonable facsimile" electronically. 
However, since "proofs of bonus" (i.e. copies of letters to newspapers, visitor logs, photos, etc) are abundantly provided, 
most people find it easier to do Field Day via the regular mail - and use a combined system of part-electronic added to 
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the paper summaries. Anything received electronically for Field Day will be receipted but we may have to manually follow 
up if we can't get the basic required information from the email.  

73' Dan Henderson, N1ND  

38.3.7 ARRL International DX contest - CW / SSB  

• Window: Select Log type  
o CW  

� Log Type: ARRLDXCW  
� Mode Category: CW  
� Sent Exchange: Your state/province - for K/VE stations Example: NY  
� Sent Exchange: Power - for DX stations (non K/VE) Example: 200 

o SSB  
� Log Type: ARRLDXSSB 
� Mode Category: SSB  
� Sent Exchange: Your state/province - for K/VE stations Example: NY  
� Sent Exchange: Power - for DX stations (non K/VE) Example: 200  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a DX 
stations or a W/VE station.  

The default power for DX stations is  

• 100 Watts - Default  
• 200 Watts - For the following countries: UA, UA2, UA9, UK, UN, UR, R1FJ, R1MV  
• 400 Watts - For the following countries: G, GM, GI, GD, GM, GM/s, GW  
• 500 Watts - For the following countries: I, IS, IT9  

Give 'Space' when the cursor is in the 'Power' field to have it filled with the default power.  
The default power will be selected, so that if you type another power level, it will replace the default power that the 
program put in there. 

Some stations give K or KW for 1000 watts. You don't have to enter 1000, just type K. The log checking software will 
understand.  

38.3.8 ARRL November Sweep Stakes - CW / SSB  

• Window: Select Log type  
o CW  

� Log Type: SSCW  
� Mode Category: CW  
� Sent Exchange: Precedence   Year first licensed   ARRL/RAC section   Example: B 70 

EMA (and in this order!) 
o SSB  

� Log Type: SSSSB 
� Mode Category: SSB 
� Sent Exchange: Precedence   Year first licensed   ARRL/RAC section   Example: B 70 

EMA (and in this order!) 

Spaces are required in the exchange except between the Nr & Prec. You may put the exchange elements in out of order 
and repeat them. The last one will be used.  
The cursor is positioned at the end of the exchange when swapping radios.  

1. Select log type and mode 
2. In the contest selection dialog, enter B 55 CT or whatever you Prec, Ck & Section are. 
3. Right click on the CW message buttons and change F2 to: #{Exch}. If you have separate run & S&P buttons, you may 
have to do it twice. 
4. If you want or don't want leading T's for the numbers, check the appropriate box in the configurer. 

Sweepstakes has different support in the logging program from any other contest because it is a five part exchange (call, 
nr, prec, ck, section). There are two text boxes for this and not six. The first is for the call. The second is for ALL five. The 
larger (second) textbox will allow you to enter any of the exchange elements in any order. There are some rules that are 
used to interpret ambiguous information, but you can always look at the frame above the textbox to tell what the program 
thinks you are trying to log.  

Here are some examples of exchanges and what they mean: 
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261 A 55 CT 261A 55 CT   

12B Q CT 61 12B 61 CT   

12B Q CT 61 EMA 44   61Q 44 EMA   

CO CT 12 13 B 12B 13 CT   

12A W1XX CT 66 12A W1XX 66 CT  W1XX overrides call in call textbox 

The rules are: 
(You must enter a space between parts, except between Nr & Prec.) 
Rule 1, parse from RIGHT to LEFT 
Rule 2, when you find a token of a certain type, stop looking for that type 
Rule 3, Nr = 1 or 3+ digit number 
Rule 4, CK = 2 digit number 
Rule 5, Section = 2 character or more alpha token 
Rule 6, Prec = 1 digit alpha token 
Rule 7, If there is one two digit and one three digit number, than the two digit is the ck & the three digit is the nr. 
Rule 8, If there are just two numbers and they are both 2 digits, the first is the nr, the second the ck. 

Try it. It's easier to use than it is to describe. 

Examples playing WAV files using ESM.  

Example 1 - You speak the callsign from the station 

• Put a space in the callsign button.  
o This replaces the advice to put empty.wav in the callsign button. Use a single space. 

• Now what you do is speak the call, Nr 123, then press enter. Your exchange wav file should be something like 
"Bravo, N1MM, Check 61 Connecticut" 

Example 2- The program speaks the callsign from the station 

• Put ! in for the callsign wav file. That will speak the call. 
• Put #wav\ssexch.wav in for the exchange wav file.  

o Don't forget the #, this will send the nr 
o wav\ssexch.wav will send your exchange file (obviously, substitute the name of your exchange 

wav file) 
o Now ESM will say when responding to W1AB this when pressing enter:   Whiskey One Alpha 

Bravo One Two Three Bravo, N1MM, Check 61 Connecticut 

38.3.9 Asia-Pacific Sprint Contest CW / SSB  

• Window: Select Log type  
• CW  

o Log Type: APSCW 
o Mode Category: CW   (spring and fall) 
o Sent Exchange: 001 

• SSB  
o Log Type: APSSSB  
o Mode Category: SSB   (summer) 
o Sent Exchange: 001  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a DX 
stations or an Asia-Pacific station. 

38.3.10 Baltic contest  

The Baltic contest can be configured for stations from the Baltic countries (ES, YL, LY) and DX stations.  
• Window: Select Log type  

• Log Type: BALTIC  
• Sent Exchange: 001  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a DX 
station or a Baltic station.  

38.3.11 CNCW Spanish contest  

The CNCW contest (EA CW NATIONAL CONTEST) is only for Spanish stations operating inside the national territory.  
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• Window: Select Log type  
o Log Type: CNCW  
o Mode Category: CW  
o Sent Exchange: Spanish Province letters   Example: SG  

38.3.12 CQ 160 Meter DX contest - CW / SSB  

• Window: Select Log type  
o CW  

• Log Type: CQ160CW  
• Mode Category: CW  

o SSB  
• Log Type: CQ160SSB  
• Mode Category: SSB  
• Sent Exchange:  

• Your state/province - for K/VE stations Example: NY  
• Your country abbreviation - for DX stations (non K/VE)  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a DX 
stations or a W/VE station. 

38.3.13 CQ World Wide DX contest CW / SSB  

• Window: Select Log type  
o CW  

� Log Type: CQWWCW 
� Mode Category: CW   (spring and fall) 
� Sent Exchange: Your zone   Example: 14  

o SSB  
� Log Type: CQWWSSB  
� Mode Category: SSB   (summer) 
� Sent Exchange: Your zone   Example: 14 

• The default zone values for US (K,N,W,A) stations are  
o Zone 3 - If number in callsign is 6 or 7  
o Zone 4 - If number in callsign is 5 or 8 or 9 or 0  
o Zone 5 - If number in callsign is 1 or 2 or 3 or 4 

• The default zone values for Canadian (VE) stations are  
o Zone 1 - If callsign starts with: VY1  
o Zone 2 - If callsign starts with: VE2, VO2  
o Zone 3 - If callsign starts with: VE7, VC7  
o Zone 4 - If callsign starts with: VE3, VE4, VE5, VE6, VA3  
o Zone 5 - If callsign starts with: VO1, VE1, XJ1, VY2  

• Give 'Space' when the cursor is in the 'Callsign' field to have the 'Zone' field filled with the default value.  
• The default zone will be selected, so that if you type another zone, it will replace the numbers that the program 

put in there.  
• For US users, Ctrl-up/dn doesn't stop at US stations.  
• US spots are not grayed out for Canadian users  
• Don't show and count own countries as workable in the Bandmaps and the Available window 
• A new zone will be shown in red in the Entry window 
• Band changes  

o The allowed band changes are 8 for all CQ Contests 
o The band change counter is reset to 0 on first contact after the top of the hour 

• The program will look up the zone if the call has been changed, provided no zone was typed by the user. 

38.3.14 CQ World Wide WPX contest - CW / SSB  

• Window: Select Log type  
o CW  

� Log Type: CQWPXCW  
� Mode Category: CW 
� Sent Exchange: Serialnumber   Example: 001  

o SSB  
� Log Type: CQWPXSSB 
� Mode Category: SSB 
� Sent Exchange: 001 i.e Serialnumber   Example: 001  

• Leading zeros are being forced on sent & received serial numbers. 
• Band changes  
• The allowed band changes are 8 for all CQ Contests 
• The band change counter is reset to 0 on first contact after the top of the hour 
• In multi user, serial numbers are by BAND. Make sure you don't operate both radios on the same band at the 

same time, and you should be ok. The WPX contest committee is ok with numbers by band for multi user. 
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38.3.15 CIS contest - CW / SSB  

The Commonwealth of Independent States Contest where everybody can work everybody for QSO and multiplier credit.  
• Window: Select Log type  

o Log Type:  
� CW: CISCW 
� SSB: CISSSB 

o Sent Exchange:  
� CIS stations: CIS area code Example for Moscow City: RU11  
� Non-CIS stations: 001 

38.3.16 Cup of the Russian federation (RFC) contest - CW / SSB 

The RFC Contest is an internal Russian contest only between Russian stations.  
• Window: Select Log type  

o Log Type:  
� CW: RFCCW 
� SSB: RFCSSB 

o Sent Exchange: Grid  Example: 4 

38.3.17 DARC 10 meter contest  

• Window: Select Log type  
o Log Type: DARC10M 
o Mode Category: Mixed or CW (depends on the entry class) 
o Sent Exchange:  

� DL stations: DOK   Example: A12 
� non DL stations: empty 

Call history lookup for DOK's is supported. Make a text file with Call and DOK and import this in the program. See 
chapter Before the Contest for more information how to use Call History and how to create the text file. During the contest 
"Call History Lookup" has to be enabled under the Config menu. When a station (which is in the Callhistory lookup table) 
is entered, pressing SPACE when the cursor is in the callsign field will enter the DOK in the section field.  

The contest manager from the DARC 10 meter contest approved and will accept the files made by N1MM logger and 
likes to receive:  

File  How to make...  Exported  

Log file File, Export, Export to File (Generic), Generic File Output sorted by time  [callsign].txt 

Summery sheet File, Export, Print Score Summary to File  [callsign].sum 

 
• Send the "Generic File Output sorted by time" as a txt-File named with your call like DL8WAA.TXT 
• Don't forget your used own call, category and if you are a DL station: own sent DOK. This can be put in the 

Email or also sent the Cabrillo-File 

38.3.18 DARC Weihnachtswettbewerb (XMAS contest)  

The DARC Weihnachtswettbewerb is a contest on December 26 from 08.30-10.59 UTC between any station on 40 and 
80 meters.  
The DARC manager for the Xmas contest accepts the standard generic file as log together with the summery sheet..  
 

• Window: Select Log type  
o Log Type: XMAS 
o Mode Category: Mixed 
o Sent Exchange:  

� DL stations: Serialnumber + DOK  Example: 001 A12 
� Non-DL stations: Serialnumber Example: 001 

During the contest info about suspicious DOK's are shown in the info bar and written to the Notes filed.  
After the contest check 'View | Notes" for the following situations: 

• "DL station non DARC member" - no DOK is given (DL station who is not a DARC member). 
• "DL station met DOK length 1" - DOK length is only one. 

• "DOK with only numbers" - no letters in DOK. 
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38.3.19 European Sprint - CW/ SSB (EU sprint)  

• Window: Select Log type  
o CW  

� Log Type: EUSCW 
� Mode Category: CW 
� Sent Exchange: Serialnumber & Operator name  Example: 001 Tom 

o SSB  
� Log Type: EUSSSB 
� Mode Category: SSB 
� Sent Exchange: Serialnumber & Operator name  Example: 001 Tom 

Example: The Exchange key (F2) can look like this:  de * # {Exch}   where "#" is current QSO Number and 
"{Exch}" is the Operator name.  

38.3.20 Field Day Region I  

The Region I field day contest can be configured for Region 1 stations and DX stations. Supported are the rules for 
sttaions in Belgium, Germany, Great Britain, Netherlands, Switzerland, Ireland (only CW) and Russia (UA, UA2, UA9).  

• Window: Select Log type  
o Log Type: FDREG1  
o Sent Exchange: 001  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a Region 
1 station or not and if you are /P etc. or not..  

N1MM Logger checks whether you are a portable or a fixed station by checking the callsign in the Station dialog under 
config ! 
So using a /P, /M etc there could make a difference in scoring! 

38.3.21 FOC marathon  

• Window: Select Log type  
o Log Type: FOC  
o Sent Exchange: membership number  

38.3.22 HA DX Contest  

The Hungarian DX Contest can be configured for HA stations and DX stations.  
• Window: Select Log type  

o Log Type: HADX  
o Sent Exchange:  

� non-HA stations: 001  
� HA stations  

• HADXC members: HADXC membership number  Example: 101 
• Other HA stations: two letters county code.   Example: GY 

 
The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a HA 
station or a DX station.  

38.3.23 Helvetia Contest  

The Helvetia Contest can be configured for HB stations and DX stations.  
 

• Window: Select Log type  
o Log Type: HELVETIA  
o Sent Exchange:  

� 001 for non-HB stations  
� 001 Your Canton   Example: 001ZH for HB-station  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a DX 
station or a HB station.  

38.3.24 High Speed CW Contest  

The HCS CW can be configured for members and non-members.  
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• Window: Select Log type  
o Log Type: HSCCW  
o Mode Category: CW  
o Sent Exchange:  

� Non-members: NM  
� Members: HSC-Membershipnumber  

38.3.25 Holyland Contest  

The Holyland Contest can be configured for 4X stations and DX stations.  
 

• Window: Select Log type  
o Log Type: HOLYLAND  
o Sent Exchange:  

� 001 for non-4X stations  
� Your Area   Example: E15RH  

 
The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a DX 
station or a 4X station.  

38.3.26 IARU radiosporting contest HF  

• Window: Select Log type  
o Log Type: IARU-HF  

38.3.27 IOTA 

• Window: Select Log type  
o Log Type: IOTA  
o Sent Exchange: 001 NA123 (default exchange)  

The received IOTA reference does not need the dash (-) when logged. Example: Enter EU123 in the IOTA field. The 
Cabrillo output will have the - added. 

N1MM logger uses separate numbering for CW and SSB 
The rules from the IOTA say: Send RS(T) and serial number starting from 001, bonus IOTA reference number if 
applicable. Do not uses you separate numbering systems for CW and SSB.  
A reply from Don Field, the IOTA contest Manager on this subject: " The key thing is to record what was sent - if different 
serial number sequences were sent on each band, then record that. Then the checking software won't bring them up as 
busted QSOs." 

38.3.28 King of Spain Contest  

The King of Spain contest can be configured for EA stations and DX stations.  
 

• Window: Select Log type  
o CW  

� Log Type: KINGEACW 
� Mode Category: CW 
� Sent Exchange:  

• non-EA stations: 001  
• EA stations: Your Province   Example: AV  

o SSB  
� Log Type: KINGEASSB 
� Mode Category: SSB 
� Sent Exchange:  

• non-EA stations: 001  
• EA stations: Your Province   Example: AV  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a DX 
station or a EA station.  

38.3.29 Michigan QRP Contest  

See the ARCI contest which uses the same rules.  
Supported are: January CW Contest ; Memorial Day CW Sprint ; July 4th CW Sprint ; Labor Day CW Sprint  

38.3.30 NA Sprint CW / SSB  
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• Window: Select Log type  
o Log Type:  

� CW: SPRINTCW  
� SSB: SPRINTSSB  

o Sent Exchange: 001 Tom CT  
� Serial number, your name and your location (state, province or country)  Example: 

PA1M DE N1MM 123 TOM CT K  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a North 
American station or a non-North American station.  

NA Sprint CW by Kenny, K2KW  

North American Sprint CW is just a few hours away, and thought I would take a moment to help others get their CW 
messages ready. Your messages may differ slightly from mine, but I just wanted to highlight what's happening on the F2 
and F3 messages which are the key setup items for Sprint. The F2 exchange is set up to give you the correct sequence 
for this contest using ESM, and the exchange sequence varies based on if you are Calling CQ, or you answered 
someone while S&P. F3 is used to confirm the message, and change your state from S&P to Running, or Running to 
S&P. The {RUN} and S&P} macros are inserted at the end of the F3 message, and will automatically change your state, 
and thus exchange sequence.  

I have also changed the Up/Down Arrow to move 1.5 kHz, giving you an "instant QSY" per the rules. You may choose to 
use a wider QSY increment, but the goal was to offer you an idea for QSYing so you can abide by the rules.  

If you are not aware of the uniqueness of the Sprint exchange and QSY rule, check out: http://n6tr.jzap.com/sprint.html 
and http://www.ncjweb.com/sprintrules.php  

73 and CU in the contest, 

Setting the Exchange:  

File> Choose Which Contest to Log > 
Sent Exchange 

"# yourname yourstate" (eg: # KEN CA)  

In the Config > Configurer > Other 
window 

I have changed the CW Up/Down Arrow Incr = 1.5 That gives me an instant QSY somewhat greater than the minimum QSY required after you leave a 
frequency. Any value over 1 kHz is recommended. 

CW MESSAGES  

RUNNING Messages  S&P Messages  

F1 CQ: * * <<<NA>>> F1 CQ: * * <<<NA>>> 

F2:  * {EXCH} F2: ! {EXCH} * 

F3: EE{S&P} F3: EE{RUN}  

F4: * F4: * 

F5: ! F5: ! 

F6: B4 E E F6: B4 E E 

F7: ? F7: ? 

F8: AGN F8: AGN 

Running Message Notes  

• For F2, there is a space before the *; E.G. "<space> * {EXCH}" 

• For F3, "EE" is there to confirm the QSO. You could easily use "TU".  

• After the "EE" is sent on the F3 message, the {S&P} macro puts you into the S&P mode. Then just hit your UP/DOWN arrow to QSY.  

• Personally I have F6 programmed as {EXCH} to send a repeat on the exchange 

S&P Message Notes  

• Note the difference in the sequence for the F2 message compared to the Running F2 message  

• For the F3 message, the {RUN} macro puts you in the running mode, ready to work a tail ender and send him the correct QSO sequence  

• Personally I have F6 programmed as {EXCH} to send a repeat on the exchange  

38.3.31 North American QSO Parties (NAQP) - CW / SSB  

• Window: Select Log type  
o CW  

� Log Type: NAQPCW  
� Operator Category: SINGLE-OP or MULTI-TWO  

• For Multi-Two see the extra info below! 
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� Mode Category: CW 
� Sent Exchange:  

• For North American stations - Operator name and station location (state, 
province, or country)  Example: Tom CT  

• For non-North American stations - Operator name only   Example: Thomas  
o SSB 

� Log Type: NAQPSSB  
� Operator Category: SINGLE-OP or MULTI-TWO  

• For Multi-Two see the extra info below! 
� Mode Category: SSB 
� Sent Exchange:  

• For North American stations - Operator name and station location (state, 
province, or country)  Example: Tom CT  

• For non-North American stations - Operator name only   Example: Thomas 

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a North 
American station or a non-North American station.  

MULTI-TWO operating : When changing operator you have to use Ctrl-O to set the NAME (not Call) of the operator. This 
name set with Ctrl-O will be used in the cabrillo file. So from the Sent Exchange only the state is being used but the name 
is needed. (Example: Tom CT). The macro {OPERATOR} can be used to automatically switch WAV files (in SSB), for 
more info see the Macro section. 

38.3.32 NRAU - Baltic Contest  

This contest is only for stations from the following countries: ES, JW, JX, LA, LY, OH, OHØ, OX, OY, OZ, SM, TF, and YL  

• Window: Select Log type  
o Log Type:  

� CW: NRAUCW 
� SSB: NRAUSSB 

o Sent Exchange: Section   Example: AA  

When a station is logged the following checks are made: 

• Is the logged station from a valid country ( ES, JW, JX, LA, LY, OH, OHØ, OX, OY, OZ, SM, TF, and YL) 
• Is the entered section a valid section (from NRAU.sec) 
• A warning is given when a qso is made an another band than 7 or 3,5 MHz. A note is made with the logged 

qso. 

38.3.33 Oceania Contest  

Supported are the CW and SSB version of the contest  
• Window: Select Log type  

o Log Type:  
� CW: OCEANIACW 
� SSB: OCEANIASSB 

o Sent Exchange: 001 

Note: Thes rules have special instructions for not complete portable callsigns so a prefix can not be deduced normally. 
Adding numbers like the rules state is not supported and should be done by editing the log file (afterwards). Example: 
N8BJQ/PA would be PA but is not a valid prefix and should become PA0 (add the zero).  

38.3.34 PACC contest  

The PACC contest can be configured for PA stations and DX stations.  
 

• Window: Select Log type  
o Log Type: PACC  
o Sent Exchange:  

� 001 for non-PA stations  
� Your province   Example: DR for PA-stations  

PA stations have to import an adapted CTY.DAT file for the PACC contest so the right multipliers will be used. In the 
'Entry window' go to 'Tools', and select 'Import country list from downloaded file'. This adapted country file can be 
downloaded from the N1MM website, select in the left menu: Other Files. Don't forget reloading the original CTY.DAT file 
again when entering other contests.  

The callsign in the Station Information dialog (Config / Change Your Station Data / Call) determines if you are a DX 
station or a PA station.  
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The PACC contest committee approved and will accept the files made by N1MM logger and likes to receive:  

File  How to make...  Exported  

Log file File, Export, Export to File (Generic)  [callsign].txt 

Summerysheet File, Export, Print Score Summary to File  [callsign].sum 

38.3.35 RAC Canada Day / Winter Contest  

With the same set of rules both contests are supported. These RAC contests can be used for VE stations and DX 
stations.  
 

• Window: Select Log type  
o Log Type: RAC  
o Exchange:  

� Province or territory for stations in Canada 
� 001 for VEØs and stations outside Canada (serialnumber) 

The callsign in the Station Information dialog (Config / Change Your Station Data / Call) determines if you are from 
Canada, VE0 or outside Canada. 

38.3.36 REF contest - CW / SSB  

The REFContest can be configured for stations in REF countries and DX stations.  
 

• Window: Select Log type  
o Log Type:  

� CW: REFCW 
� SSB: REFSSB 

o Sent Exchange:  
� For DX stations: 001  
� For stations in REF countries - Department (F and TK) or Prefix (all other REF 

countries) 

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a DX 
station or a station in a REF country. 

38.3.37 RSGB jubilee contest  

The RSGB jubilee contest can be configured for G stations and DX stations.  
 

• Window: Select Log type  
o Log Type: RSGBJUBILE  
o Exchange: 001  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are in the 
Commonwealth or not.  

38.3.38 Russian District Award contest  

The Russian District Award contest can be configured for Russian stations and DX stations.  
 

• Window: Select Log type  
o Log Type: RUSSIANDX  
o Sent Exchange:  

� Non-Russian stations: 001  
� Russian stations: District code by RDA list (for example TB02)  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are an 
Russian station or a DX station.  

38.3.39 Russian DX contest  

The Russian DX contest can be configured for Russian stations and DX stations.  
 

• Window: Select Log type  
o Log Type: RUSSIANDX  



N1MMLogger-Hilfe V.4.0.88 Seite 165 von 227 Übersetzung von Eike, DM3ML 

o Sent Exchange:  
� Non-Russian stations: 001  
� Russian stations: Your oblast code (two letters)  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are an 
Russian station or a DX station.  

Log submission notes:  

'CATEGORY-OVERLAY'. In RDXC you can submit one log and have it scored as two single band entries. Like operating 
10m during day time and 160m at night. Now, this is particular to this contest and you need to submit your log like this:  

CATEGORY-OVERLAY: [operator-cat] [band-cat] [power-cat] [mode-cat] The category overlay of the log submission 
when appropriate. In RDXC, two single band entries are allowed from one participant. In this case, one entry must be 
listed under CATEGORY tag, the other one under CATEGORY-OVERLAY, such as: 

• CATEGORY: SINGLE-OP 80M HIGH MIXED 
• CATEGORY-OVERLAY: SINGLE-OP 15M HIGH MIXED  

38.3.40 Russian YL/OM contest  

• Window: Select Log type  
o Log Type: RUSYLOM  
o Sent Exchange:  

� for male stations (OM)  
� for female stations (YL)  

 
YL stations (female) may only work OM stations (male) and vice versa.  

38.3.41 SAC contest - CW / SSB 

The Scandinavian Activity Contest uses a configuration file 'Sac.sec' with the used sections (aka QSO parties).  
 

• Window: Select Log type  
o CW  

� Log Type: SACCW  
� Sent Exchange: 001  

o SSB  
� Log Type: SACSSB 
� Sent Exchange: 001  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are an 
Scandinavian station or a DX station.  

38.3.42 SPDX contest  

The SPDX contest can be configured for Polish stations and DX stations.  
 

• Window: Select Log type  
o Log Type: SPDX  
o Sent Exchange:  

� 001 for non-SP stations  
� Your province   Example: B for Lubuskie  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are an Polish 
station or a DX station.  

38.3.43 Stew Perry Topband Distance Challenge  

The Stew Perry contest is CW only.  
 

• Window: Select Log type  
o Log Type: STEWPERRY  
o Power category:  

� HIGH when > 100 Watt 
� LOW when 10 - 100 Watt 
� QRP when less than 10 Watt 

o Sent Exchange:  



N1MMLogger-Hilfe V.4.0.88 Seite 166 von 227 Übersetzung von Eike, DM3ML 

� Your four character grid   Example: JO33  

The point calculation in the log is multiplied by a power multiplier for each qso point value. This factor depends on the 
selected Power category chosen. HIGH is multiplied by a factor 1, LOW by a factor 2 and QRP by a factor 4. 

38.3.44 UBA contest - CW / SSB  

The UBA DX Contest can be configured for ON stations and DX stations.  
 

• Window: Select Log type  
o Log Type:  

� CW: UBACW 
� SSB: UBASSB 

o Mode Category: CW 
o Sent Exchange:  

� For non-ON stations: 001  
� For ON stations - Serial + Your province   Example: 001/OV 

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a DX 
station or a ON station. 

Before submitting your log look at the page from Franki, ON5ZO at http://users.pandora.be/on5zo/n1mmlogger.htm 
The information tells in English, Dutch and French how to update the category in the cabrillo file so you are placed in the 
right category.  
The UBA contest manager approved and will accept the Cabrillo output made by N1MMLogger.  

Special Setup for Belgian participants:  

How to include your province abbreviation in the Cabrillo output?  
This MUST be done for both SSB and CW contests! Go to Config > Change your Station Data > State field: fill in the 
abbreviation for your province (OV, VB etc). It is VERY IMPORTANT to do this, as it will determine what you have sent in 
the log (Cabrillo output), and it is needed by the UBA Contest Team. The official abbreviation (2 letters) for the Belgian 
Provinces is to be found on the UBA site, under the rules for HF contests.  
Non-Belgian participants can leave this field 'as is', it is only used for Belgian contesters. 

How to send your province abbreviation after the serial number in CW? 
When you have selected to begin a new log for the UBA DX CW contest, you must change the F2 button message to 
send your province.  
This is done like this; go to: Config > Change Packet /CW/SSB/Digital Message buttons > Change CW buttons In the 
right column, second row, there is:<<<5nn>>>{EXCH} This means the incrementing serial number. Now you have to add 
your province abbreviation, preceded by a slash (/). It should look like this: <<<5nn >>>{EXCH}/OV or <<<5nn 
>>>{EXCH}/AN 

WARNING: Never change the '001' as the Sent Exchange value in the Select Log Type window, as the software will no 
longer send serial numbers!!! 

38.3.45 UK DX contest CW / SSB  

The UK DX contest can be configured for UK stations and non-UK stations.  
 

• Window: Select Log type  
o Log Type:  

� CW: UKDXCW 
� SSB: UKDXSSB 

o Sent Exchange:  
� Area code for UK stations   Example: BS  
� 001 for non-UK stations  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are an UK 
station or a non-UK station.  

38.3.46 WAEDC contest - CW / SSB  

The WAEDC Contest can be configured for European stations and non-European stations. 

• Window: Select Log type  
o Log Type:  

� CW: WAECW 
� SSB: WAESSB 
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o Sent Exchange: 001  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a 
European station or a non-European station.  

This contest has QTC Traffic: A QTC contains time, call sign and serial number of the reported QSO. Example: 
"1307/DA1AA/431" means that DA1AA was worked at 1307 UTC and sent serial number 431 

WAE DX CW / SSB by Franki, ON5ZO 

1. Introduction  

The main character of Worked All Europe (WAE), sponsored by the DARC is that Europe works non-Europe (‘DX’), and 
stations outside of Europe work all countries on the WAE-list. So far, this is not an unusual contest. However, WAE has 
something no other contest has, that you’ll either love or hate, being ‘QTC’. What is a QTC? Well, the WAE rules give the 
following definition: 
A QTC is the report of a contest QSO back to a European station.  
Let’s clear this up a bit. A QTC is a piece of traffic that can only be sent from outside EU (‘DX’) to EU (‘WAE’). DX 
stations can offer to send them, EU stations will beg to get them. Why? Simply because for both sides each QTC is 
added to the QSO total. If N1MM makes a QSO with ON5ZO, then they both get 1 point for the QSO. If they decide to 
exchange 10 QTC's during this QSO, they both have 11 points, being 1 QSO + 10 QTC's. If after the contest, ON5ZO 
made 300 QSO's, during which he got 500 QTC's, the total score will be 800, to be multiplied with the amount of 
multipliers. Hence the popularity of the QTC's… 

Now, what does a QTC look like? It has three main parts, being time, call and serial. When exchanging QSO's, the DX 
station will send the QSO's that are already in his log. He will transmit the three parts of the QSO that make up the QTC. 
Suppose that N1MM logged ON5ZO at 0123utc, and ON5ZO gave ‘012’ as his serial to N1MM. Later on in the contest, 
N1MM runs into 9A7P, who asks for a QTC. N1MM kindly willing to transmit a QTC, sends the following to 9A7P: 
0123 ON5ZO 012 
So, in other words, N1MM says to 9A7P that at 0123utc, he logged ON5ZO who gave him 012. So the serial in the QTC 
is the number given by the EU station to the DX station in their earlier QSO! 

The rules say that a DX station can only send 10 QTC's to a EU station, and it is forbidden for the DX to send a QTC 
featuring a previous QSO with the same EU station he is currently giving QTC's to. No worries, the software takes care of 
that. Furthermore, each QSO can only be sent once as a QTC, so a DX station can never have more QTC's sent than 
QSO's logged. A EU station however, can have much more QTC's than QSO's, as each QSO can raise up to 10 QTC's. 
A DX station can choose to send 10 QTC's at once during a QSO, or if he has, let’s say 100 QSO's in the log, of which 95 
have already been sent once as a QTC, he can send 5 QTC's. The EU station can ask for another 5 QTC's later on in the 
contest, after another QSO on another band - or on the same band! More on this later. 
The maximum of 10 QTC's can be reached with only 1 QSO, or with 5 QSO's on (5 bands), with each time 2 QTC's. You 
see, everything is possible. You don’t even need to make a QSO to get QTC's. Suppose that early in the contest, ON5ZO 
is running, and N1MM calls on 20m. They have a regular QSO and exchange serial numbers. ON5ZO asks ‘QTC?’ but 
N1MM does want to make some QSO's first and wait to send QTC's towards the end of the contest. 40 hours later, 
N1MM is running on 20m and ON5ZO comes across, ON5ZO sees that N1MM is a dupe because they QSO’d in the 
beginning of the contests. However, they did’t exchange QTC's, so ON5ZO asks ‘QTC? de ON5ZO’. N1MM sees that 
they have worked but indeed: there were no QTC's exchanged in the first hours of the contests, and N1MM is now eager 
to send all his QSO's as QTC's. N1MM says ‘QTC OK’ and they exchange QTC's, but no serial number for the QSO - 
because there is no QSO anymore, only the exchange of QTC's. 

But there is more. A series of QTC is to be numbered. The sending station (DX) will initiate the series of QTC's with a 
number like ‘QTC xx/yy’. This means that the DX stations is sending QTC's for the xx’th time, and this will be a series 
containing yy QTC's. Suppose N1MM sends ‘QTC 45/8’, this means that it’s the 45th time he’s sending a series of QTC's, 
and this particular series will contain 8 QTC's. 

Now that we know what a QTC is, what it looks like and why it is sent, let’s look at a real situation using the software. If 
you start a new contest using the WAE-module, it looks like a normal contest. You set it up with the usual parameters, 
like Power, Category etc. Don't forget to fill in '001' for the exchange! 
When this is done, you'll see that you have both entry windows. You can use these like you normally would, both in run 
mode and in S&P. 

2. WAE from EU-side  

This is what a WAE-QSO could look like including some QTC's, with ON5ZO running: 

CQ TEST ON5ZO 
N1MM 
N1MM 5NN 012 
R 5NN 48 
QTC? 
R QTC 12/5 QRV? 
QRV 
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0123 PA1M 12 
R 
0124 G4BUO 03 
R 
0124 F6BEE 56 
R 
0125 DL6RAI 89 
R 
0126 9A7P 102  
R TU 

How does it work? After entering the normal QSO, where both stations exchange serial numbers, ON5ZO goes into QTC 
mode by pressing Ctrl-Z . This triggers the program to send the ‘QTC?’ message to ask N1MM if he wants to give QTC's. 
At the same time, you’ll notice that the entry window changes a bit, and the cursor will be blinking the ‘N/N’ window. 
N1MM answers and gives the ‘N/N’ part, so ON5ZO logs ‘12/5’. Hitting spacebar moves to the next window, and you’ll 
send ‘QRV’ (with your paddle, for the time being), so the DX knows you’re ready to copy the QTC's. Each time you copy 
a part of the QTC and want to move to the next field, you press the spacebar. When you have a complete QTC, i.e. 
time/call/serial, you hit Enter and the program sends a confirming ‘R’, so the DX knows you got it OK and he can start 
transmitting the next QTC. If the series of QTC's is copied and you’re done with this calling station, you press F3, which is 
the Thank You message, the program will send this TU message and close the QTC-mode, returning to normal QSO 
mode. 
Remark: Sometimes DX stations don’t repeat the two digits representing the hour in the time part of the QTC. They just 
type the minutes, because the hour is the same for a bunch of QSO's that were logged in a short time span. When 
copying QTC's at 36WPM or faster, you don’t have the time to think things over so you just type what you copy. If you 
hear that after two numbers, the next character is a letter, you press space and begin typing the callsign. The software 
will automatically add the two digits of the hour. 

In S&P mode, the same keystroke, Ctrl-Z , activates QTC-mode here. There is little or no difference in the procedure. 
Only advice is to try everything well BEFORE the contest and report bugs ASAP… 

3. WAE from DX-side  

From the other side of the contest, the ‘DX’ side, the main keystroke to activate QTC-mode is also Ctrl-Z . You will then 
have a pop-up window, asking you how many QTC's you want to send to the EU-station. Hitting enter will send the ‘QTC 
xx/yy’ message, the ‘yy’ part being the number of QTC's you agreed to send in the pop-up message. 
The second most important keystroke is Alt-Enter . This will repeat the last QTC sent, or if you’re still in the ‘N/N’ stage, 
it’ll resend this information. It will occur more than once that a EU station does not copy the first time you transmit, due to 
QRM, ‘cockpit errors’ or simply because you send too fast! So Alt-Enter  will repeat the last part sent, should the EU 
station ask ‘AGN’ or something similar. 
On the bottom of the info window, you will see a message, indicating how many QTC's have already been sent to a given 
station. 

WAEDC Keyboard Assignments  

• Ctrl-Z -  activate QTC-mode and sends: QTC? and log Qso's if nr is greater than 0. Ctrl-Z cycles through QSO, 
receive QTC and send QTC modes. 
Alt-Enter -  resend last QTC or it will resend QTC n/n if that was the last message sent. 
Alt-W  - when used in a QTC leaves the sender's call and N/N so only wipes the 3 parts of the QTC  

Step-by-Step instructions 
 

• After you make a contact, first log the contact 
• If you want to send QTC's use Ctrl- Z , the log window will change to QTC mode 
• You get a screen asking how many QTC's you want to send. Enter  a number of just hit Enter and the QTC 

count will go away.  
o At the bottom of the logging area the QTC number will be indicated, i.e. 12/10, meaning the 12 

QTC series and 10 QTC's 
• The first QTC will show up with the time call and number. 
• After the station acknowledges the QTC hit enter and the next QTC will show up.  

o Continue this until all QTC's have been sent.  
• Then do Ctrl-Z  to return to normal logging. 

 
Other info 
 

• If only two digits of time entered, take first two digits from prior QTC. 
• The status line in the Info window shows the total QTC Sent and Received from the station being worked. 
• The number of the QTC in the serie sent is shown. Example: 5 from 10 
• When in reedit QTC the program will go back to QSO mode after editing. 

38.3.47 WAG contest  

The WAG contest can be used by German stations and non German stations.  
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• Window: Select Log type  

o Log Type: WAG  
o Sent Exchange:  

� non-DL stations: 001  
� DL stations:  

• DARC member: DOK (example: V11) 
• non-DARC member: 001 

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you 
are an German station or a non-German station.  
Non DL stations may only give a number  
DL stations give a DOK (DARC members) or a number (non DARC members) 
For stations not giving an exchange put “000” in the exchange field  

- minimal DOK length is 2  
- 0 is allowed to be entered  

Note: When updating a DOK in the log window you have to update not only the Exchange but also the 
Section by hand....only when the qso is in Entry window the program strips the Section (V) from the 
Exchange (V11) automatically. 

38.4 QSO parties  

The program supports 23 US QSO parties and 1 Canadian QSO party.  
There are some scoring anomalies though (there is a score disclaimer).  
The QSO parties use a configuration file named 'County.sec' with the names of the counties for each qso party. 
The program recognizes whether you are operating from the selected contest state.  
Make sure you ARRL section is entered in the station dialog. 

The list of county abbreviations has been taken from the official site for your contest, if available. This list of counties can 
be found in Config/Change Exchange Abbreviations/Change QSO Party Abbreviations. Note that you may add 
abbreviations for counties. For example, say there is a county TOL TOL. If you wanted to enter TOL for the county, you 
are all set. If you want to enter TOLLAND for TOL, then you should ADD a line TOLLAND TOL. Whether you enter TOL 
or TOLLAND, the qso will be logged with TOL.  

• Window: Select Log type  
o Log Type: QSOPARTY  
o A selection box where to choose the state / province appears (see picture below).  

� Select a State or Province (example image shows Hawaii HI)  
� Mode Category: MIXED  

o Sent Exchange:  
� The exchange depends on the QSO party. Mostly serial number and location  
� Inside the selected State/Province - See contest instructions  
� Outside the selected State/Province - See contest instructions  
� If sent exchange is specified as "001" then a serial number will be sent  

• The ARRL SECTION entered in the State field in the Station Dialog will be used to determine if you are  
in or outside a state or province. 

 

 

38.4.1 Florida QSO party  

Florida multiplier work around.  
Florida stations get a FL state multiplier for their first Florida QSO. Florida stations get no multipliers for Florida counties 
but get QSO point for Florida QSO's. To get the right multiplier change the exchange of the first Florida QSO to FLA, it 
forces the FL multiplier credit.  

38.4.2 PA QSO party  
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Florida Points work around.  
The logging program does not handle fractional points for QSO's like this contest uses. The points are doubled to make it 
easy to divide final score by two. Also, the rule to assign multiple counties to a single serial number is not supported.  

38.4.3 Updating and importing the QSO party sections  

• Always try first on a test database. 
• The 'County.sec' file located in the program directory has listed all the sections per QSO party 
• Importing is done automatically at the start of the program when the database has no QSO party section 

information (checked at startup). 
• If the 'County.sec' file has been changed (updated) after automatically been imported by the program it has to 

be imported into the database manually so the made changes 
• The load process deletes all the counties for a state before loading them. 
• The maximum length for a section is 5 characters.  

How it works   

If you want abbreviations for counties e.g. Tolland = TOLL then, Edit the Sections list, and TOLLAND in the abbreviation, 
and TOLL in the key. When you log Tolland, the program will substitute TOLL.  

Test the change   

• Open a TEST database 
• Create a new QSOPARTY contest 
• Choose Import (See image above) 
• Specify the location where you saved the attached file & "county.sec" 
• Import need only be done once (after an update/change). 
• You should now see 20+ states/provinces in the combo box. 
• Choose one & test.... 

 

38.5 VHF and up contests  

38.5.1 ARRL January VHF Sweepstakes 

• Window: Select Log type  
o Log Type: ARRLVHFJAN  
o Sent Exchange: Your four character grid   Example: JO33  

Exchange of signal report is optional. Foreign stations work W/VE amateurs only.  
Stations can be logged more than once from a different grid without being a dupe (for Rover stations).  
The score for Rover stations is not being calculated by the program!  

38.5.2 ARRL June VHF QSO Party  

• Window: Select Log type  
o Log Type: ARRLVHFJUN  
o Sent Exchange: Your four character grid   Example: JO33  
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Exchange of signal report is optional. Foreign stations work W/VE amateurs only.  
Stations can be logged more than once from a different grid without being a dupe (for Rover stations).  
The score for Rover stations is not being calculated by the program!  

38.5.3 ARRL September VHF QSO Party  

• Window: Select Log type  
o Log Type: ARRLVHFSEP  
o Sent Exchange: Your four character grid   Example: JO33  

 
Exchange of signal report is optional. Foreign stations work W/VE amateurs only.  
Stations can be logged more than once from a different grid without being a dupe (for Rover stations).  
The score for Rover stations is not being calculated by the program!  

38.5.4 Marconi CW contest  

The Marconi CW contest is CW only. For settings see the VHF Region 1 contest. 
Select: Log Type: VHFREG1 

38.5.5 REF Departments contest 50 Mhz  

• Window: Select Log type  
o Log Type: DDFM50  
o Sent Exchange: Serial Number + Your four character grid   Example: 001 JO33  

38.5.6 UKSMG sporadic-E competition  

• Window: Select Log type  
o Log Type: UKSMG  
o Sent Exchange: Your four character grid   Example: JO33  

Only the 6 meter band is shown in the Multiplier window . 4 digit grid is required and 6 digit grid is allowed to enter. 

38.5.7 IARU Region 1 contesting (50 MHz, VHF, UHF/Microwav es) 

Region 1 contesting uses a serial number and gridsquare as exchange. The points per qso is the calculated distance 
between your sent gridsquare and the received gridsquare.  
 

• Station Information    (Config | Change Your Station data)  
o Grid Square: <gridsquare>     Example: JO33fd  

• This grid square is used in calculating the distance between the stations (and is part of 
the exchange) 

• Window: Select Log type    (File | Choose Which Contest to Log)  
o Log Type: VHFREG1 
o Sent Exchange: 001 <gridsquare>  

• Example: 001 JO33fd 
• The sent exchange is not used by this specific contest otherwise the use in the macros 

for the function keys. 

This contest type has the possibility to use the CallHist table in which information can be stored which can be easy to 
have during a qso like name and gridsquare's used in previous contests. This specific contest type uses the Name, 
Locator1 and Locator2 fields from the CallHist table. Entering any information in this table is not necessary for the contest 
module to work but can be very handy. For this to work information has to be imported in the Call History table (File | 
Import | Import Call History), also this feature has to be enabled to work (Config | Call History Lookup). 

• When a callsign is entered and the SPACE key is pressed the program will check next to the normal things like 
dupe check the following:  

o Check the log if the callsign is known and if already worked the gridsquare is entered from the log 
in the Entry Window grid square exchange field. 

o If not found in the log file it will check the callhist table. If the callsign is found it will place the 
content from locator1 in the Entry Window grid square exchange field. The callsign is 'normalized' 
before searching in the CallHist table which means that /P, /A, /2 etc. will be removed before 
searching. Information in the CallHist table should be in its normalized form.  

• Information from the callhist table i.e. locator1, locator2 and the name field will be shown below the function 
keys. 

• Normally this feature is not turned on (it gives a very short delay while searching the table), to turn it on select: 
Config | Call History Lookup 

• Note: Any information already typed in the grid square exchange will not be overwritten by the log file or Callhist 
table search. So first entering a grid square and afterwards a callsign is possible without overwriting the already 
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entered grid square information. A callsign already worked will be shown in the bottom pane of the log window 
and marked with the dupe message. If the station is not worked before and is present in the CallHist table, this 
information will always be shown below the function keys. 

• More information about importing information in the CallHist table can be found in chapter VHF and Up 
contesting. A zip file with an import file for the 'Call history' lookup function and a ready master file with known 
calls can be downloaded from the N1MM web site and select in the left menu: Other Files. Don't forget to turn 
on the lookup function under 'Config | Call History Lookup' 

• More information about VHF related contesting and features can be found in chapter VHF and Up contesting 

A QSO can not be entered when  

• The serial number is missing  
o Warning: "Missing Serial Number!" 

• The grid length is not 6  
o Warning: - "6 character grid required!" 

• The grid format is not correct.  
o Warning: - "Wrong format grid. Format = AA##AA"  

These checks will (only) be done: when trying to log the qso (mostly by pressing Enter) 

How VHFREG1 looks for a known grid square  
• Look in the log if the station has been worked before (on any band)  

o If found show the grid and calculate distance and bearing  
• If not found look for the call sign in the 'call history' table including any /P /3 etc when applicable.  

o If found show the grid and calculate distance and bearing  
• If not found look for the call sign in the 'call history' table with the /P /3 etc removed (normalized callsign)  

o If found show the grid and calculate distance and bearing  
• If not found add the 'big grid' from the country when known by VHFREG1  

o If found show 'big grid' (no calculations done) 
o If not show nothing in grid square field  

• The check will (only) be done: When space is pressed and the cursor is in Callsign field  

Bearing and distance calculations  

• When space is pressed and the cursor is in Callsign field 
• When trying to log the qso (mostly by pressing Enter) 
• The grid square length has to be 4 or 6 digits. 
• Bearing info is shown in the log window and saved in the Misc field. 
• Distance info is shown in km in the log window and saved in the Points field. 
• Use Rescore to have the bearing and distance (re)calculated.  

Check Grid with country  

• When a grid is entered the program will check if the 'big grid' is a possible grid for the entered callsign.  
o Example: A Dutch station is always in JO. 

• When the callsign is entered with /MM the check will not be done. Also when you want to enter a qso which will 
be refused, the check can be ignored by entering /GO behind the callsign (example: PA1M/GO ). The /GO will 
be removed when entered in the log. The qso will get entered in the Comment field that the entered prefix does 
not match with the locator. Example: "JO not possible for this Country."  

• The check will (only) be done:  
o When space is pressed and the cursor is in Callsign field 
o When trying to log the qso (mostly by pressing Enter) 

Add 'big grid' to 4 digit grid (if last 4 digits en tered)  

• When a 4 digit grid is entered the program checks if these are the last four characters from a 6 digit grid. If so it 
will add the 'big grid' from the country (for a Dutch station it will add JO).  

• The check will (only) be done:  
o When space is pressed and the cursor is in Callsign field 
o When trying to log the qso (mostly by pressing Enter) 

Add 'big grid' when no grid is found (from log or ' call history' table)  

When a station is entered in the callsign pressing SPACE will search the 'call history' table. When the entered callsign is 
not found the program will try to add the 'big grid' who belongs to that country. If more grids are possible it uses the grid 
which occupies the most space in the country (IO in England) or is the easiest workable grid from Western Europe (JP for 
Norway, most south grid. The Netherlands will always give JO because this is the only grid possible for PA. 

• The check will (only) be done:  
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o When space is pressed and the cursor is in Callsign field 

For DL stations : The German contest manager hat informiert dass er die Logeinsendungen von N1MM gerne akzeptiert 
!  
Wie immer akzeptiert er den postalischen Versand des Logs, jedoch auch Email ist möglich !!!  
Lediglich müssen die Daten druckfähig sein !!!  
Vorab also einige Hinweis:  
1. Jedes Log muß mit dem Generic-File-Output als TXT-Format sortiert nach Zeit abgespeichert werden und als 
Bezeichnung "CALLBAND.TXT" lauten. Also DH5HV2m.txt zum Beispiel für einen Contest unter DH5HV auf 2m !  
2. Bei der Einsendung mehrerer Bänder sollte man diesbezüglich den Generic-File erstellen mit "sorted by Band" und 
dann mit einem Editor kurz bearbeiten, sodass man als Beispiel eine 2m-Datei, eine 70cm-Datei, eine 23cm-Datei, etc. 
hat !  
Auch hier natürlich dann DH5HV2m.txt und DH5HV70cm.txt und DH5HV23cm.txt erstellen bzw. benennen !!!  
3. Und wie bisher auch üblich wird für jedes Band ein seperates Deckblatt benötigt, was nur komplett ausgefüllt gewertet 
werden kann !  
Man findet dies unter http://www.darc.de/referate/ukw-funksport/index.html ganz unten als PDF- oder DOC-File !  

38.6 RTTY/PSK31 contests  

When doing RTTY and PSK contests always check the M ode tab in Configurer for correct settings!  

38.6.1 ANARTS WW RTTY contest  

• Window: Select Log Type  
o Log Type: ANARTS  
o Sent Exchange: Zone Example: 14  

38.6.2 ANATOLIAN RTTY contest  

• Window: Select Log Type  
o Log Type: ANATOLRTTY  
o Sent Exchange: 001  

38.6.3 ARRL RTTY Roundup  

The ARRL RTTY Roundup can be used by K/VE stations and DX stations.  
 

• Window: Select Log Type  
o Log Type: ARRLRTTY  
o Sent Exchange:  

• Your state/province - for K/VE stations Example: NY  
• 001 - for DX stations (non K/VE)  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a DX 
stations or a W/VE station.  

NB. US stations who work US "/MM" stations are also allowed to log serial numbers.  

38.6.4 BARTG RTTY Sprint contest  

• Window: Select Log type  
o Log Type: BARTGRTTYS  
o Sent Exchange:001  

38.6.5 BARTG RTTY Spring contest  

• Window: Select Log type  
o Log Type: BARTGSRTTY  
o Sent Exchange:001  

38.6.6 CQ World Wide DX contest - RTTY  

• Window: Select Log type  
o Log Type: CQWWRTTY  
o Mode Category: RTTY  
o Sent Exchange:  
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• North American/Canadian stations - Your zone plus the STATE or AREA   Example: 05 
NY  

• Other stations - Your zone   Example: 14  
 

The default zone values for US (A,K,N,W) stations are  
 

o Zone 3 - If number in callsign is 6 or 7  
o Zone 4 - If number in callsign is 5 or 8 or 9 or 0  
o Zone 5 - If number in callsign is 1 or 2 or 3 or 4  

The default zone values for Canadian (VE) stations are  

• Zone 1 - If callsign starts with: VY1  
• Zone 2 - If callsign starts with: VE2, VO2  
• Zone 3 - If callsign starts with: VE7, VC7  
• Zone 4 - If callsign starts with: VE3, VE4, VE5, VE6, VA3  
• Zone 5 - If callsign starts with: VO1, VE1, XJ1, VY2  

The default section values for Canadian (VE) stations are  

• VE - If callsign starts with: VE1, VE2, VE3, VE4, VE5, VE6, VE7, VE8, VO1, VO2,VY  
 

• Give 'Space' when the cursor is in the 'Callsign' field to have the 'Zone' field filled with the default 
value.  

• The default zone will be selected, so that if you type another zone, it will replace the numbers that the 
program put in there.  

• Abbreviations for Canadian regions are allowed  
• When typing the section and the entered section is new it will be shown in RED. The Available 

window will also show if a section multiplier is needed on other bands  
• When pressing Space and the entered callsign is not US or VE, the cursor will skip the state/section 

field.  

38.6.7 CQ World Wide WPX contest - RTTY  

• Window: Select Log type  
o Log Type: CQWWRTTY  
o Mode Category: RTTY  
o Sent Exchange: Serialnumber   Example: 001  

Leading zeros are being forced on sent & received serial numbers.  

38.6.8 CIS contest - RTTY  

The Commonwealth of Independent States Contest where everybody can work everybody for QSO and multiplier credit.  
 

• Window: Select Log type  
o Log Type: CISRTTY 
o Sent Exchange:  

� CIS stations: CIS area code Example for Moscow City: RU11  
� Non-CIS stations: 001 

38.6.9 DL DX RTTY contest  

• Window: Select Log type  
o Log Type: DLDXRTTY  
o Mode Category: RTTY  

� Sent Exchange: 001 .  

38.6.10 EA RTTY contest  

• Window: Select Log type  
o Log Type: EARTTY  
o Mode Category: RTTY  
o Sent Exchange:  

� For Spanish stations - Province  Example: AL  
� For non-Spanish stations - 001  
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The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a Spanish 
station or a non-Spanish station.  

38.6.11 JARTS WW RTTY contest  

• Window: Select Log type  
o Log Type: JARTSWWRTY  
o Sent Exchange: Your age   Example: 34  

� XYL and YL stations may give 00 
� Multi-operator stations must send 99 as a operator age. 

38.6.12 NA Sprint RTTY  

• Window: Select Log type  
o Log Type: SPRINTRTTY  
o Mode Category: RTTY  
o Sent Exchange: 001 Tom CT  

� Serial number, your name and your location (state, province or country)  Example: 
PA1M DE N1MM 123 TOM CT K  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a North 
American station or a non-North American station.  
Note: For RTTY only, the same station can be worked multiple times provided 3 contacts separate the contact in both 
logs, regardless of band.  

38.6.13 North American QSO Parties (NAQP) - RTTY  

• Window: Select Log type  
o Log Type: NAQPRTTY  
o Operator Category: SINGLE-OP or MULTI-TWO  

� For Multi-Two see the extra info below! 
o Mode Category: RTTY  
o Sent Exchange:  

� For North American stations - Operator name and station location (state, province, or 
country)  Example: Tom CT  

� For non-North American stations - Operator name only   Example: Thomas  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a North 
American station or a non-North American station.  

MULTI-TWO operating : When changing operator you have to use Ctrl-O to set the NAME (not Call) of the operator. This 
name set with Ctrl-O will be used in the cabrillo file. So from the Sent Exchange only the state is being used but the name 
is needed. (Example: Tom CT). The macro {OPERATOR} can be used to automatically switch WAV files (in SSB), for 
more info see the Macro section. 

38.6.14 OK DX RTTY Contest  

• Window: Select Log type  
o Log Type: OKDXRTTY  
o Mode Category: RTTY  
o Sent Exchange: CQ zone  

38.6.15 Quick PSK63 Contest  

The contest uses the same rules as the SARTG WW RTTY contest so select that contest. After the contest the cabrillo 
output has to be updated (take SARTG WW out and replace with Quick PSK63) 

38.6.16 SARTG New Year RTTY Contest  

• Window: Select Log type  
o Log Type: SARTGNYRTY  
o Mode Category: RTTY  
o Sent Exchange: 01 + name + "Happy New Year" in your native language.001 + naNew Year" in 

your native lame + "Happy nguage  

38.6.17 SARTG WW RTTY Contest  
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• Window: Select Log type  
o Log Type: SARTGRTTY  
o Mode Category: RTTY  
o Sent Exchange: 001  

38.6.18 SCC RTTY Championship  

• Window: Select Log type  
o Log Type: SCCRTTY  
o Mode Category: RTTY  
o Sent Exchange: four-digit number of the year the amateur radio licence was FIRST officially 

issued (e.g. 1983) to the operator.  

The score Summary window only shows your total score and the number of mults you have worked per band. There is no 
breakdown by points. In SCC there is one extra column of mults but that had to be there as the way things are setup to 
calculate the first multiplier (different years). Thus the name of the second mult is "N/A" . The only way to do a breakdown 
on points is to go thru your log and manually do it. 

38.6.19 SP DX RTTY contest  

• Window: Select Log type  
o Log Type: SPDXRTTY  
o Mode Category: RTTY  
o Sent Exchange:  

� 001 for non-SP stations  
� Your province   Example: B for Lubuskie  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a Polish 
station or a DX station.  

38.6.20 Russian DX RTTY contest  

• Window: Select Log type  
o Log Type: RUSDXRTTY  
o Mode Category: RTTY  
o Sent Exchange:  

� Non-Russian stations: WAZ zone   Example: 14 for Western Europe  
� Russian stations: Your oblast code (two letters)  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are a Russian 
station or a DX station.  

38.6.21 TARA Grid Dip contest  

• Window: Select Log type  
o Log Type: TARAGRID  
o Mode Category: RTTY or PSK  
o Sent Exchange: name + 4 digit grid locator   Example: Tom FN12  

38.6.22 TARA PSK Rumble  

• Window: Select Log type  
o Log Type: CQWWRTTY  
o Mode Category: MIXED  
o Sent Exchange: Name and Location   Example: Tom CT  

38.6.23 UK DX contest RTTY 

The UK DX contest can be configured for UK stations and non-UK stations.  
• Window: Select Log type  

o Log Type: UKDXRTTY  
o Sent Exchange:  

� Area code for UK stations   Example: BS  
� 001 for non-UK stations  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are an UK 
station or a non-UK station.  
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38.6.24 VOLTA RTTY Contest  

• Window: Select Log type  
o Log Type: VOLTARTTY  
o Mode Category: RTTY  
o Sent Exchange: QSO number + Your CQ Zone. Example: 001 15  

The four Band Multiplier count for this contest is displayed on info window. 

38.6.25 WAEDC contest  

The WAEDC Contest can be configured for European stations and non-European stations. 

• Window: Select Log type  
o Log Type: WAERTTY  
o Sent Exchange: 001  

The callsign in your Station Information dialog (Config / Change Your Station Data / Call) determines if you are an 
European station or a non-European station.  

For info over the WAE also see the WAE SSB/CW part above. Below info is only for WAEDC RTTY:  

• WAEDC RTTY is limited to the first Digital Window . There is just to much code and overhead to add to the 
project. This means it is limited to SO1R but you can still use the 2nd window. You just can't send and receive 
QTC's with it. When saving received QTC's the routine I'm using will pick the ##/## out of anything that you 
throw at it.  

• QTC Lines on the frame are broken up into separate boxes. This was done to allow error checking of any data 
that is input by hand and clicking on data in RX window. 

• If you click on data or enter data in the QTC windows if the routines detect bad data it will flag that data in red. 
• When saving QTC if any of the data still hasn't been corrected it will send the received ok message but will not 

save the info into the log until the bad data is fixed. Once fixed just click save again and it will save the data 
without sending the received message. A warning message is given in the Entry window status bar. 

• To select whole lines of received QTC just place the cursor over the line and left click. 
• To select individual QTC sections place the cursor over the item you want to select and right click on it. After 

the data is selected place the cursor over the text box you want the data to go into and left click it will be placed 
into it. 

• When pressing CTRL-Z to switch modes the program will display the total QTC sent and received from the 
station being worked. When the QTC frame opens on the DI only the Needed amount of QTC boxes will be 
enabled. Example(if I have worked UT5XXX and received 5 QTC's from him, the next time I work him and I 
open up the Receive QTC frame only 5 QTC lines will be enabled to reach maximum QTC amount .  

• When pressing CTRL-Z to switch modes if you have reached the MAX amount of QTC the QTC frame will close 
and give a warning message in Entry windows status bar. 

• When left clicking on a Received QTC line will split data on " ","/","-" separators if the routines can't split the 
data it will not copy the data over. You will have to click each item separate or hand type it in. 

• Selecting of individual QTC items can be done by right clicking on item. Left clicking on the box where the data 
to be placed places text. 

• Ctrl-Z cycles through QSO, receive QTC and send QTC modes. After you enter a callsign in the entry window 
pressing Ctrl-Z will cycle through the RQCT and SQTC modes. If you are receiving QTC press Ctrl-Z once and 
as the QTC appears in the digital window just click on it one time and it will transfer over to the QTC entry 
window. To send a QTC press Ctrl-Z one more time and it will show you all the QTC's you have available to 
send. 

• The status line in the Info window shows the total QTC Sent and Received from the station being worked. 

For more information look at WAEDC for SSB/CW. However, there are 2 fundamental differences between the RTTY and 
the SSB/CW version of the contest: 

• Everyone can work everyone, so DX can work DX and EU can work EU 
• Everyone can both send and receive QTC's, however they can only be exchanged between stations in a 

different continent 

38.6.26 XE RTTY Contest  

• Window: Select Log type  
o Log Type: XERTTY  
o Mode Category: RTTY  
o Sent Exchange:  

� Mexico: State. Example: AGS 
� Non-Mexico: 001 
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38.7 Deleted QSO's  

38.7.1 DELETEDQS "contest" 

Qso's which you have deleted using 'Edit Contact' are placed in this 'contest'.  
This is in especially for multi-user support. Deleted qso's can be exported.  

39. Geräteanschluss (Interfacing) 
39.1 Überblick (General) 

Das Programm kann über verschiedene Schnittstellen mit Ihrem Transceiver verbunden werden. Diese Schnittstellen 
(Ports) sind :  

• Serielle Schnittstelle(n) : Über eine serielle Schnittstelle können Sie CW tasten, die Sende-
Empfangsumschaltung (PTT) steuern und/oder mit Ihrem Transceiver kommunizieren (CAT). Sie meisten PCs 
haben 2 serielle Schnittstellen mit 9 oder 25 Pins.  

• Parallele Schnittstelle(n) : Über eine parallele Schnittstelle können Sie ebenfalls CW tasten oder die PTT 
steuern. Sie können weiterhin Antennen umschalten, wenn das CAT-Interface angesteckt ist. Mit einem 
weiteren Pin wird angezeigt, welcher Transceiver aktiv ist.  

• Soundkarte : Über die Soundkarte kann Ihr Transceiver mit WAV-Dateien moduliert werden, z.B. zum CQ-
Rufen in SSB oder Sie können RTTY oder PSK mit  einem zugehörigen Programm machen. Während des 
Empfangs können Sie alle QSOs aufzeichnen.  

Bei CW wird vorausgesetzt, dass die Parallel-Ports ihres PCs die folgenden Adressen haben (sie können bei 
Abweichungen in der Konfiguration eingestellt werden) :  

Port   Adresse   

LPT1  &H378  

LPT2  &H278  

LPT3  &H3BC  
 

 

Port   Adresse   

COM1  &H3F8  

COM2  &H2F8  

COM3  &H3E8  

COM4  &H2E8  

COM5  &H2F0 

COM6 &H3E0 

COM7 &H2E0 

COM8 &H260 
 

Bei Problemen können Sie Adressen über die Systemsteuerung von Windows abfragen (System > Hardware > 
Gerätemanager > Schnittstelle ). 
 
Bei von der Tabelle abweichenden Portadressen funkt ioniert CW nicht !  

 
Hinweis : Haben Sie Schnittstellen, wo die Adresse stimmt, und Schnittstellen, wo die Adresse nicht stimmt, nehmen 
Sie erstere für CW und letztere für die CAT-Steuerung. Dort können Sie die Adressangabe editieren.   

39.2 Transceiveranschluss (CAT)  (Radio interfacing)  

Neuere Gerät können direkt über ein serielles Kabel (durchverbunden oder gekreuzt) verbunden werden. Bei anderen 
Geräten mit einem Interface mit TTL-Pegel benötigen Sie ein spezielles Interface. Informieren Sie sich im 
Gerätehandbuch Ihres Transceivers über die Art des Interfaces. Jede Firma hat ihre eigene Lösung, die Lösungen sind 
untereinander nicht kompatibel. Auch die Möglichkeiten zur Transceiversteuerung und die benutzten Kommandos 
unterscheiden sich von Firma zu Firma, mitunter sogar innerhalb der Geräte einer Firma. 
Wenn Sie Geräte mit RS-232-Schnittstelle mit dem PC verbinden, achten Sie darauf, dass alle Pins der Geräte 
normgerecht miteinander verbunden werden. Mitunter reicht auch ein dreipoliges Kabel (RxD, TxD und Masse). 
Benötigen Sie ein zusätzliches Interface, meist zur Anpassung der RS-232-Pegel des PCs  
(-12V/+12V) auf die TTL-Pegel Ihres Transceivers (0V/+5V) haben Sie zwei Möglichkeiten. Entweder Sie kaufen sich ein 
(meist nicht gerade billiges) Interface des Herstellers oder Sie bauen sich selbst eins. Achten Sie darauf, ob ein 
dreidrähtiges Interface (RxD, TxD, Masse für eine Softwareprotokoll) oder ein fünfdrähtiges Interface (RxD, TxD, RTS, 
CTS und Masse für ein Hardwareprotokoll) benötigt wird. 
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IPin 
DB9 

Pin 
DB25 Name Signalbeschreibung  

1 1 CD Carrier Detect  

2 2 RXD Receive Data  

3 3 TXD Transmit Data  

4 4 DTR Data Terminal Ready  

5 5 GND System Ground  

6 6 DSR Data Set Ready  

7 7 RTS Request to Send  

8 8 CTS Clear to Send  

9 9 RI Ring Indicator  
 

Software 
handshaking   

DB9  DB25  Hardware 
handshaking   

Ground  pin 
5  

pin 7  Ground  

RXD  pin 
2  

pin 3  RXD  

TXD  pin 
3  pin 2  TXD  

Not used  pin 
7  

pin 4  RTS  

Not used  pin 
8  pin 5  CTS  

 

39.3 CW-Tastung und PTT-Steuerung  (CW key and PTT interfacing)  
39.3.1 Über eine parallele Schnittstelle  (Via Parallel port) 

Mit diesem Schalttransistor können Sie Ihren Sender in CW tasten und die PTT nach Masse schalten. Achten Sie darauf, 
das Pin1 nur einen begrenzten Strom ziehen kann (entspricht Masse) 

 

Signalbelegung an der parallelen Schnittstelle (LPT ) :   

• Pin 16 :  PTT – Ausgang (an Basis des Transistors) 
• Pin 17 :  CW – Ausgang  (an Basis des Transistors) 
• Pin 1 :    Masse  

Pin 1 als gemeinsame Masse kann nur einen begrenzen Strom aufnehmen. U.U. benötigen Sie einen Puffertransistor.  

39.3.2 Über eine serielle Schnittstelle  (Via Serial Port) 

 

Pinbelegung der seriellen Schnittstelle (DB-9)   

• Pin 7 : PTT-Ausgang (RTS)  

• Pin 4 : CW-Ausgang (DTR)  

• Pin 5 :  Masse  

Pinbelegung der seriellen Schnittstelle (DB-25)   
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• Pin 4 :    PTT-Ausgang (RTS)  

• Pin 20 :  CW-Ausgang (DTR)  

• Pin 7 :    Masse  

 
Hinweis  : CW- und(!) PTT-Leitung müssen von der gleichen Schnittstelle genommen werden ! 

Als Schalttransistor können 2N2222 , 2N3904, BC547 oder BC548 oder andere Kleinleistungs-npn-Transistoren 
genommen werden  

39.3.3 Über die USB-Schnittstelle (Via USB port) 

Nicht alle PCs haben genug serielle Schnittstellen, um Transceiver zu steuern (CAT), Packet anzuschliessen, CW zu 
tasten usw. In diesem Fall können Sie einen Umsetzer von USB auf serielle Schnittstelle anschliessen. Diese Umsetzer 
funktionieren in der Regel, wenn ein über eine serielle Schnittstelle anzusteuerende Gerät verwendet werden soll 
(Transceiver, TNC), sie versagen aber mitunter, wenn der Rechner zu speziellen Leitungen zugreifen soll und CW 
und/oder PTT über Leitungen wie DTR oder RTS tasten soll. Testen Sie diese Funktionen ausführlich und stellen Sie 
sicher, dass Sie die zum Adapter gehörenden Treiber installiert haben. 
Mit der N1MM-CW arbeiten alle “geborenen” seriellen Schnittstellen und in der Regel auch mit seriell<>USB-Adaptern. 
Wollen Sie ein perfektes CW erzeugen, dass nicht von den Windows-Zeitscheibenproblemenmehr oder weniger zerhackt 
wird, empfehlen wir Ihnen das Interface Winkey von K1EL. Die zu tastenden CW-Daten werden über eine serielle 
Schnittstelle als ASCII-Zeichenkette ausgegeben und von Winkey in fehlerlose CW umgewandelt.  Ein USB<>Seriell-
Adapter funktioniert problemlos. Informieren Sie sich im Winkey-Handbuch über Einzelheiten.  

On manchen Fällen macht die PTT an einem USB <> Seriell-Adapter Schwierigkeiten. Überprüfen Sie die 
Windowseinstellungen:  

• Gehen Sie über die Systemsteuerung zum Hardware-Gerätemanager  
• Öffnen Sie die USB – Kontroller und dort den USB<>Seriell-Adapter 
• Markieren Sie den USB Root Hub 
• Doplleklicken Sie darauf und gehen Sie zu Eigenschaften >  Power 

Management  
• Entfernen Sie den Haken bei „Computer kann Gerät zum Stromsparen 

abschalten „ 
In der Regel ist dort ein Haken voreingestellt 

• Starten Sie den PC neu 

Interessantes Material zu den USB<>Seriell-Adaptern finden Sie auf der RTTY-Contestseite von AA5AU unter: 
http://www.rttycontesting.com/us 

39.4 Weitere Geräte an der parallelen Schnittstelle (Addi tional Parallel Port Interfacing)  

Wenn eine parallele Schnittstellen  (LPT1, LPT2 oder LPT3) als CW-Schnittstelle festgelegt wurde, stehen weitere 
Informationen an diesem Port zur Verfügung. Legen Sie in der Konfiguration fest, welchem Transceiver (Radio 1 oder 
Radio 2) die parallele Schnittstelle zugeordnet wird.  
Der BCD-Kode an LPT gibt den aktiven Transceiver/VFO an. 

 
Hinweis : Mit der Wahl des CW-Ports legen Sie fest,  welcher Transceiver für CW, PTT, Bandanzeige und 
Anzeige „aktives Gerät“ von der Schnittstelle geste uert wird.  

39.4.1 Pinbelegung der parallelen Schnittstelle  (Parallel port pin layout) 

LPT 
pin   Beschreibung   

1  Masse für alle anderen Pins. Strombelastung beachte n., u.U. puffern  

2  Bandausgang (Bit 0,LSB), gesteuert von der Antennen tabelle  

3  TX1/TX2 für Kompatibilität zu DX Doubler.  Nur gesetzt, wenn kein Hardware-DVK-Ausgang gewählt wurde.  

4  RX1/RX2 (zeigt aktives Eingabefenster) für Kompatibilität zu DX Doubler. Nur gesetzt, wenn kein Hardware-DVK-Ausgang 
gewählt wurde.  

5  Schaltet zwischen Stereo und Mono um.  Nur gesetzt, wenn kein Hardware-DVK-Ausgang gewählt wurde 

7  Bandausgang (Bit 1)  

8  Bandausgang (Bit 2)  
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9  Bandausgang (Bit 3, MSB) siehe Konfiguration , Kart eikarte Antennas  

14  Radio 1/2.  High = Radio 1/VFO 1, Low = Radio 2/VFO 2  

16  PTT –Ausgang : H = Senden  

17  CW – Ausgang : H = Taste gedrückt  

39.4.2 Banddekoderausgang (Band decoder output)  

Die Pins 9, 8, 7 und 2 (Bit 3..0) werden über die Antennentabelle in der Konfiguration gesteuert, Welcher Code welcher 
Antennen und welchem Band zugeordnet wird, wird über diese Tabelle festgelegt. Folgende logischen Pegel erscheinen 
an den Pins :  

  Result on LPT port     Result on LPT port   
Code  

   pin 9  
D  

 pin 8  
C  

 pin 7  
B  

 pin 2  
A  

Code  
   pin 9  

D  
 pin 8  

C  
 pin 7  

B  
 pin 2 

A  

0    0  0  0  0  8    1  0  0  0  

1    0  0  0  1  9   1  0  0  1  

2    0  0  1  0  10   1  0  1  0  

3    0  0  1  1  11   1  0  1  1  

4    0  1  0  0  12   1  1  0  0  

5    0  1  0  1  13   1  1  0  1  

6    0  1  1  0  14   1  1  1  0  

7    0  1  1  1  

  

15   1  1  1  1  

39.4.3 Beispiel für den Top Ten Devices Dekoder  (Sample config Top Ten Devices  automatic band decoder) 

Unten sehen Sie eine Beispiel-Einstellung des Dekoders von Top-Ten Devices in der Karteikarte Antennas der 
N1MMLogger-Konfiguration :  

Kode  Antenne  Band  

0      

1  160 mtr  1.8  

2  80 mtr  3.5  

3  40 mtr  7  

4  30 mtr  10  

5  20 mtr  14  

6  17 mtr  18  

7  15 mtr  21  

8  12 mtr  24  

9  10 mtr  28  

39.4.4 Beispiel für zwei gestockte Antennen  (Sample config two stacked antennas) 
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Hier wird zwischen Antennendekoder und Antennenschalter eine Diodenkombination eingefügt. Der 
Dekoder soll an den Ausgängen im aktivierten Zustand eine positive Spannung liefern, die den 
Antennenschalter steuert. 
Mit einer positiven Spannung am Eingang 0 werden beide Antennen zugeschaltet, mit 1 nur die 
obere und mit 2 nur die untere. 

In der Karteikarte Antennas  wird die Zuschaltung programmiert : 

 

39.4.5 Antennenrichtung (Bearing data) 

Im Moment werden (noch) keine Daten für die Antennenrichtung an den parallelen Ports (LPT) geliefert.  

39.5 Anschluss der Soundkarte ( Sound card interfacing  
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Sound card DVK  

• Zwischen den Soundkarten-Lautsprecherausgang und den Mic-Eingang des Transceivers sollte ein Trafo 
8:1000 Ohm geschaltet werden.radio microphone input.  

• Zwischen den Line-Ausgang der Soundkarte und dem Mic-Eingang des Transceivers sollte ein Trafo  600:600 
Ohm (1:1) geschaltet werden.  

Der Ausgang der Soundkarte wird potential-getrennt an den Mikrofoneingang des Transceivers geschaltet . 

Anmerkung DM3ML : Sie sollten die Soundkarte an den ACC-(Zubehör)-Buchsen des Transceivers unter Beachtung der 
NF-Pegel anschliessen.   

39.6 Serielle und parallele Schnittstellen unter Windows NT/2000/XP  
(Serial and Parallel port interfacing under Windows NT/2000/XP) 

Bei Windows NT, Windows 2000, XP und ihren Derivaten wurde die Ansteuerung der Schnittstellen gegenüber Windows 
95, 98 (SE), ME geändert. Sie brauchen jetzt ein spezielles DLL-Programm  DLPORTIO.DLL zur Nutzung der 
Schnittstellen. 

Sie müssen folgendes machen :  

• Holen Sie sich die Datei DLPORTIO.ZIP. Einen Link finden Sie im Kapitel Erstinstallation.  
• Die Datei ist etwa  851 kB lang. Davon brauchen Sie nur einen ganz kleinen Teil.  
• Entzippen Sie die Dateien in einem temporären Verzeichnis und lesen Sie vor allem das Kapitel 3.2 der Datei 

DLPORTIO.PDF unter dem Titel Automatically Installing the DriverLINX driver.   
• Stellen Sie sicher, dass sie Administratorrechte für die Installation auf Ihrem PC haben 
• Kopieren Sie die Dateien dlportio.sys und dlportio.dll aus dem Verzeichnis \DriverLINX\drivers in das 

Verzeichnis  \install . 
• Starten Sie install.exe 

ODER 

• Holen Sie sich die Datei PORT95NT.EXE. Die ZIP-Datei enthält dlportio.dll . Einen Link finden Sie im Kapitel 
Erstinstallation.  

• Stellen Sie sicher, dass sie Administratiorrechte für die Installation auf Ihrem PC haben 
• Die Datei ist etwa 1610 kB lang  
• Starten Sie port95nt.exe 
• Wählen Sie Next, Yes und typical  
• Sagen Sie Yes  zum PC-Neustart 

 

39.7 Alles an einem COM-Port  (Everything on one COM port) 

Von  Uffe, PA5DD. 
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Sie können seit Version 2.x.x die CAT-Steuerung für den Transceiver, die PTT-Steuerung und die CW-Taste an einem 
COM-Port anschliessen und damit mit einem Laptop funken. Sie benötigen aber ein spezielles Interface dafür  und 
müssen einige Fallstricke überwinden :  

• Die CAT-Steuerung muss ohne Hardwareprotokoll (Signale RTS und CTS) 
funktionieren und mit den Signalen TxD, RxD und Masse auskommen. In der Regel 
wird dieses Protokoll nicht benötigt (ICOM, YAESU).  

• Manche Interfaces schalten die  RTS+CTS-Leitungen zwischen PC und Transceiver 
durch. Diese Verbindung muss getrennt werden. Auch DSR darf nicht durchgeschaltet 
werden. Bleiben die Verbindungen wird ein permanenter PTT-Interrupt erzeugt und 
nichts funktioniert. Tipp DM3ML : mitunter reicht eine Brücke zwischen RTS und  CTS 
im Stecker in Richtung Transceiver. 

• In manchen Interfaces werden die Leitungen RTS & DTR für die Stromversorgung des 
Interfaces verwendet. Diese Leitungen werden aber jetzt für  CW und PTT benötigt. Sie 
müssen im Interface die zugehörigen Dioden (logisches ODER) auslöten und eine 
externe Stromversorgung anschliessen. Ich (PA5DD) nehme die Spannung aus dem 
PS/2-Mouseport. Zweigen Sie RxD, TxD und Masse für die CAT-Steuerung getrennt 
ab. 

39.8 Ich brauche zusätzliche COM-Schnittstellen  (I need more serial ports) 

By Didier KO4BB 

(gekürzt und editiert von DM3ML) 

1) IRQ's sind der begrenzende Faktor beim Nachrüsten von COM-Schnittstellen mit normalen ISA-Karten. Meist sind die 
IRQs mit COM1 (IRQ 4) und COM2 (IRQ 3) schon vergeben.  Eine Doppelnutzung ist problematisch. Mitunter kann man 
auf einer zusätzlichen ISA-Schnittstellenkarte mit zwei COMs und einem LPT den IRQ5 von LPT2 der seriellen 
Schnittstellenkarte auf COM3 umlöten oder umjumpern. 
  

2a) Es gibt PCI-Karten mit eigenem Kontroller für 4,8 und sogar 16 Ports. Sie benötigen nur einen IRQ. Sie sind auf 
einen grossen Datendurchsatz mit schnellen Schaltkreisen und FIFO-Speichern ausgelegt. Sie haben aber mitunter 
Probleme mit einer schnellen Reaktionszeit und sind daher nicht so gut für CW geeignet. Sie sollten CW daher mit einer 
„geboreren“ COM-Schnittstelle machen. Allerdings treten die Probleme bei den modernen schnellen Rechnern nicht 
mehr auf. 
Tipp DM3ML : Ich habe in meinen Rechner eine PCI-Karte Vscom PCI400L mit vier zusätzlichen COM-Schnittstellen 
eingebaut, die vorzüglich funktioniert. Sie muss mit eigenen Treibern konfiguriert werden.  

2b) USB-Adapter fallen in die Kategorie der Non-Standard-Hardware, sind aber bei neueren Rechnern in das 
Motherboard integriert und werden direkt über das BIOS gesteuert und von den Betriebssystemen ab WIN98 unterstützt. 
Auch hier funktioniert in der Regel die CAT-Steuerung oder die Ausgabe z.B. zu Antennenschaltern problemlos, nur bei 
Echtzeitanwendungen wie CW kann es Probleme mit der Reaktionszeit geben und Sie sollten versuchen, für CW eine 
der Standardschnittstellen zu reservieren. 

Übrigens : Winkey kommt bald mit USB-Schnittstelle ….. (hoffe ich..) 
 

39.9 Einige Interface-Links ( Some interfacing links) 

• http://www.microham.com/ 
• http://www.packetradio.com/rascal.html  
• http://www.sedan.org/tnc2rad.htm  
• http://www.qsl.net/wm2u/interface.html  
• http://users.skynet.be/ON4AOI/keyer.shtml 

 

40. Makros (Macros) 
40.1 Überblick (General) 

Makros sind Schlüsselworte im Text, die beim Senden durch einen vordefinierten Inhalt gefüllt werden. Ein Makros ist 
das ! , das für das Rufzeichen der Gegenstation steht und beim senden durch das in das Rufzeichenfeld eingetragene 
Rufzeichen ersetzt wird. Makros werden eingesetzt in den 
  

• F-Tasten im Logeingabefenster  
• Packet-Tasten im Packet/Telnet-Fenster  
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• programmierbaren Tasten im RTTY-Fenster  
• programmierbaren Tasten im PSK-Fenster  

Nicht alle Makros können in allen Fenstern verwendet werden. Beachten Sie Hinweise zu den Makros. 

Ein Makro kann je nach Funktion durch eine grössere Anzahl an Zeichen ersetzt werden. Das Makro * wird durch Ihr 
eigenen Rufzeichen, z.B. PA1M ersetzt.  Durch eine Kombination von Makros können relativ lange Zeichenketten 
entstehen. Die Gesamtlänge wird daher auf 1024 Zeichen begrenzt, das sind immerhin 12 Zeilen mit je 80 Zeichen.  

 
Hinweis :  Makros sind grundsätzlich in Grossbuchstaben zu sch reiben  ! 

40.1.1 Allgemeine Makros  (General macros)  

Die allgemeinen Makros können in allen Einsatzfällen verwendet werden. 

  

Makroschlüsselwort  Ersetzt durch  

* Eigenes Rufzeichen aus den Stationsdaten, entspricht dem Makro {MYCALL}. 

! Rufzeichen der Gegenstation im Rufzeichenfeld 

{BEEP}  Erzeugt einen Klickton im PC-Lautsprecher 

{CALL}  

Rufzeichen der Gegenstation im Rufzeichenfeld. 
Falls das Feld leer ist, wird das letzte Call aus dem Log genommen 
Hinweis : Dieses Makro sendet das Call, wie es beim Start des Makros im Rufzeichenfenster steht. 
Wollen Sie eine erfolgte Korrektur berücksichtigten, nehmen Sie das Makro !  

{CLUSTER}  Rufzeichen des DXClusters aus den Stationsdaten  

{END}  
Das {END}-Makro teilt dem Programm mit, das noch kommende {} – Kommandos auszuführen sind, 
wenn das Programm vom Senden von CW, SSB oder DIGI – Texten zurückkommt. Alle Texte nach 
dem,{END}-Makro sind aber zu verwerfen. 

{EXCH}  Kontestnummer 

{FREQ}  Frequenz aus dem Logeingabefenster  

{GRID}  Eigener WW-Lokator (Gridsquare) aus den Stationsdaten 

{GRIDSQUARE}  WW-Lokator der Gegenstation aus dem Logeingabefenster  

{GRIDBEARING}  Antennenrichtung zwischem dem eigenen Lokator und dem Lokator im Logeingabefeld 

{REVGRIDBEARING}  Reverse Antennenrichtung zwischen dem eigenen Lokator und dem Lokator im Logeingabefeld  

{KMGRIDDISTANCE}  Entfernung in Kilometern zwischen dem eigenen Lokator und dem Lokator im Logeingabefeld 

{LOG}  Abspeichern des aktuellen QSOs , entspricht ENTER im Logeingabefenster. Setzen Sie bei DigiModes 
das {LOG}-Makro hinter das {RX}-Makro...  

{LASTCALL}  Zuletzt geloggtes Rufzeichen  

{MYCALL}  Eigenes Rufzeichen, das gleiche wie * 

{NAME}  Name der Gegenstation aus dem Logeingabefenster (bei Log DX)  

{OTHERFREQ}  Frequenz des inaktiven VFOs/Transceivers zum Ausgeben einer Skedfrequenz auf einem anderen 
Band. In CW wird das Komma in der Frequenzangabe durch ein R ersetzt.  

{PREVNR}  QSO-Nummer des zuletzt geloggten QSOs 

{LRMHZ}  Frequenz des VFO-A/linker Transceiver in MHz, z.B.  28 wenn auf 28.1234 MHz 

{RRMHZ}  Frequenz des VFO-B/rechter Transceiver in MHz, z.B. 14 wenn auf  14.1235 MHz 

{RUN}  Sendet das Call der zuletzt geloggten Station und schaltet in den Running-Modus 
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{S&P}  Sendet das Call der zuletzt geloggten Station und schaltet in den S&P-Modus. 

{STEREOOFF}  Das Stereo-Bit am  LPT-Port wird auf OFF (AUS) gesetzt 

{STEREOON}  Das Stereo-Bit am  LPT-Port wird auf ON (EIN) gesetzt  

{TIMESTAMP}  Datum und Uhrzeit des QSOs im Eingabefenster 

{CLEARRIT}  Schaltet RIT auf Null. Funktioniert nur bei Transceivern, die dieses Kommando unterstützen 

{CTRL-A}  Sendet Ctrl-A zum TNC.     ++ 

{CTRL-B}  Sendet Ctrl-B zum TNC.     ++ 

{CTRL-C}  Sendet  Ctrl-C zum TNC.     ++  

{CTRL-D} ... {CTRL-
Y} Sendet Ctrl-D bis Ctrl-Y zum TNC.     ++ 

{CTRL-Z}  Sendet Ctrl-Z zum TNC.     ++ 

{ENTER}  Sendet ENTER zum TNC. 

{ENTERLF}  Sendet CR/LF zum TNC. Versuchen Sie dieses Makro, wenn ENTER nicht funktioniert 

{ESC}  Sendet Escape zum TNC.     ++  

{DATE}  Sendet kurzes Datum wie unter Windows eingestellt (Ländereinstellung)  

{DATE1}  Datum im Nordlink-TF/WA8DED-Fomat (dd.mm.yy), z.B. :  26.02.99 

{SENTRST}  RST aus dem RST-sent-Feld des Logeingabefenster 

{TIME}  Zeit im Windows-Format wie unter Ländereinstellung gewählt 

{TIME1}  Zeit im Nordlink-TF/WA8DED-Format (hh:mm:ss), z.B. : 20:36:55 

{TIME2}  Zeit im kurzen GMT-Format (hhmm), z.B. : 2036 

{DAYTIME}  Datum und GMT im TAPR DayTime format, z.B. : 0107162036 

{DATEGMT}  Datum und  GMT-Zeit z.B. : 16-jul-01 18:36:55 

{TIMEGMT}  GMT-Zeit, z.B. : 18:36:55 

{F1}  Sendet Text der F-Taste  F1 

{F2}  Sendet Text der F-Taste  F2 

{F3}  Sendet Text der F-Taste  F3 

{F4}  Sendet Text der F-Taste  F4 

{F5}  Sendet Text der F-Taste  F5 

{F6}  Sendet Text der F-Taste  F6 

{F7}  Sendet Text der F-Taste  F7 

{F8}  Sendet Text der F-Taste  F8 

{F9}  Sendet Text der F-Taste  F9 

{F10}  Sendet Text der F-Taste  F10 

{F11}  Sendet Text der F-Taste  F11 

{F12}  Sendet Text der F-Taste  F12 

++ =  Diese Makros können bei MMTTY und PSK NICHT verwendet werden  
Das TNC-Interface akzeptiert nicht alle Makros dieser Liste  

40.1.2 CW-Makros (CW macros)  
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Die CW-Makros werden nur in für CW editierten Texten akzeptiert   

Makro  Ersetzt durch  

< CW-Tempo um 2 wpm erhöhen 

> CW-Tempo um 2 wpm verringern 

~ Sende einen halben Wortzwischenraum 

# Sende die nächste oder letzte Seriennummer 

[ SK 

@ AR 

] AS 

+ AA 

- BT 

 
CW-Tipp :  Es gibt Rufzeichen, bei denen die Verwechselung vorprogrammiert ist. Nehmen Sie z.B. als  6Y2A am 
Contest teil, steht in vielen Logs das Call BY2A. Um den Unterschied deutlich zu machen, schreiben Sie Ihr eigenes 
Rufzeichen im Menü Config >  Change Packet/CW/SSB/Digital  Message Buttons> Change CW Buttons nicht mit 
dem Makro * , sondern als  >6<~Y2A.  
Ergebnis : die 6 wird 2 WPM langsamer gesendet als der Rest des Rufzeichens und ein zusätzlicher halber 
Zwischenraum wird zwischen die 6 und Y2A eingefügt, so dass das Rufzeichen besser zu verstehen ist. Probieren Sie 
andere Kombinationen mit  <, >, oder ~ aus, um weniger Fehler zu provozieren oder schneller senden zu können. 

40.1.3 SSB-Makros (SSB macros  

SSB-Makros werden nur in für SSB-QSOs programmierten Tasten akzeptiert  Bei SSB-Makros können nicht zwei WAV-
Dateien zusammengefügt werden. Eine Kombination mit dem #-Makros an der ersten Stelle und einer weiteren WAV-
Datei funktioniert. 

 

Makro  Ersetzt durch  

# Sendet nächste (oder letzte) Seriennummerr 

{OPERATOR}  Erzeugen Sie eine WAV-Datei wie \wav\{OPERATOR}\cq.wav 
für jeden Operator 

40.1.4 SO2R-Makros  (SO2R macros)  

.  

Makro  Ersetzt durch  

{JUMPRX}  Wechselt das aktive Fenster auf den anderen Transceiver. Falls noch nicht offen, wird das zweite 
Eingabefenster geöffnet (entspricht CTRL+links/rechts-Pfeil)  

40.1.5 Multi-OP-Makros  (Multi operator macros)  

Die Multi-Operator-Makros funktionieren nur im  MultiOp-Modus  

Makro  Ersetzt durch  

{MESSAGE}  Sende eine Nachricht an die anderen Stationen im Netzwerk (über F-Taste)  

{PASS 0}  Gibt Arbeitsfrequenz von Station 0 (Master station) aus 

{PASS 1}  Gibt Arbeitsfrequenz von Station 1 aus 
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..... Gibt Arbeitsfrequenz von Station 2 ... 14 aus 

{PASS 15}  Gibt Arbeitsfrequenz von Station 15 aus 

40.1.6 Digitale Makros  (Digital (RTTY and PSK) macros)  

Die nachstehenden Makros können zusammen mit den allgemeinen Makros in den digitalen Fenstern für RTTY und PSK 
verwendet werden. 

Makro  Ersetzt durch  

{TX}  Schaltet auf Senden   

{RX}  Schaltet auf Empfang  

{GRAB}  Holt das erste Rufzeichen aus der Rufzeichenliste ins Rufzeichenfeld (Grab)  

{DELALL}  Löscht alle Einträge der Rufzeichenliste im digitalen Fenster  

{DELTOP}  Löscht das erste Rufzeichen in der Rufzeichenliste 

{DELSEL}  Löscht das markierte (hellgetastete) Rufzeichen in der Rufzeichenliste 

_ Unterstrich : Sendet einen Diddle (nur bei MMTTY) 

{PROFILE0}  Setzt auf das voreingestellte HAM-Profil zurück  

{PROFILE1}  
... 

{PROFILE8}  

Gilt nur für MMTTY : schaltet die Profile {PROFILE1} bis {PROFILE8} zu. Kann in den F-Tasten für 
unterschiedliche Einstellungen bei CQ oder S&P verwendet werden. 

{HXXXX}  Gilt für den Kontroller HAL DXP38., um Hex-Kodes an den Kontroller zu senden 

Anmerkungen :  

• Mit {TX} und {RX} können Makros verbunden werden, so dass 
nicht auf Empfang geschaltet wird, ehe nicht das letzte {RX} 
gefunden wurde oder die  RX-Taste gedrückt wurde  

• Auch  ESC schaltet auf Empfang (Not-Taste)  

 
Tipp : Sie sollten dem auf die Taste F1 zum Abbruch des Sendens (Abort) zu legenden Makro einen Zusatz zum 
Löschen des Sendepuffers zufügen. Sonst wird der im Sendepuffer noch stehende Text beim nächsten {TX} vor dem 
gewünschten Text zusätzlich ausgegeben. 

40.2 Makro-Beispiele  (Macro examples)  

40.2.1 CW-Makrobeispiele  (CW macro examples)  

• Rufzeichen aus dem Rufzeichenfeld senden  
o Macro: !  

� Sendet Rufzeichen der Gegenstation  
• CQ mit Makros 

o Macro: cq~test~de~*  
� ~ verkürzt den Wortabstand auf die Hälfte  
� * wird durch das eigene Rufzeichen ersetzt 

• Rapport senden   
o Macro: <<<5nn>>>{EXCH}  

� Der Rapport 5nn wird um 6 wpm schneller als die Kontrollnummer gesendet  

40.2.2 SSB-Makrobeispiele  (SSB macro examples)  

• Rufzeichen aus dem Rufzeichenfeld senden   
o Macro: !  

� Das Rufzeichen wird aus WAV-Dateien für Buchstaben, Ziffern und Sonderzeichen 
zusammengebaut. Die WAV-Dateien müssen im Verzeichnis \Letters stehen. Beispiele 
finden Sie auf der Webseite von N1MM unter Other Files von CT1AOZ und VK4CEJ. 
Sie sollten die WAV-Dateien aber für die eigene Stimme und die der mitarbeitenden 
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OPs selbst erzeugen. Siehe WAV-Dateien für einen SSB-Contest erzeugen  
.  

• WAV-Dateien für jeden Operator  
o Macro: wav\{OPERATOR}\cq.wav  

� Sie können die OP-bezogenen WAV-Dateien in je einem Verzeichnis mit dem Namen  
wav\{OPERATOR}\cq.wav  oder wav\{OPERATOR}\5914,wav für allgemeine Makros 
und in einem Verzeichnis wav\{OPERATOR}\letters für die Buchstabierdateien 
ablegen. 

� Sie können auch feste OP-Calls verwenden z.B. 
    N1MMCQ.wav  
    PA1MCQ.wav  

� Das Makro {OPERATOR} kann nur für SSB-Makros genommen werden  
• Hören Sie einen „Klick“, wenn Sie ein DUPE arbeiten wollen (in S&P) 

o Wenn Sie unter S&P die F6-Taste mit dem Makro {BEEP} belegen, hören Sie einen Klick, wenn 
Sie eine schon gearbeitete Station (DUPE) arbeiten wollen,.  

40.2.3 RTTY- und PSK-Makrobeispiele  (RTTY and PSK macro examples)  

• Beispiele für einen PK-232 aus dem digitalen Fenste r   

Tastentext  Makro  

Abort {CTRL-C}R{ENTER}TC{ENTER} 

TX X{ENTER} 

RX {CTRL-D} 

Band Up RB U{ENTER} 

RxReverse RXREV T{ENTER} 

 
• Beispiele für F-Tasten im Logeingabefenster für den  PK-232   

Mode  Button text  Macro  

Modus  Tastentext  Makro  

Running F1 CQ X{ENTER}CQ CQ CQ TEST DE {MYCALL} {MYCALL} K CQ{CTRL-D} 

Running F2 Exch. X{ENTER} ! UR 599 {EXCH} 599 {EXCH} BK{CTRL-D} 

Running F3 Tnx/Qrz X{ENTER} ! TU GL DE {MYCALL} QRZ{CTRL-D} 

S&P F1 {MYCALL} X{ENTER}! DE {MYCALL} {MYCALL}{CTRL-D} 

 
• Beispielmakros für den  KAM  

Tastentext  Makro  

Abort {CTRL-C}R RTTY {ENTER} 

TX {CTRL-C}T 

RX {CTRL-C}E 

 
• Beispielmakros für den SCS PTC aus dem digitalen Fe nster  

Tastentext Makro 

Abbruch {ESC}CLR{ENTER}{CTRL-D}{ENTER} 

TX/RX {CTRL-Y} 

RX-Reverse {ESC}TR 1{ENTER} 

RX-Norm {ESC}TR 0{ENTER} 

45 Baud {ESC}BAU 45{ENTER} 
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75 Baud {ESC}BAU 75{ENTER} 

Umschalten in Kommandostatus {ESC}Q{ENTER} 

• Sendeartenumschaltung SCS-PTC  

Tastentext  Makro  

RTTY {ESC}Q{ENTER}BAU{ENTER} 

PSK31 {ESC}Q{ENTER}PSKT{ENTER} 

CW {ESC}Q{ENTER}CWT{ENTER} 

AMTOR {ESC}Q{ENTER}AMTOR{ENTER} 

PACTOR {ESC}Q{ENTER}PT{ENTER} 

PACKET {ESC}Q{ENTER}PACKET{ENTER} 

 
• Funktionstasten im Logeingabefenster für den SCS PT C   

Modus  Tastentext  Makro  

Running F1 CQ {CTRL-Y}CQ TEST DE * * * k{ENTER}{CTRL-Y} 

Running F2 EXCH {CTRL-Y}! HI 599 {EXCH} {EXCH} K{CTRL-Y} 

Running F3 CFM {CTRL-Y}! QSL TU DE * QRZ? K{CTRL-Y} 

S&P F1 CALL {CTRL-Y}! DE * * K{CTRL-Y} 

S&P F2 EXCH {CTRL-Y}DE * TU 599 {EXCH} {EXCH} GL DE *{CTRL-Y} 

 

• Beispielmakros für F-Tasten im Logeingabefenster fü r  MMTTY   

Mode  Button text  Macro  

Running F1 CQ {TX}CQ CQ CQ TEST DE {MYCALL} {MYCALL} K CQ{RX}  

Running F2 Exch. {TX}  ! UR 599 {EXCH} 599 {EXCH} BK{RX}  

Running F3 Tnx/Qrz {TX}  ! TU GL DE {MYCALL} QRZ{RX}  

S&P F1 {MYCALL} {TX} ! DE {MYCALL} {MYCALL}{RX}  

S&P F2 Exch. {TX} ! UR 599 {EXCH} 599 {EXCH} GL DE {MYCALL}{RX}  

Sende CQ auf neuer Zeile {{TX} {ENTERLF} CQ DE {MYCALL}{RX}  

40.2.4 Packet-Makrobeispiele ( Packet macro examples)  

• Connect zum örtlichen DXCluster unter TAPR-Firmware :  
o {CTRL-C}C {CLUSTER}{ENTER}   

� {CTRL-C} schaltet den TNC in den Kommandostatus   
� {CLUSTER} ist das Rufzeichen des örtlichen DXClusters, z.B. PI8RWD-7, das in den 

Stationsdaten eingetragen wurde 
� {ENTER} schliesst das Kommando ab (wichtig !!)   

 
• Connect zum örtlichen DXCluster unter TF/Nordlink-F irmware :  

o {ESC}C {CLUSTER}{ENTER}  
� {ESC} schaltet den TNC in den Kommandostatus. Sie können {ESC} als Makro 

verwenden. Über die Tastatur müssen Sie es durch Shift-Escape ersetzen, sonst 
springt der Cursor ins Logeingabefenster  

� {CLUSTER} wird durch das DXClusterrufzeichen aus den Stationsdaten ersetzt, hier  
PI8RWD-7.  

� {ENTER} schliesst das Kommando ab (wichtig !!)  
�  
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• In diesem Beispiel sehen Sie, wie mehrere Kommandos  in einem Makro zusammengefasst werden 
können :  

o  {ESC}I {MYCALL}{ENTER}{ESC}P 100{ENTER}{ESC}S1{ENTER}{ESC}C {CLUSTER}{ENTER}  
Dieses Makro löst folgende Aktionen aus :   

� {ESC}I {MYCALL}{ENTER}  
Sendet mein Rufzeichen zum TNC  

� {ESC}P 100{ENTER}  
Ändert die Persistence auf 100  

� {ESC}S1{ENTER}  
schaltet auf Kanal 1   

� {ESC}C {CLUSTER}{ENTER}  
Startet Connect zum DXcluster  

Hinweis DM3ML : Ist Ihr TNC/PTC jungfräulich und der Connect funktioniert nicht, setzen Sie vor das Connect-
Kommando noch die Eingabe des eigenen Rufzeichens mit I {MYCALL}{ENTER}  (beim TNC) oder myc 
{MYCALL}{ENTER}  (beim PTC) und das Umschalten vom Monitorkanal 0 auf den PR-Kanal 1 mit S 1{ENTER}. 
Einen PTC müssen Sie u.U. noch von Kurzwelle (Prompt cmd: ) auf Packet (Prompt pac:)  mit pac{ENTER}  
umschalten.  
Beispiel von DM3ML für einen PTC-II :  

• pac{ENTER}myc {MYCALL}{ENTER}S 1{ENTER}c 2;{CLUSTER}{ENTER 

40.2.5 Beispiele für das Makro {END} ({END} macro examples ) 

Das {END}-Makro teilt dem Programm mit, das noch kommende {} – Kommandos auszuführen sind, wenn das 
Programm vom Senden von CW, SSB oder DIGI – Texten zurückkommt. Alle Texte nach dem,{END}-Makro sind aber zu 
verwerfen. 

Beispiel : F1:  {STEREOOFF}CQ TEST *{END}{STEREOON}  

Immer wenn F1 gedrückt wird, wird das Stereobit am LPT-Port auf OFF (AUS) geschaltet. CQ wird gesendet und danach 
wird das Stereobit wieder zugeschaltet. Während des CQ kann man den zweiten Transceiver abhören und danach 
wieder beide.   
Hinweis : Nur {} . Makros mit Steuereffekt werden in einem {END}-Makro wirksam. Makros wie {MYCALL} oder 5NN nach 
dem {END}.Makro werden ignoriert. {END} bewirkt das Ende des Makros, es wird nichts mehr gesendet. 

Mit dem Makro F1:   {R1 *UM0}CQ TEST *{END}{R1 *UM85} können Sie die Lautstärke eines ORION-Transceivers vor 
dem Start des CQ auf Null setzen und danach wieder auf 85.  

Sie können auch einen zweiten Transceiver steuern. Interessant ist diese Steuerung für die RX-Stummtastung EIN/AUS, 
Monitor EIN/AUS, ein QSY für den NA-Sprint und andere Möglichkeiten. 

 

41. Multinutzerbetrieb (Multi User Support) 

Sie können N1MMLogger in einer Multi-OP-Multi-TX-Umgebung einsetzen. Die Computer sind zu vernetzen. 
Maximal 16 PCs können in einem Netz betrieben werden. Die PCs müssen über eine Netzwerkkarte verfügen und 
für das Protokoll TCP/IP konfiguriert sein. Eine Station im Netzwerk wird zur Master- Station mit der PC-Nummer 0 
bestimmt.  

.  

41.1 Merkmale (Features)  

• Maximal 16 PCs (0..15) mit einer Masterstation (0) im Netz  
• Verwendung von Standard-Netzkarten (NICs)  
• IP-Adressen bei der Konfiguration 
• Nachrichtenaustausch (Talk) zwischen den Stationen im Netzwerk  
• Automatische Zeitsynchronisation mit der Masterstation  
• Arbeitsfrequenzaustausch zwischen den Stationen  
• Packet  
• Meldungen werden an alle PCs verteilt 
• Packetkommunikation über die Masterstation zum DXCluster  
• Fehlermeldungen über Stationsausfall  
• Siehe Multi-Multi-Info (Multi-User information) für zusätzliche Optionen  

41.2 Konfiguration (Configuration)  
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Es wird vorausgesetzt, dass das aufgebaute Netzwerk funktioniert. Sie können von jedem PC alle anderen PCs 
“anpingen” und Sie sehen im Windows-Explorer die PCs in der Netzwerkumgebung. Es ist für die Funktion des Netzes 
unerheblich, ob die Verkabelung über Koaxkabel oder STP-Kabel  läuft. Eine Vernetzung über serielle Schnittstellen wie 
bei älteren Programmen unter DOS wird nicht unterstützt.  

• Alle PCs einstellen  
o Richten Sie bei allen PCs die Verbindung zum Transceiver so ein, als wären  die PCs unvernetzt  
o Prüfen Sie die Transceiversteuerung, die Modulation mit WAV-Dateien, die CW-Tastung usw..  
o Auf allen PCs muss die gleiche Version von N1MMLogger laufen !!   

• Nur für die "Master" -Station  
o Packet/Telnet laufen NUR auf diesem PC  
o Stellen Sie die genaue Zeit ein. Alle PCs werden auf diese Master-Zeit synchronisiert. 
o Teilen Sie dieser Station die Nummer 0  zu !!!  

• Tragen Sie an allen anderen PC  die Nummern und die  Namen aller PCs im Netz ein  
 
Hier sehen Sie ein Beispiel für ein Netz mit fünf PCs, das an allen fünf PCs eingetragen werden muss :   

 

• Gehen Sie zu Config >  Edit Station Computer Names 
o Tragen Sie die Stationsnummer StnNr von 0..15 in der Form StnNr:StnName ein. Die 

Masterstation MUSS die Nummer 0 bekommen. Die anderen Stationen nummerieren Sie von 
1,2,3.. laufend durch. Für den Stationsnamen können Sie einen beliebigen Namen 
unabhängig von dem im NetBIOS eingetragenen Namen wählen.  

o Computer IP Address : Geben Sie die  dem PC zugewiesene IP-Adresse ein  
• Alle PCs müssen die gleichen Einstellungen haben. Ändern Sie keine der Einstellungen nach dem Aufbau 

des Netzes !  
• Alle anderen Stationen im Netzwerk  (nicht der "Master") :   

o Wählen Sie das Telnet-Fenster um alle DXCluster-Informationen  zu bekommen  
� Das Packet-Fenster liefert keinerlei Informationen bei den Slave-PCs   
� Schalten Sie immer auf das Telnet-Fenster, unabhängig ob beim Master der 

DXCluster über Packet oder Telnet connectet ist  
o Stellen Sie alle Stationen vor dem Start des Multi-Nutzerbetriebs identisch ein 

 
Tipp: Die Information zur PC-Einstellung steht in d er Datenbank. Machen Sie die Einstellung an einem 
PC für alle F-Tasten, Fenster usw.,  exportieren Si e die Einstellungen auf eine Diskette und kopieren 
Sie diese auf alle PCs des Netzes.  

 
• Start des Multinutzerbetriebs  

o Gehen Sie zu Config >  Multi-User Mode  
Klicken Sie den Menüpunkt an und los geht’s...  

41.3 Multinutzer-Werkzeuge  (Multi-User Tools)  

Das Hinzufügen und Löschen von QSOs arbeitet automatisch. Alle Bandskalen können mit den von der Masterstation 
gelieferten DX-Spots gefüllt werden. 
  
Sie haben einige Werkzeuge zu Ihrer Verfügung :   

Gehen Sie zu  Config > Multi-User Tools  
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• Talk to another station (Nachricht an andere Station) : Ctrl-E : Schickt eine Nachricht an eine oder alle 
Stationen. Geben Sie die Stationsnummer (0-15 oder *) gefolgt von einem Zwischenraum und dem zu 
sendenden Text ein  
Voreingestellt ist ein * gefolgt von dem Band, auf dem die Station arbeitet, die die Nachricht sendet.  

Diese Nummern sind möglich :   

o *   AN ALLE  
o 0  an Station 0, den Master  
o 1  an Station 1  
o usw.  

Eine Nachricht ohne Nummer geht ebenfalls AN ALLE. 

 

• Force Time Sync Now  (Zeit synchronisieren) : synchronisiert die Zeit mit dem Master. Die Zeit aber wird 
automatisch nach dem Start und etwa aller 5 min synchronisiert.  

o Der Master sollte ab und an mit einem Normalzeitgeber im Internet synchronisiert werden. 
N1MM hat gute Erfahrungen mit dem Programm  Dimension 4 

• Set your pass frequency (sende Arbeitsfrequenz) : Alt-Z  : Die Arbeitsfrequenz wird regelmässig an alle 
Stationen gesendet, so dass diese andere Stationen auf Sie hinweisen können. Mit ALT-Z lösen Sie selbst 
die Übertragung ins Netz aus. Geben Sie als Frequenz eine 0 ein, wird Ihre Arbeitsfrequenz zurückgesetzt. 
Sie können auch andere Stationen auf die Frequenzen des eigenen Calls hinweisen. Mit dem Makro {PASS 
3} können Sie z.B. einer Station die Arbeitsfrequenz der Station #3 Ihres eigenen Netzes in CW oder RTTY 
übermitteln, in CW wird aus dem Dezimalpunkt ein R gemacht. Geben Sie aber kein R bei der 
Frequenzeingabe mit ALT-Z ein. Die Arbeitsfrequenzen der Stationen im Netz werden in der Statuszeile des 
Logeingabefensters und im Info-Fenster angezeigt.   

 

• Log QSOs at all stations : speichert alle QSOs auf allen PCs des Netzes).  Alle anderen Infos wie Packet-
Spots, Arbeitsfrequenzen usw. werden weiter an alle Stationen im Netz verteilt. 
  

• Show Connections (Verbindungsanzeige)  . Gibt eine Liste aller Station des Netzes aus  

 

Die Statusmitteilungen bedeuten :   
• Connected : eine Verbindung zu dieser Station besteht  
• Listening : hört auf die Master-Station, eine Verbindung besteht (noch) nicht 
• Error : keine Masterstation zu finden oder noch nicht auf Multi-User geschaltet 
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• Resync Logs by Date  : Erlaubt es einem Computer, alle QSOs der letzten 48 Stunden aller PCs eines 

Netzwerks auf zeitliche Abweichungen zu prüfen und zu synchronisieren  
o Geben Sie ein Startdatum für die 48-Stunden-Periode ein. Voreingestellt ist der Start beim 

ersten geloggten QSO auf diesem Rechner. Falls er selbst kein Log hat, beginnt die Prüfung 
beim Conteststart in der Contesteinstellung.  

o Alle PCs müssen auf den gleichen Contest z.B. CQWWSSB eingestellt sein. 
o Die Resync-Funktion holt nur  QSOs von anderen PC auf den PC, der die Abfrage gestartet 

hat. Es werden keine QSOs auf die abgefragten PCs übertragen, die Resync-Funktion ist 
nicht bi-direktional. 

o Wenn Sie alte Logs resynchronisieren, muss die gleiche Rechneranordnung wie im Contest 
hergestellt werden. Die QSOs sind mit der Rechnernummer veknüpft, d.h. Station 0 sendet 
nur QSOs, die unter Station 0 abgespeichert usw.  

 

• Resync Last n Hours  : Resynchronisation der letzten n Stunden. Arbeitet wie die Resynchronisation nach 
Datum (s.o.)  
Anmerkung DM3ML : mit Resync können Sie (wenn ich’s richtig verstanden habe), das Log in Ihrem 
abgestürzten Rechner wieder auf den Stand vorher bringen, wenn das Loggen auf allen PCs eingeschaltet 
war. 

• Trace Multi-User Messages  : Diese Option speichert die zwischen den PCs ausgetauschten Meldungen in 
einer Datei *.TRC. Der Name der Datei ist vorzugeben. Diese Option wird nur bei der Fehlersuche benötigt, 
nicht im Contest. 

• Force Other Station to Stop Transmitting When I Tra nsmit  : diese Option sperrt einer Station die 
Sendeerlaubnis, wenn Sie selbst senden  (z.B. bei der Multisuche)  

• RSet station as Run 2  : Setzt diese Station als Run 2-Station. 
• Don't work non-mults  : Loggen von Nicht-Multis wird gesperrt 
• Show Computer Name  _ IP Address Info : Zeigt den Computernamen und die IP-Adresse an. Gestartet 

wird das Programm IPCONFIG /ALL 

41.4 Information im Info-Fenster  (Information)  

Das Bild unten zeigt den unteren Teil des Infofensters mit der Multi-User-Information in einem  Contest. Wenn Sie auf die 
grünen und roten Icons rechts klicken, öffnet sich ein Menü :   

 

• Verbindungsstatus :   
o Grün  : Verbunden (Connected) 
o Rot  – NICHT verbunden (not connected) 
o Helles Rot :  Verbindung im Aufbau oder unterbrochen, das 

Programm arbeitet an der Lösung des Problems 
 

• Station name = Stationsname 

• Pass frequency = Arbeitsfrequenz 

• Is he running or S&P = im Running- oder S&P-Modus 

• Who is the operator = Call des OP 

• Rate information = QSOs/Stunde-Rate 

41.4.1 Arbeitsfrequenz (Run/pass frequency)  

41.4.2 Regeln  (Rules) 

Folgende Regeln für die Run/Pass-Frequenzen wurden implementiert :  
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Running   
 

• Ich bin im Running-Modus (und rufe CQ)  
• Schicke alle Anrufer auf diese Frequenz. Ein Haken ist im Running-Feld 

 
Nicht im Running-Modus   
 

• Ich bin “im Prinzip” im Running-Modus, jage aber gerade einen Multi   
o Die Running-Frequenz bleibt für 1 min stehen, wird aber dann auf 0 gesetzt  

• Ich bin nicht im Running-Modus, habe aber ein Pass-Frequenz weiter oben im Band  
o Der Nutzer gibt mit ALT-Z diese Frequenz bekannt  

• Ich habe keine Pass-Frequenz, die angegebene Frequenz ist belegt  
• Es gibt keinen Zähler, der die Pass-Frequenz automatisch auf 0 setzt oder zählt, wieviel QSOs oder CQs auf 

einer bestimmten Frequenz gemacht wurden, ehe die Pass-Frequenz auf 0 gesetzt wird > OP, kümmere Dich 
selbst ! 

41.4.3 Anzeigeregeln (Displaying rules)  

Im Running-Modus  : zeigt Run-Frequenz an 

Nicht im Running-Modus  : zeigt Pass-Frequenz an, falls nicht 0 eingegeben wurde. Zeigt die letzte CQ-Frequenz an, 
falls nicht 0 eingegeben wurde. 
  

41.5 Makrotasten  (Macro keys)  

Alle Makrotasten können verwendet werden. Für den Multinutzerbetrieb gibt es spezielle Makros. Siehe Kapitel Multi-OP-
Makros .  

41.6 Weitere Möglichkeiten ( Features)  

• Remote stack call stacking  : Rufzeichen auf den Stapelspeicher eines anderen Computers speichern   
o Shift-Enter nachdem festgelegt worden ist, an welche Station(en) die Rufzeichen geschickt 

werden sollen 
o Um festzulegen, an welche Station die Rufzeichen geschickt werden sollen, klicken Sie mit rechts 

auf “Ball” vor der Station und wählen Sie die Option  Target for call stacking 
• Prohibit transmitting  (Senden sperren) 

o In den Klassen single operator oder multi-one darf nur eine Station gleichzeitig senden  
o In den Klassen multi-two oder multi-multi darf nur eine Station je Band gleichzeitig senden  
o Gehen Sie zu den Multi-User tools unter Config > Force Other Station to Stop Transmitting When 

I Transmit 

41.7 Weitere Informationen  (Other info)  

• Ein QSO, das von einer anderen Station im Multi-Multi-Betrieb gemacht wurde, darf  nicht gelöscht werden. Es 
erscheint eine Warnung.   

• Station 0 sendet alle ankommenden DX-Spots an alle angeschlossenen Stationen. Sie erscheinen dort im 
Telnet- Fenster  (nicht im Packet-Fenster) der anderen PC im Netzwerk. Wenn Sie einen DX-Spot melden, wird 
er über das Netzwerk über die Station 0 an den DXCluster gesendet, Die Antwort des DXClusters wird vom 
Netzwerk wieder an alle angeschlossenen Stationen verteilt.  

• Das Programm kann nicht beendet werden, weil sonst bei der Initialisierung des Multi-User-Betriebs 
unvorhersehbare Konflikte zu erwarten sind  

• Sie werden nach dem Operatorrufzeichen gefragt, wenn Sie es nicht selbst mit CTRL-O eingegeben haben 
• Die CQ- oder Passfrequenz wird beim Start abgefragt  
• Das Info-Fenster blinkt rot, wenn eine Nachricht eintrifft  
• Wenn Sie die Conteste durchgehen, sehen Sie einen Contest  DELETEDQS.  

Das ist kein echter Contest, sondern ein Aufbewahrungsplatz für gestrichene QSOs, speziell beim Multi-User-
Betrieb. Sie können einzelne QSOs retten.  

• Der Connect-Status wird unten im Infofenster angezeigt  
• Die Verbindungen werden aller 10 s überprüft  
• Alle Verbindungen werden beendet und neu gestartet, wenn die Datenbank, der Contest oder die 

Verbindungsliste geändert wird. 
• Auch Nicht-Master-Stationen können Ihr Telnet/Packet-Fenster schliessen  
• Die Zeitsynchronisation wird nur an der Masterstation angezeigt  
• Wenn Sie DX-Spots auf Ihrer lokalen Maschine markieren oder speichern, werden sie auf allen 

angeschlossenen Maschinen markiert oder gespeichert  
• Kommandos, die im Telnet/Packet-Fenster einer Station eingegeben werden, werden mit dem Namen der 

Station versehen, z.B.  [20M] sh/dx. Der Stationsnamen wird aber nicht an den DXCluster gesendet  
• Fällt eine Verbindung im Netz ais, wird aller 30s versucht, sie wiederherzustellen 
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• Stationen in der Klasse Multi-two MÜSSEN im Multi-User-Betrieb arbeiten und die Nummern für die Run-
Station und die Multi-Station durch den Contest hindurch beibehalten. Im Cabrillo-Log wird nur dann eine 
Stationsnummer ausgegeben, wenn im Multi-two- oder Multi-multi-Betrieb gearbeitet wurde.  

• Jede Station in einer harmonischen Frequenzbeziehung wird  rot  im Info-Fenster markiert  
• In den Klassen Single operator und Multi-one wird das Operatorrufzeichen rot  markiert, wenn der OP sendet. 
• Im Mulit-User-betrieb werden die Seriennummern einmal pro Band vergeben. Wenn der Multi-User-Betrieb 

abgeschaltet ist, werden die Seriennummern in globaler Folge vergeben. 

• Das Gruppeneditieren ist im Multi-User-betrieb nicht gestattet. 

41.8 Beispiel für den Aufbau einer Multi-User-Station (E xample Multi User setup)  

Das Beispiel zeigt ein Netz mit gemeinsamer Nutzung von Dateien (file sharing) und einem Netbios lookup (Sie können 
die PCs in der Netzwerksumgebung sehen). Das Netz wird als Windows-Netz aufgebaut.  Für ein N1MMLogger-
Netzwerk ist das nicht unbedingt nötig, es reicht wenn sich die PCs von allen PCs im Netz anpingen lassen . Es wird 
dann nur ein TCP/IP-Stack verwendet. 
Alle mit einem * gekennzeichneten Zeilen sind nicht unbedingt nötig, sie sind aber nützlich für andere Zwecke, wie den 
Zugriff zu Dateien oder die Aktualisierung von Einstellungen. Diese Arbeiten müssten sonst vor Ort mit Disketten oder 
CDs vorgenommen werden.  

41.8.1 Vor dem Contest  (Before the contest)  

Master-PC :  

• Geben Sie den Zugriff auf Dateien im Netzwerk frei  (*) 
• Geben Sie den Zugriff auf die Festplatte des Masters frei (*) 
• Halten Sie alle Installationsdateien auf dem Master bereit (*) 
• Geben Sie die IP-Adresse des Masters entsprechend der Computernamensliste (s.u.) ein 

o Mitunter müssen Sie einen Neustart machen (Win98 CD) 
o Notieren Sie die IP-Adresse für die Nachcontestarbeit 

• Notieren Sie dem Namen des Master-Windows-Computer (NetBIOS) und die Arbeitsgruppe (name & 
workgroup) (*) 

• Starten Sie  N1MM Logger 
• Wählen Sie eine neue Datenbank z.B. PACC2003.MDB auf dem Master 
• Starten Sie einen neuen Contest z.B. PACC 
• Konfigurieren Sie die F-Tasten (SSB/CW/Packet) 
• Editieren Sie die Stations-Computerliste nach Plan, z.B. :  

o Stn#:Stn Name Computer IP Address 
o 0:master 192.168.10.10 
o 1:160M 192.168.10.1 
o 2:80M 192.168.10.2 

• Laden Sie die zum Contest gehörende Länderdatei z.B. CTY-PACC.DAT mit dem Tools-Menü 
• Laden Sie die zu verwendende Master.dat-Datei bei der Contestwahl 
• Bauen Sie eine Verbindung zum DXCluster in Packet oder Telnet auf 
• Exportieren Sie alle Einstellungen mit File > Export > Export …. in Dateien  
• Schalten Sie interne Firewalls ab oder ändern Sie die Einstellung 

Nicht-Master-PCs :  

• Installieren Sie Netzwerkkarten und als Protokoll TCP/IP, wenn nicht schon geschehen 
• Schalten Sie  interne Firewalls ab oder ändern Sie die Einstellung  
• Geben Sie den Dateizugriff über Windows-Netzwerke frei (*) 
• Setzen Sie die IP-Adresse entsprechen der Computerliste   

o Windows 95/98/ME: mitunter Neustart mit Windows CD nötig 
o Notieren Sie die IP-Einstellungen für die Nachcontestarbeit 

• Suchen Sie den Master im Windowsnetzwerk (*)  
o Mit dem Explorer > Netzwerkumgebung und suchen Sie nach seinem NetBIOS-Namen 

• Installieren Sie N1MMLogger und aktualisieren Sie es 
o Mit einer Kopie vom Master übers Netzwerk (*) 

• Kopieren Sie die Datenbank hier z.B. PACC2003.MDB vom Master auf diesen Computer übers Netzwerk (*) 
o Kopieren Sie das WAV-Verzeichnis vom Master auf diesen Computer übers Netzwerk  (*) 

Alle PCs :  

• Starte N1MMLogger 
• Importiere Fenstereinstellungen und F-Tasten usw. 
• Öffnen Sie die Datenbank hier PACC2003.MDB und wählen Sie den PACC-Contest 
• Schalten Sie auf  Multi-user-Betrieb 
• Stellen Sie die Konfiguration für  CAT, PTT, CW u.a. ein und exportieren Sie die Programmeinstellungen 
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• Schalten Sie die Windows-Töne ab : Systemsteuerung > Sounds/Audiogeräte > Sounds > Soundschema > 
keine Sounds 

Gilt für alle Rechner :   

• Stellen Sie sicher, dass Sie die gleiche Programmversion auf allen Rechnern laufen lassen 
• Stellen Sie sicher, dass auf allen Rechnern der gleiche Contest eingestellt ist  
• Stellen Sie sicher, dass auf allen Rechnern die gleiche Zeitzone und die gleiche Sommer/Winter-Zeit eingestellt 

ist.  
• Stellen Sie alle Rechner auf die gleiche Ländereinstellung (Zahlen, Datum, Währung usw.) ein 
• Stellen Sie alle Rechner auf das gleiche Format für kurze und lange Zeit und Datum ein 

41.8.2 Während des Contest  (During the contest)  

• Überprüfen Sie regelmässig die Zeit am Master, u.U. mit einem Zugriff zu einem Internet-Zeitserver  
• Überwachen Sie den Status des Netzwerks und stellen Sie – falls nötig die Verbindung wieder her und 

resynchronisieren Sie sie  
• Beachten : ein Resync importiert QSOs nur zu dem PC von dem Sie QSOs importieren. Der Computer von dem 

der Import kommt, wird nicht aktualisiert mit dem Log des Computers, von dem sie importieren. 
  

41.8.3 Nach dem Contest  (After the contest)  

• Stellen Sie sicher, dass noch alle PCs im Netz und angeschaltet sind 
• Machen Sie ein Resync auf allen PCs 
• Prüfen Sie die Zahl der QSOs und Multis auf allen PCs und vergleichen Sie sie 
• Kopieren und verdichten Sie die Datenbank, hier PACC2003.MDB zur Datensicherung (backup) 
• Stellen Sie die geborgten PCs wieder auf ihre Original-Netzeinstellung (z.B. IP-Daten) und  Soundeinstellung 

unter Windows zurück 

41.9 Multi-User übers Internet  (Multi User via the internet)  

Es ist durchaus möglich einige oder alle Stationen über ein externes LAN oder sogar über das Internet zu vernetzen. Hier 
gibt es aber eine Menge an Problemen, zu denen umfangreiche Kenntnisse über den Netzbetrieb benötigt werden, wie 
z.B. IP-Adressen, Firewalls,Port-Einstellungen, NAT usw.  

Sie benötigen die externe IP-Adresse Ihres PCs. Wenn Sie mit dem Web direkt verbunden sind, können Sie diese 
Adresse mit den Programmen ipconfig.exe  (NT, 2000, XP) oder  winipcfg.exe  (95,98,ME) abfragen. Starten Sie diese 
Programme aus der Kommandozeile „Ausführen “ im Startmenü. Wenn Sie in einem LAN eingeloggt sind, läuft die 
Verbindung meist über einen Router. Die PCs nutzen eine interne IP-Adresse, der Router nutzt eine externe Adresse. 
Wählen Sie  http://megawx.aws.com/support/faq/software/ip.asp, dieser Link zeigt Ihnen die externe Adresse an. 

Wenn ein Multi-User-Link nicht mehr funktioniert, überprüfen Sie die IP-Adresse. Diese Adresse ändert sich von Zeit zu 
Zeit, wenn Sie dynamisch vergeben wird (DM3ML : z.B. bei einer Einwahl bei einem Provider), auf jeden Fall jedoch bei 
einem PC-Neustart und einer neuen Einwahl oder einem Restart des Routers. 
 
Der Router sollte so eingestellt werden, dass er ankommende Nachrichten über den Port 12070 an Ihre IP-Adresse 
schickt. Eine Port-Transformation sollte abgeschaltet werden. Hier gibt es etwas für Spezialisten zu tun, da es hier viele 
verschiedene Möglichkeiten gibt, die an dieser Stelle nicht in Einzelheiten erläutert werden können.  

Firewall : Öffnen Sie Port 12070 für ankommenden Verkehr 

Router :  Verwenden Sie u.U. NAT für ankommenden Verkehr über Port 12070 (für den ersten PC in der Liste) zu Ihrer 
IP-Adresse 

Beispiel :  Menü Config >  Edit Station Computer Names  

• Ein * muss vor den Namen des lokalen Rechners gesetzt werden. Damit kann der lokale Rechner seine Identität 
bestimmen, wenn eine externe IP-Adresse in der Namensliste eingetragen ist :   

o Beispiele (siehe Bilder) :  
� 0:*USA  
� 1:*Europe 

• Die im Beispiel angezeigte IP-Adresse ist nicht die IP-Adresse von Tom, N1MM :-) 
• Im Bild steht oben die Station von N1MM (USA) und unten  PA1M (Europe). 
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42. Ein Operator-zwei Transceiver (SO2R) 
42.1 Grundlagen (The Basics) 

Der Funkbetrieb als einzelner Operator mit zwei Transceivern (Single Operator 2 Radio = SO2R) kann, wenn richtig 
organisiert, eine Menge an QSOs und Multis zusätzlich ins Log bringen. Sie können damit Ihre Effektivität in den 
Totzeiten, z.B. wenn eine Station CQ ruft, verbessern. Sie hören auf dem zweiten Transceiver, wenn der erste sendet. 
Auf dem ersten Transceiver kann Ihre CQ-Maschine laufen, während Sie auf dem zweiten nach Multis und anderen 
Stationen suchen. Sie haben zwei unabhängige Eingabefenster und können selbst mit ein paar zusätzlichen Stationen 
oder Multis Ihre Punktzahl deutlich aufwerten. 

Die Philosophie von SO2R geht davon aus, dass Sie zwei nicht unbedingt identische Transceiver an unterschiedlichen 
Antennen auf unterschiedlichen Bändern unabhängig voneinander tasten, steuern und schalten können.  Vorausgesetzt 
ist natürlich, dass die Transceiver ausreichend von einander getrennt sind und sich durch den Einbau von Filtern- und 
EMV-Mitteln nicht gegenseitig stören. Die meisten Station verwenden Transceiver gleichen Typs, damit sie nicht dauernd 
umdenken müssen, aber mit N1MMLogger können es auch verschiedene Typen sein.  

SO2R ist gut bei grossen Contesten wie CQWW und ARRL-DX-CW-Contesten einsetzbar. Knackpunkt ist die 
Automatisierung der Station. Wenn Sie selbst mit dem Mikrofon oder der Taste CQ rufen müssen, können Sie nicht 
gleichzeitig an einem Transceiver nach Multis suchen. In Fone-Contesten müssen Sie Ihre Soundkarte mit DVK laufen 
lassen. Natürlich müssen Sie gute Nerven haben, sonst büssen Sie eher an Punkten ein, als Sie dazu gewinnen. Der 
Sprint CW contest ist speziell für SO2R gemacht  -- er ist nur 4 Stunden lang. 

Sie können bei SO2R auch ältere Transceiver wie JRC-Geräte einsetzen, die nicht für die CAT-Steuerung von 
N1MMLogger vorbereitet sind oder Geräte ganz ohne Computersteuerung. 

Im SO2V-Betrieb, einem "Single Operator mit 2 VFO's", können Sie auch mit einem Transceiver mit 2 VFOs arbeiten. 
Hier werden die 2 VFO's, VFO A und VFO B jeweils einem Logeingabefenster zugeordnet. Hat Ihr Gerät einen Zweit-
Empfänger, können Sie mit getrennten Eingabefenstern arbeiten. Als wir die Programmvorgaben zusammenstellten, 
hatten wir den Eindruck, dass SO2V öfter als SO2R verwendet wird. Wenn Sie Ihren Transceiver für SO2V-Betrieb 
vorbereiten, müssen Sie die LPT-Tastung von Radio1  auf BOTH umstellen, sonst wird Ihr Radio2  nicht getastet. 
Es werden nur zwei Transceiver oder zwei Empfänger vom Programm unterstützt. 
Der SO2V-Betrieb nützt zwar den Zweitempfänger moderner Transceiver, ist aber nicht so effektiv wie der SO2R-Betrieb, 
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da Sie mit dem zweitem RX nicht hören können, wenn Sie mit dem Transceiver senden. Sie können am Zweitempfänger 
nur hören, wenn Sie auf eine Antwort für Ihren CQ-Ruf im Erst-RX warten.  

Für einen neuen SO2R-Operator haben wir nur drei tröstenden Worte : Praxis, Praxis, Praxis… Sie brauchen eine 
gewisse Zeit, um sich in diese Betriebstechnik einzuarbeiten. 

42.2 Intuitives Nutzerinterface  (Intuitive User Interface) 

Arrangieren und nutzen Sie die N1MMLogger so, dass sie intuitiv bedient werden können :  

• Ordnen Sie die Logeingabefenster so an, wie die Geräte stehen  
• Sie können über die Eingabefenster alle benötigten Funktionen auslösen   
• Sie sehen sofort, welcher VFO als nächster senden wird (im ESM-Modus)  
• Sie sehen an den Farbpunkten, welches Fenster aktiv ist und sich im Running- oder S&P-Modus befindet und 

sendet  

42.3 Unterstützte Möglichkeiten  (Supported features) 

N1MMLogger unterstützt alle die Möglichkeiten, die Sie von einem Weltklasseprogramm für den SO2R-Betrieb erwarten. 
Im einzelnen sind das :  

• Unterstützt zwei Transceiver – nicht drei und mehr  
• Zwei Logeingabefenster werden angezeigt, die voll gegen einander austauschbar sind   
• Die beiden Fenster können wahlweise allen Running- und S&P-Modi für den SO2R-Betrieb zugeordnet werden :   

o Running / S&P  
o S&P / Running  
o S&P / S&P  
o Running / Running (noch nicht programmiert)  

• Die Eingabefenster können beliebig auf dem Schirm angeordnet werden : typisch links/rechts oder oben/unten, je 
nach Stationsaufbau  

• In jedem Fenster wird die Frequenz in der Kopfleiste angezeigt  
• 'LEDs' zeigen den Status an : Am sendenden Transceiver leuchtet eine rote LED, eine grüne  LED markierte den 

RX und die aktive Tastatur (kombiniert)   
• Am Hintergrund des Eingabefensters erkennen Sie den Status :  weiss = Run und hellgelb = S&P  
• Möglichkeit, die Frequenz des inaktiven Transceivers vom aktiven Eingabefenster durch ein vorangestelltes / zu 

ändern und diesen zu aktivieren  
• Der Modus “Loggen durch ENTER” (ESM) wird in beiden Fenstern unterstützt  
• Die Eingabe eines Rufzeichens in das zweite Eingabefenster beendet nicht die Sendung am Running-Transceiver  
• Die Eingabe von ESC beendet das Senden auf beiden VFOs, schaltet aber nicht die aktive Tastatur um  
• Die Umschaltung eines Transceivers auf Senden beendet das Senden auf dem anderen Transceiver vor dem 

Umschalten  
• Mit der CTRL-Taste können Sie auf dem anderen Transceiver F-Tasten-Texte starten (CTRL = anderer 

Transceiver)   
• "Hotkeys" (Kurzruftasten) für spezielle Funktionen auf dem anderen Transceiver (im Moment noch nicht 

programmiert))  
• Alle Tastenzuordnungen arbeiten mit beidem Transceivern (wenn nicht anders festgelegt)  
• Programm unterstützt  Top Ten DX Doubler und WX0B Station Master  
• Unterstützt SO2R, auch wenn die Transceiver kein Interface haben  
• Dueling CQ's sendet CQ ohne  Verzögerung abwechselnd auf beiden Transceivern (Ctrl+B).  
• Resume CQ auf dem Running-Transceiver startet CQ erneut, wenn auf dem S&P-Transceiver nicht gesendet wird 

(Ctrl+X).  

42.4 Die Eingabefenster (Entry Windows) 

Ordnen Sie die Fenster am besten so an, wie Ihre Geräte stehen (links/rechts oder oben/unten). Sie können die Fenster 
im View > Hide button zur besseren Schirmausnutzung verkleinern, die F-Tasten-Zeile wird dann abgeschaltet. 
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oder  

 

Öffnen Sie das zweite Fenster mit \  (DM3ML: oder mit CTRL-Pfeil links/rechts). 

42.5 Typische SO2R-Eingabefenster  (Typical SO2R Entry Windows) 

Meist reduzieren die OPs das zweite Fenster wie in dem Beispiel unten mit View > Hide Buttons . Sie rufen auf dem 
ersten Fenster CQ (VFO A) und machen S&P mit dem zweiten Fenster (VFO B).  
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Diese Anzeigen sind interessant : 

• LED-Grün  mit Schriftzug Ru = Transceiver im Running-Modus  
Eingabefensterhintergrund weiss 

• LED-Rot  = Transceiver aktiv , leuchtet hellrot beim Senden 
Ist in roten der LED ein R eingeblendet, ist auf wiederholtes CQ (Repeat) geschaltet 

• LED-Grün mit Schriftzug SP = Transceiver im S&P-Modus 
Eingabefensterhintergrund hellgelb 

• Blaue Anzeigen in beiden Fenstern rechts unten : Nächster ESM-Schritt 

Diese Anzeigen sind sowohl im SO2R- als auch im SO2V-Betrieb aktuell. Wenn Sie im S&P-Modus über die Bandskala 
drehen und sie kommen an einem gespotteten Rufzeichen vorbei, wird dieses Rufzeichen über dem Rufzeichenfeld des 
Eingabefensters bereitgestellt und kann mit einem Druck auf die Leertaste in das Rufzeichenfeld übernommen werden. 
Wenn Sie auf dem Running-Transceiver eine Station anruft, schalten Sie mit der Backslash-Taste \ oder CTRL-Pfeil 
links/rechts zwischen den Transceivern um. Die Rufzeichen bleiben in den jeweiligen Eingabefenstern solange aktiv, bis 
sie das QSO geloggt,  das Rufzeichen mit ALT-W oder CTRL-W gelöscht oder im S&P-Modus auf der Bandskala weiter 
gedreht haben. Im S&P-Modus können Sie mit Spot all QSOs Locally das eingegebene, aber nicht gearbeitete 
Rufzeichen in der Bandskala eintragen und für ein späteres QSO vormerken. 

42.6 Die SO2R-LEDs ( The SO2R dots (LEDs)) 

Sie sehen in den Eingabefenstern  die Imitation einer grünen und/oder einer roten LED. Die LEDs helfen Ihnen, mit 
einem Blick den Status des Eingabefensters und des von ihm gesteuerten Transceivers zu erfassen. Diese Anzeige ist 
Teil der Philosophie des N1MMLoggers, die dem Nutzer zeigen will, was in jedem Augenblick des Contests passiert. 
 
Die grüne LED zeigt an, das der VFO auf Empfang steht und die Tastatur aktiv ist. Eine rote LED zeigt an, dass der VFO 
senden kann. Das Senden selbst wird durch eine hellrote LED angezeigt. 
Die Buchstaben innerhalb der beiden LEDs liefern zusätzliche Informationen.  

Grüne LED  : Dieser VFO/Transceiver ist für RX und Tastatur aktiv (beides gehört zusammen) 

• In der LED steht Ru oder SP (Run/S&P). Ru zeigt an, dass die Station im Running-Modus ist, mit SP ist sie im 
S&P-Modus  

• Der RX/Tastatur-Status zwischen den VFO's/TCVRn wird umgeschaltet mit   
o Einem Mausklick an eine freie Stelle eines Eingabefensters  
o Mit der Taste  \  (Backslash)  

• Der Sende- UND Empfangstatus wird umgeschaltet mit   
o CTRL-Pfeil links/rechts   

Rote LED   : Dieser VFO/TCVR hat Senderechte  

• Die Senderechte können mit F10 (Änderungen möglich) umgeschaltet werden  
• Die Sende/Empfangszuordnung kann mit CTRL+Pfeil links/rechts umgeschaltet werden 
• Während des Sendens kann die Zuordnung nicht umgeschaltet werden 
• Hat ein  VFO/TCVR  Senderechte ist die LED dunkelrot. Wenn der VFO/TCVR sendet, ist die LED hellrot 
• Ein  R in der roten LED zeigt an, dass die CQ-Wiederholung (Repeat) aktiv ist  

42.7 Tastenzuordnung nur für SO2R  (Key Assignments (unique to SO2R)):  

• Backslash ( \ )  : Öffnet eine zweites Eingabefenster, wenn nur eins offen ist und   
o Bei einem TCVR : schaltet RX und TX  zwischen VFO-A und VFO-B um  
o Bei zwei Transceivern : schaltet RX und Tastatur hin und her   

• F10 :  schaltet Senderecht hin und her (F10-Funktion kann geändert werden)   
• CTRL+Pfeil links  : Schaltet bei SO2R auf den linken TCVR (RX/TX+Tastatur) bzw. bei SO2V auf den VFO-A  
• CTRL+Pfeil rechts  :  Schaltet bei SO2R auf den rechten TCVR (RX/TX+Tastatur) bzw. bei SO2V auf den VFO-B  
• ALT+ENTER  :  Sendet den nächsten ESM-Text auf dem anderen Transceiver/VFO (wenn ESM eingeschaltet ist)  
• CTRL+F1 to F8  : Sendet F-Tasten-Text auf dem anderen Transceiver/VFO  
• Ctrl+B  :  Dueling CQ's sendet abwechselnd CQ (ohne Wartezeit) auf den beiden Transceivern  
• CTRL+B  : Wiederholt CQ auf dem Run-TCVR, wenn auf dem S&P-TCVR nicht gesendet wird   

42.8 Mauszuordnung (Mouse Assignments ☺☺☺☺ 

• Linker oder rechter Mausklick  auf eine freie Stelle in den beiden Eingabefenstern schalten den RX-Status auf den 
zugehörigen TCVR/VFO um 

42.9 Programmeinstellungen  (SO2R menu (under Tools))  

Auf  SO2R und SO2V wird im Konfigurationsmenü umgeschaltet :  



N1MMLogger-Hilfe V.4.0.88 Seite 202 von 227 Übersetzung von Eike, DM3ML 

• Config > Configure Ports, Telnet Address, Other > Karteikarte Hardware  
 
Haben Sie  SO2V gewählt  : 
 

• Transceiver-CAT einstellen 
• Tastung einstellen (LPT auf BOTH oder Winkey) 
• Klicken Sie SO2V an 
• Schliessen Sie das Fenster mit OK  
• Starten Sie N1MMLogger, wählen Sie den Contest usw. 
• Öffnen Sie das zweite Eingabefenster mit Backslash \ oder CTRL-Pfeil links/rechts 

 
Haben Sie  SO2R gewählt : 
 

• Transceiver-CAT einstellen (getrennte Schnittstellen für beide Transceiver)  
• Tastung einstellen (LPT oder Winkey) 
• Klicken Sie  SO2R an 
• Wählen Sie im sich öffnenden Fenster (s.u.), welcher Transceiver rechts (right) und welcher links (left) steht 
• Click OK 
• Starten Sie N1MMLogger, wählen Sie den Contest usw. 
• Öffnen Sie das zweite Eingabefenster mit Backslash \ oder CTRL-Pfeil links/rechts  
• SO2R : ein TCVR mit CAT (1 computer radio)  + ein TCVR  ohne CAT  (1 manual radio),  also zwei Transceiver 
• SO2V : ein Transceiver mit CAT-Steuerung und  2 VFOs  

Modus  Transceiver mit CAT  Angewählt im Fenster  Auswahl  

SO2R Keiner  •  SO2R - Left Manual, Right Manual  automatisch 

SO2R 
einer 

(Kenwood) 
•  SO2R - Left Manual, Right Kenwood Com1  
•  SO2R - Left Kenwood Com1, Right Manual  

Von Hand wählen 

SO2R 
Zwei  

(Kenwood und  FT847) 
•  SO2R - Left Kenwood Com 1, Right FT847 Com 2  
•  SO2R - Left FT847 Com1, Right Kenwood Com 2  

Von Hand wählen  

SO2V 
Einer  

(Kenwood) •  SO2V - Kenwood  automatisch 

42.9.1 Tastung über LPT  (LPT keying) 

Wenn Sie mit  SO2V (und SO2R) arbeiten, müssen Sie in der Konfiguration die LPT von Radio 1 (voreingestellt) auf  
BOTH stellen. Sonst wird Ihr Radio 2 nicht getastet. 

42.10 SO2R mit DX Doubler oder SO2R Master ( SO2R Using DX Doubler or SO2R Master) 

N1MMLogger ist kompatibel zu den beiden Interfaces Top Ten Devices "DX Doubler"  und  der Array-Lösung von 
WX0B "SO2R Master".  Diese Geräte steuern Tastung, PTT und NF-Leitungen zu jedem Transceiver.  

Sie brauchen ein einfaches DB-25-Kabel von der LPT-Schnittstelle Ihres PCs zum  DB-25-Anschluss dieser Produkte. 
Informieren Sie sich über den Anschluss der Steuer- und Zubehörleitungen in den zugehörenden Handbüchern. Beide 
Produkte haben die gleiche Signalbelegung an der LPT-Schnittstelle. 
Bisher erwähnen aber beide Produkre die Einstellung für N1MMLogger. noch nicht Sie haben die Varianten 
CT/TR/Writelog und NA . Wählen Sie für N1MMLogger die Einstellung CT/TR/Writelog.  

 Stellen Sie N1MMLogger wie folgt ein :   

• Config > Configure Ports, Telnet Address, Other  > Karteikarte Hardware  
• Wählen Sie eine (!)  LPT -Schnittstelle   
• Klicken Sie auf die Set – Taste der LPT-Schnittstelle  
• Klicken Sie auf Radio Nr und wählen Sie BOTH 
• Klicken Sie auf  OK  

 
Hinweis : Die DX-doubler-Leiterplatte hatte mehrere Fehler. Gehen Sie zu  http://www.qth.com/topten/appnotes.htm  
und informieren Sie sich über Modifikationen 

42.10.1 Winkey mit SO2R verwenden (Using Winkey with extern al SO2R controllers) 
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Das Gerät Winkey arbeitet ebenfalls mit zwei Transceivern. Der Ausgang Pin3 von  WinKey ist normalerweise CW und 
Pin 5 ist PTT. Unter Steuerung des Programms kann Pin 3 den Transceiver 1 in CW und Pin 5 den Transceiver 2 in CW 
tasten. Die serielle Schnittstelle, an die Winkey angeschlossen ist, muss auf Radio Nr both gesetzt werden. Zusätzlich 
muss auf der Karteikarte Hardware  der Betrieb SO2R aktiviert werden. Gehen Sie dannn zur Karteikarte WinKey  und 
setzen Sie die Funktion von Pin 5  auf 2nd CW . 
Der Ausgang K  der Winkey-Leiterplatte geht an Transceiver 1 CW und P an Transceiver 2 CW.  N1MMLogger steuert 
die richtige Auswahl des richtigen Transceivers. 

42.11 Transceiversteuerung unter SO2R ( Transceiversteuerung unter SO2R  (SO2R Radio Support)) 

Alle früher aufgezählten Transceiver arbeiten auch unter SO2R. Viele OPs wollen ältere Transceiver, die noch ohne 
Computersteuerung arbeiten, bei SO2R verwenden. N1MMLogger ermöglicht jede Kombination von CAT-gesteuerten 
und TCVR ohne CAT-Steuerung. Wenn Sie einen TCVR ohne CAT-Steuerung einbeziehen, stellen Sie für diesen TCVR  
keine COM-Schnittstelle ein. Sie benötigen eine COM-Schnittstelle nur, wenn der Transceiver über den PC gesteuert 
werden kann.  

Sie legen unter der SO2R-Einstellung unter Config > Config Ports > Karteikarte Hardware   fest, welcher der 
Transceiver (rechts/links) über eine COM-Schnittstelle gesteuert wird und welcher von Hand (manual) bedient wird. 

42.12 SO2R und MMTTY (SO2R and MMTTY) 

Nachstehend finden Sie einige Informationen für SO2R mit MMTTY :  
(Anmerkung DM3ML :  Sie benötigen zwei Soundkarten in Ihrem PC) 

• Erzeugen Sie zwei getrennte Verzeichnisse mit zwei getrennten Installationen von MMTTY. Sie können damit zwei 
getrennte Profile anlegen. 

• Tragen Sie die beiden Pfade für die Interfaces DI-1 und DI-2 unter Config > Configure Ports, Telnet Address, Other 
> Karteikarte Digital Modes ein . 

• Öffnen Sie das Programm MMTTY im ersten digitalen Fenster  
• Gehen Sie in das MMTTY/Setup und wählen Sie in der Karteikarte MISC eine  der Soundkarten-Nummer 0,1,2,3 , 

wählen Sie NICHT  -1. 
• Öffnen Sie das Programm MMTTY im zweiten digitalen Fenster  
• Gehen Sie in das MMTTY/Setup und wählen Sie in der Karteikarte MISC eine  der Soundkarten-Nummer 0,1,2,3 , 

wählen Sie NICHT  -1 und nicht die Nummer vom ersten Fenster 
• Bei einem Neustart müssen Sie MMTTY noch einmal die gewählten Soundkartennummern mitteilen  
• Nach einem weiteren Neustart sind diese Werte in den MMTTY-Profilen hinterlegt und bleiben gespeichert 

Noch ein Hinweis : Mit der zweiten COM-Schnittstelle, die sie für das zweite MMTTY-Programm festgelegt haben, wird 
auch die PTT für das zweite digitale Fenster geschaltet 

42.13 Beispiel für einen Bildschirm  (Example screen layout) 

Das unten abgebildete Schirmbild stammt vom 17”-Monitor von K2KW.  Beachten Sie die Symmetrie für dem linken und 
den rechten VFO mit den Bandskalen und dem zugehörigen Logeingabefenster. Gemeinsam genutzte Informationen wie 
das Logfenster und das Rufzeichenprüffenster stehen in der Mitte. Natürlich können Sie die Fenster nach Ihren 
Wünschen anordnen….. 
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43. Unterstützte Transceiver (Supported Radios) 

Informieren Sie sich vorher im Kaptitel Geräteanschluss (Interfacing) 

 
Hinweis : Nicht alle aufgeführten Eigenschaften stehen bei allen Transceivern und allen unten aufgeführten Herstellern 
zu Verfügung. So weit bekannt, haben wir auf bekannte Probleme hingewiesen. Bitte informieren Sie uns, wenn Sie 
Hinweise haben,  die hier wiedergegeben werden sollten. 

43.1 Gilt für alle (General)  

• Wenn Sie ein selbstgebautes und von der Schnittstelle gespeistes Interface verwenden setzen Sie :  
o DTR - Always On 
o RTS - Always On  
o Gilt auch für ICOM-Clone-Kabel 

• Alle Transceiver : ein Bandwechsel während des Sendens ist verboten 
• Gilt für alle Transceiver : es ist eine maximale Einschaltzeit von 10 s eingestellt (einstellbar)0 seconds (user 

settable).  
o Eine Warnmitteilung erscheint, wenn der Transceiver nicht auf Kommandos antwortet Er wird dann auf 

manual geschaltet.  
o Wollen Sie die Verbindung zum Transceiver wieder herstellen, klicken Sie rechts in die Bandskala und 

wählen Sie Reset radios. 
o Die 10 s werden mit jedem Senden neu gestartet. 
o Wenn die Transceiversteuerung eine Warnung 10s nach dem Start von N1MMLogger gibt, obwohl Sie 

keinen Vorgang ausgelöst haben, überprüfen Sie die Hardware und die Einstellung der seriellen 
Schnittstelle. Informieren Sie sich im Transceiver-Handbuch und lesen Sie unten nach. 

• Die Abfrage des Transceivers während des CW-Sendens wird für alle Transceiver mit Ausnahme des FT-1000 
unterstützt.. 

• Es kann passieren, dass die Pfeile Up Arrow, Down Arrow , Page Up  oder Page Down  beim Hoch- und 
Runterschieben der Frequenz nicht arbeiten :  

o Die VFO-Frequenz wird nicht geändert, wenn die geforderte Schrittweite kleiner ist, als der 
angesprochene Transceiver pro Schritt macht. Diese Eigenschaft ist meist in den Handbüchern nicht 
näher beschrieben. 

o Der Icom 751 macht 10Hz-Schritte mit, obwohl in der Skala nur bis 100 Hz angezeigt wird. 
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o Die oben genannten Tasten sind so zu programmieren, dass die von den Tasten erzeugten 
Frequenzsprünge gösser als die minimale Schrittweite der Transceiver ist. 

o Testen Sie die Tasten, ob sie wie gewünscht funktionieren. Wenn nicht, korrigieren Sie die Einstellung.  
o Die voreingestellte Schrittweite für CW ist 10 Hz. Versuchen Sie es mit 100 Hz unter Configurer > Other.  
o Die Angaben treffen nur auf die Tasten zu, die die aktuelle Frequenz verstellen sollen.   

43.2 Icom  

• Die meisten Geräte benötigen ein Interface ICOM CT-17 für das Signalspiel CI-V oder eine kompatible Lösung. Sie 
finden Unterlagen zu dem CI-V-Iinterfaces unter  http://www.plicht.de/ekki/civ/civ-p2.html und 
http://www.eham.net/reviews/products/53  

• IICOM-Geräte arbeiten mit Softwarehandshaking. Sie benötigen die Signale DTR und RTS nicht. Werden die 
Interfaceschaltungen aus der RS232-Schnittstelle mit Betriebsspannungen versorgt, sollten DTR und/oder RTS auf 
Always On gesetzt werden. Sehen Sie in den Interface-Datenblättern nach, wie DTR und RTS gesetzt sein 
müssen.  

• Setzen Sie  N1MMLogger und den Transceiver auf :   
o Adresse : entsprechend der am Gerät eingestellten Hexa-Adresse zwischen 00 und 7F 
o Baudrate :  9600 oder 19200 (siehe Gerätehandbuch) 
o 8 Datenbits :  8 bits 
o keine Parität (N) 
o 1 Stoppbit  

• Stellen ie am Transceiver ein :   
o CI-V Transceive auf OFF  : Diese Einstellung sehr wichtig ! Wenn der Transceiver auf ON steht, meldet 

er jefe Frequenzänderung, diese Funktion bringt den mit einer Abfrage (Polling) arbeitenden 
Rechner durcheinander und führt zu Fehlermeldungen und Fehlanzeigen. Bei schnellen Rechnern 
können Sie es mit ON versuchen.  

o CI-V with 731/735 auf OFF. : Der IC-735 arbeitet mit 4 Byte zur Frequenzdarstellung, alle späteren 
ICOM-Geräte mit 5 Byte. Die 4-Byte-Darstellung kann nur beim IC-735 verwendet werden, sonst 
muiss sie abgeschaltet sein.  

• VFO A=B wird an ICOM-Geräte vor der Umstellung auf Splitfrequenz gesendet 
• ICOM-Geräte melden die Frequenzen von VFO A und VFO B nicht getrennt an den PC. Erst mit der Umschaltung 

A/B werden die beiden Bandskalen nach Frequenz und Sendeart richtig gefüllt. Mit CTR-Linkspfeil kommem Sie zu 
VFO-A und mit CTRL-Rechtspfeil zu VFO-B und in die richtige Bandskala. 

Diese ICOM-Modelle werden unterstützt :  

• IC-1275A/E nit Adresse 18 hex und 9600 Baud 
• IC-275A/E/H mit Adresse 10 hex und 9600 Baud 
• IC-475A/E/H mit Adresse 14 hex und 9600 Baud. 
• IC-706 mit Adresse 48 hex und 19200 Baud 
• IC-718 mit Adresse 5E hex und 19200 Baud  

o Setzen Sie  N1MMLogger auf 19200 Baud und den Transceiver auf 
"AT". Es gibt Berichte, das die Einstellung "HI"  das gleiche sein soll 
wie 19200. Schreiben Sie uns eine Email, wenn Sie wissen was "HI" 
bedeutet. 

• IC-725 mit Adresse 28 hex und 9600 Baud (Anmerkung DM3ML : Internen 
Jumper umstecken !) 

• IC-728 mit Adresse 38 hex und 9600 Baud 
• IC-729 mit Adresse 3A hex und 9600 Baud 
• IC-735 mit Adresse 04 hex und 9600 Baud (Anmerkung DM3ML : Internen 

Jumper umstecken !) 
� Datenlänge 4 Bytes beachten ! 

• IC-736 mit Adresse 40 hex und 9600 Baud 
• IC-737/737A mit Adresse 3C hex und 9600 Baud 
• IC-738 mit Adresse 44 hex und 9600 Baud 
• IC-746 mit Adresse 56 hex und 19200 Baud  
• VFO-B ist ein virtueller VFO,.so lange er nicht aktiviert ist. Die Skale wird 

nicht vom VFO-B gesteuert. Er wird erst zum aktiven VFO, wenn er aktiviert 
wird. Der IC-746 wird auf VFO-B geschaltet und auf die in der Bandskala B 
angezeigte Frequenz gesetzt. . (Anmerkung DM3ML: Dieses Verhalten 
wurde inzwischen abgestellt. VFO-B wird normal angezeigt)   

• IC-746 PRO mit Adresse 66 hex und 19200 Baud 
• IC-751/751A mit Adresse 1C hex und 9600 Baud  

� Wir wissen nicht, ob das Gerät für die CI-V die Funktion 
Transceive hat und das Datenformat wie IC-735/731 hat. 
Schreiben Sie uns eine Email, wenn Sie es wissen ! 

� Das Gerät kann nicht auf Splitfrequenz oder Duplex 
geschaltet werden 

� Das Gerät benutzt ein altes CI-IV -System und benötigt den 
Zusatz UX-14 um an CI-V angeschlossen werden zu 
können.. 

• IC-756 mit Adresse 50 hex und 19200 Baud 
• IC-756 PRO mit Adresse 5C hex und 19200 Baud 



N1MMLogger-Hilfe V.4.0.88 Seite 206 von 227 Übersetzung von Eike, DM3ML 

• IC-756 PRO II mit Adresse 64 hex und 19200 Baud 
• IC-761 mit Adresse 1E hex und 9600 Baud  

� Das Gerät kann nicht auf Splitfrequenz oder Duplex 
geschaltet werden 

• IC-765 mit der Adresse 2C hex und 9600 Baud 
• IC-775/775DSP mit der Adresse 46 hex und 19200 Baud 
• IC-781 mit der Adresse hex und 9600 Baud 

43.3 Kenwood  

• Alle Modelle werden unterstützt   
o Neuere Modelle sind direkt anschliessbar 
o Für ältere Modelle wird ein Interface Kenwood IF-10 oder IF-

232C benötigt (oder eine kompatible Lösung)  

• Software handshaking wird verwendet  

• Kenwood  ist so voreingestellt :  
o Speed: 4800 Baud  
o Parity: N  
o Databits: 8  
o Stopbits: 2 (!!, wichtig !)  
o Beim Splitbetrieb werden beide VFOs auf die gleiche Sendeart 

gestellt 

• TS-570  
o Wenn Sie die Buchse ACC2  an der Geräterückseite 

verwenden, müssen Sie sowohl das NF-Signal als auch das 
PTT-Signal über diese Buchse einspeisen. Das PTT-Signal 
schaltet den Mikrofoneingang ab und die NF von der ACC-
Buchse zu  

• TS-2000  
o Verwendet 9600 Baud und 1 Stopbit (bei 4800 Baud müssen 2 

Stopbits verwendet werden) 
o Auch Frequenzen über 100 MHz  werden verarbeitet 

43.4 TenTec  

Die folgenden Modelle werden unterstützt. Nicht aufgeführte Modelle werden nicht unterstützt..  

• OMNI-VI  
� Vewrendet den gleichen Kode wie der ICOM-735, zusätzlich 

wird die PTT gesteuert. 

 

• ORION  
o Firmware mit Version 1.363 oder später wird benötigt 
o PTT kann mit dem ORION nicht per Kommando gesteuert werden 
o Voreingestellte Bandbreiten : CW: 300/800; SSB: 2000/2800; RTTY 

250/400 
o CW auf dem Haupt-RX ist LCW. 
o Unterstützt die DVK via AUX-Buchse 
o Schmale SSB-Bandbreite ist gesetzt auf 1990 Hz, das 2.4 kHz - Filter 

wird im Auto-Modus angeschaltet. 
o Beispiel für die Einstellung : FSK/CW/SSB  

� In FSK oder SSB benutzt das Programm den PTT-Eingang 
zum Schalten auf Senden 

� In CW benutzt das Programm die PTT zum Tasten der CW   
• Digital-Einstellung und MMTTY  

o N1MM Config > Config Ports > 
Hardware   : Wählen Sie DTR (Pin 4) 
für CW 

o MMTTY Einstellung : MMTTY > TX > 
Radio command  : Wählen Sie PTT 
unter DTR/RTS 

43.5 Yaesu  

Diese Modelle werden unterstützt :  
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• FT-100 
• FT-817 
• FT-840 
• FT-847  
• FT-857 (select FT-817 as radio)  
• FT-890 
• FT-900 
• FT-920  
• FT-990  
• FT-1000(D) 
• FT-1000MP  
• Benötigte Interfaces :  

o Neuere Modelle können direkt mit der seriellen Schnittstelle des PC 
verbunden werden  

o Ältere Geräte benötigen ein Yaesu FIF-232C CAT-Interface (oder eine 
kompatible Lösung). 

• Software handshaking  wird verwendet  
• Yaesu  nutzt die Voreinstellung :  

o Baudrate: 4800 Baud  
o Parity: N  
o Databits: 8  
o Stopbits: 2 (!) Neuere Modelle scheinen mit einem Stoppbit 

auszukommen 
• FT-100D  

o Der FT100D hat einen internen Jumper für entweder CAT/TUNER 
oder LINEAR. Er ist auf CAT/TUNER. zu setzen  

o Konfigurieren Sie den Transceiver als FT-100, 4800, N, 8, 2, 
Handshake, Tx=1, DTR=CW, RTS=PTT.  

o Sie benötigen ein Kabel FT-100 CAT (CT-62).   
• FT-847  

o Split-Betrieb kann über CAT nicht eingestellt werden, muss von Hand 
eingestellt werden  

o RIT und XIT aus der Bandskala wird ebenfalls vom FT847 nicht 
unterstützt  

o Frequenzen über 100 MHz  können verwendet werden 

• FT-857  : Wählen Sie FT-817 als Gerät  
• FT-920 : PTT via CAT wird unterstützt 
• FT-1000 : Folgt die Bandskala nicht dem Transceiver, schalten Sie mit dem 

VFO/MEM – Schalter vom Memory auf VFO. N1MMLogger schaltet den 
FT-1000 bei Start auf den VFO-Modus. 

• FT-1000MP (Mark-V)(Field)  

o Informieren Sie sich im Kapitel Tastenzuordnungen (Key 
Assignments) über die Tasten CTRL-F9 und CTRL-F12 

o Das Programm kann kein CW über das serielle Kabel zum Gerät 
senden. Sehen Sie in der Hilfe nach, wie Sie ein CW-Interface 
bauen können. 

� Folgt die Bandskala nicht der VFO-Abstimmung schalten 
Sie mit dem VFO/MEM-Schalter auf VFO. N1MMLogger 
setzt den FT1000MP beim Programmstart in diesen 
Modus. 
 

o Verwenden Sie ein 1:1 durchverbundenes serielles Kabel 
o Stellen Sie 4800 Baud und Datenformat 8N2 ein. DTR+RTS auf 

Allways Off  

• FT-1000-Serie, FT-990 und FT-920 Filtereinstekllung en : Klicken Sie rechts 
in die Bandskala und öffnen Sie das Menü Set transceiver filter codes .mit 
sechs Untermnüs : CW Wide, CW Narrow, SSB Wide, SSB Narrow, Digi Wide 
und Digi Narrow.  

• Die Einstellungen in der Tabelle funktionieren mit FT-1000, FT-1000D,  FT-
1000MP, FT-1000MP/MKV und t FT-1000MP/MKV Field (oder jede 
Kombination von zwei  Geräten aus der Familie FT-1000  beim SO2R-Betrieb)  

• Für SO2R (zwei Geräte) stellen Sie beide Bandskalen wie folgt ein :  

Filter  Bandbreite  Einstellung  Bemerkungen  

CW Wide  500 Hz 0 0 0 2 140   

CW Narrow  250 Hz 0 0 0 3 140   
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SSB Wide  2.4 KHz 0 0 0 0 140   

SSB Narrow  2.0 KHz 0 0 0 1 140   

Digi Wide  2.0 KHz 0 0 0 1 140 Doppelt die Voreinstellung 

Digi Narrow  500 Hz  0 0 0 2 140 Doppelt die Voreinstellung 

Digi Wide  500 Hz 0 0 0 2 140 Optional 

Digi Narrow  250 Hz 0 0 0 3 140 Optional  

Die Filtereinstellung auf der Bandskala des VFOB Bandmap für den Zweit-Empfänger unterstützt nur die 
Bandbreiten :  6.0 KHz, 2.4 KHz und 500 Hz.  

Filter  Bandbreite  Einstellung  Bemerkungen  

CW Wide  500 Hz 0 0 0 130 140   

SSB Wide  2.4 KHz 0 0 0 128 140   

Digi Wide  500 Hz 0 0 0 130 140   

 
Einige Hinweise : 
  

• Die gedoppelte Voreinstellung triftt nur auf den F1000 MK/V und Field zu. Der FT-1000/D/MP erlaubt eine flexilere 
Filterwahl. 

• Der FT-920 hat keine 2.0 KHz und 250 Hz-Filter. Es macht mehr Sinn, die CW und Digimode-Einstellung auf 
2.4/500 Hz (0 0 0 0 140 und 0 0 0 2 140)-Filter zu setzen. 

• Der FT-920 hat keinen Zweit-RX, man kann aber unterschiedliche Bandbreiten für die beiden VFOs wählen. Die 
CAT-Kommandos sind die gleichen wie für den Zweit-RX der 1000er-Serie: 0 0 0 130 140 wählt das 500 Hz-  und 
0 0 0 128 140 das 2.4 KHz-Filter. 

• Die FT-990-Kommandos sind die gleichen wie für VFO A der 100er-Serie 

43.6 Andere Marken (Other brands) 

Elecraft K2   

verhält sich in Bezug die Schnittstelle und alle Kommandos wie ein Kenwood-Transceiver. Nur das Elecraft-spezifische 
KY-Kommando wird nicht unterstützt 

• Einstellung der Wide (breit) und Narrow (schmal) – Filterkodes :   
• Stellen Sie die Filterkodes für beide VFOs ein. Klicken Sie rechts in die zugehörige Bandskala.  
• Ersetzen Sie den Kode den kompletten Kenwood-FL-Kode, der mit der Voreinstellung kommt durch : 

K22;FW99991;K0;   (keine Zwischenräume, alles Großbuchstaben, Semikolon nicht vergessen) 
Dieses Kommando setzt das Filter auf FL1 im K2.  Wenn Sie den Kode unter SSB "Wide" eintragen, wird FL1 bei 
SSB eingeschaltet. Wenn Sie den Kode bei CW "Wide" eintrage, wird FL1 bei CW eingeschaltet. Die aktuelle 
Bandbreite hängt davon ab, wie Sie FL1 in Ihrem K2. eingestellt haben,  Wenn Sie ein anderes Filter haben 
wollen, ersetzen Sie die "1" nach der 9999 durch eine Ziffer 1,2,3 or 4. Ein Beispiel ist  K22;FW99993;K0; , das in 
der Sektion CW "Narrow" eingetragen ist und das Filter FL3 einschaltet, wenn der Transceiver auf "Narrow" und in 
CW steht. 

• , "K22" teilt dem K2  mit, dass es sich um ein "extended command mode" (erweiterter Kommando-Modus) handelt. 
Die  ";" teilen dem K2 mit, dass das Kommando beendet ist.  "FW" setzt die Filterbandbreite, die Zahl 9999 wird 
ignoriert und die "1" gibt das Filter vor. Erlaubt sind (1 - 4) . Mit  "K0" geht der K2 in den  "normal command mode." 
zurück. 

• Sie können mit der gleichen Technik die RTTY-Filter einstellen  

Have fun es 73  --don n4hh  

• Andere Marken werden (im Moment) nicht unterstützt  
 

44. Beispiele für die F-Tasten (Example Function Keys) 

Nachstehend finden Sie einige Beispiele für die F-Tasten in SSB/CW/RTTY – Kontesten  : . 

44.1 CW 

Diese CW-Tasten sind voreingestellt. Die Tasten F3 bis F8 sind unter S&P nicht getrennt belegt, es wird die Einstellung 
des Running-Modus übernommen.   
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Run S&P 

F1 CQ cq~test~de~*  F1 {MYCALL} *  

F2 {Exch} <<<5nn >>>{EXCH}  F2 5NN {EXCH} <<<< 5nn >>>> {EXCH}  

F3 TU TU de *    

F4 {MYCALL} *    

F5 His Call !    

F6 QSO B4 QSO B4 de *    

F7 ? ?    

F8 Agn Agn    

44.2 SSB 

WAV-Dateien können im Verzeichnis von N1MMLogger abgelegt werden, solange der richtige Pfad in den Dateinamen 
der F-Tasten angegeben wird. Die WAV-Dateien sollten in einem Unterverzeichnis unter ..\wav\<datei>.wav oder unter 
dem Kontestnamen z.B. arrldx\<datei>.wav  abgespeichert werden.  

44.3 RTTY 

44.3.1 Beispiel  WPX RTTY 

Die Texte wurden frei von der Seite von AA5AU's unter http://www.rttycontesting.com/rttymessages.html übernommen. 
Die Beispiele stammen aus einem anderen Kontestprogramm. Die Makros wurden aber an N1MMLogger angepasst. 
Wer mit den Makros nicht so vertraut ist, kann sich hier über die “Übersetzung” informieren.  Die Tasten können auch im 
ESM-Modus ähnlich wie beim WPX-RTTY verwendet werden.   

Run S&P 

F1 CQ {TX} CQ TEST DE * * CQ{RX}  F1 CQ {TX} CQ CQ DE * * CQ{RX}  

F2 Exch 599 {EXCH} {EXCH} ! BK{RX} F2 Exch {TX}{ENTERLF} DE * TU 599 {EXCH} {EXCH} {EXCH} BK{RX}  

F3 TU {TX}{ENTERLF} ! TU DE * QRZ?{RX}  F3 TU {TX} ! TU {RX}  

F4 {MYCALL} {TX} DE * K{RX} F4 Call Him {TX} DE * * * K{RX} 

F5 His Call {TX}{ENTERLF} ! F5 1x1  {TX} ! DE * K{RX}  

F6 QSO B4 {TX} B4 DE * CQ{RX}  F6 0x1  {TX} DE * K{RX} 

F7 Rpt Exch {TX} {EXCH} {EXCH} {EXCH} {EXCH} K{RX}  F7 Rpt Exch {TX} {EXCH} {EXCH} {EXCH} {EXCH} {EXCH} BK{RX} 

F8 Agn {TX} AGN AGN DE * K{RX} F8 Agn {TX} AGN AGN de * K{RX}  

Sie können diese Tastenbelegung auch für andere Konteste abwandeln und dann unter einem anderen Namen 
abspeichern, der Satz oben ist unter WPX_RTTY.mc abgespeichert. Ich habe den Austausch mit der Taste F2 für 
Running und S&P getrennt belegt. 
Unter Running wird aus der Taste F3 von AA5AU die Kombination F5+F2. Wenn Sie ESM nicht verwenden wollen, 
können Sie F5 und F2 zu einer Message zusammenfassen. Ich habe das ! am Ende zugefügt. AA5AU macht das in der 
Taste F8, aber nicht bei F3. . 
Bei S&P benötigen Sie das Rufzeichen der Gegenstation nicht beim Nummernaustausch, ich habe daher bei der Taste 
F2 das Rufzeichen ! durch eine dritte Seriennummer ersetzt, auch das DE habe ich vom Anfang an das Ende gesetzt. 
AA5AU verwendet zwei Tasten zur Wiederholungsanforderung, eine für das Rufzeichen F6 und eine für die Nummer 
F10. Ich habe beide Abfragen zu AGN in F8 kombiniert, vor allem weil im Running-Modus die Zahl der Tasten begrenzt 
ist.  Sie haben aber im Digital-Fenster eine ausreichende Anzahl an Tasten zur Verfügung. 

73, Rich VE3IAY  

44.3.2 Beispiel für den RTTY Sprint  

Run S&P 

F1 CQ {TX} CQ NA DE * *  NA{RX} F1 CQ {TX} CQ NA DE * * NA{RX} 

F2 Exch * {EXCH} BK{RX} F2 Exch {TX}{ENTERLF} ! {EXCH} * K{RX} 

F3 TU {TX} TU{ENTERLF}{RX} F3 His Call {TX} ! {RX}  

F4 {MYCALL} {TX} DE * K{RX} F4 {MYCALL} {TX} DE * * K{RX}  

F5 His Call {TX}{ENTERLF} ! F5 NR {TX} # # # K{RX} 

F6 QSO B4 {TX} B4 DE * CQ{RX} F6 NAME {TX} RICH RICH RICH BK{RX} 

F7 Rpt Exch {TX} ! DE * {EXCH} {EXCH} K{RX} F7 QTH {TX} ON ON ON BK{RX} 

F8 Agn {TX} AGN AGN DE * K{RX}  F8 Agn {TX} AGN AGN DE * K{RX}  

73, Rich VE3IAY  

45. Rufzeichenprüfung (Call Checking) 
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Das von Dave Robbins, K1TTT's, geschriebene Programm zur Rufzeichenprüfung wurde nach N1MMLogger 
übernommen. Geprüft wird als erstes, ob es sich um ein mögliches Amateurfunkrufzeichen handelt. Sie erhalten eine 
Warnung, wenn an dem Rufzeichen etwas nicht stimmt. Die Mitteilung wird im Check -Fenster ausgegeben. Hier ist das 
Rufzeichen im Rufzeichenfeld anscheinend vertippt worden :  

       

Die Prüffunktion arbeitet NUR auf Kurzwelle ohne WARC und in CW/SSB. Sie arbeitet NICHT  in RTTY,  NICHT auf 
UKW und NICHT in den WARC-Bändern.  

 
****WARNUNG**** Wenn Sie der Meinung sind, richtig gehört zu haben,  können Sie das Rufzeichen trotzdem 
übernehmen. Funkverwaltungen geben Rufzeichen aus, die vom Programm als fehlerhaft beurteilt werden, a ber 
nicht falsch sind.  

45.1 Rufzeichenschema aktualisieren  (Updating the pattern file) 

Die Bildungsregeln für Rufzeichen stehen in der Datei callsign.pat  , die im N1MMLogger-Verzeichnis zu finden ist. Die 
Datei enthält allgemeine und länderspezifische Bildungsregeln. Da aber die Fernmeldeverwaltungen in aller Welt sich 
ständig neue Rufzeichen ausdenken, muss das Programm ständig aktualisiert werden. Finden Sie Rufzeichen, die vom 
Programm abgelehnt werden, aber gültige Rufzeichen sind, teilen Sie es uns bitte mit.  

Wollen Sie die Datei callsign.pat editieren (z.B. mit Notepad) beachten Sie bitte :  

• Zeilen, die mit einem ! beginnen, sind Kommentarzeilen und werden vom Programm ignoriert 
• Die Zeilen wechseln miteinander ab, die jeweils erste enthält die Fehlermeldung, die zweite die Bildungsregeln in 

verschlüsselter Form  
• Auf die Text-Mitteilung folgt eine kryptische Zeile, die nur maschinenlesbar ist und die Regel enthält. 

Wenn Sie die Regeln durchsehen, halten Sie sich an die Fehlerausschrift, sie gibt an, wo das Problem liegt. Informieren 
Sie uns, welche Rufzeichen mit welcher Fehlerausschrift markiert worden sind und helfen Sie uns, das Programm aktuell 
zu halten. 
Das Programm enthält etwa 200 Regeln zur Rufzeichenbildung, kann aber leicht erweitert werden 

 
Bitte ändern Sie die Regeln nicht für sich allein. Teilen Sie uns Ihre Erkenntnisse mit, damit sie all en eine Hilfe 
sein können. Schreiben Sie uns auch die Bildungsreg eln der Rufzeichen Ihres Landes.  

45.2 Bildungsregeln  (The pattern file) 

Die Bildungsregel beschreibt, wie ein falsches Rufzeichen aussieht. Wird bei der Rufzeicheneingabe kein möglicher 
Fehler festgestellt, wird angenommen, dass das Rufzeichen richtig ist. 

45.2.1 Komponenten  (Components ) 

Die Komponenten einer Regel sind :  

Einzelne Zeichen  

A  entspricht dem Buchstaben  'A' 

1  entspricht der Ziffer '1' 
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 usw. 

   

Wiederholungsmarke   wird gefolgt von einer 
Zeichenspezifikation:   zu einer Phrase wie :  

:  eine Übereinstimmung   N  stimmt mit jedem Zeichen  (A-Z, 0-
9) überein 

  :D  stimmt mit einer beliebigen Ziffer überein 

+  eine oder mehrere 
Übereinstimmungen 

  A  
stimmt mit jedem Buchstaben 
überein 
(A-Z) 

  +A  
stimmt mit einem von allen Zeichen überein 

*  stimmt mit keinem oder mehr 
Zeichen überein 

  D  stimmt mit jeder Zahl (0-9) überein    *N  stimmt mit keiner oder beliebigen 
Buchstaben oder Ziffern überein  

-  optimale Übereinstimmung        -D  stimmt mit einer Ziffer überein 

   

Übereinstimmung in Zeichengruppen:   Beispiele für Zeichengruppen  

[ ]   Übereinstimmung    [ABCFXZ]   Übereinstimmung mit A,B,C,F,X und Z 

!  Übereinstimmung mit allen Zeichen ausgenommen die in der Liste    [!ABC]   Zeichen A,B und C nicht in Gruppe enthalten  

-  Übereinstimmung mit einer Gruppe von Zeichen   [!A-R]  Zeichen A-R nicht in Gruppe enthaltenr 

Weitere Informationen betreffen die Einbeziehung von Bändern und Sendearten (s.u.)  

45.2.2 Beispiele (Examples) 

Es folgen einige Beispiele für Übereinstimmungen und Nicht-Übereinstimmungen :  

 

Muster   Übereinstimmende Muster    Nicht übereinstimmende Muster   

:A:D    A1  Z0  Q8  :A:D    A1  Z0  Q8  :A:D    A1  

+A:D    A1  AA1  ABC1  +A:D    A1  AA1  ABC1  +A:D    A1  

*A:D    1  19  A1  *A:D    1  19  A1  *A:D    1  

F:D    F1  F2  F9  F:D    F1  F2  F9  F:D    F1  

[ABC]B:D     AB1  CB1  BB9  [ABC]B:D     AB1  CB1  BB9  [ABC]B:D     AB1  

[!ABC]B:D     ZB1  DB9  QB0  [!ABC]B:D     ZB1  DB9  QB0  [!ABC]B:D     ZB1  

45.2.3 Wonach wird gesucht ?  (What are we trying to match) 

Es wird nach falschen Rufzeichen gesucht. Wenn eins gefunden wird, erscheint die Meldung im Check-Fenster. Was ist 
ein falsches Rufzeichen ? : 

• Rufzeichen, das mit drei Buchstaben beginnt 
• Rufzeichen, das mit B beginnt, aber ein Prefix hat, das NICHT BT,BV,BY,BZ lautet 
• Französisches Rufzeichen mit einer 1 oder 6  im Call, aber keinem 3-Buchstaben-Suffix 
• Ostdeutsches Rufzeichen, das nicht auf A bis O endet ((East Germany gibt es eine Weile nicht mehr, es ist 

aber ein sehr gutes Beispiel)  

Einige Funkverwaltungen haben Rufzeichen eingeführt, die nur für bestimmte Bänder oder Sendearten zugelassen sind, 
z.B. HJ nur in CW auf 40m und SSB auf 80m. Diese Angaben müssen zusätzlich bei den Bildungsregeln eingeführt 
werden. Sie werden mit einem = an die Rufzeichen mit Kombinationen angehängt :  

=3C     '3' bedeutet 40m und "C" bedeutet CW, hier also nur  40m CW. 
=4        '4' bedeutet 20m und jede Sendeart 
=:DS   heisst SSB auf allen Bändern und bedeutet einen Fehler, wenn das Rufzeichen in SSB  gefunden wird 
=[1456]S  bedeutet einen Fehler auf 160, 20, 15, oder 10m  in SSB 

Bevor das Rufzeichen geprüft wird, werden Zusätze wie  /QRP, /A, /MM, /CT3 usw. abgetrennt. 
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Sehen wir uns jetzt die Regeln für die oben schon vorgestellten Fälle an  

1. Rufzeichen beginnt mit 3 Buchstaben  
Diese Regel ist einfach, geprüft wird auf drei aufeinanderfolgende Buchstaben vom Typ :A. Die Regel lautet :   
:A:A:A 
Dieser Fehler wird schon bei der Eingabe der ersten Zeichen erkannt, das Rufzeichen muss nicht weiter eingegeben 
werden. 

2. Rufzeichen fängt mit B an und hat andere Prefixe  als BT,BV,BY,BZ  
Hier werden die ersten beiden Buchstaben des Rufzeichens ausgetestet. Der erste muss ein B sein, der zweite muss in 
der Gruppe ‚TVYZ' enthalten sein. Ein Fehler liegt vor, wenn das Rufzeichen mit B anfängt und der zweite Buchstabe 
nicht in dieser Gruppe enthalten ist :   
B[!TVYZ]  
Hier wird das Rufzeichen schon nach zwei Zeichen als fehlerhaft erkannt. 
Anmerkung DM3ML : Rufzeichen in Taiwan inzwischen erweitert z.B. BO 
 

3. Französische Rufzeichen mit einer  1 oder 6 und keinem 3-Buchstabensuffix  
Gesucht wird nach F1- oder F6-Rufzeichen, die weniger als drei Buchstaben nach der Ziffer haben :  
F[16]:A-A=  
’:A-A’ steht für zwei beliebige Buchstaben. Das = schliesst die Regel ab. ‚+A’ kann nicht verwendet werden, den hier 
würden auch 3 Buchstaben passen. Unglücklicherweise gibt es in Frankreich auch Prefixe mit FB, FD, FE, FF , die nach 
der gleichen Regel zu testen sind. Sie können aber hier nicht eingebaut werden, weil sie zwar nach den gleichen Regeln 
gebildet werden, aber nicht unbedingt 3 Buchstabensuffixe haben.  Rufzeichen wie  FR, FS, FJ, FC, FT passen ebenfalls 
nicht in die 3-Buchstabenregel. Wir können die Regel aber erweitern auf : 
F[BDEF][16]:A-A=  
Sie filtert alle französischen 2-Buchstaben-Prefixe in FB- bis FF-Rufzeichen mit 1 und 6 im Rufzeichen heraus. 

4. Ostdeutsche Rufzeichen, die nicht auf A bis O en den  
Diese Rufzeichen gibt es nicht mehr, aber sie sind ein gutes Beispiel. Die Endbuchstaben müssen zwischen A und O 
liegen. Die Rufzeichen fangen mit Y2 bis Y9 an, dann folgt eine weitere Ziffer zwischen 0 und 9. Bei 1-Buchstaben-
Suffixen folgt ein Buchstabe zwischen A und O, bei 2-und 3-Buchstaben-Suffixen ein oder zwei beliebige Buchstaben 
und zum Abschluss ein A bis O. Diese Regeln gelten : : 
Y[2-9]:D[!A-O]=      für ein 1-Buchstaben-Suffix 
Y[2-9]:D:A[!A-O]=      für ein 2-Buchstaben-Suffix 
Y[2-9]:D:A:A[!A-O]=      für ein seltenes 3-Buchstaben-Suffix 
Auch hier muss jeder Fall einzeln beschrieben werden und jeweils mit [!A-O] enden, um die Verletzung der Regeln zu 
testen. 
 
Wenn Sie in der Datei CALLSIGN.PAT  nachsehen, sehen Sie die Sammlung der Regeln und die zugehörige 
Fehlerausschrift im Check-Fenster. Manche Regeln betreffen ausgesprochen seltene Fälle. 
Sie sind jetzt bestimmt zum Experten geworden und können sich daran machen, neue Regeln aufzustellen. Es wird aber 
schwierig sein, Sonderrufzeichen wie HI500ABC ausser mit dem Hinweis „CALL TOO LONG“ zu erfassen. Sie treten 
aber relativ selten auf und es liegt dann am OP sie zu akzeptieren oder abzuweisen. 

4. Ostdeutsche Rufzeichen, die nicht auf A bis O en den  
Diese Rufzeichen gibt es nicht mehr, aber sie sind ein gutes Beispiel. Die Endbuchstaben müssen zwischen A und O 
liegen. Die Rufzeichen fangen mit Y2 bis Y9 an, dann folgt eine weitere Ziffer zwischen 0 und 9. Bei 1-Buchstaben-
Suffixen folgt ein Buchstabe zwischen A und O, bei 2-und 3-Buchstaben-Suffixen ein oder zwei beliebige Buchstaben 
und zum Abschluss ein A bis O. Diese Regeln gelten : : 
Y[2-9]:D[!A-O]=      für ein 1-Buchstaben-Suffix 
Y[2-9]:D:A[!A-O]=      für ein 2-Buchstaben-Suffix 
Y[2-9]:D:A:A[!A-O]=      für ein seltenes 3-Buchstaben-Suffix 
Auch hier muss jeder Fall einzeln beschrieben werden und jeweils mit [!A-O] enden, um die Verletzung der Regeln zu 
testen. 
 
Wenn Sie in der Datei CALLSIGN.PAT  nachsehen, sehen Sie die Sammlung der Regeln und die zugehörige 
Fehlerausschrift im Check-Fenster. Manche Regeln betreffen ausgesprochen seltene Fälle. 
Sie sind jetzt bestimmt zum Experten geworden und können sich daran machen, neue Regeln aufzustellen. Es wird aber 
schwierig sein, Sonderrufzeichen wie HI500ABC ausser mit dem Hinweis „CALL TOO LONG“ zu erfassen. Sie treten 
aber relativ selten auf und es liegt dann am OP sie zu akzeptieren oder abzuweisen. 

46. Links 
46.1 N1MM Links 

N1MM Free Contest Logger Home Page.   

• Ein Überblick mit den neuesten Informationen zu Programm 

• Help-Dateien ansehen und downladen (in verschiedenen 
Sprachen)  

http://pages.cthome.net/n1mm  
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• Probleme melden und neue Möglichkeiten anfragen 

• Testeinstellungen  

• mehr 

N1MM logger discussion group   

• Diese Diskussionsgruppe bespricht Eigenschaften, auftretende 
Fehler und Ideen für den N1MMLogger 

• Werden Sie Mitglied der Diskussionsrunde   
o Stellen Sie Fragen und besprechen Sie Probleme 
o Verfolgen Sie die Weiterentwicklung des Programms  

http://groups.yahoo.com/group/N1MMLogger  

  

http://groups.yahoo.com/group/N1MMLogger/join  

Download  

• Program / Basisinstallation mit N1MM.zip 

• Programaktualisierungen/Updates  mit der aktuellen Version 
NewexeVx.x.xxx 

• Weitere Dateien / Other files  

• Windows-Hilfe   N1MMLoggerHelp.chm 

• Handbuch im PDF-Format N1MMLogger.pdf 

• Schnittstellenprogramm für 32-Bit-Systeme DLPORTIO.dll  

Gehen Sie auf die Download-Seite 

46.2 Links zu zusätzlichen Dateien (Support file links) 

HF-Länderdateien (Country files)  

• Länderdateien die in das Programm importiert werden können (cty.dat oder 
wl_cty.dat). 

• Sie können mit den Werkzeugen die Länderdateien importieren 

• Sehen Sie sich das Kapitel DXCC-Liste anpassen (Customizing the DXCC list) an  

http://www.k1ea.com/cty/index.htm 

Rufzeichen-Datenbanken für HF-Konteste 
Super Check Partial Database Files for HF contests  

• Mit der Datenbank master.dta werden bekannte Rufzeichen zum Vergleich 
bereitgestellt. Importieren Sie die Datei und geben Sie die Nachfrage in dieser Datei 
in der Kontesteinstellung frei.  
Hinweis : für verschiedene Konteste (z.B. RTTY und EU-VHF-Konteste) gibt es 
separate Dateien  

http://www.k5zd.com/scp  

Rufzeichen-Datenbank für nordamerikanische UKW-Kont este  
Super Check Partial Database Files for VHF and up c ontests (North America only)  

• Die Rufzeichen der Datei master.dta erscheinen nach Eingabe von mindestens zwei 
Zeichen im Prüffenster. Wählen Sie bei der Kontesteinstellung die zugehörige Datei 
ein.   

http://www.qsl.net/k1tr/master.htm 

46.3 Links zu Hardware  (Hardware links) 

Von N1MMLogger unterstützte Hardware  

K1EL  
http://www.k1el.com 
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• WinKey  : CW-Geber an serieller Schnittstelle  

microHAM   

• Banddekoder in Zusammenarbeit mit N1MMLogger (seriell und parallel) 
http://www.microham.com/ 

Top Ten Devices, Inc.  

• Banddekoder und SO2R-Kontroller  
http://www.qth.com/topten/ 

46.4 Links zu Programmen  (Software links) 

MMTTY Software Page  (freeware)  

• MMTTY wird für den RTTY-Contestteil benötigt 
http://www.qsl.net/mmhamsoft/ 

PSKCore.dll  (freeware)  

• DLL von Wheatley, AE4JY für die Entwicklung von  PSK31 und PSK63-
Anwendungen, eingesetzt bei N1MMLogger 

http://www.qsl.net/ae4jy/ 

winPSKX.dll  (freeware)  

• PSK31-DLL von Dave, WA0TTN. Bei N1MMLogger nicht eingesetzt, 
funktioniert aber sehr gut 

http://www.netdave.com/wa0ttn/PSK31.asp 

Master.dta Editor (freeware) 

• Ansehen und editieren der Master Callsign Database (Datei 
Master.dta),  die in vielen Contestprogrammen eingesetzt wird. Grosses 
Programm von Alex, VE3NEA 

http://www.netvampire.com/ham/ 

Dimension 4  (freeware) 

Zeitsynchronisation mit Internet-Normalzeitservern. Den Nutzern von N1MMLogger sehr zu 

Lösung für Windows XP unter  FAQ. 

http://www.thinkman.com/dimension4 

AboutTime (freeware) 

• Zeitsynchronisation mit Internet-Normalzeitservern. Den Nutzern von 
N1MMLogger sehr zu empfehlen  

• Lösung für Windows XP unter  FAQ.  

http://www.arachnoid.com/abouttime/ 

Cool Edit  (shareware) 

• Audio-Programm zum Aufzeichnen, Säubern, Mischen, Mastern und zum 
Export nach MP3. Viele, viele Möglichkeiten… 

http://www.syntrillium.com/ 

Audacity  (freeware) 

• Audacity ist ein Audio-Editor zum Herstellen, Bearbeiten, Importieren  und 

http://audacity.sourceforge.net/ 
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Exportieren von Sound-Dateien für  WAV, AIFF, und MP3-Dateien und 
mehr. Verwenden Sie es zum Bearbeiten Ihrer WAV-Dateien. 

QuickMix  (freeware) 

• Mit QuickMix können Sie die Einstellungen Ihrer Soundkarte und 
Mischereinstellungen abspeichern und wiederherstellen. Die 
Einstellungen werden in *.qmx-Dateien abgelegt 

http://www.msaxon.com/quickmix/ 

Sound Mixer  (freeware from PA1ARE) 

• Auch dieses Programm dient der Einstellung, Abspeicherung und 
Wiederherstellung von Einstellungen der Soundkarte. 

http://www.qsl.net/pa1are/software.html 

AR Cluster User  (freeware) 

• Programm zur Aufbereitung von DXCluster-Meldungen speziell für AR-
Cluster, aber auch für andere Cluster-Typen verwendbar. 
 

http://www.bcdxc.org/ve7cc/default.htm 

46.5 Links zu Contestinformationen  (Contest links) 

ARRL Contest Calendar Page  http://www.arrl.org/contests/  

SM3CER Contesting service  
 

VK4DX Contest Calendar  http://www.vk4dx.net/ 

WA7BNM Contest Calendar Main Page  http://www.hornucopia.com/contestcal/  

 
47. Übersicht zu DXClustern  (DX Clusters) 

Es gibt eine Reihe von DXCluster-Typen. Sie haben meist den gleichen Kommandovorrat, wie z.B. SH/DX nach dem 
Original von AK1A. In der Tabelle sind die DXCluster-Typen nach verschiedenen Gesichtspunkten aufgezählt. 
Informieren Sie sich bei den jeweiligen DXClustern mit der angebotenen Hilfe über die Bedienung.  : 

47.1 Überblick (Overview)  

Cluster   AR-
Cluster   

CLX  DXnet   DXSpider   Wincluster   Clusse   PacketCluster(tm)   

Progammiert von  AB5K  DJ0ZY and 
DL6RAI  

F5MZN  G1TLH  KH2D  OH7LZB  AK1A  

Betriebssystem   Windows 
32 bits  

Linux  Linux, 
Windows, Dos  

Linux, 
Windows  

Windows 
32 bits  

Dos  Dos  

Kommandosatz   SH/DX  SH/DX  SH/DX  SH/DX  SH/DX  eigener  SH/DX  

Version für den 
Überblick  

 5.04  4.3b9  1.51  2.3.8  1.0  nichts gefunden 

Noch unterstützt   Ja  Ja  Ja Ja  Ja  Nein Nein  

Kosten $$$  Freeware  Freeware  Freeware  $$  Freeware  $$  

mehrsprachig  ?  ?  Ja Ja  Nein Ja  ?  

Website  Website  Website  Website  Website  Website  Website  No  

Hilfe   Web  Web  
nichts 

gefunden  

Web  
PDF file  

from FRC  

nichts 
gefunden 

nichts 
gefunden  nichts gefunden 

Hilfe zu DX-Spots   Web  Web  nichts 
gefunden 

Web  nichts 
gefunden 

nichts 
gefunden 

nichts gefunden 
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Hilfe zu Filtern   Web  
Web  
Web  

nichts 
gefunden 

Web  
PDF file  
By Jim - 
W3BG  

nichts 
gefunden 

nichts 
gefunden nichts gefunden 

47.2 Kommandos (Commands)  

Aktion  AR-Cluster   CLX  DXnet   DXSpider   Wincluster  Clusse   

DXCluster-Abfrage  SH/DX SH/DX SH/DX SH/DX SH/DX List 

Nutzer anzeigen  SH/USERS SH/USERS SH/USERS SH/USERS SH/USERS   

WWV anzeigen  SH/WWV SH/WWV SH/WWV SH/WWV SH/WWV   

Konfiguration anzeigen      SHow/Conf       

Filter anzeigen  show/filters show/filters SHow/Filter  show/filter     

Filter setzen  set/filter [..] set/filter 5         

Einzelne Filter setzen/löschen    set/nofilter 1   clear/spots 1     

Alle Filter rücksetzen  set/nofilter set/nofilter SET/NOFilter  clear/spots all     

Seitenzahlnummer auf 0 setzen         SET/PAGE 0   

DXSpot Auswahl anzeigen    SHOW/DXDEDX         

DXSpot-Auswahl setzen    SET/DXDEDX         

DXSpot-Auswahl rücksetzen    SET/NODXDEDX         

Sprache ändern        

Sprache setzen      -   

Hilfe-Datenbank suchen        apropos <string>      

47.2.1 SH/DX-Kommandosatz  (SH/DX command set)  

SET/FILTER  
SHow/Filter  
SET/NOFilter  
SET/DX_announcements  
SET/NODx_announcements  
SET/Announcements  
SET/NOAnnouncements  

47.3 Filter und andere Möglichkeiten  (Filter and other examples/features)  

Filter für die Bänder und Sendearten sollten nicht gesetzt werden. Sie blockieren mitunter den Splitbetrieb speziell auf 
den unteren Bändern. 
Beim  Yankee Clipper Contest Club (YCCC). finden Sie Infos zu den DXClustern. 

47.3.1 AR-cluster  

Einzelheiten finden Sie unter : http://www.ab5k.net/ArcDocs/UserManual/ArcFilters.htm 

Beispiele : 
 
set/filter k/pass Sie sehen nur Meldungen und Annoncen von USA-Stationen 

set/filter k,ve/pass    Sie sehen nur Meldungen und Annoncen von USA- und kanadischen Stationen 
 
set/filter dxbm/reject vhf,uhf   VHF und UHF-Meldungen werden unterdrückt 

set/nofilter  alle Filter entfernen  
 
show/filters   alle Filter anzeigen 

47.3.2 CLX 

Einzelheiten finden Sie unter : http://clx.muc.de/user/english/html/userman.html 

SET/FILTER <nr1,nr2,..,nrX>  Filter einschalten (Meldungen unterdrücken) 
 
1 VHF 144.000 MHz und darüber 
2 HF 30.000 MHz und darunter 
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3 TOP 1.800-2.000 MHz 
4 alle CW - Bandsegmente 
5 alle SSB - Bandsegmente 
6 alle RTTY-Bandsegmente 
7 alle WARC - Bänder 
 
Sehen Sie mit SHOW/FILTERS nach, welche Filter der Sysop zur Verfügung stellt 
Beispiele :   
SET/FILTER 4,6 schaltet alle CW und RTTY-Meldungen ab 
Sie können zusätzlich weitere Filter setzen. Mit  
SET/FILTER 1,3 sperren Sie zusätzlich alle Bänder ab 2m und das 160m-Band 
Sie haben insgesamt die Filter 1,3,4 und 6 eingeschaltet. 
  

SET/DXDEDX und SET/NODXDEDX 

Mit diesen Kommandos erlauben Sie Internetspots (DX de DX) oder sperren sie (NO DX de DX) 
  
SET/DX_ANNOUNCE and SET/NODX_ANNOUNCE 
 
schaltet den Empfang von DXSpots an oder ab  
 
SET/LOGIN_ANNOUNCE  
 
schaltet die lokalen Meldungen beim Einloggen anderer Station zu. Belastet das System. 
z.B.:  
Login at 1929Z: DL6RAI 
Logout at 1930Z: DK2OY.  

47.3.3 DXSpider  

Einzelheiten finden Sie unter: http://www.dxcluster.org/main/usermanual.html oder holen Sie sich die PDF-Datei vom 
FRC : http://www.gofrc.org/pdf/dxspider.pdf 

Eine PDF-Datei zur Konfiguration von Filtern durch den Nutzer finden Sie unter DXSpider von Jim Samuals - N3BG unter  
: http://www.gofrc.org/pdf/Filter Primer.pdf 

SET/USSTATE  fügt zu einer Station den US-STATE hinzu. Die Information wird aus der FCC-Datenbank geholt. 

Das Basisformat für Filter ist : 
 
accept/spots <pattern> 
reject/spots <pattern>  

Das <pattern> hat viele Kombinationen :   

Die exakte Syntax ist für die Definition eines Spotters ist:  
 
by_zone  - Spotter in den CQ Zonen 1-40 
by_dxcc  - Spotter aus einem DXCC-Land 
by_state  - Spotter ist in ME, CT, RI, NH 
 
oder der Spotter kann auf bestimmte Bereiche beschränkt werden : 
 
call_zone  – die Zone des Spotters 
call_dxcc  – das Land des Spotters 
call_state  -  der US-Staat des Spotters 

Beispiele :  
 
accept/spots by_dxcc w,ve  <---nur Spots von W & VE -Stationen  
accept/spots by_zone 5  <--- nur Spots von Stationen aus Zone 5  
accept/spots by_state me  <--- nur Spots von Stationen aus dem Staat Maine 
reject/spots call_dxcc G  <--- keine Spots von G - Stationen  
reject/spots call_zone 14 <--- keine Spots aus der Zone 14  
reject/spots call_state md  <--- keine Spots von Stationen aus Maryland  

Löschen Sie alle Filter mit clear/spots all 
 
Die für Ihre Station eingestellten Filter bleiben beim DXSpider gespeichert.  



N1MMLogger-Hilfe V.4.0.88 Seite 218 von 227 Übersetzung von Eike, DM3ML 

Sie können die Angaben noch weiter spezifizieren :  
  
accept/spots by_dxcc w,ve and on 10m  <--- nur 10-Meter-Spots aus W & VEs  
reject/spots call_zone 25 and on 160m  <--- keine Spots aus JA auf 160m !  

47.4 Links  

General cluster information from The UK DX Cluster http://www.armscroft.demon.co.uk/UKDXC/home.html 

DX PacketCluster WebNet http://www.cestro.com/pcluster/ 

Webclusters and other usefull information  http://hamgallery.com/clusters/ 

OH2AQ WebCluster (DX-Summit) http://oh2aq.kolumbus.com/dxs/ 

  

48. DXCC-Liste anpassen (Customizing the DXCC list) 
48.1 Aktualisieren der Länder-Datei  (Updating the country file - CTY.DAT) 

In der Datei CTY.DAT sind alle Informationen zum Landesnamen, der CQ-Zone und  ITU-Zone, der geographischen 
Koordinaten des Landeszentrums usw. abgelegt. Die Datei wird für alle Conteste benötigt. Sie wird nicht direkt genutzt, 
aber ihre Daten werden in die aktuelle Datenbank eingelesen. Der Import kann ausgelöst werden und es können 
verschiedene cty.dat-Dateien für verschiedene Contest eingelesen werden. 

Wenn Sie ein Rufzeichen in das Rufzeichenfeld des Logeingabefensters eintragen, sehen Sie im linken Teil Prefix, 
Ländername, CQ-Zone und Kontinent. Im Info-Fenster stehen ausführliche Informationen zur Antennenrichtung, der 
Entfernung und Sonnenauf- und untergang am Zielort.  

Die Datei CTY.DAT bietet die Möglichkeit, Rufzeichen aufzunehmen und sie Zonen zuzuordnen, die vom Rufzeichen 
abweichen. Ein Beispiel ist K2KW, der normalerweise der Zone 5 (K2) zugeordnet würde, aber in Kalifornien (Zone 3) 
wohnt. 

48.1.1 Länder-Datei aktualisieren  (How to update the country file).  

• Holen Sie sich die neueste Länder-Datei. Siehe Punkt 7 der Tabelle unter 
Installation  und 'Update the Country file (cty.dat or wl_cty.dat)' )   

• Die Datei, die Sie benötigen, heisst cty.zip . Sie enthält Datensätze für die 
Logprogramme CT, NA, TR und WriteLog. Diese Dateien können auch 
getrennt von dieser Seite geholt werden   

• Verwenden Sie die Version für CT9 (cty.dat ) oder die Version für Writelog  
(wl_cty.dat ) 

• Kopieren Sie die Datei in das N1MMLogger-Verzeichnis  und laden Sie sie 
nach N1MMLogger mit dem Menüpunkt Tools > Reload cty.dat  

48.1.2 Format der Datei CTY.DAT  (CTY.DAT file format)  

Das Format der Datei  CTY.DAT sieht so aus  

Spalte  Länge  Beschreibung  

1 26 Landesname mit : abgeschlossen 

27 5 CQ-Zone , abgeschlossen mit : 

32 5 ITU-Zone,  abgeschlossen mit : 

37 5 2-Buchstaben-Kontinent, abgeschlossen mit : 

42 9 Breite in Grad, + für nördl.Breite, abgeschlossen mit : 

51 9 Länge in Grad, + für westl.Länge, abgeschlossen mit : 

61 9 Zeitversatz der Lokalzeit gegen GMT, abgeschlossen mit : 

69 6 Primärer DXCC-Prefix, abgeschlossen mit : 

Nächste 
Zeilen 

  
Liste der Prefixe und ganze Rufzeichen, getrennt durch Kommas, abgeschlossen mit einem 
Semikolon .  
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Hinweis : Die Leerzeichen zwischen den Feldern wurden zur besseren Lesbarkeit eingeführt. Für die Feldbegrenzung 
ist der Doppelpunkt zuständig. 

Alias-DXCC-Prefixe, das primäre eingeschlossen, folgen in anschliessenden Zeilen. Gibt es mehr als ein Zeile, fängt sie 
mit einem & an. Die Prefixe werden durch Kommas getrennt, eine Semikolon schliesst die Liste der Alias-Prefixe ab.  

Falls sich das Land über mehrere Zonen erstreckt, wird zu den Prefixen in runden Klammern die CQ-Zone und in eckigen 
Klammern die ITU-Zone angegeben. Die CQ-Zone muss vor der ITU-Zone stehen. 
Diese speziellen Zeichen werden den Alias-Prefixen hinzugefügt :   

(#) Override CQ zone where # is the zone number 

[#] Override ITU zone where # is the zone number 

48.1.3 Länder-Datei für Writelog  (Writelog country file)  

N1MMLlogger kann auch die Länder-Datei von Writelog  WL_CTY.DAT  verarbeiten. Diese Datei einhält  eine zusätzliche 
CQWW-Zoneninformation für mehrere grosse Länder wie Kanada, Australien und China. Da es in diesen Ländern sehr 
viele Prefixe gibt und zu jedem Prefix die Zone angegeben wird, ist die Datei ziemlich umfangreich. Die Datei  
WL_CTY.DAT enthält spezielle Makros, aus der die CQ-Zone für ein Prefix bestimmt werden kann. .  

48.1.4 Weitere Informationen  (Other info)  

• Sie können Kontinent und Zone auf einer Prefix-zu-Prefix-Basis abändern  
• Primär-Prefixe, die mit einem * markiert sind, sind nur für die CQWW und WAE – Conteste gültig. Sie werden vom 

Logprogamm sonst übergangen. Entfernen Sie bei der Überarbeitung bitte nicht die *.  
• Prefixe wie FR5ZQ/J werden nicht korrekt verarbeitet. Die Notation von FR/J als Prefix für  Juan de Nova 

funktioniert nicht, es sei denn, das Rufzeichen der Station ist FR/J. Sie müssen in einem solchen Fall das 
komplette Rufzeichen für das Land als Alias für dieses Land von Hand eintragen   

• Wenn Sie die Datei  CTY.DAT bearbeiten, nehmen Sie einen Texteditor wie Notepad, auf keinen Fall WORD oder 
ein ähnliche Programm. Falls Sie mit Wordpad arbeiten, achten Sie darauf, die Datei als Textdatei abzuspeichern.  

• Wenn Sie die Datei CTY.DAT geändert haben, müssen Sie sie mit Tools > Reload CTY.DAT wieder in 
N1MMLogger importieren 

• Dieser Import bezieht sich auf die jeweils aktive Datenbank. Wenn Sie auf eine andere Datenbank umschalten, 
müssen Sie auch hier die aktuelle CTY.DAT importieren. 

• Wird eine Datenbank kopiert, werden auch die neuesten Einstellungen von CTY.DAT übertragen. Hier brauchen 
Sie CTY.DAT nicht noch einmal kopieren. 

 
Hinweis zu KG4-Stationen:  Ein KG4-Rufzeichen mit einem  2x2 – Rufzeichen wird zu Guantanamo gezählt. Alle 
anderen (2x1 or 2x3) werden zu K (USA) zugeordnet. Weicht die Zuordnung eines bestimmten Rufzeichens von diesem 
Schema ab, muss es als Alias in die Liste zu dem jeweiligen Land eingetragen werden. 

48.1.5 Beispiele (Examples)  

Niederlande (Netherlands) PA  : hier gibt es keine speziellen Einträge :  CQ-Zone 14, ITU-Zone 27, EU als Kontinent, 
Koordinaten für die Hauptstadt, GMT gegenüber der Ortszeit um eine Stunde zurück, PA als Primär-Prefix (auch im Log 
als Multi), zugelassene Prefixe PA, PB, PC, PD, PE, PF, PG, PH, PI : 

Netherlands: 14: 27: EU: 52.40: -4.90: -1.0: PA:  
PA,PB,PC,PD,PE,PF,PG,PH,PI;  
 
Grönland (Greenland) OX  : auch alles normal, nur das Sondercall XP1AB wurde als Alias zusätzlich eingetragen  :  

Greenland: 40: 05: NA: 62.50: 45.00: 3.0: OX:  
OX,XP1AB;  
 
Afrikanisches Italien (African Italy) IG9  : Das ist ein Fall mit einem * vor dem Primär-Prefix, es zählt nur für CQ-
Conteste :   

 
African Italy : 33: 37: AF: 35.40: -12.50: -1.0: *IG9:  
IG9,IH9,IQ9L,IZ9;  
 
Sehen Sie sich die Einträge für VE und UA9 in der Datei CTY.DAT an.  
 
Beispiel für einen Writelog-Eintrag mit dem Makro #  und der Zuordnung von ausgewählten chinesischen Prefixen zur 
CQ-Zone 23, der Rest gehört zur Zone 24. 
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China:  24: 44: AS: 40.00: -116.40: -8.0: BY:  
# BY: BY3G(23),BY3H(23),BY3I(23),BY3J(23),BY3K(23),BY3L(23),  
BY9A(23),BY9B(23),BY9C(23),BY9D(23),BY9E(23),BY9F(23),BY9G(23),  
BY9H(23),BY9I(23),BY9J(23),BY9K(23),BY9L(23),BY9T(23),BY9U(23),  
BY9V(23),BY9W(23),BY9X(23),BY9Y(23),BY9Z(23),BY0(23);  
3H,3I,3J,3K,3L,3M,3N,3O,3P,3Q,3R,3S,3T,3U,BG,BT,BW,BY,BZ,XS;  

49. Technische Informationen (Technical Information) 
49.1 Überblick  (General Information) 

N1MMLogger ist ein Contestprogramm. Es ist in Microsoft Visual Basic geschrieben und nutzt eine Microsoft Access 
2000 – Datenbank um die Daten abzuspeichern. Das Schreiben und Lesen von Daten in und aus der Datenbank wird mit 
SQL (Structured Query Language) realisiert.  
Zum Abarbeiten von N1MMLogger werden keine weiteren Programme und Dateien benötigt, als die in der 
Basisinstallation und bei der Programmaktualisierung (Update) mitgelieferten. 

Müssen Sie nachstehende Information unbedingt lesen ?  NEIN (NO) 

Wir empfehlen Ihnen, keinerlei Daten der Datenbanken oder Inhalte anderer Dateien zu ändern, wenn Sie nicht ganz 
sicher sind, was Sie tun. Sie können das Verhalten des Programms verändern und fehlerhafte Ergebnisse erhalten. 
Gehen Sie bei solchen Problemen zurück zur Originalfassung.  

Wir lehnen den Support für Nutzer ab, die die Struktur der Datenbank oder ihren Inhalt geändert haben. Das gleiche gilt 
für Änderungen in der Registry oder Änderungen in vom Programm genutzten Dateien. 

Übrigens : Sie sind sich selbst überlassen !  

 
Hinweis  : Es besteht keine Notwendigkeit die Datenbank oder die Registry zu ändern  

Wenn Sie sich für die Datenbank und ihre Struktur interessieren, öffnen Sie sie mit Microsoft Access 2000 oder dem 
Access 2000 Viewer oder älteren Versionen.   

 
Hinweis  : Machen Sie vorher ein Backup der Datenbank und/oder des gesamten N1MMLogger-Verzeichnisses Note:  

49.2 Warum gibt es diese Information ?  (Why is this information given?)  

Sie können mit einem Direktzugriff die gespeicherten Daten auf eine Weise verarbeiten, die vom Programm selbst nicht 
bereitgestellt wird.  

Beispiele :  

• Sie können mit einiger Kenntnis von SQL und Access die Daten nach Ihren Wünschen auswerten   
• Die Daten können mitunter wesentlich einfacher geändert werden, als es mit N1MMLogger möglich ist. Beispiel : 

QSO-Zeit um eine Stunde für den ganzen Contest verschieben  

 
Hinwweis : Machen Sie nach jeder Änderung eines QSO ein Rescore !   
Multis und QSO-Punkte werden im Cabrillo-Log geändert.  

Noch ein Hinweis : Sie können keinen Contest auf diese Weise hinzufügen. Die Conteste und die Regeln dazu stehen 
im Hauptprogramm N1MM logger.exe  und werden  nicht in der Datenbank oder anderen Dateien abgelegt. 

49.3 Verzeichnisstruktur (Directory structure)  

Voreingestellt wird N1MMLogger unter Program Files  im Laufwerk C: installiert. Es werden zwei Unterverzeichnisse für 
die Arbeit mit der Soundkarte angelegt, hier mit DVK ( Digital Voice Keying) bezeichnet. 
Anmerkung DM3ML : Der Installationsort von N1MMLogger ist frei wählbar. 

C:\Program Files\N1MM 
Logger 

Programmverzeichnis (voreingestellt) 
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C:\Program Files\N1MM 
Logger\Letters 

Enthält alle WAV-Dateien für Buchstaben, Zahlen und Sonderzeichen, um ein Rufzeichen 
oder eine Kontrollnummer zu buchstabieren. Beispiele sind auf der N1MM-Seite unter 
Other Files zu finden. 

C:\Program Files\N1MM 
Logger\Wav 

Enthält alle WAV-Dateien für die Funktionstasten in einem SSB-Contest, Diese Dateien 
müssen Sie sich selbst herstellen. 

49.4 Wo sind die Programminformationen gespeichert ( Where is the program information stored?)  

Die Programminformationen sind an verschiedenen Stellen abgelegt :  

• ACCESS-Datenbank   
o Hat beim Erststart den Namen HAM.MDB  
o Sie können anderen Datenbanken hinzufügen  
o Alle Infos zum Contest  

� Contestdaten  
� Stationsdaten  
� QSO's im Contest 
� Packet-DXSpots  
� F-Tasten-Belegung  
� Länder-Daten  
� U.a.  

• N1MMLogger.ini – Datei  
o Programmeinstellungen aus der Konfiguration  
o Fenstereinstellung  

• Konfigurationsdateien  
o Einstellung für den externen TNC 
o MMTTY-Einstellungen  

• Andere Dateien   
o Wav-Dateien für CQ, QRZ u.a.  
o Exportierte Cabrillo-, ADIF-, generic log- und Summary-Dateien 
o *.sec-Dateien für spezielle Contest (Sektions-Dateien z.B.) 

49.5 Die ACCESS-Datenbank  (The Access database)  

Die Datenbank enthält Tabellen mit zugehörigen Daten :.  

Tabelle  Inhalt  

Antennas 
Antennendaten aus Config  > Configure Ports, Telnet Address, Others >   Karteikarte 
Antennas  

BandModeFrequency Transceiver/VFO-Nummer, Frequenz, Sendeart für Bandwechsel 

CallHist Rufzeichentabelle für die Funktion Call History Lookup  

Contest Alle mit dem Programm abarbeitbaren Conteste 

ContestInstance Liste der schon gearbeiteten Conteste (Previous contests ) 

CTYDAT Länderinformation zu Prefix, Ländername, CQ- und IARU-Zone, Breite, Länge u.a. 

DXLOG QSO's aller vorherigen Conteste 

Lookup F-Tasten, Staaten, Provinzen usw. 

PacketSpots DXSpots für alle Bänder. Sie werden in den Bandskalen angezeigt 

PacketSpotsTest Test-Packet-Spots für die Programmentwicklung 

Prefixes Vom Programm erkannte Prefixe mit dem voreingestellten Länderprefix 

SectionsWorked Multiplikatortabelle / Multis je Band  

Station Stationsdaten wie Rufzeichen, Name, Adresse u.a. 

ValidCalls Nicht mehr verwendet (leer) 
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49.6 Die Datei N1MM logger.ini-Datei (The "N1MM logger.i ni" file)  

Alle Einstellungen in der Datei N1MM logger.ini können über das Programm im Nutzer-Interface gesetzt werden. 
Voreingestellte Werte finden Sie unter Default Settings.txt  . Entspricht eine Einstellung von N1MMLogger der 
Voreinstellung, ist sie in der Datei N1MM logger.ini nicht zu finden. Beide Dateien finden Sie im Programmverzeichnis. 
Die Datei N1MM logger.ini  ist in Funktionen (oben in der Datei) und Fenster (unten in der Datei) eingeteilt. Werden in 
den Abschnitten Funktionen gelöscht, werden die Voreinstellungen genommen. Die Abteilung mit den Fenstern enthält 
die Postionen und andere Angaben zu den Fenstern Diese Angaben sollten nicht geändert werden, es sei denn, ein 
Fenster wird entfernt. 
Sie sollten die Anordnung der Datei beibehalten, so ist es einfacher einen Punkt zur Diskussion in der Nutzergruppe 
anzugeben. Kommentare werden durch ein Semikolon ; eingeleitet.  

49.6.1 Funktionen-Abschnitt (Functions section )  

Possible functions are: 

[Com1] [Com2] [Com3] [Com4] [Com5]  [Com6] [Com7] 

[Com8] [Lpt1] [Lpt2] [Lpt3] [MutiplierWindow] [SO2R/V] [Files] 

[Digital1]  [Digital2] [MMTTY] [Function Keys] [Other] [Winkey] [Mode Control] 

[Antennas] [SO2R/V Setup] [Available] [Packet]  [Configurer] [ConfigurerDialog] [CW Window]  

[Digital Interface] [Digital Interface Setup] [DigitalIO2] [EditContact] [EditLookupTable]      

Beispiele  :  

[Packet]  
Packet Tab=1  - Telnet window is selected, if removed the Packet ta b is selected.  

[Configurer] 
Database Name= C:\Program Files\N1MM Logger\PI4GN-Maart-2004.mdb Selected database   
Contest Type= VHFREG1 Selected contest in the selected database   
Contest NR =1 Selected contest number in the selected database   
Recent Contest 1= VHFREG1:6-3-2004:C:\Program Files\N1MM Logger\PI4GN-Maart-2004.mdb Most recent opened 
contest   

49.6.2 Fenster-Abschnitt (Window Section)  

Mögliche Fenster sind  

[EntryWindow] [EntryWindow2] [GraphicalBandMap 1] [GraphicalBandMap 
2] 

[InfoWindow] [Log] [LogTypeSelectionDialog] [MultsByBand] 

[PacketWindow] [PSKEngine] [ScoreSummary] [StationDialog] 

[SuperCheckPartial] [AvailableMultsAndQs] [BandMap]   

Beispiele :  

[EntryWindow] 
Top=3825  
Left= 2985 
Height= 3330 
Width= 5370 

[PacketWindow] 
WindowState= 0 Window is open (default) or closed (0), the Entry w indow can not be closed  
Top=9000 
Left= 3270 
Height= 2550 
Width= 12105 
Telnet Port= K1TTT.NET The selected telnet cluster from the list. Specific  for this section.  

[BandMap] 
CW Wide - 1=*RMF400CW Narrow - 1=*RMF250 

[InfoWindow] 
WWVMessagesVisible=False WWV messages are not shown in the Info window   



N1MMLogger-Hilfe V.4.0.88 Seite 223 von 227 Übersetzung von Eike, DM3ML 

49.7 Konfigurationsdateien  (Configuration files)  

Nach der Installation befinden sich Dateien im N1MMLogger-Verzeichnis.  

49.7.1 Programmdateien (Program files)  

Löschen Sie auf keinen Fall diese Dateien !!  :  

• arrow.bmp: Pfeil für die passive Bandskala  
• ClearRegistry.bat : Löscht die Registry und entfernt die Programmeinstellungen. Nach diesem Programm müssen 

alle Daten für N1MMLogger neu eingestellt und konfiguriert werden. Gilt nicht 
für N1MMLogger ab Version 4, dann kann diese Datei gelöscht werden. 

• cty.dat: ist der voreingestellte Name der Länderdatei, kann mit Tools > reload CTY.DAT in die Datenbank 
eingetragen werden  

• CW IF.exe : ist eine Active X – Komponente und erzeugt CW  
• cyanarrow.bmp : Pfeil für die aktive Bandskala  
• Default Settings.tx : enthät die Voreinstellungen, Differenzen dazu stehen in der N1MM Logger.ini  
• dirswap.BAT : Umbenennung des WAV-Verzeichnisses (Beispiel)  
• empty.wav : stoppt die Aussendung einer WAV-Datei  
• led_Red.bmp : ICON zur Markierung einer wichtigen Ausschrift  
• master.dta : Rufzeichendatei mit Contest-Stationen  
• N1MMLoggerHelp.chm : Windowshilfe für N1MMLogger, mit ALT-H rufen  
• N1MM Logger.exe : Hauptprogramm von N1MMLogger  
• N1MM loger.ini : Konfigurationsdatei für Funktionen und Fenster. Sorgfältig editieren !   
• N1MM loger.ini.init : Konfiguration aus der Datei NewExe . Wird in N1MM Logger.ini umbenannt, wenn diese Datei 

nicht gefunden wird. 
• reddot.gif : Warnung für Mitteilung im Eingabefenster 
• *.sec : Textdateien für verschiedene Conteste , wie  SAC.sec, REF.sec u.a. 
• ST6UNST.LOG : Datei zur Uninstallation von N1MMLogger  
• Suncalcs.dll : berechnet Sonnenstand  
• Update Log.wri : Änderungsgeschichte der Programmentwicklung (kann gelöscht werden)  
• Upgrade.bat : registriert CW IF.exe unter Windows, wird automatisch gestartet  
• *.init : markiert die bei der Erstinstallation verwendeten Dateien z.B. ham.mdb als ham.mdb.init. Können gelöscht 

oder gegen vorhandene Dateien ausgetauscht werden.  

49.7.2 Datenbankdateien (Database files)  

• ham.mdb : voreingestellte Datenbank (nicht löschen !)  
• new.mdb . voreingestellte Datenbank für die Erzeugung einer neuen Datenbank durch den Nutzer (nicht löschen !)  
• *. MDB : Datenbanken, die mit File > New Database erzeugt werden 

Wenn Sie eine Datenbank löschen, verlieren Sie alle QSOs. Eine gute Praxis ist es, für grosse Conteste eine neue 
Datenbank einzurichten und ihr den Contestnamen zu geben, z.B. PACC2002.mdb  

49.7.3 Vom Nutzer erzeugte Dateien (Files created on your command)  

• N1MMSettings.txt : erzeugt mit File  > Export > Export Windows settings to File  
• N1MMWindows.txt : erzeugt mit File > Export > Export Program settings to File  
• <YOURCALL>.ADI :  ADIF-Datei erzeugt mit File > Export > Export ADIF to file...  
• <YOURCALL>.LOG:  Cabrillo-Log erzeugt mit File / Export / Export Cabrillo to file... 
• <YOURCALL>.SUM : Logdeckblatt (Summary) erzeugt mit File > Export > Print Score Summery to File 
• <YOURCALL>.TXT : Logdatei (generic log) erzeugt mit File >  Export > Export to File (Generic)...  
• *.MC : enthält die Funktionstasten-Belegung  
• *.TXT : enthält andere Dateien, z.B. die Packet/Telnet-Tasten 

49.7.4 RTTY-Dateien  (RTTY files)  

Zu MMTTY gehören mehrere Dateien, die nicht in der N1MMLogger-Installation vorhanden sind und von MMTTY 
angelegt werden, wenn es im N1MMLogger-Verzeichnis steht : 

• MMTTY.exe : MMTTY-Programm  
• MMTTY.ini :  MMTTY-Konfigurationsdatei  
• MMTTY.* : andere von MMTTY benutzte Dateien 
• XMMT.ocx : wird von  MMTTY.exe benötigt  
• Settings.txt : Beispieledatei für die Einstellung des AEA PK-232-Controllers  
• UserPara.ini : MMTTY-Programmeinstellung des Nutzers  

49.7.5 PSKCore-Dateien  (PSKCore files)  
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Im N1MMLoggerverzeichnis werden nur zwei DLL-Dateien benötigt :   

• PSKCore.dll (datiert vom 6/5/20003)  
• XMMT.ocx  
• PSK63.dll (kann gelöscht werden)  
• WINPSKX.dll (kann gelöscht werden)  
• PSK.pal : Farbeinstellungen (nicht mehr benötigt, kann gelöscht werden) 
• WINPSKX.oca - WINPSK support file (nicht mehr benötigt, kann gelöscht werden)  

49.8 Weitere Informationen  (Other info)  

Die Aufzeichnung (Recording) -  mit dem Schalter im Eingabefenster aktivierbar - wird mit 11025 Hz, 8 bit, mono 
gemacht und benötigt ca. 1 GB in 24 Stunden 
 

50. Ausserhalb des offiziellen Programms, aber interessant (Off Topic, but nice to know) 

Dieses Kapitel gibt Tipps zum Contesten, die bei Diskussionen im YAHOO-Reflektor entstanden sind. Sie gehören nicht 
unbedingt zu diesem Handbuch, aber wie heisst es in der Überschrift : Ausserhalb des offiziellen Programms, aber nett 
zu wissen. Wir danken den Autoren für ihre Mitarbeit … 

50.1 Dupes arbeiten oder nicht  (Working dupes or not) 

Zur Zeiten der Papierlogs wurde man bestraft, wenn man zu viele Doppel-QSOs im Log hatte und diese nicht als solche 
markiert waren und man Punkte dafür haben wollte. Mir ist aber kein Fall bekannt, dass man bestraft wurde, wenn man 
Doppel-QSOs im Log hatte, diese aber markiert hat und KEINE Punkte dafür haben wollte. 
Es ist schon ein bisschen ironisch, dass es im Cabrillo-Logformat keine Möglichkeit gibt, Doppel-QSOs zu markieren. Der 
Contestveranstalter lässt alle Logs durch sein Contestauswerteprogramm laufen und berechnet die Punktzahlen nach 
seinen Regeln, so dass Sie sich über Doppel-QSOs keine Gedanken mehr machen müssen. 
Nun zu Ihrer Frage ; ON5ZO  arbeitet 6Y2A, trägt aber BY2A ins Log ein. 6Y2A loggt richtig ON5ZO. 6Y2A bekommt das 
QSO anerkannt, so lange nicht noch ein Log von BY2A kommt. Schickt aber BY2A ein Log, das Log wird mit ON5ZO 
verglichen und das QSO nicht gefunden, so wird es gestrichen. Schickt aber BY2A kein Log, bleibt das QSO gültig. 
Ruft ON5ZO während des Contests 6Y2A noch einmal und nun mit richtigem Rufzeichen an, wird er von 6Y2A mit 
QSOb4 abgewiesen .ON5ZO ist sich keiner Schuld bewusst, bei ihm steht ja BY2A. Hätte man bei 6Y2A den Schalter 
„logge DUPES“ auf EIN gestellt, wäre jetzt ON5ZO noch einmal im Log, bei ON5ZO würde beim Vergleich auch 6Y2A 
gefunden und beide bekämen ihre Punkte. 

Lassen Sie also ruhig Doppel-QSOs zu. Sie sind dann auf der sicheren Seite und überlassen Sie es dem 
Auswerteprogramm des Contestveranstalters, sie anzuerkennen oder auszusortieren. 

 David Robbins, K1TTT  
e-mail: mailto:k1ttt@arrl.net  
web: http://www.k1ttt.net  

50.2 Arten des Funkbetriebs (Types of operating ) 

Running-Modus : Hier haben Sie in der Regel nur ein Auge auf neue Multis unter den DX-Spots. Sie können die Filter 
so einstellen, dass Ihnen nur neue Multis angezeigt werden, die Sie zwischendurch arbeiten und dann wieder zu Ihrer 
CQ-Frequenz zurückkehren. 
  

Der traditionelle S&P-Modus : Sie suchen das Band ab und prüfen jedes Signal, das Sie hören. Hier helfen die 
Bandskalen, in denen Sie eine Station identifizieren und sie als neues QSO, neuen Multi oder Dupe einordnen können.  
  

Der neue Packet-unterstützte S&P-Modus : Sie starten an einem Bandende und springen von einem DX-Spot zum 
anderen und arbeiten das Angebot ab. Bei den hohen Melderaten ist dieses Verfahren recht effektiv. Speziell für 
Stationen im SO2V oder SO2R-Betrieb, die auf einem Band CQ rufen und mit auf dem anderen Band Multis sammeln, ist 
es das geeignete Verfahren. 
  

David Robbins, K1TTT  

50.3 Eingabe schneller machen  (A qso speedup tip (how is your typing speed?))  

Ich bin mit CT gross geworden. Wenn Sie dort die Einfg (Insert) – Taste drücken wird das Rufzeichen der Gegenstation 
und der Rapport gesendet. 
Um der Gegenstation schneller antworten zu können, gebe ich nur das Prefix ein, behalte den Suffix im Kopf, drücke 
sofort die Einfg-Taste und gebe dann das Suffix ein. Die Gegenstation muss nicht warten, bis ich das komplette 
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Rufzeichen eingegeben habe und ich komme sofort für sie zurück und ihr Rufzeichen wird auch komplett gesendet. Sie 
sparen eine Menge Zeit und können mehr Station der Zeiteinheit arbeiten. 
Dieser Trick funktioniert auch im ESM-Modus, Sie können aber unter N1MMLogger die Insert-Taste ebenfalls 
programmieren. 

73 es CU in contest! 
Franki ON5ZO  

50.4 Ist GMT gleich GMT ?  (GMT is GMT, or not?) 

Nein, nicht ganz. Die schmucken Entwickler von Bill Gates hatten Schwierigkeiten, die Greenwich Mean Time (GMT)  
von der Ortszeit in Greenwich zu trennen. Wenn Sie Ihren PC auf GMT, das heisst die Ortszeit für  Dublin, Edinburgh, 
Lisabon, London einstellen, haben Sie während der Sommerzeit eine Differenz von einer Stunde plus gegen die „echte“ 
GMT. Wenn Sie diese „echte“ GMT auf Ihrem PC haben wollen, wählen Sie unter Zeitzone GMT für Casablanca und 
Monrovia, hier gibt es keine Sommerzeit-Effekte. 

Unter N1MMLogger können Sie Ihren PC aber beruhigt mit Ihrer Ortszeit laufen lassen, das Betriebssystem übernimmt, 
daraus die jeweils richtige GMT zu machen. 
 

51. Zusätzliche Programme (Additional Software) 
51.1 I8NHJ web interface 

I8NHJ hat ein sehr nettes Web-Interface zur N1MMLogger-Datenbank geschaffen. Sie erhalten online eine aktuelle 
Statistik über den Contest, gearbeitete Stationen und mehr in Echtzeit.  Sehen Sie sich die Datei 
WebInterface_Howto.txt  in der ZIP-Installationsdatei an. Getestet mit Windows NT/W2K/XP. Sie benötigen MSOffice 
und MSAccess 2000. MSOffice wird nicht extra benötigt wenn zusammen mit dem N1MMLogger gearbeitet wird. Es wird 
für das Web-Interface gebraucht. 

Aus der Datei HowTo.txt file und weitere Informationen von Max, I8NHJ 

Das Programm wurde geschrieben, um ein einfaches, aber leistungsfähiges und nützliches Interface zum Log, das von 
N1MMLogger während eines Contests oder einer DXpedition erzeugt wird, zu erzeugen. Es wird verbreitet als AS IS, 
unter den GNU-Lizenzbedingungen. Es kann frei benutzt und verteilt werden, Sie sollten aber den Erzeuger (I8NHJ) und 
den Programmierer (AGO) nennen, der bei der Entwicklung des Kodes zur Version 1.0, November 2002 geholfen hat. 

Das Web-Interface wurde in einer in die Tiefe gehenden ASP-Technik geschrieben und benötigt volle ASP-
Unterstützung. Es ist einige Nachforschung nötig, um eine gute ASP-Unterstützung auf anderen Plattformen als bei 
Microsoft zu finden und diese Art der Lösung wird für einen durchschnittlichen Nutzer zu komplex.  

Um die volle Funktion des Werkzeugs zu erhalten, muss das Microsoft-Office-Paket auf der Serverseite installiert sein. 
MSccess wird nicht unbedingt benötigt, denn einige grafische Werkzeuge können von EXCEL und WORD genutzt 
werden. T  

Erläuterungen von  Franki, ON5ZO  

Max, I8NHJ, hat ein Interface zum N1MMLogger und seiner Datenbank (*.mdb-Dateien) geschaffen. Sie sehen es voll in 
Aktion, wenn Sie auf den Link  http://193.207.106.231/s05x/log/default.asp gehen. Hier wurde ein Beispiel unter 
Verwendung des Logs der Dxpedition SO5X aufgebaut. Sehen Sie sich an, wie es funktioniert und holen Sie das 
Programm für den eigenen Gebrauch. 

Sie können Sich das Programm von der N1MM logger website holen, wenn Sie dort zum Menü  Other files gehen .  Der 
Dateinamen ist 'webinterface1-x.zip  . Es ist aber kein Programm, das allein läuft. Es ist eine Art Webseite und Sie 
müssen einen Webserver auf Ihrem PC laufen lassen. Es gibt mehrere Möglichkeiten : 

a) Sie wissen alles über Server und ASP und haben schon einen Server mit ASP am laufen. Sie wissen mehr als ich ... 

b) Sie haben einen PC mit Windows 2000 / NT / XP Pro > Installieren Sie ein Ding, das heisst IIS. Sie können ISS von 
Ihrer Installations-CD holen, idem Sie das Windows-Setup > Komponenten hinzufügen starten.  

c) Win XP Home: sie haben Pech,  IIS wird nicht mitgeliefert. Sie können aber mal die Adresse  
http://www.15seconds.com/issue/020118.htm probieren und einen freien Nicht-Microsoft-Server mit ASP-Unterstützung 
installieren (Siehe Information weiter unten von Dave, G3VGR) 

d) Läuft Ihr Rechner unter Windows 98 (eventuell geht  Windows 95 auch, nicht getestet), gehen Sie zu  
http://coveryourasp.com/PWS.asp und arbeiten Sie die Schritte 1 bis 7 ab. 
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Wenn a) bis d) erfolgreich war und der Server IIS oder PWS läuft, folgen Sie den Vorgaben von Max in seiner ZIP-Datei 

73' Franki 

Zusätzliche Information von Dave, G3VGR 

Ich habe das I8NHJ-Interface erfolgreich mit der Freeware Abyss Web Server  von http://www.aprelium.com/ getestet 
Fügen Sie die ASP-Unterstützung mit der Freeware  ActiveHTML  von seliSoft hinzu. 
http://www.selisoft.com/en/ahtml/index.html. 
Auf der Aprelium-Website erhalten Sie Hilfe, wie Sie die Programme nutzen  http://www.aprelium.com/abyssws/asp.html. 
 
Ich selbst haben mit N1MMLogger gerade erst angefangen, so dass ich nur ein kleines Testlog ausprobiert habe.  

73, Dave 

Zusätzliche Informationen von Uffe, PA5DD 

Ich habe vor kurzem mein ganzes System auf Windows 2000 (gilt auch für XP) umgestellt. Es funktionierte alles 
problemlos, bis ich I8NHJ Web interface aktiviert habe. Dabei war die gleiche Datenbank von LOGGER32 geöffnet. Der 
Zugriff wurde abgewiesen. LOGGER32 öffnet die Datenbank „exklusiv“. das hat mit den Zugriffsrechten zu tun. Nach 
Öffnen des Web-Interfaces müssen dem Internetnutzer Zugriffsrechte sowohl zum Web-Interface als auch zum 
LOGGER-Verzeichnis eingeräumt werden. Sehen Sie unter  
http://www.aspemporium.com/aspemporium/tutorials/permdenied.asp , 
wie das gemacht werden muss. 
Der Web-Server sollte die Datei default.asp in seiner Liste der voreingestelltelten Dokumente haben. Alternativ können 
Sie diese Seite direkt adrssieren mit  http://localhost/logger/default.asp  

73 Uffe PA5DD  

zum Personal Web Server 

Falls Sie Win’95 auf Ihrem Rechner installiert haben, können Sie den Microsoft Personal Web Server vom Optionspaket 
von Windows NT 4.0 auf Ihrem Rechner installieren. Sie können das Option Pack.von der Microsoft Web Site holen. 
Den Microsoft Personal Web Server (PWS) kann man auch im Add-on\pws-Verzeichnis der Installations-CD von 
Win98SE finden (mindestens jedoch auf der Win98SE upgrade CD, US version.  

Zusätzliche Information zum PWS von Frans, PA5CA  

Ich installierte die PWS-Software für WIN98SE. Sie müssen vor der Installation eine DLL-Datei überschreiben. 
Ich habe einige Zeit gebraucht, bis ich die ASP-Statistik zum Laufen gebracht habe, aber jetzt funktioniert es sehr gut. Ich 
benutze die folgenden Links :   

http://support.microsoft.com:80/support/kb/articles/Q246/0/81.ASP &NoWebContent=1 

http://support.microsoft.com/default.aspx?scid=fh;NL;w98  

73 Frans PA5CA 

52. Schlusswort zur Übersetzung von DM3ML 
 
Ich habe mal den elektronischen Übersetzer aus dem Internet versucht und das ist für einen kleinen Abschnitt dabei 
herausgekommen :  
 
 Die N1MM Blockwinde ist ein Freeware- Programm, das entworfen wird, um den loggenden und etwas allgemeine   
Protokollierung Wettbewerb zu tun. Es ist nicht ein allgemeines loggenprogramm mit Preis aufspüren etc., aber es ist  
hauptsächlich ein loggenprogramm des Wettbewerbs. Überprüfen Sie die Eigenschaften Registrierung.  
 
Es ist mir also nichts anderes übriggeblieben, als den Text von der ersten bis zur letzten Seite in einem ordentlichen 
Deutsch einzutippen. 
 
Ich bin so vorgegangen bzw. habe so vorgehen müssen : 
 

• Ich habe die mitgelieferte englische Help.chm-Datei mit einem Unpacker auseinander genommen. Es entstanden 
diverse HTML-Dateien mit der zugehörigen Kapitelüberschrift.  

• Diese HTMLs habe ich nach WORD-2000 importiert und WORD-Dateien daraus gemacht. 
• Diese Dateien habe ich nach dem Inhaltsverzeichnis des PDF-Handbuchs wieder zusammengebaut. Ich habe zu 

allen Überschriften den englischen Originaltitel in Klammern stehen lassen, um eine Referenz zum englischen 
Handbuch zu ermöglichen.  
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• Alle Links innerhalb der neuen WORD-Datei waren neu zu definieren und zuzuordnen 
• Dann habe ich mich von Seite 1 bis zum Ende durchgekämpft und den englischen Text Abschnitt für Abschnitt 

durch den deutschen Text ersetzt 
• Ich habe erheblichen Ärger mit der Übernahme der Aufzählungen (die mit dem Punkt davor) gehabt und musste 

alle neu und einzeln formatieren 
• Das N1MMLogger-Programm lief beim Übersetzen im Hintergrund mit, damit ich sehen konnte, was der Autor sich 

so gedacht hat und wie die Tasten funktionieren. Dabei erkannte und auftretende Probleme und Rückfragen habe 
ich direkt über den YAHOO-Reflektor geklärt.  

• Ich habe mich bemüht, der deutschen Sprache möglichst viel Gerechtigkeit zukommen zu lassen. Nicht übersetzte 
englische Fachbegriffe und Menü-Punkte habe ich jeweils fett und kursiv markiert. 

• In einigen Kapiteln habe ich den freien Redefluss der Autoren etwas gekürzt und ihre mitunter sehr wortreichen 
Ausführungen auf den technischen Inhalt reduziert und ohne Sinnverlust komprimiert (deswegen auch der Verweis 
zum englischen Original) 

• Die Contestbeschreibungen habe ich nicht übersetzt. Sie sprechen für sich und sollten in Verbindung mit 
deutschen Contestausschreibungen vorbereitet werden. 

• Ich habe zum Schluss  aus der WORD-2000-Datei wieder eine PDF-Datei gemacht, damit die Nutzer unabhängig 
von ihrem Betriebssystem das Handbuch lesen können.  
Die Erfahrungen mit anderen Übersetzungen haben gezeigt, dass die Verteilung als WORD-Datei nicht sinnvoll ist, 
z.B. lassen sich Grafiken aus WORD-2000 nicht mit WORD-97 drucken und alle Bilder werden unterdrückt. Bei der 
Umsetzung von WORD in PDF habe ich größere Probleme gehabt. Mein Rechner verläuft sich bei der Adobe-
Version des PDF-Makers ins Nirwana, so dass ich die Umsetzung mit einer anderen Software machen musste, bei 
der leider die Links innerhalb des Dokuments nicht übernommen werden.  

• Bitte teilen Sie mir Übersetzungs- und Tipp-Fehler mit, damit ich diese Datei korrigieren kann. Ich bitte im Voraus 
um Entschuldigung 

• Die vorliegende Übersetzung hat die Versionsnummer 4.0.88. Sie ist aus dem Vergleich mit dem der letzten 
Version zu Grunde liegenden Version 3.0.109 entstanden. Die Änderungen betreffen eine Menge an Details, es 
sind auch größere Änderungen und neue Kapitel dazu gekommen, ohne dass sich an der prinzipiellen Funktion 
von N1MMLogger etwas geändert hat. Ich werde mich weiter bemühen, die deutsche Hilfe in grösseren Abständen 
auf den neuesten Stand zu bringen. 

 
Viel Spass mit N1MMLogger und Gut Funk wünscht Eike, DM3ML 
Dresden, 26.8.2004 
 

 


